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NEO Lighting Control Console
IMPORTANT INFORMATION

Warnings and Notices

Philips Strand Lighting Limited Two-Year Warranty
Philips Strand Lighting offers a two-year limited warranty of its products against defects in materials or
workmanship from the date of delivery. A copy of Philips Strand Lighting two-year limited warranty containing
specific terms and conditions can be obtained from the Philips Strand Lighting web site at www.strandlighting.com
or by contacting the local Philips Strand Lighting office.

When using electrical equipment, basic safety precautions should always be followed including the following:

a. READ AND FOLLOW ALL SAFETY INSTRUCTIONS.

b. Do not use outdoors.

c. Do not use near gas or electric heaters.

d. The use of accessory equipment not recommended by the manufacturer may cause an unsafe 
condition.

e. Do not use this equipment for other than intended use.

f. Refer service to qualified personnel.

SAVE THESE INSTRUCTIONS.

WARNING: You must have access to a main circuit breaker or other power disconnect device before installing 
any wiring. Be sure that power is disconnected by removing fuses or turning the main circuit breaker off before 
installation. Installing the device with power on may expose you to dangerous voltages and damage the device. 
A qualified electrician must perform this installation.

WARNING: Do not open the console. There are no user serviceable parts inside. This equipment is designed to 
operate from the mains electrical supply and contains voltages, which, if touched, may cause death or injury. It 
should only be operated in accordance with the instructions provided and for the purpose of a lighting control 
system.

WARNING: Avoid spilling liquid on the equipment If this should happen, switch the equipment off 
immediately at the mains. To reduce the risk of fire or electric shock, do not expose the equipment to rain or 
moisture. For indoor use only.

WARNING: Refer to National Electrical Code® and local codes for proper use specifications.

WARNING: This equipment is intended for use in accordance with the National Electric Code® and local 
regulations. It is also intended for installation in indoor applications only. Before any electrical work is 
performed, disconnect power at the circuit breaker or remove the fuse to avoid shock or damage to the control. 
It is recommended that a qualified electrician perform this installation.
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INTRODUCTION

1. Preface

The introduction of the NEO lighting control console marks a new chapter in the evolution of control. This console
allows the ability to seize light; to grab, move, change position, color and motivate the lighting design simply and
effectively. The NEO lighting control console is the closest that a designer can get to actually touching the light;
encompassing the dreams and aspirations of both professionals and amateurs alike. 

The NEO lighting control console starts with the inclusion of many timesaving features, allowing the user to program
faster and more accurately. NEO is a native graphical interface console with Command Line support. NEO allows the
user to choose between traditional Command Line style operation and touchscreen style operation using the
Graphical User Interface. 

With advanced features for all lighting situations, from museum to stage shows, NEO does it all. Control up to 100
DMX Universes with 25,000 control channels. Authorization can be purchased in DMX Universe blocks for a truly
scalable system.

This manual describes all of the features of the software and demonstrates how to use it to its fullest potential.

2. About This Guide

Congratulations on your purchase of a Strand Lighting NEO Lighting Control Console. This manual provides
important information regarding safety, installation, and operation for all console hardware components.
Familiarizing yourself with this information will help you get the most out of your lighting system. 

This manual describes the installation and operation procedures for the following models: 

• 91001, NEO Lighting Control Console

• Avoid spilling liquid on the equipment. If this should happen, switch the equipment off immediately. To reduce the 
risk of fire or electric shock, do not expose the equipment to rain or moisture. 

• For indoor use only. 

• This equipment is designed and manufactured to comply with international safety standards IEC950, UL1950, 
CS950 and is intended for use as part of a lighting control system. It must not be used for other purposes where 
there is a risk of safety to persons. The equipment contains power voltages, socket outlets will be installed near the 
equipment and be easily accessible. 

• Working Voltage/Current: 90 - 240VAC

• Frequency: 50/60 Hz 

• Maximum Ambient Temperature: 50° C (122° F) 

• Do not restrict ventilation 

WARNING!  It is important to read ALL included safety and installation instructions to avoid damage to the product 
and potential injury to yourself or others. 

NEO NOTES & TIPS:  Important notes and tips will are shown in like this with the NEO logo on the left. The notes 
often contain important information about the current topic.
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NEO SOFTWARE LICENSE

1. NEO Software License Agreement

These terms and conditions (License) form a legally binding agreement between you (Licensee) and Philips Strand
Lighting and Dream Solutions Limited (Philips and DSL) of 18 Ascot Way, Orewa, Auckland, New Zealand.

The Licensee will be permitted to use the NEO console, encompassing all applications and databases (Software) only
by accepting the terms of this License. Clicking on the "I Agree" button will constitute acceptance of the terms of this
License. If you are not willing to enter into this License, the "Cancel" button should be clicked, and you must not
install or otherwise download the Software.

Where the Licensee is not an individual then the agreement of the person accepting the terms of this License shall be
deemed to be acceptance by the Licensee. 

1. Intellectual Property

1.1 The Licensee acknowledges and agrees that all intellectual property rights, including copyright, relating to
the Software are the sole property of Philips and DSL.

1.2 The Licensee acknowledges and agrees that all source code and form definitions relating to the Software are
the sole property of DSL and may not be modified in any way.

1.3 The Licensee acknowledges and agrees that all enhancements, modifications or customizations, including
associated source code and form definitions, made by or on behalf of the Licensee and relating to the Software, vest
on creation in and are the sole property of Philips and DSL.

1.4 Subject to clause 2.2, the Licensee does not obtain, either under this License or by reason of use of the
Software, any right to copy the Software, or any right to use the Software after the License has terminated.

2. License

2.1 The Licensee is granted a non-exclusive, non-transferable, non-sublicensable license to install and use the
NEO Software for the Licensee's own internal business purposes, provided that the Licensee pays the charges for the
Console and/or output authorization.

2.2 The Licensee is permitted to make one copy of the Software for backup purposes only.

2.3 The Licensee will during the continuance of the License:

2.3.1 use the Software only as allowed for under this License and will not resell, rent, sub-license or otherwise make
the Software available to any person or entity;

2.3.2 subject to clause 2.2 or as permitted by applicable law, not copy, decompile, adapt, modify or reverse engineer
the Software or allow it to be copied, decompiled, adapted, modified or reverse engineered by any third party, or
modify the source code or form definitions in any way;

2.3.3 not remove or alter any copyright or other proprietary notice contained in the Software;

2.3.4 effect and maintain adequate security measures to safeguard the Software from access or use by any
unauthorized person; and

2.3.5 retain the Software and all copies of it under the Licensee's effective possession and control.

3. Assignment

3.1 The Licensee may not transfer the benefit of this License or the Software to any person or entity without the
prior written consent of Philips and DSL. Philips and DSL may assign or transfer this License without the Licensee's
consent.

4. Warranty 

4.1 Refer to  "Philips Strand Lighting Limited Two-Year Warranty" on page 1 or Philips Strand Lighting website
at www.strandlighting.com.
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4.2 Subject to clause 4.1, all conditions, warranties, terms, representations and undertakings, whether express or
implied, statutory or otherwise, in respect of the Software are hereby excluded to the extent permitted by law. In
particular, but without limitation, Philips and DSL disclaims, to the greatest extent permissible by law, any warranty
or representation, either express or implied, of the console or software's performance, non-infringement or fitness for
a particular purpose or process.

4.3 If a significant defect in the Console is found within the ninety (90) days warranty period from shipment, the
Licensee may return the Console for a refund with a 25% restocking fee on giving written notice to Philips
Entertainment. The Licensee is not entitled to any updates, patches, fixes or upgrades in respect of the Console unless
Philips Entertainment and DSL in its absolute discretion otherwise agrees. Philips Entertainment and DSL may in its
discretion provide limited email and telephone support in respect of the Console but, following the 90 day warranty
period, reserves the right to charge the Licensee for the provision of support.

5. Limitation of Liability

5.1 To the extent permissible by law, in no event will Philips and DSL be liable to the Licensee for any direct,
special, incidental, indirect or consequential loss, damage, cost or expense suffered or incurred by the Licensee or any
third party in connection with the Software.

5.2 The entire liability of Philips and DSL in connection with the Software will not exceed the price paid by the
Licensee for the Software.

6. Term and Termination

6.1 This License will remain in effect until terminated.

6.2 Philips and DSL may terminate this License on ninety (90) days' written notice to the Licensee or
immediately if the Licensee fails to comply with any term of this License.

6.3 Upon termination by Philips and DSL, the Licensee will be required to return the Software to DSL and
confirm in writing that no copies of the Software have been made and retained.

6.4 The provisions of clauses 4, 5, 7 and 8 of this agreement shall survive termination of this License for
whatever reason.

7. Governing Law

7.1 This License shall be governed by the laws of the State of Texas and is subject to the exclusive jurisdiction of
the Courts of the State of Texas.

8. Miscellaneous

8.1 This License records the entire understanding and agreement between the Licensee and DSL. This License
supersedes all previous understandings or agreements (whether written, oral or both) between the Licensee and DSL.

8.2 Philips and DSL reserves the right to amend the terms of this License on sixty (60) days' written notice, posted
on Philips and DSL's websites. Continued use of the Software by the Licensee following the sixty (60) day notice
period will constitute acceptance of the amended terms of the License, and the provisions of this License will be
deemed to be altered accordingly.

8.3 Any waiver by Philips and DSL of its rights or remedies under this License will be effective only if it is
recorded in writing and signed by Philips and DSL. If the waiver related to a breach of any provision of this License,
this will not (unless stated otherwise) operate as a waiver of any other breach of that provision. No waiver of any
breach, or failure to enforce any provision, of this License at any time by Philips and DSL will in any way affect limit
or waive Philips and DSL's right to subsequently require strict compliance with this agreement.

8.4 If the Licensee has any dispute with Philips and DSL in connection with this License or the Software, it must
give written notice to Philips and DSL and may submit the dispute for mediation by a single mediator nominated by
the Courts of the State of Texas In the event of any submission to mediation:

8.4.1 the mediator will not be acting as an expert or as an arbitrator;

8.4.2 the mediator will determine the procedure and timetable for the mediation; and

8.4.3 the parties will share equally the cost of the mediation.
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8.5 The Licensee agrees that it will not issue any legal proceedings against Philips and DSL relating to any
dispute, unless the Licensee has first taken all reasonable steps to comply with clause 8.4. Nothing in this License will
prevent DSL from taking any steps it deems in its sole discretion necessary or desirable to protect its intellectual
property rights or otherwise to enforce any of its rights under this License.

8.6 If any provision of this License is or becomes invalid or unenforceable, that provision will be deemed deleted
from this License. The invalidity of unenforceability of that provision will not affect the other provisions of this
License, all of which will remain in full force and effect to the extent permitted by law, subject to any modifications
made necessary by the deletion of the invalid or unenforceable provision.

Note:  If you have questions about the NEO Software License, please send an email to 
entertainment.service@philips.com or call us at 1.214.647.7880 prior to using. 
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CUSTOMER SUPPORT

1. How to Reach Us 

Contact Strand Lighting Customer Service at: 1-800-4STRAND (U.S.) or 1-214-647-7880 (international). 

For a complete list of support and field service contacts, go to www.strandlighting.com, select the Support tab and
then the "Support/Field Service Contacts" link. 

2. Additional Resources

Additional Documentation - DMX512
For more information on installing DMX512 control systems, the following publication is available for purchase
from the United States Institute for Theatre Technology (USITT), "Recommended Practice for DMX512: A Guide for
Users and Installers, 2nd edition" (ISBN: 9780955703522). USITT Contact Information:

USITT
315 South Crouse Avenue, Suite 200                                                
Syracuse, NY 13210-1844 USA
1-800-938-7488 or +1-315-463-6463
www.usitt.org

NEO Software and Documentation
The console's graphical user interface (GUI) is provided by Dream Solution. For detailed instructions on using the
NEO operating software, refer to the NEO operating software manual within the software itself. 

For the latest software documentation updates, please visit: www.strandlighting.com or www.neocontrol.net.

For a printed or printable version of NEO Console documentation, visit: www.strandlighting.com or
www.neocontrol.net.
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OVERVIEW

1. Components

Included Items
The NEO Lighting Control Console system includes the following items: 

• 1 x Console with built-in Trackball, Keyboard, and Rotary Encoders 

• 3 x Power Cables for all countries (EU, UK, and USA)

• 1 x Neoprene Dust Cover 

• 1 x Installation & Setup Guide on USB stick

• 2 x Littlite® Gooseneck Lamp

2. Processor

The console processor utilizes Microsoft® Windows7 to run a specially designed NEO lighting control software. The
processor will not accept nor run standard Windows-based applications. It is only intended for use with the NEO
software application. 

In 2017, Philips Entertainment Lighting upgraded the NEO's processor and the connectors have been upgraded.

The original processor has 1 - DVI port, 1 - HDMI port and 1 - Display Port (see note below).

The 2017 processor has 2 - Display Ports and can still support 3 monitors with the use of a Display Port to HDMI
Splitter (not included). One splitter can be used per system however it doesn't matter if the splitter is used on the first
or second Display Port. The console does include 2 - Display Port to HDMI adapters.

3. Accessories and Expansion Devices

Monitor/Touchscreen 
The processor supports the use of up to three HD touchscreen monitors. Refer to Touchscreen Calibration under 
"System" on page 333. 

Note:  Using touchscreens will enhance the usability of the console software and is highly recommended. 

Optional Accessories (sold separately)
• Touchscreens/Monitors

Note:  If using a single touchscreen monitor, we recommend plugging into the native USB port generation of the 
touchscreen. For example, the Planar monitor that Strand provides (model number 91021) is a USB 3.0 monitor and 
should be plugged into one of NEO's USB 3.0 ports on the processor (back of the console -  "Connectivity Features" 
on page 24). This will ensure proper operation. 3rd Monitor Note: If using a third monitor over the Display Port, the 
monitor must have a native Display Port for this to work. USB to VGA/HDMI/DVI adapters are not acceptable.

• Android or OS/iOS Remote device

• NEO Submaster Wing (model number 91004)

• NEO Playback Wing (model number 91005)

Note:  NEO can have a maximum of 3 touchscreens and 3 wings connected (regardless of wing combination).

4. Software Upgrades

Software upgrades are free of charge and are available at: www.strandlighting.com or www.neocontrol.net.
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NEO NOTES & TIPS:  Before updating NEO console software, Philips Strand Lighting recommends users make a 
backup of all current show files. 

NEO Console OS Software Installation

To install or update NEO Console software, follow these simple instructions…

Step 1. Download the latest upgrade file (file name: Neo_Setup_X_X_XX.exe) from the Strand Lighting website 
(www.strandlighting.com).

Step 2. Copy the software file onto a USB key.

Step 3. Plug the USB key into the console.

Step 4. On the console, open the Control Panel (More > Control Panel).

Step 5. Go into the Maintenance environment and select “Update NEO Software”. The updater will look for the 
latest version of the software both on the hard drive first and then any USB key. Confirm that it is the right 
version. If not, then copy the correct version onto the hard drive before proceeding.

Step 6. On the console, the User Account Control dialogue box will appear.

Step 7. Confirm the program name is the correct version of software and click "Yes".
20 Overview
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Step 8. The NEO software installation screen will appear. Click "Next" and follow all prompts to install the 
software.

Step 9. During the update process the following load screen will be seen, followed by a prompt to “Retry” or to 
“Cancel”. Select "Cancel" to proceed with the update.

Step 10. After the software installs, the fixture library update will launch. Select one of the options:

• Replace Library – Overwrites the existing library. Any show file with a custom fixture loads into the 
library when the show file is loaded.

• Merge Library – Adds new fixtures and updates to the existing library.

• Keep Library – Does not install the new library.

Step 11. The console needs to reboot to complete the installation.
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Note:  If not already done, be sure to register to receive updates and product information notifications. Click here to 
go to the NEO Console OS Sign Up Page.

Have questions? Need assistance?

Contact Strand Lighting Customer Service at: 1-800-4STRAND (North America) or 1-214-647-7880 (international).

5. DMX Output Universe Upgrades

The DMX output functionality included with your console is pre-authorized at the level initially purchased. However,
the DMX output authorization can be easily upgraded at any time. To purchase a DMX output upgrade for your NEO
Lighting Control Console, please contact your Authorized Strand Lighting Dealer. 

NEO NOTES & TIPS:  Network nodes may be needed if the system output is over 2048 DMX outputs.

6. Features

Standard Features
• 1 to 100 universe output (depending on number of universes purchased or utilizing Philips Advantage DMX) 

• 2048 DMX512 output

• Unlimited cues

• Unlimited groups

• Unlimited shortcuts

• Windows® 7 processor

• 120GB solid-state hard drive

• Installed, Internet Browser, Adobe Acrobat Reader

• Supports Pathport®, ShowNet, Art-Net, CKNet, Color Kinetics™, and streaming E1.31 (ACN) Ethernet Protocols 

• Free offline editor available at: www.strandlighting.com or www.neocontrol.net

Control
• Split up/down fade times

• Split up/down delay times

• 99 parts per cue

• 32-bit fades

• Independent timing by attribute

• Fade times from 1/100 second to 20 days

• Follow time

• Cue loops

• Pre-programmed effects wizard

• Moving light patch (graphical or command line)

• Channel check

• Channel labels

• Tracking/Cue Only/Hybrid Tracking style operation

• Astronomical time clock and time events

• Macros 
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Playback
• 10 Submasters on NEO base console (Unlimited Pages) 

• 4 moving light encoders with LCD status screens

• Support for 3 HD touchscreen monitors 

• 5 playback faders

• A/B faders

• True Last Action Tracking operation 

• Unlimited cue list with unlimited simultaneous fades 

• Integrated Trackball

• Level wheel (accessible from top and bottom of console)

• Touchscreen monitor support

• Two programmable Grandmaster sliders 

Display Functions
• Live editing

• Blind editing

• Groups List/Details

• Cue List/Details

• FX List/Details

• Palette List/Details

• Cue Playbacks

• FX Playbacks

• Macro Editor

• System Properties

• Shortcuts Window

• Submaster Window

• Playbacks Window

• DMX View

• Live Video Preview

• Touchscreen Keyboard

• Timecode Monitor

• Power Monitor

• Console Debug Window

• Control Panel

• Fixture Library

• Matrix Editor

• Profile Editor

• Color Filter Editor
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Connectivity Features
• Supports Pathway®, ShowNet, Art-Net, KiNet 1 and 2 (Color Kinetics), and streaming E1.31 (ACN) Ethernet pro-

tocols.

• DMX512A/RDM

• RS232

• MIDI In/Out

• SMPTE In/Out

• Audio Out

External Control
• NEO Remote (iOS and Android)

• MyInterface (iOS, Android and PC)
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SOFTWARE OVERVIEW

1. NEO Software

Benefits of NEO Software: 
NEO software is an extremely flexible theatrical lighting control software application. It can be setup to run for a
native theatrical environment consistent with tracking consoles, cue only consoles and more. It can also be setup to
run as a direct action console. The flexibility is yours. 

NEO adds an easy-to-use Graphical User Interface to the powerful Command Line operation that has a proud history
within the world of Strand consoles. 

NEO displays a wealth of information on the graphical screens allowing the user to work faster and more efficiently. 

NEO can be upgraded, at no additional cost, when new software becomes available. 

2. Offline Editor

A free off-line editor is available at: www.strandlighting.com or www.neocontrol.net.

3. Control of Connected Devices

Control of connected devices and/or lighting systems is achieved by using the console desk hardware in conjunction
with the NEO software application. In some cases, actions can be performed using either the hardware or software,
providing you with a variety of choices suitable to your preferences and requirements. 

For more information about external hardware controls, refer to  "Hardware Interfaces" on page 361. 

For more instructions on using the NEO software, please refer to the user manual within the program itself (by either
selecting it from the Options menu or Control Panel. 

4. External Control

The console can accept several forms of external control, depending on your console's particular configuration.

These include, but are not limited to, Touchscreens and Remote Focus Units. 
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INSTALLATION AND SETUP

1. Unpack

Site Requirement
The console and its components require a sturdy, flat surface for installation. The surface should be able to support
the weight of the console (including monitors, etc.) and should provide suitable ventilation. Also, the site should be
clean (i.e. absent of any construction dust or debris) and dry. Before setting up, ensure that the installation site meets
these requirements. Refer to product specification sheet on the Philips Strand Lighting web site for console
dimensions and power requirements. 

Product Care
In the event the console needs to be cleaned, remove all power from unit and use only a very mild soap on a damp
cloth. Dry immediately with a soft lint-free cloth after cleaning. Never use harsh chemicals such as window cleaners,
paint removers, vinyl conditioners, etc. 

It is recommended to gently blow out the sub pots and desk occasionally to prevent buildup of dust and dirt. 

Unpack and Assemble Components

To unpack and assemble the console components, do the following:

Step 1. Remove console components from shipping container or case.

Step 2. Place console desk on installation surface.

Step 3. Place monitor(s)* and other external components close enough to console so that cabling will reach.

*Monitors sold separately.

2. Hardware Setup

Connecting Console Components
Figure 1 outlines the NEO Lighting Control Console’s connections.

Figure 1:  Console Rear Panel Connections 

On/Off Switch

Console Light 
Receptacle (x2)

DMX Input

DMX Output (x4)

Status Indicators

SMPTE In/Out

MIDI In/Out

AC Input

Kensington 
Security Lock 
Slot
(security cable 
and lock by 
others)

DC

Display Port Display Port

USB 3.0 Port (x4)

DC Power Supply
(do not use)

VESA Display Ports
Network Ports

Mic Input
Line Out

Note: This image displays the 2017 processor. 
The original processor has a different 
input/output configuration.
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To connect console components, do the following:

Step 1. At console rear panel, IEC power cable (included).

Step 2. Connect monitor(s)* or touchscreen(s)*. Should the console's monitor(s) not have a native Display Port, the 
console with the 2017 processor ships with two Display Port to HDMI converters.

Step 3. Install gooseneck lamps (included).

*Optional accessories sold separately.

3. NEO Submaster Wing

Follow the instructions in the NEO Submaster Wing documentation for connecting the wing.

For operational information, refer to“Submaster Wings” chapter on page 136.

4. NEO Playback Wing

Follow the instructions in the NEO Submaster Wing documentation for connecting the wing.

For operational information, refer to “Playback Wings” chapter on page 137.

5. NEO PC

NEO PC is a PC version of NEO that allows theatrical lighting control
operation from a user-supplied PC.

NEO PC can be run on Windows XP or later versions.

The NEO PC utilizes the same software application as the NEO so all
operational functionality is the same. However, NEO PC runs on a user
supplied PC. This means that any graphical solution to programming will be
similar. Use a laptop or a compatible touchscreen as would be done on NEO.
Command Line programming can be achieved with the PC's keyboard. For
Commands on NEO PC, just type in the command. For example, to record a
cue on NEO, type [RECORD] [CUE] [1] [ENTER]. Each of the 4 command
entries has a dedicated key. But on NEO PC, type "Record cue 1 enter" each as
a key as if writing in a text document. There are shortcuts. For example, to
record the next cue, use the shortcut "rec rec", which is short for [RECORD]
[RECORD]. Many shortcuts will appear on the Command Syntax Help that can be turned on/off in System
Properties > System Settings.

Minimum System Requirements
The following are the minimum system requirements to operate NEO PC. The computer should have:

NEO Submaster Wing

NEO Playback Wing
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• Processor: 1 gigahertz (GHz)

• RAM: 1 gigabyte (GB)

• Hard disk space: Greater than 300 MB of free disk space

• Display: 1024 x 768 (minimum), 1920 x 1080 (highly recommended for best performance)

NEO PC - Ethernet Version
NEO PC's Ethernet Version comes with an authorization key. This will allow the inserted authorization key to
authorize output from the PC's network interface card. This requires some form of Ethernet node to take the network
signal and convert it to a DMX signal. There are many nodes on the market for achieving this. In addition, there are
manufactured DMX boxes that can output over NEO. Please download the latest NEO software and confirm that the
desired protocol or DMX box is supported. System Properties > System Input/Output and open the Device list in
the network configuration table.

NEO PC - DMX Version
NEO PC's DMX Version comes with a Philips Entertainment USB/DMX cable. This will allow the inserted cable to
authorize the registration as well as output a single universe of DMX all on one cable.

NEO PC - Installation
The NEO PC authorization key or Philips Entertainment USB/DMX cable comes pre-authorized and fully
operational. The NEO PC software is available on the web at www.strandlighting.com. Download the latest version
(make sure it's the NEO PC version and not the NEO or NEO Playback Controller version of NEO software). When
installing, the software will install the drivers for the Philips Entertainment USB/DMX cable. This is mandatory for
operation. Just follow the instructions that came with the NEO PC kit.

NEO PC Registration

The NEO PC authorization key or Philips Entertainment USB/DMX cable comes pre-authorized and fully
operational. However, there are additional options for the NEO PC authorization.

• Convert License to Registration - Allows the user to convert a provided license to a fully registered system. This 
would be utilized to allow the user to register a system manually. 

• Generate New Serial Number - Allows the generation of a new serial number should that be required.

• Transfer registration to a New PC - Once a registration has be transferred to the PC hardware, it can be moved 
should the registered PC need to be replaced.

• Transfer registration to Hardware - Allows the registration to be moved from an authorized USB key to a 
Philips Entertainment USB/DMX cable.
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CAUTION:  Transferring registration to hardware or a new PC is a one way transfer. Once completed, it cannot be 
transferred back.

6. NEO Playback Controller

The NEO Playback Controller (often referred to as Rack NEO) utilizes the same software application as the NEO so
all operational functionality is the same. However, the Rack NEO does not have the faceplate. A monitor and
keyboard are typically used. This means that any graphical solution to programming will be similar. Just use a
compatible touchscreen as with NEO. Command Line programming can be achieved with an external keyboard. For
Commands on Rack NEO, just type in the command. For example, to record a cue on NEO, type [RECORD] [CUE]
[1] [ENTER]. Each of the 4 command entries has a dedicated key. But on Rack NEO, type "Record cue 1 enter" each
as a key as if writing this in a text document. There are certain shortcuts that can be used. The shortcut "rec rec",
which is short for [RECORD] [RECORD] will record the next whole cue number at the end of the cue list. Many
shortcuts will appear on the Command Syntax Help that can be turned on/off in System Properties > System
Settings.

NEO Playback Controller Screen
Tabs across the top of the screen display operational features of the console.

NEO Rack Display - Live

The Live display shows a processing graph, loaded show, cue list, active cue date and time.

When the Rack NEO is running in Tracking Backup, the display shall identify the status and give the options...

• "Start DMX Output" for the Rack to take over control.
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• "Sync Show File" for the Rack to sync the show file with the Main NEO. Warning, as this will overwrite your 
show file

NEO Rack Display - Shortcuts

The Shortcuts display shows Shortcuts 1 - 25.

NEO Rack Display - Submasters

The Submasters display shows the live page of faders for which the showfile is configured.
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NEO Rack Display - Config DMX Ports

The Config display allows configuration of the DMX ports and the network ports. The ports available are determined
by the configuration in the System Properties > System I/O on the NEO Playback Controller unit.

Adjust the port and universe assignment to the desired configuration, then press Apply to accept those settings.

NEO Rack Display - Config Universes

When using the NEO Playback Controller's display to configure the network, the top line is for the DMX universe
setting.. This is the same as the Universe column in the System Properties > System I/O Screen on the network table.

The middle line is same as the Device column in the System Properties > System I/O Screen on the network table.
This determines the device or protocol used.

The last line displays the output universe. This is the same as the Port column in the System Properties > System I/O
Screen.

The single arrows will advance up/down one unit where the double arrows go to the start/end of the list.

Back Double Arrow - Back to First Port

Back Single Arrow - Backup One Port

Forward Single Arrow - Advance One Port

Forward Double Arrow - 
Advance to Last Port

Back Single Arrow - Assigns One Universe Lower

Forward Single Arrow - Assigns One Universe Higher
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NEO Rack Display - System

Allows the configuration of the network adapter that is connected to a working network.

Obtain IP Automatically will obtain an IP address automatically when switched to On. When Off, requires a
manually entered IP address.

To set an IP address or subnet mask manually, just select the box to adjust and use the Up/Down arrows appropriately.

When configured, press Apply & Restart, Shutdown or Restart as required.

Note:  A restart will be required if an IP address change is made.

NEO Rack - Console Hardware Display

With a monitor attached (sold separately), the Console Hardware display (More > Console Debug Window) will
display the firmware version for the Rack Display screen.
32 Installation and Setup



NEO Lighting Control Console
7. DMX512 Output

The console provides four standard XLR 5-
pin connectors for connecting to DMX512
devices. Each connector supports one
DMX512 universe of 512 DMX channels.
Connect DMX512 devices as shown in Figure
1.

When DMX is being used, there are status
LEDs on the back of the console to help
identify and understand the traffic that is
transmitting on this card. The DMX card also
has the MIDI/SMPTE components engineering onto it. Look on the Console Debug Window (More > Console
Debug Window, see Figure 2.), for a listing for the DMX card and its firmware. The firmware version number is
#.##.###. The first two sets of numbers are for the DMX card firmware version. The last set of numbers is for the
MIDI/SMPTE card firmware version. (For example: 1.23.102) Firmware version #.##.102 is the first version to have
the status light feedback. The LEDs will blink in different patterns to indicate receive/transmit (Rx/Tx) signal status. 

Note:  Firmware versions numbers may change with each version of software upgraded.

DMX/RDM Status LED (Right LED when facing the back of the console):

• Red On Solid -- DMX board power is ON

Orange On Solid -- transmitting DMX on one or more of 4 DMX OUT ports, not receiving DMX

• Orange 0.25s/Red 0.75s -- Receiving DMX

• Orange 0.125s/Red 0.125s -- RDM is active

8. MIDI / SMPTE

The NEO has the capability to both send and receive MIDI and SMPTE time code.

When MIDI/SMPTE is being used, there are status LEDs on the back of the console to help identify and understand
the traffic that is transmitting on this card. The MIDI/SMPTE device is engineered onto the DMX card. Look on the
Console Debug Window (More > Console Debug Window, see Figure 2.), for a listing for the DMX card and its
firmware. The firmware version number is #.##.###. The first two sets of numbers are for the DMX card firmware
version. The last set of numbers is for the MIDI/SMPTE card firmware version. (For example: 1.23.102). MIDI/
SMPTE firmware version 102 is the first version to have the status light feedback. The LEDs will blink in different
patterns to indicate receive/transmit (Rx/Tx) signal status.

MIDI/SMPTE Status LED (Left LED when facing the back of the console):

OFF - No MIDI or SMPTE traffic

Green - MIDI activity

• Green Pulse 0.5s for every MIDI message sent

• Green Pulse 0.125s for every MIDI message received

Red - SMPTE activity

• Red ON 0.5s/Off 0.5s -- Receiving SMPTE timecodes

• Red ON 0.25s/Off 0.25s -- Transmitting SMPTE timecodes

9. Console Power Up Procedure

Once the console has been installed and all components connected, the console and processor can be powered up. 

To power up: 

Figure 2:  Console Debug Window
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Step 1. At back of console, toggle the power switch to on.

Step 2. After boot up is complete, go into System Properties and set the system to work to your preferences. See 
Quick Start Guide for guidance (Options > Manuals & Documentation > Open Quick Start Guide.).

Step 3. While in "System Properties," verify that other important and systemic features are set correctly for you. 

• System Settings

• Show Defaults 

• Appearances
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USING THE MANUAL

1. Nomenclature

Using this manual to its full potential is aided by knowing the format in which the information is provided.

There will be Command Line instructions. These are commands that are entered by typing on the NEO console keys.

Figure 3:  NEO console keys

All Command Line entries in this document will be displayed in brackets.

[1] [@] [30] [ENTER]

For example, if the manual indicates (Fixture List) [@] (Level), then the Fixture List entry would be the operators
choice of fixtures and the Level entry would be the operators choice of intensity level. The monitor offers many
opportunities for direct entry to the graphical user interface. This can be accomplished via a touchscreen monitor. In
the absence of a touchscreen, the console's trackball can be used.

Info in {braces} will indicate text that appears on the Command Line that is different than the text on the keys (or
combination of keys) that is pressed.

For example, type [SHIFT] + [THRU] the "Thru" on the Command Line changes to "Thru-on". This will be
represented in this manual by [SHIFT] + [THRU] {THRU-ON}.

Info in (parentheses) will indicate a general item but not any specific key. 

Congratulations on the purchase of the NEO console and let's get started! 
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CONTROLS

1. Desk Layout

Console Overview
Figure 4 provides an overview of console desk controls. Refer to subsequent pages for more in-depth explanations of
individual button and slider functions.

Figure 4:  NEO Control Console Overview

2. Programming Button Layout

The programming section of the desk provides direct access to intensity channels, channel attributes, playback
control, console setup and display options. 

A

I

E

K

A. Motorized Faders / Submasters
B. Level Wheel
C. 10 Bump Buttons
D. USB Port (showfile storage, USB key sold separately)
E. Tablet Well with USB Power (tablet by others)
F. Grand Masters (2)

G. Black Out Buttons
H. Shortcuts (10 each)
I. Encoders with Encoder Status (4 each)
J. Programming Buttons
K. A/B Playback Controls (with Go and Stop/Back buttons)
L. Track Ball

Legend

G

C

B

D

F

H

J
Pull out Keyboard Drawer with 
Phone Storage and USB Charger
(phone by others)

Top of Unit

L
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Display Keys
All secondary windows (all displays with the exception of Live, Blind,
Report and More) will be opened by pressing the appropriate display
button and will be closed by pressing the "Close" button. A secondary
display window will be a separate window that can be minimized,
maximized, sized and located in the users preferred location. This can
best be taken advantage of with multiple monitors. Each of these displays
button's text will flash when the window is open and in focus.

[LIVE]
Live is the main viewport and will show all active output for fixtures and
cues. When in Live mode the display button's text will be red. Pressing
[LIVE] when in Live will sync the selected cue (blue background) with
the active cue (gold border) and scrolls the active cue to the 3rd cue in the
visible list.

[BLIND]
Activates Blind Mode. While in Blind, the channel grid has a Grey background. Blind allows for non-Live viewing
and editing. When in Blind mode, the display button's text will be red.

[CUE LISTS]
Opens the Cue List Details window. All details about cues are available here.

[CUE PB]
Opens Cue playback popup window.

[GROUPS]
Opens Groups popup window. Allows editing of groups and submasters assignment. 

[PALETTES] 
Opens the Generic Palette Century Array for applying, storing and editing Generic Palettes. [SHIFT] + [PALETTE]
opens the Palette pulldown and allows access to Specific Palette for each attribute families century array for applying,
storing and editing specific palettes.

Another way to open these windows is to hold down the [PALETTE] button and press [POSITION/COLOR/BEAM/
EDGE] to open the appropriate palette button window.

[FX LIST]
Opens Effects editor window. Allows for adding, editing, and deleting effects.

[FX PB]
Opens effects playback window. Displays any saved effects for previewing. 

[PATCH]
Switches the screen display to view the patch screen (single monitor layout) or opens Patch popup window (multiple
monitor layout). Allows for editing of fixture assignment and how they are controlled.

[MACROS]
Opens macro editor window. Allows for creating/editing/deleting of macros.

[REPORT]
Opens Selected Fixture Report popup window.

[MORE]
Brings up MORE menu from lower right, which allows access to additional screens and functionality. When pressing
the [MORE] key and that pulldown opens up, pressing [MORE] again closes it.
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Effects Keys
These are the primary keys used for creating and editing effects.

[CREATE FX PB]
Opens Effects editor popup window. Allows for adding, editing, and deleting
effects. 

[ADD STEP] 
Adds a step to the selected existing effect.

[FX RESET] 
Resets the currently running effect.

[ADD FX] 
Opens popup window with effects types to aid in the creation of effects. Includes an Effects wizard to guide user
through creating custom effects. 

[ADD CHANNELS] [ADD CHANNELS]
Adds channels to the selected step in effects creation/ editing. 

[FX PLAY/PAUSE] 
Acts as a GO/Stop button for the selected effect. 

Playback Keys 
[REL CUE LIST]
Releases the current primary cue list and all fixtures will restore to default.

• Advanced Functionality: When outputting multiple cue lists, [REL CUE LIST] + (PB#) will 
release the cue list that is assigned to the selected Playback.

• [REL CUE LIST] releases in the Master Fade Time. 

• [SHIFT] + [REL CUE LIST]: will release all cue lists when multiple cue lists are running.

• (PB#) + [REL CUE LIST]: will release the selected Playback.

[GOTO] 
Places desired cue live on stage. Ex: [GOTO] [1] [ENTER].

• Advanced Functionality: [GOTO] (PB#) [CUE] (#) [ENTER] or [GOTO] (PB#) (#) [ENTER] will 
assert a cue from a secondary cue list.

• [GOTO] [LAST/NEXT] or [DOWN ARROW/UP ARROW] [ENTER] will place the last/next cue 
on the Command Line and ENTER will complete the process of going to that cue.

• [GOTO] [SHIFT] + [LAST/NEXT] or [DOWN ARROW/UP ARROW] [ENTER] will place the 
first cue of the cue list or the last cue of the cue list on the Command Line and ENTER will com-
plete the process of going to that cue.

• [GOTO] [ENTER] will reassert the current cue. This is helpful if you have adjusted the cue but want to restore to 
the cue in the goto time.

[STEP UP (ARROW UP)] 
Cuts to the previous cue in the cue list.

[STEP DOWN (ARROW DOWN)] 
Cuts to the next cue in the cue list.

[LOAD] 
Will preset the loaded cue as the next cue that runs on Go. [LOAD] (#) [ENTER]
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[TEMPO] 
Allows the user to establish a tempo for manually stepped effects.

Action Keys
This tile holds the primary action keys and the primary items that they manipulate.

[UPDATE]
Stores changes to selected item. This could be a Cue, Group or other item. Ex: [UPDATE]
[UPDATE] [CUE] [1] [ENTER]. Press the "Cue" key, and the Command Line will display
what the update option will do. The options are "Changed" or "Selected". Just press [CUE]
again to toggle between the available options. 

• [UPDATE] [UPDATE] or [UPDATE] [ENTER] will update the current cue and is likely 
the most common Command Line use of the Update functionality.

• Ex: [UPDATE] [GROUP] (#) [ENTER]. Press the "Group" key and the Command Line 
will display what the update option will do. The options are "Selected", "Selected & 
Changed", "Changed", or "Active".. Just press [GROUP] again to toggle between the 
available options.

• Ex: [UPDATE] [SUB] (#) [ENTER]. Press the "Sub" key and the Command Line will 
display what the update option will do. The options are "Selected", "Selected & 
Changed", "Changed", or "Active"..

• Ex: [UPDATE] [PALETTE] (#) [ENTER]. Press the "Palette" key, the Command Line 
will display what the update option will do. The options are "Changed" or "Selected". 

• [UPDATE] [POSITION/COLOR/BEAM/EDGE] (#) [ENTER]. When you press the 
"Position/Color/Beam/Edge" key, the Command Line will display what the update option will do. The options are 
"Selected", "Selected & Changed", "Changed", or "Active".

• Just press [POSITION/COLOR/BEAM/EDGE] again to toggle between the available options.

• Advanced Features: Leading Fixture List Update. Allows using a leading fixture list to update cues. Ex: [1] 
[UPDATE] [CUE] [2] [ENTER]. This will take fixture 1's level and update it to cue 2.

• Leading fixture list record/update works for ranges of cues when applying new levels to a conditional level. Ex: 
(Fixture List) [UPDATE] [CUE] (#) [THRU] (#) [@] (#) [If] (#) [ENTER]. Hard Example: [6] [UPDATE] [CUE] 
[1] [THRU] [5] [@] [70] [If] [60] [ENTER]. Basically, for fixture 6, Update Cues 1 thru 5, to 70% when it's at 
60%. 

[RECORD] 
Stores lighting state as a selected item. This could be a Cue, Group or other item. Ex: [RECORD] [CUE] (#)
[ENTER], [RECORD] [GROUP] (#) [ENTER], [RECORD] [SUB] (#) [ENTER], [RECORD] [FX] (#) [ENTER],
[RECORD] [GENERIC PALETTE] (#) [ENTER], or [RECORD] [Position/Color/Beam/Edge] (#) [ENTER] press
the "Cue" key and the Command Line will display what record mode option will be used. The options are Live,
Selected, Active, Changed. Just press [CUE] again to toggle between the available options. For recording options on
Groups and Subs, they are "Selected", "Selected & Changed", "Changed" and "Active".

[PART]
A portion of a single cue that can be assigned a unique time value. Ex: With channels selected and changed [PART]
[1] [ENTER] will assign selected channels to the desired part (Part 1 in this example). Continue part assignment until
completed. Then Record or Update to store or edit the cue. Parts 1 through 99 are available.

[CUE]
A recorded state that can be played back in time.

[MACRO]
Triggering device for stored keystroke entry.
Programming Button Layout 39



User’s Manual
[GROUP]
A collection of channels/fixtures and their data. Groups can be just a collection of channel/fixtures at an intensity 
level, the can hold attribute information or both. Groups are very flexible and all groups (when stored in a cue) will 
reference back to the group data. This allows the user to change the data in the group without changing the cue itself. 
Specifies group selection. Ex: [GROUP] [1] [ON] or [RECORD] [GROUP] [1] [ENTER].

• Advanced Functionality: When recording groups using Command Line pressing Group again will change the 
record mode. Recording a Group remembers the fixture selection order. This becomes important when groups are 
used to build effects. The effect will be applied in the order in which the fixtures were selected when recording the 
group.

• Ex: [RECORD] [GROUP] (#) [ENTER] will display {Record Group (Selected)} on the Command Line and will 
record only selected fixtures. Pressing [GROUP] again will cycle through all recording group options.

• [RECORD] [GROUP] works without specifying a group number or group name. The next group number after the 
last group will be automatically selected.

Note:  There is a Default Group Record Mode in System Properties > Show Defaults > Intermediate Options 
that allows changing the mode.

[SHORTCUT]
A shortcut is a quick route to a particular setting or feature that is used frequently. A Shortcut can be triggered from
the Shortcut buttons on the console, from the Shortcut page, a Cue, a Group or at startup.

[SUB]
A fader that controls a group. In the Groups display, there is a Submaster column where a submaster can be assigned
to a group. In addition, when recording groups there is a box where a submaster can be assigned. Quick recording is
available by typing [RECORD] [SUB] (#) [ENTER]. This will record a group of the same number and apply the
submaster as a fader to that group. In addition, while holding down RECORD, press SUB and the Record Group
dialogue box will appear. Also, type [RECORD] (Bump) where bump is the appropriate submaster's bump
button.While this dialogue box is open, notice that all available sub's bump buttons are flashing. Pressing one will
assign that sub to the Submaster number box for recording.

• Advanced Functionality: Use the dialogue box solution to help the record sub process. With the desired fixtures 
selected and at the desired levels, type [RECORD] + [SUB]. The Record Group dialogue box will appear. All 
available subs and shortcuts will be flashing. Just press the desired sub button and that sub's number will populate 
the Submaster Number box. Once all other settings are correct, pressing [ENTER] will complete the record group 
action.

[CREATE FX]
Will take a currently running effect from the Effect Library and create a new show based effect.

[FX]
Places FX on the command line for command line operation. Allows the ability to assign effects to cues and run
effects manually.

• Advanced Functionality: When applying Command Line record, the FX button can be pressed again to change the 
recording mode to just record changed values.

• Ex: [RECORD] [FX] (#) [ENTER] will record the Live values to the next available FX's step number.

• [RECORD] [FX] [FX] (#) [ENTER] will record only the Selected fixtures to the next available FX's step number.

[GENERIC PALETTE] - Places PALETTE on the command line for command line operation. Allows the ability to
create Generic Palettes. A generic palette is stored information that doesn't care what fixture or type of fixture it is
applied to. A Palette can be built called Red and it can be applied to any fixture type patched and it will turn the light
red. (Assuming the fixture type can do it.)

[TRACKING OPTIONS]
Toggles through the tracking options for recording and updating purposes. Ex: [RECORD] [CUE] (#) [TRACKING
OPTIONS] [ENTER]. The Command Line will display the next available option after the first press (If in Tracking
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Mode then this will display "Cue Only", if in Cue Only mode, then this will display "Tracking". Additional presses
will toggle through any additional options.

Command Keys
The command tile holds the 10 key, auto-completing level keys,
channel/fixture manipulation keys as well as mode keys.

When the mode keys are active (Active Select Mode, Inclusive
Mode and Hi Light) the button's text will be red. When these
modes are not active (normal) the button's text will be white.

[ACTIVE SELECT MODE]
Sets the selected fixture at the ON level and allows NEXT/LAST
to run through all fixtures to perform a rig check.

[INCLUSIVE MODE]
Will add any fixtures selected to the existing selection set.

[HI LIGHT]
Will send selected fixtures to the "Hi Light" value. The goal of Hi
Light is to allow the user to identify the highlighted fixtures on
stage when many fixtures are in use. This usually will set the
fixture to full intensity, clear all color parameters and all beam
parameters. However, each fixture type's hi light values can be
adjusted within the fixture library editor.

This will allow for global hi light values for each fixture type. There is also the ability to set the hi light values per
patched fixture within the show file.

Just set the fixture's state and [RECORD] [HI LIGHT] [ENTER].

Lo Light [SHIFT] + [HI LIGHT]
Lo Light gives the user the ability to set a Lo Light state. Many programmers use a low light state that is similar in
function to Hi Light but instead of taking the fixture to a clear beam state to pull focus "to" the fixture, Lo Light
would pull the focus "away" from the fixture. Essentially minimizing the contrast so that the fixture is not what stands
out on stage. There is no default Lo Light state and nothing exists with the fixture library as it does with Hi Light. So
the user would need to program a state for it. Say a clear beam but with a deep blue. When the state is set, just
[RECORD] [SHIFT] + [HI LIGHT] to store the Lo Light state for the selected fixtures. In order to apply, just select
the fixture and press [SHIFT] + [HI LIGHT]. 

[FAN]
Launches the Fan tool. This is used for dynamic level changes.

[FAN] + Encoder will spread the encoder's parameter in the order in which the fixtures are selected.

[RELEASE]
First press - will release all selected fixtures. Second press will release all adjusted fixtures. Any adjusted fixture can
be identified by the red (changed) data.

Note:  [SHIFT] + [RELEASE] will release all control, including channel control, cues, subs, FX...everything, 
effectively taking the system to a state of black. Using [SHIFT] + [RELEASE] to release all control will ignore all 
Exclusive Submasters. This includes channel captures from the remote.

Additionally functionality with the release key are...

[RELEASE] + [SUB] - will release all active subs.

[RELEASE] + [FX] - will release all active effects.

[RELEASE] + [GROUP] - will release all active groups.

[RELEASE] + [GENERIC PALETTE] - will release all active generic palettes.
Programming Button Layout 41



User’s Manual
[RELEASE] + [Position/Color/Beam/Edge] will release all Position/Color/Beam/Edge values.

Release key shows red if there is something to release in the system. If there is no channels to release the key will be
white. 

[REM DIM]
Switches all channels, except those which are selected, off. [UNDO] [REM DIM] will restore to the state prior to
Rem Dim.

[Last]/[Next]
Advances to next or reverses to previous channel. Also acts as a tab key for navigating dialog boxes.

In general, it allows the ability to go to the Next or Last number in many places when using Command Line.

• [UPDATE] [NEXT/LAST] will place the next/last cue number on the Command Line.

• [GOTO] [NEXT/LAST] will place the next/last cue number on the Command Line.

• Advanced Functionality: [1] [+] [Next] will place 1 + 2 on the Command Line. [10] [+] [Last] will place 10 + 9 on 
the Command Line. Next/Last can be used multiple times as needed. Ex: [1] [+] [Next] [Next] will place 1 + 3 on 
the Command Line. Plus/Minus can be used multiple times during one command. Ex: [1] [+] [Next] [+] [Next] 
will place 1 + 2 + 3 on the Command Line.

[THRU]
Used when entering a range of numbers.

• Advanced Functionality: [1] [SHIFT] + [THRU] {Thru-on} [10] [ENTER] will select all "on fixtures "thru" the 
range of 1 to 10. The indicator for this is when pressing [SHIFT] + [THRU] the "Thru" on the Command Line will 
be replaced with "Thru-on". (Fixture List) [THRU] [ENTER]. This will select all fixtures up to a change in fixture 
type or an unpatched fixture. Ex: If 100 fixtures are patched, type [51] [THRU] [ENTER], 51 thru 100 will be 
selected as long as fixtures 51 thru 100 are the same fixture type. If 51 thru 60 are VL1100s, then the above syntax 
will select 51 thru 60. (Fixture List) [SHIFT] + [THRU] {Thru-on} [ENTER] will select all fixtures up to a change 
in fixture type or an unpatched fixture but only active fixture throughout the identified range.

Backspace functions as a typical PC backspace key would function. It removes the last command/keystroke entered
on the Command Line.

[SHIFT] + [BKSP] will clear out the entire Command Line entry.

[0 - 9,.] - 10-Key Numerical Entry. 
Numerical entry is not only about selecting fixtures and item numbers, but can assist in advanced features. See
Record or Update for more about advanced features. See  "Working with Command Line Operation" on page 52.

[+]/[-] keys. 
Allows for adding and subtracting fixtures from the Command Line fixture list. Ex: [1] [+] [3] [+] [5] [THRU] [10] [-
] [7] [ENTER]. This will select 1, 3, 5, 6, 8, 9, and 10.

• Advanced Functionality: Relative Values: Allows for using [+] and/or [-] in the Command Line for relative 
changes. Ex: [1] [@] [+] [10] [ENTER] This will add 10% to the selected fixtures.

[On]
Takes intensity value to designated ON level for all selected channels. This level can be changed in: System
Properties > System Settings.

[FULL] 
Takes intensity value to 100% for all selected channels. 

[Out]
Takes intensity value to zero for all selected channels.

[@]
Used to enter specific intensity value for all selected channels. 
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Advanced Functionality: [@] [@] can be used instead of the [FULL] key.

[SHIFT]
Used in conjunction with command/action keys for advanced functionality.

The list of Shifted commands are...

• [SHIFT] + [PAGE UP/PAGE DOWN] = Playback page up/down.

• [SHIFT] + [REL CUE LIST] = releases all active cue lists.

• [SHIFT] + [STEP UP/STEP DOWN] = jumps to the first/last cue in the current cue list.

• [SHIFT] + [HI LIGHT] = Lo Light.

• [SHIFT] + [RELEASE] = global release. This releases everything. Channels, cues, subs, effects…everything.

• [SHIFT] + [BACKSPACE] = removes all entered commands from the Command Line.

• [SHIFT] + [THRU] = “Thru-On”. This selects only the active channels throughout the entered range.

• [SHIFT] + [@] = Places “@ DMX” on the Command Line to enter a DMX value rather than a percentage value.

• [SHIFT] + [ENTER] = places the last executed command on the Command Line without executing with the Enter 
key.

• [SHIFT] + [PAGE] = pages back up the channel grid view.

• [SHIFT] + [VIEW] = opens the View pulldown.

• [SHIFT] + [TIME] = applies the current Stopwatch time to the current cue.

• [SHIFT] + [FOLLOW] = Link

• [SHIFT] + [EDIT] = Delete

• [SHIFT] + [TAB] = Reverses the Tab key.

• [SHIFT] + [LIVE] = Live Timing Display

• [SHIFT] + [BLIND] = Blind Timing Display

• [SHIFT] + [CUE LISTS] = Tracksheet

• [SHIFT] + [HELP] = Lock console

• [SHIFT] + [DIMMER] = SELECT DIMMER - used to select a channel by the dimmer patched to it.

• [SHIFT] + [DIMMER] in Patch = will default the Fixture Make/Model back to “Standard Dimmer”.

• [SHIFT] + [BLOCK] = UNBLOCK

• [SHIFT] + [SELECT CHANGED] = Added the "changed" list of channels to the command line as text.

• [SHIFT] + [SELECT ACTIVE] = Select all active channels excluding submasters

• [SHIFT] + [Select Prev] = Select channels last updated to a cue

• [SHIFT] + [Shortcut Keys] = shortcuts 11..20

• [SHIFT] + [PB Select Keys] = Open the cue list/fx selection window to assign to the playback

[ENTER]
Completes an action or selection when entered from the Command Line. 
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Advanced Keys
These are advanced action keys that are often used in conjunction with Action keys
in for command line operation. In addition there are a few direct action keys (Undo,
Up, Down) as well as the inverted "T" arrow keys.

[UNDO]
Allows undoing of the last level change [UNDO] [ENTER], the last record
[UNDO] [RECORD] [ENTER], update, goto or delete action. Two presses releases
selected devices or undoes selected commands. See Undo command at the top of
the main monitor for more advanced Undo history options.

• Bonus: If fixtures have been released in error, [UNDO] [RELEASE] will restore 
released fixtures in order. So the first [UNDO] [RELEASE] will restore the first 
fixture set and the second [UNDO] [RELEASE] will restore the second fixture 
set.

[PAGE]
Will "page" the channel display down to show additional fixtures. [SHIFT] +
[PAGE] will "page" up.) Note: In Patch, [PAGE] will "page" down the channel list
and [SHIFT] + [PAGE] will "page" up the channel list.

[VIEW]
Allows the user to use VIEW on the command line. User can identify a range of fixtures to view. Example: [VIEW]
[1] [THRU] [200] [ENTER]. [VIEW] (ALL) shall restore to default. Note, [SHIFT] + [VIEW] will open the View
pulldown. 

[TIME] 
Allows the changes of times for cues and other elements. Example: [CUE] [1] [TIME] [5] [ENTER]. When setting
Time in a Cue, pressing Time multiple times will allow for changing other time parameters. 

• Pressing [TIME] while in a cue will put CUE # TIME on the Command Line making it easier to change the time 
on the current cue. 

• [TIME] [SHIFT] + [TIME] is used to change the Master Fade Time of the console. 

• If channels are selected, pressing [TIME] now defaults to setting fixture timing. 

• 1st press: Cue Time

• 2nd press: Down Time. This is represented by a slash "/".

• [CUE] (#) [TIME] (#) [TIME] {/} (#) [ENTER]

• Advanced Functionality: (Fixture List) [TIME] (#) [ENTER] will provide timing for each fixture in the fixture list.

• 3rd press - Position Time, 4th press - Color Time, 5th press - Beam Time, 6th press - Edge Time. From there it will 
cycle around again. 

Example: [CUE] (#) [TIME] {/} (#) [TIME] {Pos Time} (#) [TIME] {Color Time} (#) [TIME] {Beam Time} (#)
[TIME] {Edge Time} (#) [ENTER]. That will assign a specific Up Time, Down Time, Position Time, Color Time,
Beam Time and Edge Time.

When this is done, in the Side Bar the cue will apply a "aft" flag for Attribute Family Timing.

Another use of the time key, is to work with the attribute family keys to apply attribute family timing.

Example: [CUE] (#) [POSITION] [TIME] (#) [ENTER] will change the position time for the selected cue.

[DELAY]
Any delay value will hold the cue for the specific amount of time prior to activating the cue. Example: [CUE] [1]
[DELAY] [2] [ENTER]

Pressing [DELAY] while in a cue will put CUE # DELAY on the Command Line making it easier to change the delay
on the current cue.
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Delay, like Time, can be applied to the Up, the Down, as well as Position, Color, Beam or Edge time. The syntax for
TIME will work with the DELAY key.

[FOLLOW]
Assigns a cue a follow command. A follow command on any cue will allow the next cue to run automatically after the
follow time has expired. Example: [CUE] [1] [FOLLOW] [5] [ENTER]

There are 3 ways to use the Follow command.

• Follow In Time - [CUE] [1] [FOLLOW] [5] [ENTER] will force cue 2 to be triggered 5 seconds after cue 1 is trig-
gered.

• Follow in Cue Time - [CUE] [1] [FOLLOW] [ENTER] will force cue 2 to be triggered at the completion of cue 1.

• Relative Follow - [CUE] [1] [FOLLOW] [+] [2] [ENTER] will force cue to be triggered 2 seconds after cue 1 
completes.

• If a cue has a follow command, [CUE] [1] [FOLLOW] [ENTER] will remove the follow command.

• If the console is sitting in the cue that needs a follow command, [CUE] (#) can be skipped and the first key pressed 
can be the Follow key.

• Historically, LightFactory has defined Follow cues differently. The follow command to automatically trigger the 
cue WITH the follow command rather than the cue AFTER the follow command, go to System Properties > Show 
Defaults (Intermediate Options) and uncheck the option "Follow to run next cue".

[Up]
Takes selected channel up a predetermined amount (e.g. 10%). Also works in other instances, such as time windows,
data fields, etc. Change this setting in System Properties > System Settings. [SHIFT] + [UP/DOWN] applies up/down
operation to active fixtures only. This is the same as using the [SHIFT] + [THRU] for the "Thru On" functionality.

[If] - Allows the use of IF on the command line for advanced IF/THEN statements. More will be published about this
command as the software develops and matures.

[Scroll To]
Allows display to "scroll to" a specified fixture.

[Down]
Takes selected channel down a predetermined amount (e.g. 10%). Also works in other instances, such as time
windows, data fields, etc. Change this setting in System Properties > System Settings. [SHIFT] + [UP/DOWN]
applies up/down operation to active fixtures only. This is the same as using the [SHIFT] + [THRU] for the "Thru On"
functionality.

[COPY]
Allows data to be copied* from selected channels. Example: [1] [@] [COPY]{COPY FROM} [2] [ENTER].

• Additional advanced functionality also exists. An example is copying ranges of cues. Ex: [cue] (#/range) [copy] 
{copy from} [cue] (#/range) [enter].

Note:  *Also works as a traditional Windows copy when data is selected.

[Paste]
Will apply the copied data as a traditional Windows paste action.

[EDIT]
Allows data to be editable. Also, is used in Command Line operation to edit or label information. For example,
[CUE] (#) [EDIT] will allow labeling of a cue. When edit is pressed, the word "Text" appears on the Command Line.

Note:  [SHIFT] + [EDIT] will put "Delete" on the Command Line. EX: [CUE] [1] [SHIFT] + [EDIT] {Delete} 
[ENTER] will delete Cue 1.
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[TAB]
Advances to the next edit cell with dialogue boxes.

[Arrow Keys]
Moves the cursor in the desired direction within dialogue boxes.

Shortcut Keys 

[Shortcut 1]... [Shortcut 10]
Quick access to the first 10 Shortcuts programmed on each Shortcut page.

Shortcuts are trigger points that can trigger any action that NEO can perform. 

• Advanced Feature: [SHIFT] + (Shortcut 1/10) allow quick access to Shortcuts 11 thru 20.

Use the Shortcut command to execute a shortcut, enable or disable a shortcut. The shortcut command can be
abbreviated to "SC".

NEO NOTES & TIPS:  SC 2 - Execute shortcut 2.

NEO NOTES & TIPS:  SC 2 disable - This will temporarily stop the shortcut from being executed.

NEO NOTES & TIPS:  SC 2 enable - This will re-enable shortcut 2.

[HELP]
Opens up console documentation.

Selection/Attributes Keys 
The Attribute Family keys of Intensity, Position, Color, Beam and Edge filter all attributes to present only the
available attributes for that family. These attributes will be available in two locations. Graphical control of the
attributes will be available on the main monitor in the Side Bar on the right side in the Fixture Control Tab.

Encoder control will be available on the 4 rotary encoders on the right side of the console. Pressing the same attribute
family key multiple times will "page" if multiple pages of attributes are available.

[SHIFT] + [INTENSITY/POSITION/COLOR/BEAM/EDGE] will page back rather than forward.

[Intensity]
Assigns any intensity attributes to the encoders. Advanced
functionality assigns utility parameters to the intensity encoder
assignments.

[POSITION]
Assigns any position attribute to the encoders. Example: Select a
Moving Light. (Fixture List) [ENTER]. By default, the Side Bar
Fixture Control GUI and the encoders will be assigned to the
Position page.

• Additional Functionality: (Fixture List) [@] [POSITION] (#) [ENTER] will assign the fixtures selected to the 
position palette number. This will work for users that have used [RECORD] [POSITION] (#) [ENTER] to record 
the position group. This functionality works with all attribute families.
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[COLOR]
Assigns any Color attributes to the encoders. Pressing Color again will access multiple pages.

[Beam]
Assigns any Beam attributes to the encoders. Typical attributes for this are Gobos and Prism.

[EDGE]
Assigns Beam parameters to encoders. Typical edge parameters are Focus, Iris, Zoom and Shutters. Press again to
bank the four encoders to other Edge attribute pages.

[SELECT]
Will open the Selection Shortcut pulldown. This box will access programmed items in the current showfile as well as
provide access to Tools & Macros.

[SELECT ACTIVE]
Will capture all fixtures with a level above zero.

[SELECT CHANGED]
Will capture all fixtures with adjusted values. [SHIFT] + [SELECT CHANGED] will place all changed channels
numerically on the Command Line. 

[Select Prev]
Will capture the previously selected fixtures. Pressing again, it will go back to the previous selection from that.
Pressing again and again will go back and forth between the last 2 previous selection sets. [SHIFT] + [Select Prev]
will place all previous channels numerically on the Command Line.

[SHIFT] + [SELECT PREV] will select the last selection set updated to a cue.

[Clear Selected]
Uncaptures all selected fixtures.

Additional Keys
These are the additional keys that were not collected in other tiles.

[BLOCK]
Allows Blocking a Cue. [CUE] (#) [BLOCK] [ENTER]. Block can be either a Block (forces an
instruction for every fixture/attribute in the system) or a Smart Block (only blocking intensities
for the channels that are in the current cue list). Press [BLOCK] again to change the Block
type that is applied in the above syntax in the selected cue list.

[DIMMER]
Allows applying a level to a dimmer. [DIMMER] (#) [FULL] will assign the selected dimmer
to full. Use [NEXT] / [LAST] to do a dimmer check. Flag appears on bottom right of the main
screen. [DIMMER] [DIMMER] will restore all dimmer levels back to normal control.

• Advanced Functionality: Any level can be assigned to a dimmer's level. Ex: [DIMMER] [1] 
[@] [5] [ENTER]. Dimmer 1 will be at 50%. The Dimmer in combination with the Next/
Last keys can be used as a Dimmer Check. Ex: [DIMMER] [1] [FULL] [Next] 
[Next]...Ranges are available with dimmer control. Ex: [DIMMER] [1] [THRU] [5] 
[FULL]. Once a range of dimmers are assigned, they can either be returned individually, 
(Ex: [DIMMER] [2] [DIMMER]) or they can all be returned to their patch assignment. (Ex: 
[DIMMER] [DIMMER]).

• A flag stating "Dimmers Unpatched" will appear bottom right on the main screen when 
dimmers have been manually assigned a level. Unpatched dimmers do NOT restore them-
selves. They must be released using [DIMMER] [DIMMER] to allow channel control to take affect.

[PARK]
Assigns the current fixture value to a locked level.

Example: With fixtures selected, [PARK] [ENTER] will park the selected fixtures at the current level.
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Note:  The option "Don't record parked channels" will determine if parked fixtures are recorded or not. System 
Properties > Show Defaults (Intermediate Options).

• Advanced Functionality: [SHIFT] + [PARK] will place Unpark on the Command Line and allow the unparking of 
fixtures. (Fixture List) [SHIFT] + [PARK] {Unpark} [ENTER] will unpark the listed fixtures. [SHIFT] + [PARK] 
{Unpark} [ENTER] will unpark the selected fixture or in the even no fixtures are selected, will unpark all fixtures.

[HOME]
Applies the Home values (default values) to the selected fixtures. Use this with the Attribute Families keys.

Custom home values can be stored per show. Adjust the values on the LEDs or Movers as desired. Then [RECORD]
[HOME] [ENTER]. Select Update (default), Replace, or Cancel.

Holding down [HOME] and pressing an encoder will "Home" a specific attribute.

[PAGE UP]
Advances the submaster page assignment up one page of faders.

[SHIFT] + [PAGE UP] advances the Playback page up one page of playbacks.

The Submaster Page and Playback Page locations are displayed at the bottom right hand on the Live screen.

[PAGE DOWN]
Advances the submaster page assignment down one page of faders.

[SHIFT] + [PAGE DOWN] advances the Playback page down one page of playbacks.

[CLOSE]
Closes the focused open window.

[OPEN DETAIL]
Opens detail window as opening a file folder.

• Advanced Feature: [SHIFT] + [OPEN DETAIL] will collapse the opened file folder.

3. Intelligent Lighting Buttons and Encoders

The encoders and buttons found in these sections of the desk provide special controls for intelligent lighting fixtures. 

The rotary four encoders provide navigation of the NEO software and control of channel attributes. The encoders are
context sensitive to allow appropriate control of attributes such as one percent, one DMX512 step, one gobo, one
second of time, etc. 

Holding [SHIFT] wil engaging the encoder will place the encoder in fine mode allowing movment per DMX value.

Pressing any active encoder for approximately 1/2 a second, will place that encoders attribute on the Command Line.
This allows a numerical value to be entered. For example, if an encoder has Edge for channel 12 and that encoder is
pressed, "12 Edge @" will appear on the Command Line. Typing [30] [ENTER] will set the Edge parameter to 30%.

An attribute can be set to the Home value by typing [HOME] + (Encoder Press). 

Level Wheel
The console features a level wheel that provides intensity level control for the selected channels.
48 Controls



NEO Lighting Control Console
Automated Luminaire Encoders
The LCD display left of each wheel will change depending on [SELECTION/
ATTRIBUTES] Button pressed. [Beam] is shown below. Each encoder wheel rotates
clockwise and counterclockwise, [SHIFT] + Encoder rotation will produce "fine" mode
movement, and pressing the encoder and holding for a short period will place the encoder's
attribute on the Command Line so that a numerical value can be entered.

4. Submaster Controls and Button Layout

Ten Submaster sliders are programmable to hold groups, effects, etc. Submasters can be programmed
as Additive, Subtractive, Pile-on, Exclusive and other modes. [RECORD] [SUB] (#) [ENTER] or
[RECORD] (Bump) where "Bump" is pressing the appropriate sub's bump button, will store the
selected channels to the submaster.  Submasters are just sliders assigned to Groups so the Groups
display will show the group list, each group's contents and all parameters that can be adjusted.

[1] / [10] - Bump button for corresponding Submaster slider

[UP] / [DOWN] - Increments or decrements Submaster pages

5. Playback Controls Layout

The playback section of the desk provides control of cue lists or show based effects. 

The Master Playback consists of double wide Select, Stop/Back and Go buttons, with split A/B faders. These faders
can be configured from System Properties > System Settings > Basic Settings: A/B Fader Mode. 

Primary Split Playback Faders
The primary split playback faders are motorized and will always activate the primary cue list. 

These faders have different configuration options.

1) Disabled - Choose this option and the sliders will do nothing. If doing a "GO SHOW", this is the safest 
mode of operation as inadvertent moves on these faders will have no effect. 

2) PB Master and Crossfader - In this mode, the left hand fader is the overall intensity master of the cue list 
assigned to this playback and the right hand fader is, at will, a manual cross fader. The [GO] and [HALT/
BACK] buttons function as normal, but at any time grab the fade and manually complete it using this 
handle. If the cue is Paused, either press [GO] to complete it or use the handle to manually complete the 
transition to the next cue. If sitting in a cue, moving the handle will initiate the transition to the next cue. All 
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levels going up and down will be affected. All times will be re-scaled to the distance the handle has to 
travel, with the greatest time in the cue being measured using that distance and all others scaled to that. Wait 
times will be scaled too. At any point before reaching the end of travel, move the handle backward to 
reverse the transition. Once the end of travel is reached, the next cue in the cue list will be pending. 
Reloading the cue or moving the fader back to it's starting point is not necessary. The next cue transition will 
begin by moving the fade off the end of travel or by simply pressing [GO]. If the user holds down [SHIFT] 
while manually moving a Crossfader, this will move backwards through a cue list. (i.e., the cue that has just 
been completed will be the pending cue, rather than the next cue in the cue list). In this case, the pending cue 
is Cue 1 - the cue just before Cue 2:.

3) PB Master and Disabled - In this mode, the left hand fader is the overall intensity master of the cue list 
assigned to this playback and the right hand fader is disabled. This mode is appropriate when the user does 
not want to manually execute fades and does not want to inadvertently start a transition by touching a fader.

4) Cue List Split Crossfader - The Split Crossfader mode sets up the left-hand fader to, at will, manually 
control the levels moving up in the next cue while the right-hand fader manually controls the levels going 
down in the next cue. Moving these faders in tandem executes a standard crossfade. Both handles need to 
reach their end-travel destination before the cue completes. Once the cue completes, the pending cue 
changes and the handles are ready to execute the next manual fade. There is no need to exercise the full 
travel of the handles to re-load the next cue.

NEO NOTES & TIPS:  PB faders can be configured in System Properties>System Settings.

Master Playback
Given that a NEO showfile always has a default cue list, it is always assigned to the Master Playback
by default. To change the cue list that is assigned press [SHIFT] + [SELECT]. A window will appear
on the Live screen that allows the selection of a different cue list (should multiple cue lists exist in
the showfile).

Multiple Cue List Playback
We have expanded master playback controls (PLAY, STOP/BACK and AB faders) so that they now
operate for the selected playback. With multiple cue lists that are assigned to additional playbacks,
just press the PB1/PB5 buttons (these are the Select buttons for the selected playback) and that
Playback will be able to be triggered from the Master Playback. To get back to the primary cue list
just press the double wide Select button above the Master Playback. That will return the Master
Playback to the primary cue list.

Playback Faders
[PB1] / [PB5]/ [SELECT] - Selects cue list to display and default record location. A solid white LED indicates that
there is a cue list assigned to the playback and it is selected. A blue LED indicates that there is a cue list assigned to
the playback.

[SHIFT] + [PB# or SELECT] allows clearing the playback or reassigning to a different cue list.
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In order to assign a secondary cue list to a playback, press the SELECT button above the appropriate playback. Then
select the appropriate cue list from the dialogue box on screen.

Playback Faders - Controls Fade times (in/out), cross faders,
intensity masters, or the playback faders can be setup to control

different things as determined by the NEO OS software.

• Advanced Functionality: During recording when using multiple 
cue lists, [RECORD] (PB#) will place the cue list name on the 
command line and allow recording to the cue list that is on the 
selected playback. During editing when using multiple cue lists, 
[UPDATE] (PB#) will place the cue list name and the cue number 
on the command line to update the sitting cue to the cue list that is 
on the selected playback.

[II] -Halts active cue (if running) or steps back to previous cue (if
stopped). 

[ d] - Activates next cue (following the active Cue) on the Cue List.

The Play/Arrow button [ d] will be solid when a cue list is active
and no cues are running. The same button will flash when cues are running. 

[STOP/BACK] - Same function as the [II] keys. Halts active cue on A/B slider (if running) or steps back to previous
cue (if stopped). 

[GO] - Same function as [ d] Activates next cue on A/B slider (following the active Cue) on the Cue List. Green LED
will be solid when a cue list is active and no cues are running. The Green LED will flash when cues are running. 
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6. Grand Masters and Master Fade Time Fader

The NEO console features two programmable Grand Masters and a Master Fade
Time Slider.

• [GM1]/ [GM2] - bump buttons for corresponding Grand Master slider.

• Disabled

• DBO Momentary - Dead Black Out as long as the button is pressed.

• DBO Latch- Dead Black Out toggle.

• Stop Attributes - stops all attributes from moving.

• Full Momentary - all outputs are set to 0 as long as the button is pressed

• Full Latch - all outputs are set to 0 as a toggle.

Grand Master 1/Grand Master 2 - Programmable Grand Masters. These are
special groups and can be edited in the Groups display.

Command Line - [RECORD] [GM1] or [GM2] [ENTER] will allow recording of
selected/changed fixtures to the Grand Master groups. Type [RECORD] [GM1/2]
it will default to "Selected", press GM1/2 again and it will toggle through the options of "Selected" or "Changed".

Note:  If a GM has been recorded with a custom set, going into the Groups display, in the Channel List cell for the 
GM1/2 groups, just replace with "All" to restore to the default.

Master Fade Time Slider - controls the rate for channel and shortcut recall. Does not affect timed cues and effects.

Command Line functionality: [TIME] [SHIFT] + [TIME] will place MASTER TIME on the Command Line. This
allows changing of the Master Fade Time from the Command Line. Just input a value in seconds and then press
ENTER to complete the command.

Note:  There is a system setting to allow wheel changes to ignore master fade time. System Properties > System 
Settings (Intermediate Options)

7. Trackball/Mouse Controls

The NEO console features a trackball/mouse.

[LEFT] - mimics the left mouse button.

[CENTER] - toggles between mouse mode (white LED) and pan/tilt mode (red LED)

[RIGHT] - mimics the right mouse button.

8. Working with Command Line Operation 

The term Channel is historically used for conventional dimmers only. While the term Fixture is historically used for
attributed units like LEDs or automated luminaires. With the NEO console, the use of the terms Channels or Fixtures
are interchangeable. Any reference in this documentation to channel or fixture is referring to the control number for
each unit. Below are some examples of the power of Command Line and a sampling of NEO's capabilities.
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Channel Selection
Channel Selection can be directly from Channel Control, Items or Modifiers. Channel Control applies to the current
selection set. This can be one or more channels each of which can include both intensities and attributes. Channel
control can be set or modified using console keys via Command Line for Full, On, Out, Up, Down or any level using
the @ key, the level wheel, the Channel Control graphical interface, the external keyboard, or encoders for the
attributes.

• Channel Control would be direct action from the Command Line with Channel List.

• [1] [ENTER] - will select channel 1 and m[ENTER] ake it the current selection set.

• Clicking the Channel icon directly on the Classic View with either mouse or via touchscreen.

• Double clicking* the Channel icon directly on the Classic View with either the mouse or via touchscreen shall set 
the clicked channel to the "On" level.

Note:  *There is an option to enable/disable this double click features. System Properties > System Settings > 
Intermediate Options: "Disable double click function."

• [1] [FULL/ON/OUT] - will select channel 1 and go to Full, the On level or Out.

• [1] [@] [LEVEL] [LEVEL] [ENTER] - will select channel 1 and output to desired level.

• [1] [UP/DOWN] - will move 1's level up/down based on the Up/Down level in System Properties > System Set-
tings.

• [2] [..] [5] [..] [2] will select every 5th channel (interleave) starting at channel 2 and clustered by 2 channels.

Note:  Interleave works on selected channels so if nothing is selected, type [201] [..] [5] [..] [2] [ENTER] . This will 
select 2 consecutive channels starting and 201 with the selection gap being 5 channels. So 201,202, 205,206,210,211 
and so on. This will continue for all patched channels. If the user wants this to effect only a range of channels (say 
201 through 300), just select them first [201] [THRU] [300] [ENTER]. Then use the interleave command.

There is another way to go about this and that is Offset. [+] [+] will place OFFSET on the Command Line. This
allows offsetting the selected channels by the offset number applied. For example, to select every 3rd channel from 1
to 20, type [1] [THRU] [20] [+] [+] {OFFSET} [3] [ENTER]. This will select 1, 4, 7, 10, 13, 16, and 19.

After selecting an OFFSET, adding [+] [+] again will provide the CLUSTER option in conjunction with OFFSET.

While Offset will select every X channel, Cluster will determine the number of consecutive channels to select. For
example, [1] [THRU] [20] [+] [+] {OFFSET} [3] [+] [+] {CLUSTER} [2] [ENTER] will select 1+2, 4+5, 7+8,
10+11, 13+14, 16+17, 19+20. This can also be applied to a selected set of fixture. Just start with the ++ to initiate the
offset command on the currently selected fixtures. For example, [+] [+] {OFFSET} [3] [+] [+] {CLUSTER} [2]
[ENTER]

• [1] [UPDATE] [CUE] [#] [ENTER] will update only channel 1's level to the identified cue. This is called a Lead-
ing Channel List for update and any channel listing can be used for this.

• [UPDATE] [LAST] or [UPDATE] [NEXT] will automatically place the previous or next cue onto the command 
line for Updating.

• (Channel) [@] [CUE] (X) [THRU] (Y) applies a command line cue range. This will apply the channel’s value from 
the first cue in the range that has a value for that channel.

• (Channel List) [@] [GROUP] (#) [POSITION] [EDGE] will recall partial palettes and groups.

• [LOAD] {GROUP/INT/POS/COLOR/BEAM/EDGE} (#) [ENTER] will load the palette into active control for 
editing.

• [LOAD] (Palette bump) will load a palette into the Live screen for editing. 

• [LOAD] [ENTER] [GO] will now load the current cue so that GO will rerun the current cue. Great for rerunning 
the current cue when changes made in Blind need to be made Live.
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• (Channel List) [@] (Palette Name) [THRU] (Palette Name) [THRU] (Palette Name) [ENTER] –adds the ability to 
apply a palette range thru more than 2 palettes.

• In Blind, (Channel List) [@] [POSITION/COLOR/BEAM/EDGE] [LIVE] will pull the current live values into 
Blind.

• In Blind, (Channel List) [@] [LIVE] [ENTER] will pull the current live values into Blind. This can be filtered to 
only include selected attribute families by adding the attribute family key into the command. For example, (Chan-
nel List) [@] [COLOR] [LIVE] [ENTER] will pull only color from Live for the listed fixtures.

• [GROUP] (#) [SHIFT] + [THRU] [ENTER] adds the ability to do “Thru On” with a Group. Thru On grabs the 
active channels in the specified group.

• (Channel Number) [COPY] {Copy From} [NEXT/LAST] will put the next/previous channel on the Command 
Line. 

• (Channel list) [TIME] [INTENSITY/POSITION/COLOR/BEAM/EDGE] (#) [ENTER] will add complex timing. 
Once set Update/Record to store the time info in the cue. This will be stored as Complex Timing and a “C Timing” 
flag will appear in the cue list.

• On selected channels that already are outputting a level, [@] [THRU] {/} (#) [ENTER] will adjust the live level to 
a proportional value. If a channel is sent to a proportional value of 50% ([@] [THRU] {/} [50] [ENTER], then the 
channels level will be half of what it was. If a channel is sent to a proportional value of 200% ([@] [THRU] {/} 
[200] [ENTER], then the channels level will be doubled. There is no limit on the proportional value that can be 
applied.

• Added "`" key as a substitute for the @ key in the command line processor.

• (Channel List) [@] [CUE] (X) [THRU (Y) [ENTER] will set the leading channel list at the highest value from that 
cue range.

• [VIEW] + [POSITION/COLOR/BEAM/EDGE] will open or bring forward the selected Palette window.

• (Channel List) [THRU] [ENTER] [ENTER] will select all channels up to a change in fixture type or an unpatched 
fixture.

• (Channel List) [SHIFT] + [THRU] [THRU ON] will select all active channels up to a change in fixture type or an 
unpatched channel.

• (Channel) [THRU] [ENTER] will select the range of from the starting channel through the rest of the patched 
channels or until a channel gap occurs and/or the type changes. Ex: If 1 thru 5 are VL1000s and 6 thru 10 are 
PLFresnels, then [1] [THRU] [ENTER] will select 1 thru 5. 

• (Channel) [THRU] (Channel) [+] [+] {OFFSET} (#) will select the desired channel offset. For example, if the user 
wants to grab every 3rd channel between channels 1 and 10, type [1] [THRU] [10] [+] [+] {OFFSET} [3] 
[ENTER]. That will select 1, 4, 7, and 10.

• [SELECT ACTIVE] will select all "active" channels.

• With channels selected, typing [+] [Next/Last] will add the next/last channel to the selection set.

• [SHIFT] + [SELECT ACTIVE] will ignore submasters.

• Command Line entry allows for mixing channels and groups and subs in the same command. i.e. (Channel List) 
[+] [GROUP] (#) [+] [SUB] (#) [@] (Level) [ENTER]. The exception is starting with "Sub" will assign a level to 
the sub, not select it's stored channels.

Starting any command with an Item (Cue, Group, Submaster, Palette, FX Step) or 
calling up a channel list from an Item will apply the stored levels to channel control 
live.
• [CUE] [1] [@] [FULL] will apply the cue's values at the specified level to channel control.

• [1] [@] [CUE] [2] [ENTER] will apply fixture 1's value from cue 2 to channel control.

• [GROUP] [4] [@] [50] [ENTER] will apply group 4 to 50% of the stored value to channel control.

• [GROUP] (Label) [@] (Level) [ENTER] will apply the named group at the assigned level. Ex: With a group 
labeled FOH, then [GROUP] [FOH] [FULL] will place that group's fixtures as their stored levels.
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• (Label) [@] (Level) will apply the named group at the assigned level. This example eliminates the need for the 
Group button to be used prior to the label info.

• [SUB] [1] [FULL] will apply submaster 1 to full. This is the same as taking submaster 1's fader and pushing it to 
full.

• [SUB] [1] [On] will apply submaster 1 to the On value.

• [SUB] [1] [@] (Level] [ENTER] will apply submaster 1 to the desired level.

• [3] [@] [GROUP] [11] [ENTER] will apply channel 3's value from group 11 to channel control.

• [1] [@] [POSITION] [2] [ENTER] will apply channel 1's values from position 2 to channel control.

• (Channel List) [@] [SUB] (#) [ENTER] will load the submaster state into channel control.

• [GROUP] [1] [-] [3] [@] [50] [ENTER] will put group 1 at 50% of its recorded value minus fixture 3.

• [CUE] (#/range) [COPY] {COPY FROM} [CUE] (#/range) [enter]. Allows for copying of cue ranges.

• [CUE] (#) [+] (#) [FX] (#) [ENTER] allows the ability to add an FX to multiple cues not in order.

• [CUE] (#) [THRU] (#) [FX] (#) [ENTER] allows the ability to add an FX to a range of cues.

• [CUE] (#) [FX] [ENTER] will remove all FXs from the specified Cue.

• [CUE] [PLAYBACK#] will select a playback using the command line.

• [CUE] [PLAYBACK#] [0] will select the Master Playback.

Modifiers (+, -, Thru, Next, Last) will add or subtract to existing Command Line entry.
• [1] [+] [3] [ENTER] will select channels 1 and 3.

• [1] [+] [Next] will place 1 + 2 on the Command Line. [ENTER] will select 1 and 2. The use of [Next], [Last], [+], 
and [-] is not limited.

• [1] [THRU] [5] [FULL] will select channels 1 thru 5 and set their output to 100%.

• Clicking and dragging the Fixture icon range directly on the Classic View with either mouse or via touchscreen.

• [1] [THRU] [ENTER] will select from channel 1 up to a change in channel type or an unpatched channel. 

• [1] [SHIFT] + [THRU] {Thru-on} [ENTER] will select from channel 1 up to a change in fixture type or an 
unpatched channel for active channels only.

• [1] [THRU] [10] [-] [5] [@] [5] [ENTER] will select channels 1 thru 4 and 6 thru 10 and set the output to 50%.

• [1] [+] [3] [+] [5] [THRU] [13] [-] [6] [THRU] [10] [ENTER] will select 1, 3, 5, 11, 12, and 13.

• [1] [THRU] [10] [@] [10] [THRU] [100] [ENTER] will range the output value of 10% to 100% across channels 1 
thru 10 in a linear application. Example: 1 at 10%, 2 at 20%, 3 @ 30% and so on until 10 is at 100%.

• [1] [THRU] [10] [@] [10] [THRU] [FULL] or [On]. Range commands can work with auto completing keys like 
Full or On.

• [199] [+] [Last] will place 199 + 198 on the Command Line. [ENTER] will select 198 + 199. The use of [Next], 
[Last], [+], and [-] is not limited.

Extending the Current Channel Selection
[+] (Channel List) [ENTER] or [-] (Channel List) [ENTER] will modify the current selection set. This can include the
use of [THRU] within the channel list.

(Channel list) [@] [ENTER] removes the instruction for channels controlled by submasters.

When updating a submaster channels with no control information are removed from the group.

Using Next/Last
While Next/Last can be used to minimize 10 key entry (Ex: [199] [+] [Next]), it can also be used to cycle through the
current selection set. Ex: [1] [THRU] [5] [FULL]. This puts 1 thru 5 at full. [Next] will select channel 1. Continuing
to press [Next] will move the selection set to 2 then 3 then 4 then 5 then back to 1. To go back to the entire selection
set, press [Select Prev] and 1 thru 5 is again selected. This is very useful when focusing a collection of automated
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luminaires and when finished focusing, the uesr needs to go back to all of them to change color, beam or edge
parameters.

Releasing the Current Selection
The current selection can be cleared so that no fixtures are selected or captured. Channel Control will then have no
effect. 

• [RELEASE] has 2 stages. The first press of Release will let go of the current selection set and send their levels 
back to any active control item (like a Cue, Sub or FX.) Channel control has priority of the other elements but 
when channel control is no longer in play, the levels will return to the other control items. The second press of 
Release will let go of all remaining adjusted channels and then their levels back to any active control item. Ex: [1] 
[FULL]. [2] [FULL]. The first press of Release will let go of channel 2 as that is the current selection set. The sec-
ond press of Release will let go of channel 1.

Setting Levels with the Command Line
Channel levels can be set directly from the Command Line by using the 10 key to select channels and specify levels.

• (Channel List) [@] (Level) [ENTER] selects the listed channels and sets their intensity level to the specified per-
centage. 

• [@] (Level) [ENTER] will apply the intensity level entered to the selected channels.

• [@] (Level) [THRU] (Level) [ENTER] will apply a range of levels to the selected channels.

• [@] (Level) [THRU] (Level) [THRU] (Level) [ENTER] will apply one range to the mid point and another range to 
the end of the range of selected channels. This allows for programming "peaks" and "valleys" from one Command 
Line entry.

• [SHIFT] [@] {@ DMX} (DMX Value) [ENTER] will apply a DMX value to the selected channels.

• [@] [CUE] [ENTER] will restore the current cues data to selected channels.

• [@] [CUE] [Last] [ENTER] will restore the previous cues data to selected channels. The previous cue's cue num-
ber will appear on the Command Line when [Last] is pressed.

• [@] [CUE] [Next] [ENTER] has been added. Will restore the next cues data to selected channels. The next cue's 
cue number will appear on the Command Line when [Next] is pressed.

• [@] [ENTER] restored the previous cue's intensity value.

• [@] [.] [ENTER] has been added. Will restore all selected channel's attributes from previous cue.

• [@] [THRU] (Value) [ENTER] will set a relative value to the selected channels. For example, if the selected chan-
nel is at 50%, type [@] [THRU] [50] [ENTER] and the selected channel's value will be at half of 50% which is 
25%.

Setting Parameter Values with the Command Line
Channel/Fixture parameter values can be set directly for the Command Line by using the encoders to change each
parameters values. Console keys add functionality by changing attribute family pages as well as work with the
encoders for advanced functionality.

• (Channel List) [ENTER] will select the desired channels. 

• (Encoder Rotate) will adjust the assigned parameter. There are 4 encoders on NEO. Just identify the appropriate 
parameter from the encoder's screen located next to each encoder. Each encoder can rotate clockwise (for positive 
or additive movement) or rotate counterclockwise (for negative or subtractive movement). 

• [INTENSITY/POSITION/COLOR/BEAM/EDGE] allows the encoders to change pages. When assigned to the 
Position family, selecting [COLOR] will change the attribute assignment to the Color family assignment. Should 
the fixture have more than attribute family page setup, pressing the current attribute family page button again, will 
change from the first page to the second and so on. Once the last page is reached pressing again will cycle back to 
the first page.
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NEO NOTES & TIPS:  The encoder assignment will depend greatly on the fixture's DMX map and how the fixture 
is setup within the fixture library. If there are more than 4 colors, the fixture may be setup with multiple color pages. 
If the fixture has only basic intensity, there may not be a encoder page setup for multiple intensity parameters.

• (Encoder Press). When the encoder is pressed down until it "clicks" and held for 1/5 of a second (the delay is to 
keep this functionality from happening accidentally), the attribute itself will be placed on the Command Line to 
allow providing a direct digit value for each parameter. For example, if the user is in the Color family of an LED 
fixture and the 2nd encoder has Green assigned to it, if the user presses and hold the 2nd encoder for 1/5 of a sec-
ond, then enter [50] [ENTER] and Green will go to 50%.

• [SHIFT] + (Encoder Rotate) will adjust the desired parameter to the next DMX value. Therefore this is considered 
a "fine" mode that allows for a more discreet level of control.

Should the assigned parameter be an 8 bit parameter, fine movement will allow each encoder indentation to change 1
DMX value. Should the assigned parameter be a 16 bit parameter, fine movement will allow each encoder indentation
to change 1 16 bit DMX value.

• [+] or [-] + (Encoder Rotate) will set the selected channel's parameter to it's maximum value if rotated clockwise 
and to it's minimum value if rotated counterclockwise. This is a quick way to just get parameters like color mixing, 
zoom, iris, focus to their maximum value.

Note:  To continue this action the "+" or "-" key must be released and pressed again.

• [HOME] will default all selected channel's parameters that are not currently in their default value.

• [HOME] + [Position/Color/Beam/Edge] will default the selected channels attribute family parameters that are not 
currently in their default value.

• [HOME] + (Encoder Press) will default the selected channels attribute that is not currently in its default value.

• (Channel List) [@] [Int/Pos/Color/Beam/Edge] [ENTER] should remove any instruction for the selected attribute 
family and track from the previous cue. If there is no instruction, then the command should have no affect.

Force Parameters to Changed
Should the need arise to force parameters to report as changed values without actually changing them, select the
channels/fixture desired, then press [SELECT CHANGED] + [+].

To filter this down and only mark an attribute family as changed, then press [SELECT CHANGED] + [INTENSITY/
POSITION/COLOR/BEAM/EDGE] for each attribute family that needs to be changed. Remember this works on
selected fixtures so select them first.

Recording Items with the Command Line
Storing fixture level information into an item is referred to a Recording. Recording is used to create a new item. The
item can be a Cue, Group, Sub, Palette or Effect. In most cases, the proper procedure is to output the fixtures at the
desired level and then store the data into the appropriate item. All examples below will assume that the fixtures have
been adjusted and will outline the recording actions.

• [RECORD] [CUE] (#) [ENTER] will record the state using the "Default Record Mode" setting into the desired 
cue. Note: When the Cue button is pressed, the Command Line listed will demonstrate when default record mode 
the record command will use. The options are Live, Selected, Active, Changed.

• [RECORD] [CUE] [CUE] {Live/Selected/Active/Changed} - when pressing the cue button after record, it will 
change the record mode that this action will use. Continuing to press [CUE] will cycle through all record mode 
options.

• [RECORD] [CUE] [ENTER] will record the state using the "Default Record Mode" setting and create a new whole 
cue number at the end of the cue list.

• [RECORD] [ENTER] will record the state using the "Default Record Mode" setting and create a new whole cue 
number.
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• [RECORD] [CUE] ("Label") [ENTER] will record the state using the "Default Record Mode" setting and create a 
new whole cue number at the end of the cue list and label the cue within the quotation marks.

• [RECORD] [CUE] (#) (Label) [ENTER] records the selected cue number and add the entered label.at the end of 
the cue list.

• [RECORD] [CUE] [EDIT] {Text} (Label) [ENTER] records the cue as a new cue number to the end of the cue list 
and includes the entered label.

• [RECORD] [RECORD] will record the state using the "Default Record Mode" setting and create a new whole cue 
number at the end of the cue list.

• [RECORD] [Tracking Mode] {Track/Cue Only/Trackback} [ENTER] will record a new cue using the tracking 
mode selected by the "Tracking Mode" button. Just press the "Tracking Mode" button multiple times until the 
desired mode is listed on the Command Line.

• [RECORD] [GROUP] (#) [ENTER] will record to the numbered group based on the Group Record setting. The 
options are Selected/Changed/Live. This setting is in System Properties > Show Defaults (Intermediate Options) 
"Group record changed (off = selected)". By default, [RECORD] [GROUP] (#) [ENTER] will record "Selected". 
This is very convenient as it allows the recording of a group even if outputting a cue. Anything not selected will be 
ignored.

Note:  When recording a group, if the selected channels have no level, they will be stored at full. If they have a level, 
then they will be stored at the assigned level. For traditional group recording either have all channels at full or no 
level info assigned when recording.

• [RECORD] [GROUP] (Label) [ENTER] will record a new group at the end of the existing group list with the label 
info provided based upon the Group Record setting.

• [RECORD] [GROUP] [GROUP] {Live/Selected/Changed} - when pressing the Group button after record, it will 
change the group record mode that this action will use. Continuing to press the [GROUP] button will cycle through 
all record mode options.

• [RECORD] [SUB] {Selected} (#) [ENTER] will record a new group of selected fixtures with the desired submas-
ter number and assign the desired submaster for fader control. If the user presses "Sub" multiple times during this 
command line operation, NEO will cycle through recording options for subs. Options are "Selected", "Changed" 
and "Live".

• [RECORD] [SUB] [SUB] {Live/Selected/Changed} - when pressing the Sub button after record, it will change the 
group record mode that this action will use. Continuing to press the [SUB] button will cycle through all record 
mode options.

• [RECORD] + (Bump) where (Bump) is touching a submaster's bump button. This allows for the fastest recording 
action for recording submasters.

• [SUB] (#) [THRU] [Sub (#) [RECORD] [SUB] (#) [ENTER] allows the ability to record a range of subs to another 
sub regardless of output. i.e. [SUB] [1] [THRU] [SUB] [5] [RECORD] [SUB] [6] [ENTER].

• [RECORD] [INTENSITY/POSITION/COLOR/BEAM/EDGE] (#) [ENTER] records the designated intensity/
position/color/beam/edge specific palette.

• [RECORD] [INTENSITY/POSITION/COLOR/BEAM/EDGE] [ENTER] records the next available intensity/
position/color/beam/edge specific palette at the end of that attribute families palette list.

• [RECORD] [INTENSITY/POSITION/COLOR/BEAM/EDGE] (Name) [ENTER] records the next available 
intensity/position/color/beam/edge specific palette at the end of that attribute families palette list and assigns the 
given name.

• [RECORD] [INTENSITY/POSITION/COLOR/BEAM/EDGE] (#) [INTENSITY/POSITION/COLOR/BEAM/
EDGE] [ENTER] records the designated intensity/position/color/beam/edge specific palette and adds the addition-
ally selected attribute families to the designated specific palette. For example: [RECORD] [POSITION] [1] 
[COLOR] [ENTER] will record position 1 but add color's data to it.
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• [RECORD] [GENERIC PALETTE] (Label) [ENTER] will record a new generic palette at the end of the existing 
palette list with the label info provided.

• [RECORD] (Bump) where (Bump) is touching an open generic palette button. Note: First, press the Palette display 
key to open the Generic Palette window. Once the Generic Palette window is open, just [RECORD] (Bump) to 
store to the desired palette. Then a window will pop up to add a label and change other properties. Make all neces-
sary additions/adjustments and press [ENTER] to complete.

• (Channel List) [RECORD] [Position/Color/Beam/Edge] (#) [ENTER] records the designated position/color/beam/
edge specific palette.

• (Channel List) [RECORD] [Position/Color/Beam/Edge] (# Text) [ENTER] records the designated position/color/
beam/edge specific palette and labels it.

• [RECORD] (Bump) where (Bump) is touching an open specific palette button. Note: First, press [SHIFT] + [PAL-
ETTE] display key and select/open the desired specific Palette window (Position, Color, Beam, Edge, Utility) from 
the pulldown. Once the appropriate Specific Palette window is open, just [RECORD] (Bump) to store to the 
desired palette. Then a window will pop up to add a label and change other properties. Make all necessary addi-
tions/adjustments and press [ENTER] to complete. 

Note:  When recording Specific Palettes, the attribute filtering will be determined by the Palette Type filtering. This 
is available in the Groups display > Options pulldown.

• [UPDATE] + (Bump) where (Bump) is touching an existing palette button. If no fixtures are selected, this will 
update all changed data. If fixtures are selected, then it will update only the changed data on the selected fixtures.

• [RECORD] [FX] (#) [ENTER] will record a new step to the desired effect number.

• [RECORD] [FX] (#) [.] (#) [ENTER] will now record the FX number and step number.

• [UPDATE] [FX] (#) [.] (#) [ENTER] will now update the FX number. step number.

Updating Items with the Command Line
While Record is used to create the item initially, Update is used to edit any item that already exists. In general, any
record syntax can be initiated using update assuming  want to edit the existing data. (See "Recording Items with the
Command Line" on page 57). The nature of Update is that it only uses changed information (data in red) when
affecting the editing of the identified item.

• [UPDATE] [CUE] (#) [ENTER] - will edit the changed values into the selected cue using the default tracking 
mode. This does NOT have to be the current live cue.

• [UPDATE] [CUE] [ENTER] - will edit the changed values into the current cue using the default tracking mode.

• [UPDATE] [ENTER] - will edit the changed values into the current cue using the default tracking mode.

• [UPDATE] [UPDATE] - will edit the changed values into the current cue using the default tracking mode.

• [UPDATE] [Tracking Mode] {Track/Cue Only/Trackback) [ENTER] - will edit the changed values into the current 
cue using the default tracking mode. Just press "Tracking Mode" multiple times until the desired tracking option is 
selected. This works for this one time action only and does NOT change the default tracking mode.

• [UPDATE] [POSITION] [ENTER] (for example, Updating a palette without specifying the number) updates the 
most recently edited palette.

• [UPDATE] (Bump) to a Palette button will edit and store changed data.

• [UPDATE] [CUE] [PART] (#) [ENTER] - will take all changed values (values in red) and create the part if neces-
sary and update the values into the identified part cue.

• [UPDATE] (Bump) to a Submaster's bump button will update the submaster.

Working with Color Mixing Fixtures to Apply Gel Filters Colors
The 4 major brands of gel manufacturers are part of the NEO software. Each brand and color can be accessed using
Command Line on selected channels by typing [@] [COLOR] (#) [.] (#) [ENTER]. Where the first number (on the
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left side of the point key) is the gel manufacturer based upon the following table and the second number (on the right
side of the point key) is the gel number.

Gel Manufacturer Table

1 - Apollo

2 - GAM

3 - Lee

4 - Rosco

They are listed in alphabetical order.

So to set the selected color mixing fixture to Rosco 68, you would type [@] [COLOR] [4.68] [ENTER].

Note:  Go to More > Edit Color Filters to see the gel manufacturer's ID and all gel library information.

Working with Palettes
It is important to understand the difference between Generic Palettes,
Specific Palettes (Intensity, Position, Color, Beam, and Edge), and
Virtual Palettes. It is equally important to have the console setup to
store the desired data.

Generic Palettes
Generic Palettes hold "generic" information that can apply to any
patched fixture with matching parameters. For example, to build a
Blue color on channel 12 (an LED), it will apply that to ANY color
changing patched unit. Generic Palettes are engineered to be used for
Color. However other parameters (like zoom and iris) are a good use of
generic palettes. Position is often not a good use of generic palettes as the user often wants two or more moving lights
to be focused on the same position. This requires different values. A generic palette will apply the SAME values to all
fixtures. Often not desirable for position. 

Specific Palettes
Specific Palettes hold "specific" information that can apply to only the patched fixtures with stored values. For
example, a Blue color built on channel 12 (an LED) can ONLY apply that color palette to channel 12 because it is the
only fixture for which the data has been stored. Specific palettes are good when different info is needed in different
patched fixtures.

Virtual Palettes
Virtual Palettes allow a palette to apply to any fixture regardless of whether it has been recorded in the Palette or not.
Specific Palettes now have the option of being Virtual Palettes. This allows them to function as Generic Palettes but

smarter. For example, with three types of color mixing fixtures - VL1100s, Selecon PL4s, and a generic RGBA
fixture - a color mixed in the VL1100 and stored as Color Palette 1 can be used in all three fixture types by default.
The VL1100s CMY color mixing system is converted and applied to RGB for the other two fixture types. During the
CMY to RGB conversion process, the white channel on the PL4s cannot be calculated and the data is ignored. Add
the missing data by selecting PL4, applying Color Palette 1, and adding the white value. Update Color Palette 1 to
update the PL4 (and any added PL4 fixtures). Next apply Color Palette 1 to the generic RGBA fixture. With no
existing data for this fixture NEO looks to the first fixture with color data and finds the VL1100 as the lowest channel
number. NEO then converts CMY to RGB, ignoring the missing amber value. Select the RGBA and add amber value
as needed. Update Color Palette 1 and now the generic RGBA (and any added RGBA fixtures) adopt that fixture’s
color palette data. Now if one particular RGBA fixture needs different values to output the correct value, then adjust
appropriately and update. Once data exists for a particular fixture, that data will be used first and take priority over
data from another fixture of the same type.
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Palette Types
In the Groups Display, under Options, open "Edit Palette Types". This allows the user to determine what parameters
are stored under each attribute family. For example, for Groups to only store Intensity information, then deselect
(make the cell grey, not green) for each attribute family or attribute that is NOT intensity. 

For the Position palette to also include all Edge parameters, then select the "Edge" cell under the Position column. 

Applying Palettes
By default palettes can only be applied to the selected channels. So if I have a position palette #1 called "DC" for
Down Center and the Moving Lights that are stored in the palette are channels 201 thru 210, if nothing is selected and
I type [@] [POSITION] [1] [ENTER], the command will fail as there are no fixtures selected that have data stored in
the palette. However if I type [201] [@] [POSITION] [ENTER], that will apply the DC position's reference to 201
and the light will move to that location.
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With the Position Palette window open, just press the position 1 button. As long as the desired fixtures are selected
first, the palette reference will be applied and the light will move. 

Palette Windows
Palette windows can be opened by pressing [PALETTES] from the display tile. This will open the Palettes pulldown
where the desired palette window can be selected. 

Once opened, [VIEW] + [INTENSITY/POSITION/COLOR/BEAM/EDGE] will open or bring forward the selected
Palette window should it be hidden behind the Main display.

Deleting Palettes
With the Palette window open, palettes can be deleted as easily as they are created. [SHIFT] + [EDIT] {DELETE}
(Palette bump) will bring up a Delete Palette dialogue box for confirmation. The Palette deleting can be confirmed
with OK or Canceled.

A Palette can also be deleted by other methods.

• In a Palette window, select and hold a palette to access the right click list. Select "Delete" and confirm.

• In a Palette windows, hover over a palette with the mouse and right click. Select "Delete" and confirm.

• The Command Line only solution is [SHIFT] + [EDIT] {DELETE} [POSITION] (#) [ENTER].

Group Default Record Mode
Next, it's important to understand "what" the console is set to record/update when dealing with Groups and Palettes.
In System Properties > Show Defaults > Intermediate Options: Group Default Record Mode. The options are
Selected, Changed Only, Live.

• Selected - only stores selected channels. 

• Selected + Changed - record only fixture's parameters that are selected AND changed. 

• Active - only stores channels that have a level above 0.

• Changed - only stores channels with changed information. 

These are available as defaults in System Properties > Show Defaults > Intermediate Options: Group Default Record
Mode.

These can be accessed on the fly while recording when it’s needed to change
the record mode for this one recording instance. [RECORD] [GROUP] will display the record mode on the
Command Line. The example here show the default being “Changed”. To change the record mode for this one
recording instance, just press [GROUP] as needed to cycle through all of the record modes. When the correct mode is
displayed, continue the record process as normal by typing in the group number and [ENTER].

Once NEO is setup in the preferred manner, move forward with storing palettes as building blocks for the cueing
session.

For the following to work, it is recommended to have the palette windows open and available on a second monitor.
Press the [PALETTES] display key and select the appropriate palette window (or press [PALETTES] +
[INTENSITY/POSITION/COLOR/BEAM/EDGE] to open each window). A third option is to press the "Palettes"
display key at the bottom of the main monitor or F6 on the external keyboard. 

• (Channel List) (Bump) where Bump is selecting a palette will apply the palette to the selected channels.

• (Channel List) [ENTER] (Bump) where Bump is selecting a palette will apply the palette to the selected channels.

• (Channel List) [FULL/ON/OUT] (Bump) will apply Full/On/Out to the selected channels then apply the palette to 
the selected channels.

• (Channel List) [@] (Level) (Bump) will apply the assigned level to the selected channels then apply the palette to 
the selected channels. 

Setting Time with Command Line
• [TIME] (#) [ENTER] will apply the adjusted time to the selected cue.
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• [CUE] (#) [TIME] (#) [ENTER] will apply the adjusted time to the cue the next time it runs.

• [CUE] (#) [TIME] (#) [TIME] {/} (#) [ENTER] will change the up time (1st press of Time) and the down time 
(2nd press of Time) to the cue the next time it runs. The separation between up and down time will be identified 
with a slash "/".

• Additional presses of the Time key will allow assignment of Attribute Family Timing. The 3rd press - Position 
Time, 4th press - Color Time, 5th press - Beam Time, 6th press - Edge Time. From there it will cycle around again. 

Example: [CUE] (#) [TIME] (#) [TIME] {/} (#) [TIME] {Pos Time} (#) [TIME] {Color Time} (#) [TIME] {Beam
Time} (#) [TIME] {Edge Time} (#) [ENTER]. That will assign a specific Up Time, Down Time, Position Time,
Color Time, Beam Time and Edge Time.

• When this is done, in the Side Bar the cue will apply a "aft" flag for Attribute Family Timing.

• Another use of the time key, is to work with the attribute family keys to apply attribute family timing.

Example: [CUE] (#) [POSITION] [TIME] (#) [ENTER] will change the position time for the selected cue.

• (Channel List) [TIME] (#) [ENTER] will apply the adjusted time to the selected fixtures. Once this is accom-
plished. [UPDATE] [ENTER] to edit the cue to include the Fixture timing.

• When Fixture timing is included, a "F Timing" flag will appear on the cue in the Side Bar Cue List.

• [CUE] [PART] (#) [TIME] (#) [ENTER] changes time on the current cues' part cue.

• [CUE] (#) [PART] (#) [TIME] (#) [ENTER] changes time on the identified cue and identified part.

Changing Cue Time over a Range of Cues
• [CUE] (#) [THRU] (#) [TIME] (#) [ENTER] allows the user to change time over a range of cues.

Changing Cue Time with Relative Data
• [CUE] (#) [TIME] [+/-] (#) [ENTER] allows the user to change time on a cue with relative timing info. This works 

for both + and -. 

• This also works with a range of cues so, as an example, one second can be added to a range of cues by entering 
[CUE] [1] [THRU] [3] [TIME] [+] [1] [ENTER].

Setting Delay with Command Line
• [DELAY] (#) [ENTER] will apply the adjusted delay to the current cue.

• [CUE] (#) [DELAY] (#) [ENTER] will apply the adjusted delay time to the cue.

• Additional presses of the Delay key will allow assignment of Attribute Family Delay. The 2nd Delay - Down 
Delay, the 3rd press - Position Delay, 4th press - Color Delay, 5th press - Beam Delay, 6th press - Edge Delay. 
From there it will cycle around again. 

Example: [CUE] (#) [DELAY] (#) [DELAY] {/} (#) [DELAY] {Pos Delay} (#) [DELAY] {Color Delay} (#)
[DELAY] {Beam Delay} (#) [DELAY] {Edge Delay} (#) [ENTER]. That will assign a specific Up Delay, Down
Delay, Position Delay, Color Delay, Beam Delay and Edge Delay.

• Another use of the delay key, is to work with the attribute family keys to apply attribute family delay.

Example: [CUE] (#) [POSITION] [DELAY] (#) [ENTER] will change the position delay for the selected cue.

Changing Cue Delay with Relative Data
• To add or subtract delay time from a cue [CUE] (#) [DELAY] [+/-] (#) [ENTER] allows the user to change delay 

time on a cue with relative timing info. This works for both + and -. 

• This also works with a range of cues so, as an example, add 1 second to a range of cues' delay by entering [CUE] 
[1] [THRU] [3] [DELAY] [+] [1] [ENTER].

Deleting a Cue with Command Line
• [CUE] (#) [SHIFT] + [EDIT] {Delete} [ENTER] will delete the identified cue.
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• [SHIFT] + [EDIT] {DELETE} [CUE] (#) [ENTER] will also delete the identified cue. [CUE] (#) [THRU] (#) 
[SHIFT] + [EDIT] {DELETE} works for ranges of cues.

Active Cue vs. Selected Cue
The Active Cue is the cue that is currently outputting. This will appear on the Side Bar Cue List with a yellow border
to highlight the cue. The Selected Cue is the cue that will currently be affected with Command Line syntax and is
identified by a blue background. Under normal circumstances the Active Cue and the Selected Cue will be the same
cue. However, there are instances where they are not the same by circumstance or separated deliberately.

Re-syncing the Active and Selected Cues
• [LIVE] - will re-sync the Active and Selected cues already in Live and the Selected Cue is not synced with the 

Active Cue.

Moving the Selected Cue in the Side Bar Cue List
If the side bar cue list is in focus, then the Arrow Up/Down keys will move the Selected Cue either up or down the
cue list appropriately. This allows the ability to apply Time, Delay, and Follow without entering the cue number.
When completed, just press [LIVE] and the selected and active cue will be synced up. Otherwise if the Side Bar Cue
List is not in focus, the Arrow Up key will place the previously used Command Line command back onto the
Command Line. This is very useful when repeating Command Line commands. To place the Side Bar Cue List into
focus, just tap once on any cue in the Side Bar Cue List. At this point, Up/Down will move through the Command
Line history list. When the desired previous command is on the Command Line, pressing [ENTER] will complete the
command as normally expected.

Working with Cues
• [GOTO] [CUE] (#) [ENTER] will take the identified cue in the default goto time. [GOTO] (#) [ENTER] can also 

be used. After a goto, the Arrow Up/Down keys will move the select cue pointer.

• [GOTO] [ENTER] will restore the current cue.

• [GOTO] [CUE] (#) [TIME] (#) [ENTER] will take the identified cue in the selected time. Press the [Down Arrow/
Up Arrow] multiple times to go back/ahead more than one cue.

• [GOTO] [LAST/NEXT] or [DOWN ARROW/UP ARROW] [ENTER] will place the last/next cue on the Com-
mand Line and ENTER will complete the process of going to that cue.

• [GOTO] (#) [Next/Last] [ENTER] will place the console is the cue that is after/before the numbered cue. This is 
useful when a Stage Manager will request "Goto the cue before Cue 16".  [GOTO] [16] [Last] [ENTER] will place 
the console in the cue before cue 16.

• [STEP UP/STEP DOWN] will go to the previous/next cue using the Goto Time. [SHIFT] + [STEP UP/STEP 
DOWN] will go to the cue at the beginning/end of the cue list (disregarding) cue 0.

• [GOTO] [SHIFT] + [LAST/NEXT] or [DOWN ARROW/UP ARROW] [ENTER] will place the first cue of the 
cue list or the last cue of the cue list on the Command Line and ENTER will complete the process of going to that 
cue.

• [UPDATE] [CUE] (#) [THRU] (#) [ENTER] will update a range of cues. Note, Tracking Option modifiers like 
Track and Cue Only can be used here.

• [UPDATE] [CUE] (#) [THRU] [CUE] (#) [ENTER]. Syntax improvement for updating cue ranges. The CUE key-
word is now valid after the THRU key.

• [CUE] (#) [BLOCK] [ENTER] will block the selected cue. A "Block" flag will appear on the cue in the Side Bar 
Cue List.

• [CUE] (#) [BLOCK] [BLOCK] {Smart Block} [ENTER] will smart block the selected cue. A "Smart Block" flag 
will appear in the Side Bar Cue List.

• On a unblocked cue, performing [CUE] (#) [SHIFT] + [BLOCK] {UNBLOCK} [ENTER] will remove redundant 
values (white values) from the cue. Any Block flag will be removed.
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• Pressing [LIVE] when in Live will sync the selected cue (blue background) with the active cue (golden border) and 
scrolls the active cue to the 3rd cue in the visible list.

• [CUE] (#) [EDIT] {Text} (Label) [ENTER] allows the ability to label a cue.

• [CUE] (X) [THRU] (Y) [EDIT] {TEXT} (Label) [ENTER] allows the ability to label a range of cues from cue X 
to cue Y.

• [CUE] (#) [SHIFT] + [EDIT] {DELETE} is available to delete a cue.

• [SHIFT] + [EDIT] {Delete} [CUE] is available to delete a cue. When in Tracking Mode, it's possible to delete a 
cue "Cue Only". This can be achieved by typing [CUE] (#) [SHIFT] + [EDIT] {Delete} [TRACKING OPTIONS] 
{Cue Only}. A dialogue box will appear and provide options to delete tracking (OK), cancel or delete cue only 
(Cue Only).

• When focused on the Side Bar, the Up/Down Arrows move the selected cue Up/Down.

• [LOAD] [CUE] (#) [ENTER] [GO] will load the selected cue to be the next cue on the GO. This is different than 
GO as it allows the cue to run in the recorded time.

• [LOAD] [ENTER] [GO] will now load the current cue so that Go will rerun the current cue. Great for rerunning 
the current cue when changes made in Blind need to be made Live.

• [CUE] (#) [FX] (#) [ENTER] will assign the selected FX to be run by the selected cue. So [CUE] [3] [FX] [4] 
[ENTER] will trigger FX 4 when Cue 3 is run.

• [CUE] (#) [FX] [-] (#) [ENTER] will remove the selected FX from the selected cue. So [CUE] [3] [FX] [-] [4] 
[ENTER] will remove FX 4 from Cue 3.

• [CUE] (#) [FX] [ENTER] will remove all FX from the selected cue.

• [CUE] (X) [SHORTCUT] (Y) [ENTER] – this will add SC Y to be triggered by Cue X.

• [CUE] (X) [SHORTCUT] [-] (Y) [ENTER] – this will remove SC Y to be triggered by Cue X.

• [CUE] (X) [THRU] (Y) [SHORTCUT] (A) [ENTER] – this will add the same SC (A) to be triggered by a range of 
Cues (X thru Y).

• [CUE] (X) [THRU] (Y) [FX] (A) [ENTER] – this will add the same FX (A) to be triggered by a range of Cues (X 
thru Y).

• The following syntax adds a scene break after the desired cue. Notice that the [EDIT] key toggles between "Text" 
and "Break". 

a. [CUE] (X) [EDIT] {Text} [EDIT] {Break} (Scene Break Description) - this will create a scene break and 
add the scene break description.

b. [CUE] (X) [EDIT] {Text] [EDIT] {Break] [ENTER] will remove the scene break after cue X.

c. Or just type "Break" instead of pressing the [EDIT] key twice.

• [CUE] (#) [EDIT] [EDIT] {BREAK} [SHIFT] + [EDIT] {DELETE} [ENTER] will delete a scene break after the 
confirmation.

Preheating Cues
• [CUE] (#) [UP] will preheat all channels in that cue to 5% of their recorded value. (Assuming the UP value is set to 

5%)

• [CUE] (#) [ENTER] [@] [07] [ENTER] will preheat all channels in that cue at a level of 7%. Any preheat level 
can be entered. Once this is done, just update the cue normally.

Working with AutoFollow Cues
An AutoFollow cue will allow the next cue to trigger automatically after the end of the follow time. It's a great way to
have consecutive cues run automatically. 

The AutoFollow command is set to the "triggering" cue and then the "triggered" cue will run automatically.
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[CUE] [2] [FOLLOW] [3] [ENTER] will place an AF command on Cue 2 and after cue 2 is triggered, 3 seconds later,
cue 3 will be triggered automatically. This will occur regardless of cue 2's time. There are 3 different ways to work
with Follow.

Follow In Time
[CUE] (#) [FOLLOW] [ENTER] - will add a follow time equal to the cue time. So if the cue has a time of 5, this will
add a follow of 5. This is called "Follow In Time". If working on the currently selected cue, the cue number can be
ignored so [CUE] [FOLLOW] [ENTER] will work. So if changing the time of the cue, the follow time will
automatically be adjusted so that the triggered cue will always be triggered when the triggering cue has completed.

Removing a Follow Command
If a cue has a follow command then [CUE] (#) [FOLLOW] [ENTER] will remove the command. If working on the
currently selected cue, the cue number can be ignored so [CUE] [FOLLOW] [ENTER] will work.

Follow Hold
Follow Hold is a way to provide an additional amount of time for the follow to delay after the completion of the
previous cue. So if Cue 2 has a time of 5 and the next cue wants to trigger 7 seconds after cue 2 was triggered, then
assign [CUE] (#) [FOLLOW] [+] [2] [ENTER]. The advantage of Follow Hold is that if the time changes on cue 2,
cue 3 will always trigger 2 seconds "after" cue 2 has completed.

Working with Cue Links
Linking cues allows cues to be triggered out of numerical order. [CUE] [1] [SHIFT] + [FOLLOW] {LINK} [5]
[ENTER] will link cue 5 to cue 1 so that pressing GO from cue 1 will run cue 5. If Cue 5 wants to run automatically,
a Follow command on Cue 1 will accomplish that.

Command Line allows for the programmer to set a Link, the number of Loops and the cue that it will fall out to or exit
to.

[CUE] [3] [SHIFT] + [FOLLOW] {LINK} [1] [@] {LOOPS} [2] [@] {Exit to} [5] [ENTER]. This means that cue 3
will link to cue 1, loop through this sequences twice and then exit to cue 5.

[CUE] (#) [SHIFT] + [FOLLOW] [ENTER] on a cue that has a Link command will remove that Link command.

Note:  In the Cue List display, there is a link column. There provide 3 numbers separated by a comma for linked cue, 
number of loops and the fall out cue number. So 5,2,6 would like the desired cue to cue 5, have it loop through twice 
and then fallout to cue 6 on the next Go.

Copying Cues
[CUE] (X) [@] [CUE] (Y) [ENTER] will copy the cue if there a cue in between cue x and cue y. If there is NOT a cue
between cue x and cue y, it will move the cue.

Selecting a Cue's Channels
This will select all channels that have an instruction in a cue. This does not include tracked values.

[CUE] (#) [ENTER] will select the identified cue's channels. After that, a value can be applied. i.e. [@] (Level)
[ENTER]. 

Applying a Cue's Level/State
Apply a cue's levels and state at anytime by typing [CUE] (#) [@] (Level) [ENTER]. This shall apply all attributes to
the cue state and the levels will be applied proportionally. Example: [CUE] [1] [@] [5] [ENTER] will apply the state
of Cue 1's attributes and all Cue's levels at 50% of their recorded value.
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Quick Name
Immediately after a cue/group/palette has been recorded, a Quick Name feature is available by pressing [EDIT] and
entering the requested label into the dialogue box for the recently created cue/group/palette.

Working with Groups
• A Group can stored a selection of channels AND their attribute data. If that behavior wants to be changed, go to the 

[GROUPS] display, Options > Edit Palette Types and adjust as needed. The Groups column will identify any info 
that is included with the green cells. Just click to change. Green will include, grey will exclude.

• [GROUP] [1] [FULL] will select group 1 and apply all stored values. So if Group 1 has intensity and color, it will 
be in the stored intensity value and color. This allows the use of groups as both selection and applying the stored 
values.

• [GROUP] [1] [@] [5] [ENTER] will select group 1 and apply the stored values at a proportionate value of 50%. So 
if the values in the group are stored at 80%, then applying the group to 50% will net an output value of 40%. (50% 
of 80% is 40%).

• [GROUP] [1] [ENTER] [FULL] will select all channels in group 1 and then set the intensity to full. This allows the 
use of groups as selection group.

• [GROUP] [1] [@] [POSITION] [2] [ENTER] will select Group 1's channels and put them in Position 2. This 
works with any specific palette that is stored using the Intensity, Position, Color, Beam and Edge attribute family 
buttons.

• [GROUP] (#) [ENTER] (Bump) allows the selected channels to accept an applied specific palette or generic pal-
ette. Note: Any Specific Palette or Generic Palette window must be open to select from.

• [GROUP] + (Bump) will open the Groups display and select the submaster.

• [SUB] + (Bump) will open the Groups display and select the submaster.

• [GROUP] (#) [BLIND] will open the Group display and select the Group.

• [SUB] (#) [BLIND] will open the Group display and select the Submaster.

• [GROUP] [1] [+] [GROUP] [2] [@] [50] [ENTER] adds the ability to concatenate groups when setting levels.

Note:  If additional channels are required that must be placed at the end of the list. i.e. [GROUP] [1] [+] [GROUP] [2] 
[+] [50/58] [@] [50] [ENTER].

Working with Special Groups (GM1, GM2, Home, Hi Light and Lo Light 
Groups)
Special Groups are groups that are part of the software and always there. Programmers have the ability to store data in
the group but they all have a default state.
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The default states are...

• GM1 - All patched channels reside in this Grand Master group.

• GM2 - All patched channels reside in this Grand Master group.

• Home - is the default state that the fixture goes to when released. Same as when the system starts up. 

• Hi Light - there is a default Hi Light state as specified in the fixture library. However a show state can be stored for 
each fixture. The show based Hi Light state will override the default state from the fixture library.

• Lo Light - there is no default state in the fixture library. However a show state can be stored for each fixture.

GMs
Many users like the ability to use the GMs to control different groups of lights. Maybe moving lights for GM1 and
conventional fixtures for GM2 or front of house for one and stage for the other.

Regardless of the need, custom GMs can be very helpful.

Home
The Home key will take any selected channel to it's default home state. This is determined by the home data stored for
each parameter in the fixture library for each fixture type. But with the ability to store custom home states, this will
override the default home state for each fixture patched. Just adjust the desired fixture(s). Then type [RECORD]
[HOME] [ENTER].

Hi Light/Lo Light
Many users like the ability to help identify a specific fixture when looking at a complex stage picture with many
fixtures on. Hi Light is a great way to identify a fixture as it will clear out the beam from images and clear out the
color. Lo Light gives users the ability to take the fixture to a different state, often used to go to a lower level or to take
the fixture to a saturated color.

The standard Hi Light button will send the selected fixture to the Hi Light value set in the fixture library. This is
global for each fixture type.

For more flexibility, the Hi/Lo Light groups allow setting Hi/Lo Light states for each patched fixture per show file.

Select the fixtures and set them to their desired state. To store the show's Hi Light state type: [RECORD] [HI LIGHT]
[ENTER]. Now press {Hi Light} using those fixtures, they will go to the show's Hi Light state rather than the fixture
libraries Hi Light state.

Lo Light is a show file only state that allows the stored fixtures to goto to a different state to help identify them while
programming. To program fixtures to a Lo Light state, select the fixture and set them to their desired state. Type:
[RECORD] [SHIFT] + [HI LIGHT] {LO LIGHT} [ENTER]. Once stored, the Lo Light state can be accessed by
typing [SHIFT] + [HI LIGHT] {LO LIGHT} with the desired fixtures selected.

Note:  These special groups appear in the Groups Display and the data can be edited by just editing the appropriate 
groups data. 

Working with Park
• [PARK] [ENTER] will park all selected channels. This command will not park anything if no channels are 

selected.

• [1] [PARK] [ENTER] will park channel 1 at it's current level.

• [1] [FULL] [PARK] [ENTER] will first put channel 1 at full and then park at it's current level. 

• [1] [SHIFT] + [PARK] {Unpark] [ENTER] will unpark channel 1.

• With Active Select Mode turned on, [1] [ENTER] will take channel 1 to the On value. [Next] [Next] will have 3 at 
the On value. [PARK] [ENTER] will park channel 3.

• From a clean Command Line [SHIFT] + [PARK] {Unpark} [ENTER] shall unpark ALL parked channels.
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Working with Effects
NEO effects are very powerful, flexible and easy to work with whether quick pre-built effects or manually built
specific effects. There are many ways to build and trigger effects.

FX Library
The quickest way is to select the desired channels and apply an FX Library Effect. Ex: [1] [Thru [10] [ENTER]. [FX
Library]. [Intensity FX: Square Wave Wrap]. The last two buttons are at the top of the main screen. This will apply
the Square Wave Wrap effect to the selected channels. The Side Bar has a new tab, Library FX Control with 4 FX
parameters (FX Length, Offset, Scale and Stagger). Adjust as necessary. This can run live as is, it can be stored as a
Show FX or store it directly into a Cue.

Store Library FX into Cue
Make sure the recording default will "Include Running FX". (System Properties>Show Defaults). Then just record a
cue as normal (Ex: [RECORD] (#) [ENTER]).

When recording an FX into a cue. This is essentially, taking a library based FX and creating a show based FX.

When typing [RECORD] [FX], the Command Line will display the default record mode for the FX. By pressing FX
again, this will toggle through the different record mode options available.

Store Library FX as Show FX
With the library effect running, [Create FX] will open the create effect dialogue box. Provide a name, optional label
and press OK to create.   The effect has now been created and is running independently. Open the FX Playbacks to
stop or manipulate the effect further.

Add/Remove FX to Cues with Command Line
In order for this to work, the FX number must be known. This can be found in the FX Editor display.

• [CUE] (#) [FX] (#) [ENTER]. This will add the assigned FX to the assigned Cue.

• [CUE] (#) [FX] [-] (#) [ENTER]. This will remove the assigned FX number from the Cue.

• [FX] (# or Name) (PAUSE) will now pause the running FX if the FX is running in an independent FX playback.

FX Editor [FX LIST]
There are many different FX engines to use to create effects. [FX LIST] will open the FX editor.

1) Chase - are step based effects. Any combination of intensity and parameters can go into each step. There is 
no limitation. 

2) Timeline - is based on a visually running timeline. Create an unlimited number of lines, one for each 
channel or group of channels, adjust the effect length (in time), then click and drag within each line's 
timeline to create a segment. When the segment is within the running timeline indicator (vertical red line) 
the line's channels will be on. Select any created segment to open the segment editor and adjust as desired.

3) Profile - is based on 3 things. Selected channels, selected attribute (pan, red, zoom), and selected profile 
(Sine, Inverted V, Shake). From there, the Length, Offset, Scale, Start Position, and Stagger can be adjusted.

4) Matrix - is based on 2 things. The Matrix created and the image that the Matrix is applied to. First create the 
matrix (More > Edit Matrices) as desired. Create the Matrix and then populate with channel assignments. 
Each channel needs to be assigned to a square within the matrix. These can be intensity only or color mixing 
channels. Once created, go to the FX Editor [FX LIST], into the Matrix FX tab and create a Matrix FX. In 
the Matrix Definition pulldown, select the desired Matrix that was created in the Matrix Editor. Click on the 
image. This will place the matrix on the image for a starting point. Adjust the Zoom and Length as 
appropriate. Now from the point of the box identifying the matrix on the image, click a point on the image 
outside the box. This creates a path for the image to follow. Continue to click and create the desired path for 
the image box to follow. When complete, press the Play arrow. On the Live screen, the colors from the 
image box are visible as they are applied to the channels that are assigned to the matrix in the assigned 
location. If the channels have no intensity, selected them as normal and apply a level so that the Matrix FX's 
output is visible on stage.

5) Paint Box - this is for color effects only. Allows the user to create a color path for a Matrix. What's unique 
is that it allows Length, Spread and 10 different directions in which the effect can playback.
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6) Media - takes an image or video file and outputs the media to a NEO console video port. 

7) DMX Rec - takes a DMX input data stream and records it live as a data stream.

8) Library - shows all default library effects where they can be viewed or edited.

Adding/Removing FX to Cues in Blind - [Cue List Editor]
[CUE LISTS] will open the Cue List Editor. In this editor, there is a column call "Effects (FX)". Clicking on the "..."
button will open the Cue List Effects dialogue box. Any selected effect can be added/removed to/from the selected
cue. There is also a convenient button to "Add FXs from the previous cue".

Adding/Removing FX to Groups/Subs in Blind - [GROUPS] Display
[GROUPS] display button will open the Groups display. In the editor, there is a column called "Effects". Clicking on
the "..." button will open the Group Effects dialogue box. Any selected effect can be added/removed to/from the
selected group.

See  "FX List (Effects Editor)" on page 200 for more detailed info.

Working with Shift
Shift works with many of the Command Line keys to add functionality to those keys.

Below is a list of all Shifted commands...

• [SHIFT] + [PAGE UP/PAGE DOWN] = Playback page up/down.

• [SHIFT] + [REL CUE LIST] = releases all active cue lists.

• [SHIFT] + [STEP UP/STEP DOWN] = jumps to the first/last cue in the current cue list.

• [SHIFT] + [HI LIGHT] = Lo Light.

• [SHIFT] + [RELEASE] = global release. This releases everything. Channels, cues, subs, effects…everything.

• [SHIFT] + [BACKSPACE] = removes all entered commands from the Command Line.

• [SHIFT] + [THRU] = “Thru-On”. This selects only the active channels throughout the entered range.

• [SHIFT] + [@] = Places “@ DMX” on the Command Line to enter a DMX value rather than a percentage value.

• [SHIFT] + [ENTER] = places the last executed command on the Command Line without executing with the Enter 
key.

• [SHIFT] + [PAGE] = pages back up the channel grid view.

• [SHIFT] + [VIEW] = opens the View pulldown.

• [SHIFT] + [TIME] = applies the current Stopwatch time to the current cue.

• [SHIFT] + [FOLLOW] = Link

• [SHIFT] + [EDIT] = Delete

• [SHIFT] + [TAB] = Reverses the Tab key.

• [SHIFT] + [LIVE] = Live Timing Display

• [SHIFT] + [BLIND] = Blind Timing Display

• [SHIFT] + [CUE LISTS] = Tracksheet

• [SHIFT] + [HELP] = Lock console

• [SHIFT] + [DIMMER] = SELECT DIMMER - used to select a channel by the dimmer patched to it.

• [SHIFT] + [DIMMER] in Patch = will default the Fixture Make/Model back to “Standard Dimmer”.

• [SHIFT] + [BLOCK] = UNBLOCK

• [SHIFT] + [SELECT CHANGED] = Added the "changed" list of channels to the command line as text

• [SHIFT] + [SELECT ACTIVE] = Select all active channels excluding submasters

• [SHIFT] + [SELECT PREV] = Select channels last updated to a cue
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• [SHIFT] + [Shortcut Keys] = shortcuts 11..20

• [SHIFT] + [PB Select Keys] = Open the cue list/fx selection window to assign to the playback

Working with Vision.net
• Once properly configured, NEO and Vision.net can communicate bi-directionally. From the NEO Command Line, 

Vision.net ASCII commands can be sent. Just begin with [VISIONNET] or [VN] prior to entering the Vision.net 
ASCII command.

• See  "Vision.net" on page 151 for details.

• See the Vision.net manual for more information regarding Vision.net.

Editing the Command Line
At any time before a command on the Command Line is completed, it is possible to move back through the
Command Line to correct it. 

• [BKSP] removes the last entered key when a command is entered.

• [ARROW LEFT]/[ARROW RIGHT] will move the cursor with the entered commands. The blue highlighted text 
will be replaced when a new command is entered.

• [SHIFT] + [BKSP] removes the complete command line entry. If nothing has been entered, then it has no effect.

Troubleshooting with Command Line
Should an illegal command be entered using Command Line, there is an exception handler that stops the Command
Line from completing. If this issue appears, check the command history log and there will likely be an entry that
starts "Critical Parser Error". This can be reported to Philips Entertainment Tech Support if a resolution is needed.

Accessing the Command History
There are different levels of Command History.

• The first and simplest is the last few commands. They are available from the Command Line. From a clean Com-
mand Line press the [ARROW UP] key. This will place the last completed command on the Command Line. Con-
tinue to press [ARROW UP] and that will continue to go back one command at a time and place them on the 
command line. They are then available as needed for Command Line programming.

• The second level of command history is to press the NEO icon to the left of the Command Line. This will replace 
the live screen with Command History window. Every command entered during the current programming session 
is listed here. Restarting the software or the desk will reset this list.

• The third level and most extensive command history is available by opening the Control Panel (More > Control 
Panel > Maintenance: "Open Log File Folder". Once the Windows File Manager has opened, open the file called 
"NEO_Log_Year_Month.txt". This will have all of the commands listed by date/time.

Setting Up the Fixture Grid
The layout of the Fixture Grid is determined by settings in the View pulldown. All options will be discussed in the
section on the View pulldown. The default option is Classic. 

• View > Show Palette Information - On this displays Palette references. Off it shows raw data.

• View > Enter the column count - allows the user to determine the number of fixture columns displayed.

• View > Show 3rd line of text - is a View pulldown option that allows a third line of text underneath the fixture's 
level. This will display information the user entered in the Patch screen in the Position, Unit #, Purpose and Color 
Description columns. See  "Patch" on page 242 for detailed information.

Classic View Zoom
• The Classic View can now be zoomed in/out to increase/decrease the size of the Channel Blocks to make viewing 

easier.

• [VIEW] + (Level Wheel) will increase/decrease the zoom scale of the Classic View.
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• While [SHIFT] + [VIEW] opens the View pulldown, it also allows [SHIFT] + [VIEW] (Level Wheel) to restore 
the zoom scale back to the default.

Note:  From an external keyboard, [CTRL] + [SHIFT] + (+/-) will also increase/decrease the classic grid zoom scale. 

Fixture Status Identification
The fixture number in the Classic screen uses color to indicate fixture type.

The fixture's level in the Classic screen uses colors to indicate status.

Symbol Description Meaning

Channel Not patched

This channel has been giving a patch of dimmer 0. This allows the 
channel to appear in the Live screen and programming can occur 
on it. However, since it has no actual working dimmer assignment, 
there will be no output.

Grey Fixture Block Indicates a fixture with a dimmer

Blue Fixture Block

Indicates a attributed fixture. This typically would be an LED or 
moving light. Note: The "3rd Line of Text" is turned on here which 
makes the channel block bigger. Under View > Show 3rd Line of 
Text will turn the 3rd line of text on/off. When on, an additional line of 
text is available to show Position/Purpose data from the Patch table.

Red Border Around Block
Indicates the fixture is captured. Levels can be adjusted without 
reentering the selected fixtures. [RELEASE] to remove this.

Blank The fixture is off.

White on Red Level has been adjusted. [RELEASE] to remove this.

Cyan on Black Indicates an intensity going up from a cue.

Green on Black Indicates an intensity going down from a cue.

Magenta on Black
Indicates an intensity or attribute that is tracking its value from the 
previous cue.
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* Note: These examples are from the ML Attribute window not the Classic View.

Three Levels of Timing
There are three levels of timing information within the NEO console - Cue Timing, Fixture Timing, and Complex
Timing.

Cue Timing 
Cue Timing is the lowest priority and is the simplest of them all. Cue Timing is the time that is set on the cue for
timing transitions from one cue to another. This is set by the following Command Line options.

For changing time on the current cue, type [CUE] [TIME] (#) [ENTER]. That will change the time on the current cue.

To specify the cue number, type [CUE] (#) [TIME] (#) [ENTER].

Up Time / Down Time
Different time values can be assigned for up time and down time. Up time is the time that the values going up in the
cue will take while down time is the time that values going down in the cue will take.

[CUE] [TIME] (#) [TIME] {/} (#) [ENTER] for the Current Cue. [CUE] (#) [TIME] (#) [TIME] {/} (#) [ENTER] for
a non-current cue.

Notice that hitting Time for the second time will place a slash "/" on the Command Line signifying down time.

White on Grey with White Box Indicates a Parked Fixture.

White on Grey Indicates a level coming from an effect.

Yellow on Black Indicates a level coming from a Submaster.

Yellow Box Indicates an inhibited value.

Blue on Black Indicates an attribute that is has changed from a cue.*

Grey on Black Indicates a ML's attributes in its default values.

Light Green on Black Color of the text for a Specific Palette.*

Orange on Black Indicates any value that has Auto Marked.*

Symbol Description Meaning
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Changing the Down Time Only
[CUE] [TIME] [TIME] {/} (#) will change the down time only on the current cue.

[CUE] (#) [TIME] [TIME] {/} (#) will change the down time only on the selected cue.

All cue timing will be displayed in the Side Bar Cue List and in the full Cue List display.

Fixture Time
Fixture Timing is the 2nd (middle) level of timing priority and will apply to all components of the channel / fixture.
So if this is a moving light, Fixture Time will apply to intensity, position, color and all of the fixture's parameters.

Fixture Time is set by applying time information to the fixtures. This must be done with supplying a leading channel
list.

Example: [1] [THRU] [5] [TIME] [5] [ENTER] will set a fixture level timing of 5 seconds to channels / fixtures 1
thru 5.

It's important to understand that Fixture Timing will apply to the channels in the order in which they are selected. So
[1] [+] [3] [+] [2] [TIME] [0] [THRU] [2] [ENTER] will assign time 0 to channel 1, time 1 to channel 2 and time 2 to
channel 3.

• [GROUP] (#) [TIME] (#) sets fixture timing. Once applied, Record/Update the cue to store. 

• [GROUP] (#) [DELAY] (#) sets fixture timing. Once applied, Record/Update the cue to store. 

• [GROUP] (#) [TIME] (#) [DELAY] (#) [ENTER] now works to set both Time and Delay on a group of channels in 
the same Command Line action. 

• (Channel List) [TIME] (#) [DELAY] (#) [ENTER] adds ability to set both time and delay in the same command 
when working with a channel list. 

• (Channel List) [DELAY] [ENTER] will remove a channel or attribute delay. 

Peaks and Valleys for Complex Timing
Fixture timing can now be applied using multiple "thru" key entries for ranges of values. So that 10 channels peak in
the middle, just type [1] [THRU] [10] [TIME] [0] [THRU] [10] [THRU] [0]. That will start 1 at 0 and 10 at 0 and put
5 and 6 at 10. The same can be done with the Delay command.

Instead of a "peak" range, maybe a "valley" range is desired. So that the center channels are low instead of high.
Using the same channels as above type [1] [THRU] [10] [TIME] [10] [THRU] [0] [Thur] [10] [ENTER]

When Fixture Time is assigned a "FT" will appear in the Classic View display on the effected channel's channel
block.

Once updated, the Cue List will display "F Timing".

Fixture Timing View
[SHIFT] + [LIVE] will display the fixture timing info that has be programmed. Fixture timing info that has been
programmed will be in White. The default cue timing will be in gray. Pressing [LIVE] will return the level screen.
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Or use the View pulldown and select "Display complex timing" to view.

Fixture Delay
Fixture Delay is a form of fixture timing. It just applies to the delay of the fixture's instructions rather than applying to
the timing. All rules and syntaxes for Fixture Time apply to Fixture Delay. Just replace the [TIME] key with the
[DELAY] key.

Example: [1] [THRU] [5] [DELAY] [5] [ENTER] will set a fixture level delay of 5 seconds to channels / fixtures 1
thru 5. This means that 1 thru 5 won't start moving for 5 seconds after the GO for that cue is executed.

Complex Time
Complex Timing is the 3rd (highest) level of timing priority and will apply to any attribute or combination of
attributes. If there is a moving light, Complex Time can be applied to Position or Color or any attribute family via
Command Line or any individual attribute in the Cue List Detail window.

Example: [1] [THRU] [5] [POSITION] [TIME] (3) [ENTER] will apply 3 seconds to channels 1 thru 5's position
family attributes.

It's important to understand that Complex Timing will apply to the channels in the order in which they are selected.
So [1] [+] [3] [+] [2] [POSITION] [TIME] [0] [THRU] [2] [ENTER] will assign time 0 to channel 1's position
attributes, time 1 to channel 2's position attributes and time 2 to channel 3's position attributes.

In addition, with fixtures selected [TIME] (Attribute Family) (#) [ENTER] will assign designated time to the
designated attribute family. 

When Complex Timing is assigned a "CT" will appear on the affected channel's attributes in the ML attribute display.

Once updated, the Cue List will display "C Timing'.

Complex Timing View
[SHIFT] + [LIVE] will display the Complex Timing info that has be programmed in the Intelligent Lights (ML) view.
Complex Timing info that has been programmed will be in White. The default cue timing will be in gray. Pressing
[LIVE] will return the level screen.

Note:  "Show 3rd line of text" must be turned on to view this data. (View pulldown > check "Show 3rd line of text").

Complex Delay
Complex Delay is a form of complex timing. It just applies to the delay of the attributes instructions rather than
applying to the timing. All rules and syntaxes for Complex Timing apply to Complex Delay. Just replace the [TIME]
key with the [DELAY] key.

Example: [1] [THRU] [5] [POSITION] [DELAY] [5] [ENTER] will set an attribute family level delay of 5 seconds to
channels / fixtures 1 thru 5's position family. This means that 1 thru 5's position won't start moving for 5 seconds after
the GO for that cue is executed.
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Using Recorded Items in the Fixture Lists
• [1] [@] [CUE] [5] [ENTER] will apply cue 5's stored values to fixture 1.

• [2] [@] [GROUP] [3] [ENTER] will apply group 3's values to fixture 2.

• [3] [@] [SUB] 

Attribute Groups
[RECORD] (Attribute Family) (# Label) [ENTER] will record an attribute family group with both a number and
label. Ex: [RECORD] [POSITION] (2 DC) [ENTER]. This will record group #2 with just position info that has a
label of "DC". Just use a space between the number and the label for this to work.

Using the Level Wheel
The level wheel is automatically assigned to selected fixtures' intensity. In addition, when using the Side Bar's Fixture
Control graphical user interface, should a number box be selected and the numbers are highlighted, the level wheel
will change the highlighted numbers value.

Setting DMX Levels
[SHIFT] + [@] {@ DMX} allows entry of a DMX value instead of a percentage value.

Copying Fixture Levels
• (Fixture List) [@] [COPY] {Copy From} (Fixture) [ENTER] will copy from the second fixture entered to the first 

fixture list.

• (Fixture List) [@] [COPY]{Copy From} (Fixture) (Attribute Family) [ENTER] will copy from the second fixture 
enter to the first fixture list and filter to the listed attribute family. Ex: [1] [THRU] [5] [@] [COPY] {Copy From} 
[6] [POSITION] [ENTER]. This will copy position data from fixture 6 to fixtures 1 thru 5.

• (Fixture List) [@] [COPY] {Copy From} (Fixture) (Attribute Family) (Attribute Family) [ENTER] will copy from 
the second fixture enter to the first fixture list and filter to the listed attribute family. Ex: [1] [THRU] [5] [@] 
[COPY] {Copy From} [6] [COLOR] [Beam] [ENTER]. This will copy color and beam data from fixture 6 to fix-
tures 1 thru 5.

Undoing Level Changes
• [UNDO] [ENTER] will undo the last level change.

• [UNDO] (Attribute Family) [ENTER] will under the last change to the selected attribute family. Ex: [UNDO] 
[POSITION] [ENTER] will undo the last position change.

• [UNDO] [RELEASE] will undo the first stage of release. Duplicating this command will undo the second stage of 
release.

Holding Channels on the Fixture Control
When "Release Channels on Cue Go" is not checked, all adjusted fixtures will remain in their adjusted state and not
go to any activated cue state. When checked, all adjusted fixtures will go to the activated cue's state. This is in System
Properties > Show Defaults (Intermediate Options).

Restoring Playback Levels
• [RELEASE] will restore the adjusted selected fixtures to playback levels.

• Pressing [RELEASE] a second time will restore all adjusted fixtures back to playback levels.

Parking Channels
• With channels selected, [PARK] [ENTER] will park the selected channels at their current value.

• When a channel is parked, it will display a gray box with a white border and white text.

• With channels selected, [SHIFT] + [PARK] {Unpark} [ENTER] will unpark the selected channels at their current 
value.
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• (Channel List) [PARK] [ENTER] will park the listed channels at their current level.

• (Channel List) [@] (Level) [PARK] [ENTER] will set the listed channels at the desired level and park them.

• (Channel List) [SHIFT] + [PARK] {Unpark} [ENTER] will unpark the listed channels.

• [SHIFT] + [PARK] {Unpark} Enter will unpark the selected channels. Should no channels be selected, this com-
mand will unpark all parked channels.

Parking Channels by Dimmer
Allows the ability to park the channel's outputs rather than the channel itself.

(Channel List) [PARK] [DIMMER] [ENTER]

Note:  This triggers the "Dimmer Unpatched" flag to appear.

Press [DIMMER] [DIMMER] to restore.

Parking Channel's Attribute Families by Dimmer
Allows the ability to park the channels attribute families outputs by dimmer rather than the channel itself.

(Channel List) [PARK] (Attribute Family) [DIMMER] [ENTER]

Note:  This triggers the "Dimmer Unpatched" flag to appear.

Press [DIMMER] [DIMMER] to restore.

Channel Check
A Channel Check can be accomplished by pressing [Active Select Mode]. This will place the NEO in Active Select
Mode and the button's text will turn red. Once accomplished, press (Fixture) [ENTER]. The selected fixture will go to
the On level and then [Next] / [Last] will advance the fixture selection set to the next or last patched fixture.

Working with Dimmers
Controlling dimmers in Live allow the user the flexibility to access outputs with the dimmer number rather than the
channel number.

[DIMMER] (#) (Level) - allows the user to put a dimmer at a level. The fastest use of this is [DIMMER] [1] [FULL].
This will place dimmer 1 at full.

Dimmers Unpatch
When a dimmer is given a level, a flag appears at the bottom right hand screen. "Dimmers Unpatch". When a Dimmer
is supplied with a hard level, it is being instructed to ignore it's channel assignment in patch and output at the direct
level requested. Effectively, it has been unpatched. Dimmers will remain unpatched until they are released by using
[DIMMER] [DIMMER].

Dimmer Check
A dimmer check is a convenient way to check all dimmers prior to a performance to determine if everything is
functioning properly. [DIMMER] [1] [FULL] [NEXT / LAST]...

This will set dimmer 1 to full and "Next" will take out dimmer 1 and set dimmer 2 at full. This procedure can
continue until all dimmers have been checked.

Notice that the Command Line area will identify the dimmer that is currently active.

Dimmer Dimmer
When the hard dimmer level is no longer needed, just press [DIMMER] [DIMMER] to restore all adjusted dimmers
to the patching assignment. Selected dimmers can be restored rather than all adjusted dimmers. [DIMMER] (Dimmer
List) [DIMMER] will restore only the dimmer list that was entered.
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Select a Channel by the Dimmer
When the dimmer number is known but the channel number is what needs to be selected then use the "Select
Dimmer" command. [SHIFT] + [DIMMER] {Select Dimmer} (#) [ENTER]. If dimmer 15 is patched to channel 2
and [SHIFT] + [DIMMER] [15] [ENTER] is entered, on screen channel 2 will be selected.

Working with Cues in Blind
Blind allows changes to non live cues. This enables the user to change the data in the cue without the need for seeing
it live.

• [BLIND] - changes the Live Classic Channel display to Blind (signified by the grey background). Here, cue con-
tent can be adjusted as needed. This will go to the current live cue in Blind.

Note:  There is an option in System Properties > System Settings > Intermediate Options: Blind Follows Live. If this 
is on, then pressing Blind will always go to the Live cue in Blind. If this is turned off, pressing Blind will go to the 
previous cue that was displayed in Blind.

• [BLIND] [ARROW UP / DOWN] - will go to blind and select the previous or next cue in blind. This will be signi-
fied by the blue background on the selected cue.

• [CUE] (#) [BLIND] - goes to blind for the selected cue number. This is very useful when the blind cue that is 
requested is far away from the live cue.

• [BLIND] [CUE] (#) [ENTER]. If the cue number exists, it will select the channels that have an instruction in the 
entered cue. So if cue 1 has channel 1 thru 5 going to 50% and [CUE] [1] [ENTER] is entered, it will select chan-
nels 1 thru 5. 

Creating a New Cue in Blind
• [BLIND] [CUE] (#) [ENTER]. However, if the cue number entered does NOT exist, the NEO software will create 

this cue. (After accepting the warning.) This will create a copy of the previous numerical cue in the list.

For example, in blind with cue 15 and no cue 16, type [CUE] [16] [ENTER]. A dialogue box reading "Add a new
cue?" appears. Selecting Yes will add the cue and No will retreat the command. Now there is a cue 16 that is a copy of
cue 15.

Changing Levels in Blind Display
Changing levels in Blind will be identical to changing levels in Live.

When new instructions are given in Blind, the data is NOT stored at that time. The next action is likely the one that
actually stores the changes. Examples are...

1) Going back to Live

2) Previewing a different cue

3) Selecting one of the options on top of the main screen (Exit Blind will revert back, Exit Blind Track Fwd 
will track the data, Exit Blind Track Back will trackback the data, and Exit Blind Cue Only will store the 
changes in this cue only.

• (Channel List) [@] [ENTER] will remove an intensity instruction. 

• (Channel List) [@] (Level) [ENTER] will assign the channel list the instructed level.

• (Channel List) [@] [CUE] [ENTER] will recall the channel list from the designated cue.

• [UPDATE] [TRACKING OPTIONS] allows updating in the non-default mode. For example, if in Tracking Mode 
and an update cue only is desired, type [UPDATE] [TRACKING OPTIONS] and look at the Command Line to see 
what tracking option appeared. If it's "Cue Only", then press [ENTER], if not then just press [TRACKING 
OPTIONS] to go through all options. Press [ENTER] when the right option is present.

Working with Blind Display
Blind is not only for Cues. It also allows for editing of Group and Sub data in the Group display window.

• [GROUP] (#) [BLIND] will open up the Group display and highlight the identified group for editing.
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• [SUB] (#) [BLIND] will open up the Group display and highlight the identified group for editing.

• [SUB] (Sub Bump Button) will open the Group display and highlight the identified group for editing.

Fading an Intensity Value in Time
• (Fixture List) [@] (Level) [TIME] (Value) [ENTER] will send the listed fixtures to the assigned level in the desired 

time.

• [TIME] (Value) [ENTER] will set the Master Fade Time to the desired time value. Then assigning a level will 
apply in the Master Fade Time. Ex: [TIME] [5] [ENTER]. [1] [@] [80] [ENTER] will set 1 to 80% over 5 seconds.

Working with Tracksheet
[SHIFT] + [CUE LISTS] will open the tracksheet.

The tracksheet will display a spreadsheet of the cues and their content. Cues are columns and channels are rows.
Levels can be edited just by clicking on a cell and changing or adding a value. 

Fading an Attribute Value In Time
With fixtures selected, press and hold the encoder. When it is released, the encoder's assigned attribute will appear on
the Command Line and a value can be applied followed by the Time that is desired. Ex: With fixture 1 patched as an
automated luminaire and selected, (press + hold encoder 1, then release for Pan @) [90] [TIME] [5] [ENTER]. This
will rotate fixture 1's pan to 90° in 5 seconds.

Working with Multiple Cue Lists
Working with multiple cue list can seem complicated at first. The following recommendations can help make this
simpler and a more effective tool for productions.

When using only one cue lists at a time even though there are multiple cue lists recorded, there is no reason to change
how the desk is setup to work normally. However, running multiple cue lists at the same time, then there are
adjustments that can help the workflow.

Smart Block
A Block cue will block all patched channels / fixtures in a cue while a Smart Block will block only intensities in the
selected cue list. This allows attributes to track as well as other cue lists to function in an uninterrupted manner.

Default Record Mode
Working in the default of Record (Live) is very traditional for a single cue list theatrical environment. Again, if
running one cue list at a time, then this can continue to be the preferred record mode. However, if running multiple
cue lists at the same time, Recording (Live) will capture everything that is outputting from all active cue lists and
"steal" channels from those other cue lists. Likely not desirable. Change the default record mode to "Changed". This
will ensure that only changed values are stored in the recorded cue list. Another option would be to use the default
record mode of "Selected". At that point, make sure everything is selected that the user wants to store.

Working with Cue Playbacks
In the world of multiple cue lists, each cue list can be assigned to different playbacks. This is useful when the user
needs to output multiple cue lists simultaneously. 

On the console press [PB1 / 5] to open up the Select dialogue box for assigning a cue list or effect to each playback.
When assigned the PB# button will be backlit. If the Playback is assigned with a Cue List and selected, it will be
Amber. A Playback that is assigned with a cue list but not selected will be cyan. A Playback that is assigned with an
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effect will be magenta. This also appears on the graphical Cue Playback window. Just press [CUE PB] to open up this
display.

To manipulate Cue List PB assignment graphically, just click on the identifier button at the top of each unassigned
playback. This will open the cue list / effect dialogue box for assignment. If the Playback is already assigned, just
right click on the desired selection button and that will allow reassignment.

• Reset - releases the cue list and resets the cue pointer to cue 0.

• Stop / Back - will stop a currently running cue. If no cue is running, this action will go back one cue.

• Go - will trigger the next cue.

• Page Up / Page Down - will change the available Playbacks either up / down one page. So if the user is on page 0, 
this accesses PB 1 thru 5. Page 1 will access Page 2.

Note:  [SHIFT] + [PAGE UP / PAGE DOWN] will change Playback pages.

Working with Relays
As we move toward LED based lighting systems and away from incandescent fixtures, we move away from dimmers
and more into relay systems.

LEDs require relays as a dimmed circuit (even locked at full) is still not a true constant powered source and the
electronics for many devices over time will be damaged in the process. Therefore, if using a device like an LED,
automated luminaire or other, the units must be powered from a constant power source. Before beginning to light a
production, provide power to the relays in order to provide power to the fixtures. There are ways to make this a
simple procedure.

Patching Fixtures as Relays

NEO has a generic fixture in the fixture library called "Relay". Use the left text box in Patch to set the fixture type to
Relay. (Just type Relay in the left box and it will appear as an option). Once "Relay" is selected, then patch as normal
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in the right box. (Channel) [@] (Dimmer) [ENTER]. Repeat as necessary to get all relays patched. Example: [500]
[@] [491] [THRU] [512] [ENTER].

Once they are patched, the dimmers are automatically set to a Inverted Non-Dim profile. In Patch, go to Options >
Edit Dimmer Profile.

This means that their output is inverted. So when the system boots, they automatically go to Full and the Relays
provide power to the LED and movers. Nothing additional is needed to have the system online and operational. When
the console shutdowns, the relays lose their DMX signal and they go off. Power the console back up, and the relays
are on the system to go. 

Back in the Live screen, all relays display the label "Relay" on the Classic Grid. They are also available as a Selection
Shortcut. Press [SELECT] and there isaccess to all Relays by pressing the Selection Shortcut "Relay". To turn them
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off, select them and go to Full. (Remember, with the Inverted profile, 0 is Full and FL is out. It's the opposite of what
is normal).

Working With Relays - Option 2
There is another way to work with relays. The previous example is great if the user wants to have access to the relays
via a channel. However, many theaters just want the relays to turn on when the system is on. This method will
accomplish that and has the additional benefit of not giving the programmer access to relays via a channel. The
benefit is that there is no accidental way to turn the relays off.   

Just go into Patch and under Options select Edit Dimmer Profiles.

Scroll down to the dimmer address that correspond to the relays. They need to be set to Inverted Non-Dim. This
means that the default (Linear) will be replaced with the new profile. Inverted means that it will behave in the
opposite manner. So if it is set to 0, it will be outputting at full. Non-dim means that it will not be able to dim. If a
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value is more than 50%, then the console will send a DMX signal to be at full and sense it's always at full, (being at
0), then the relay will be one when the console is on.

Working with Scrollers
Scrollers is just a different fixture type in NEO. Each different scroll will be patched as a different fixture. Visit the
Fixture Library Editor to create the necessary fixtures prior to patching.

Once a scroller is built and patched, make sure that the dimmer for the incandescent unit has it's dimmer patched in
the Aux Dimmer column.
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Color selection on a scroller has a some unique features. Once selected, the Side Bar Fixture Control has several
different options for selecting color.

Auto Set Virtual Dimmer to Full Upon Setting Color
In the Show tab, there is an option called "Auto set virtual dimmer to full upon setting color". When checked, upon
selecting a color, if the intensity is not on, it will automatically go to full. This is assuming that if a color is selected,
then intensity output is desired. With this feature off, selecting color on a non-active fixture and it will not change the
intensity value.

All of the normal color mixing interfaces are available. HSI, RGB, CMY, Spectrum and more. The only difference is
that they will be limited to the output of the gel strings colors.

Selecting Gel Colors with Command Line
The 4 major brands of gel manufacturers are part of the NEO software. Each brand and color can be accessed using
Command Line on selected channels by typing [@] [COLOR] (#) [.] (#) [ENTER]. Where the first number (on the
left side of the point key) is the gel manufacturer based upon the following table and the second number (on the right
side of the point key) is the gel number.

Gel Manufacturer Table

1 - Apollo

2 - GAM

3 - Lee

4 - Rosco

They are listed in alphabetical order.

To set the selected color mixing fixture to Rosco 68, type [@] [COLOR] [4.68] [ENTER].

Note:  Go to More > Edit Color Filters to see the gel manufacturer's ID and all gel library information.
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Selecting Gel Frames with Command Line
If the preference is to go old school, frame numbers can be called up directly. NEO's Command Line allows for that
too.

To get to frame 3 on the selected channels, type [@] [COLOR] [.] [3] [ENTER]. Repeat for any other gel frame
numbers that are desired.

Working with Macros
Macros allow for command strings to be triggered with Shortcuts. A Shortcut can then be triggered by a Shortcut
button, a Cue or a Group.

While a Shortcut can activate a single line command, a Macro can trigger an unlimited number of lines.

The Macro editor can be opened by the [MACRO] display key or the "Macro Editor" on screen display key.

For example, for a Shortcut to trigger a Macro that has command to trigger multiple cue lists. The macro could be the
following...

CUE {optional cue list name} {NUMBER} GO

// {DESCRIPTION}

Sleep {number of seconds}

CUE {optional cue list name} {NUMBER} GO

// {DESCRIPTION}

This will trigger one cue list's cue, provide a description of the cue list that was just triggered, wait for the specified
amount of time and then trigger a different cue list's cue and provide a description of the second cue list's cue that was
triggered.

Additional Commands
Macros consist of the same commands that are available in the command window. In addition to these commands,
comments, labels and the commands listed below can be entered.

C++ Style Comments 

To add a line of text that will not be executed, place two slashes (//) before the text. As the system executes each line,
it will ignore lines that begin with these symbols.

Sleep 

The sleep command will cause the software to pause before continuing to execute commands after this line. In the
above example, Line 4 contains a 1 second sleep command.

Loop and Loop End

Loop a series of commands using the “Loop” and “Loop End” keywords.

Loop {number of times} – This command will mark the beginning of the loop and also define how many times
LightFactory will perform the loop block. In the example, Line 2 starts a loop with the number of iterations set by the
value in the variable “Maxcount”. Lines 3-5 will be executed maxcount times after which the macro will continue at
Line 7.

Loop End – This command will mark the end of the loop. All the commands between these two commands will
executed however many times was specified in the “Loop” command.

Branch, Label, and End

The “Branch” command can be used to create conditional jumps in the macro. If the condition is true, the macro will
jump to a predefined label. If the condition is false, the macro commands after the “Branch” will execute until the
“End” command.

Branch {condition} {label}

Condition takes the form: {variable} {operator} {value}. In addition to variables defined, the following special
variables can be used:
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• channel ({number}) – Returns the current output level (%) of the specified channel number.

• group ({number}) – Returns the current value (%) of the specified group number.

• submaster ({number}) – Returns the current level (%) of the specified submaster number.

• playback ({number}) – Returns the current cue number running in the specified playback.

The operators are: Equal (=), Greater than (>), Less than (<), Greater or equal (>=), & Less or equal (<=).

Labels are any text that starts with the hash (#) character.

Examples:

branch channel(3) > 30 label1

3@10

end

#label1

3@50.

The above macro will set channel 3 to 50% if its current value is greater than 30; otherwise it will be set to 10%.

branch my_variable <= 5 label1

Jump to label1 if the current value of my_variable is less than or equal to 5.

branch playback(0) > 10.5 label1

Jump to label1 if the current active cue number in playback 0 is greater than 10.5.

See  "Macros" on page 357 for more details.

Working with Scheduled Events
A scheduled event can be edited and controlled from the Command Line. The syntax format works like this...

Schedule {SCHEDULE NAME} {SHORTCUT} / PAUSE / RESUME / GET {SCHEDULE}. This command is used
to control the task scheduler. If for example I have a task called "End of day" then the following commands can be
used.

• SCH "End of Day" PAUSE - Stops the task from running

• SCH "End of Day" RESUME - Starts the task if its been paused

• SCH "End of Day" 12 - Sets the shortcut that the task will fire

• SCH "End of Day" GET - Will display a readable text of the schedules task. e.g. Daily at 3 pm.

• SCH "End of Day" 12 "Daily at 3pm" - Create or change a task called "End of day" to run shortcut 12, daily at 
3 pm.

Working with Tempo
Tap tempo currently only works with chase effects and simply replaces the step time.

The system will register a tempo after the button is pressed three times. Once a tempo is registered, a flashing red
indicator will appear in the FX playback window and the tempo button on the console will also flash at the tempo
entered. The more "taps" of the button the more accurate the tempo is going to be. Its essentially just averaging the
taps on the button. If the user waits more than 3 seconds, the averaging process will start again. Holding down the
tempo button (2 sec) will reset it and stop the tempo function.

Once a tempo is running it can be applied to any number of chase effects. In the FX playback window, when the
playback is selected and get the properties window appears there are two buttons along side the step time override.
The first button configures the chase to be audio triggered and the second button configures it to be tempo triggered.

Note:  Internally audio trigger is a step time of -1 and tempo trigger is a step time of -2.
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When an FX (chase) is put into a cue it can be manually set to be triggered by the tempo function by putting a T into
the "Step Time" field.

Working with LUA
LUA is a powerful command language that is being advanced into NEO. LUA has many advantages because of it's
direct access and ability to be added to web page design when web servers are desired. The current implementation
has LUA available as a Command Line Command LUA {file name}. e.g. LUA "c:\my script.lua" (the quotes are
necessary if there is a space in the file name). The command will trigger a file with the LUA command that the user
builds. 

Below is a list of available commands...

• "SetChannelLevel(channel number, level, fade time)"

• "SystemRestart([<maintain state>true|false]"

• "SystemShutdown())"

Build the file using Notepad (make sure it has the following extension ".lua") with the desired command. Notepad is
available directly on NEO from the Control Panel > Applications.

Use the Command Line to activate the LUA command. LUA (file name.lua) [ENTER].

Reserved Words 
The following is a list of reserved words used in commands. When used in commands, these words are case
insensitive. Named objects such as groups or palettes should not be defined using any of the following: 

@  @@  all  block  chilli  clear (clr)   

connect  cue  dim(mer)  disconnect  dmx  down   

fade  full  goto  group (grp)  home  ican 

if  last  load  macro  midi  next   

off  on  palette  park  rec(ord)  rel(ease)   

rem dim  save  scrollto  send  sendto  shortcut (sc)   

smart block  solo  stats  sub(master)  tempo  thru on   

time  timecode (tc)  unblock  undo  unpark  up   

update (upd)  view   
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SOFTWARE CONFIGURATION

This is the Live Display and will always show the status of the fixtures as they are outputting Live.

This section will break down this screen and all of its components.

1. Command Pulldowns

The Command Pulldowns are single action buttons that also have a down arrow on the right hand side that reveal
advanced actions within the same action family.

NEO NOTES & TIPS:  When discussing the advanced options, if the item / action shown with an icon, it has a NEO 
console key for that feature.

Commands/Pulldowns
Control Tabs

Master Playback

Master Playback

Cue List

Side Bar

Clock

Command
Line

Fixture
Grid

Display/Options
Split View

Master Fade Time

Playback 
Page

Shortcut Page/Display

Submaster Display

Record Type default 
- Tracking default - 
Marking default
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Command Pulldown - Selection

Select Active - captures all fixtures with an intensity level above 0.

Clear Selected - uncaptures all captured fixtures.

Select Last - selects the previous numerical fixture.

Select Next - selects the next numerical fixture.

NEO NOTES & TIPS:  For advanced functionality, if a group of fixtures is selected, NEXT / LAST will allow the 
user to cycle through that group of fixtures only. For example, if 11 thru 15 are selected. Pressing NEXT will select 
11. Pressing NEXT again will select 12. Continuing to press NEXT will cycle thru all fixtures in the group and then 
cycle around and start over again. This same functionality works for LAST.

Select - opens advanced selection dialogue box. Allows quick selection of show built groups. From the Select
Pulldown menu, available commands are...

• Edit - opens the Group display window for group editing.

• Add - allows the creation of a Group.

• Detach - will detach from the pulldown and allow the user to use this as a floating window or drag the window into 
the Advanced Docking System.

Use the option "Filter by selected matrices" to sub-select channels by the currently selected matrices in the Magic
Sheet view.

Use the option "Filter by current selection" to sub-select only from what is currently selected. If nothing is currently
selected then the selection range will cover all channels.

Use the option "Filter by fixtures in the active cue" to limit the selection to only channels used in the currently
running cue. If a channel is not in the current cue it will remain unselected when using selection shortcuts.

The Select from cue button allows the use of a pulldown to select fixtures from a cue.

A great way to take advantage of these is to populate the Patch columns of Position, Purpose and Color with useful
information for the lighting rig. FOH, 1K, Front Light, Bxs, R68, L201 and such. NEO will automatically create
Selection Shortcuts with this information and allow quick access to pre-built groups. 
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Select Pulldown

Within the Selection Pulldown, there is a Tools & Macros tab. Once the Select pulldown is open, the 10 key can be
used to call up the appropriate tool. There are 3 sections:

Selection Tools
[1] Odd - filter to the odd fixtures from the selected fixtures.

[2] Even - filter to the even fixtures from the selected fixtures. 

[-] Interleave - filter to a mathematical subset of the selected fixtures Ex: select every 5th fixture by blocks of 2.

Pan and Tilt Tools
[3] Mirror Pan - will send Pan to its current degree location on the opposite side of 0°.

[4] Mirror Tilt - will send Tilt to its current degree location in the opposite hemisphere.

[-] Mirror Pan and Tilt - will accomplish both previous commands together.

[5] Flip Pan 360° - will add / subtract 360° from its current Pan position assuming the fixture has the range.

[-] Flip Pan 180° - will add / subtract 180° from its current Pan position assuming the fixture has the range.

[6] Flip Pan 180° and Mirror Tilt - will accomplish both Flip Pan 180° and Mirror Tilt together.

Fixture Macros
[7] Lamp On - will send the fixture lamp on command, wait several seconds and then complete.

[8] Lamp Off - will send the fixture lamp off command, wait several seconds and then complete.

[9] Lamp Reset - will send the fixture lamp reset command, wait several seconds and then complete.
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Select Active Options
Select all fixtures - selects all patched fixtures.

Select inactive (off) fixtures - selects all non-active fixtures. (with a level of 0).

Select changed fixtures - selects all fixtures that have had a value changed (in red).

Invert current selection - will deselect all selected fixtures and select all deselected
fixtures.

Select Previous - select the previously selected set of fixtures.

Show only selected fixtures (View) - changes the current view to only display
selected fixtures. [UNDO] [ENTER] restores to the previous view.

View fixtures used in this show - displays only fixtures that are used in cues, subs
and FXs.

Select odd fixtures of currently selected - takes current selection set and filters to
only the odd fixtures.

Select even fixtures of currently selected - takes current selection set and filters to
only the even fixtures.

Interleave selection - from existing selection set, allows user to select every
"number" and choose the size of the cluster Interleave selection is also available from
the Command Line. See  "Working with Command Line Operation" on page 52.

Mirror Options - allow for different mirroring options for moving lights. Mirror Pan,
Mirror Tilt, Flip Pan 360°, Flip Pan 180°, or Flip Pan 180°, Mirror Tilt

Inclusive Selection Mode - when mode is selected (button text is red) all selected
fixtures will add to currently selected fixtures. The Inclusive Mode button is a toggle. When off, all selected fixtures
will replace any currently selected fixtures. Button text shown in yellow when running in "Inclusive Selection Mode"

Active Select Mode - when mode is selected (button is red) sets selected fixture value to Full and allows [NEXT] /
[LAST] buttons to advance while maintaining selected fixture at full level. This is the best way to do a rig check or
find a lamp. When off (button text is white, selected fixture's intensity goes back to normal. "Select Active" button
appears red if the "Clear selection after setting channels" option is on. This feature is ONLY available when in
Inclusive Selection Mode. This feature will deselect channels after a level is set.

"Clear selection after setting channels" option is disabled rather than hidden when not in "Inclusive mode". Therefore
if this feature is on and unavailable, just turn on Inclusive Mode, deselect and turn off Inclusive Mode.

Command Pulldown - Level

On - applies the ON value to the selected fixtures.

Out - applies the Out value to the selected fixtures. It turns those fixtures off.

Home - applies the Home values (default values) to the selected fixtures.

Fan - opens the Fan dialogue box to apply a "fan" any attribute on the selected fixtures.

Fan
The "fan" function is a powerful way to create organized looks on stage without having to modify a number of
fixtures one at a time. There are a number of different looks that can be created depending on the attributes desired to
be controlled. 
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In Figure 5, we see all of the fixtures fanned out across the stage and Figure 6 on page 92 shows the same fixtures are
crossed over each other in a two by two formation.

Figure 5:  Fan

Figure 6:  Fan (Crossed)
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To use the "Fan" select the fixtures to modify and click on the button at the top of the screen.

Figure 7:  Fan Options

Pan & Tilt
Use the pan and tilt offset to position the moving lights into the center of the stage. Adjust the Spread option until the
desired look is achieved. Use the check box at the bottom of this selection to switch between a fanned or crossed look
on stage.

Fan the fixtures in both pan and tilt by adjusting the appropriate spread. The spread function also allows a negative
spread to be sset that will change the look of the fan operation.

Use the "Relative" check box to fan pan and tilt relative to the current location of the fixtures.

Color
The color selection can be used to spread out the color of several fixtures across the spectrum. By default fully
saturated colors are used for this fan operation. To use different saturation and intensity levels adjust the controls at
the bottom of this section.

Use the spread control to "fan" out the color of each fixture selected. Each fixture is represented as a triangle that
points at the color being set. As the spread controls move, the triangles move out from the center. The center point can
be moved using the control just below the spread.

The "Invert Colors" option will invert the color range used.

The "Mirror Colors" option will start the color range in the center and move out either side.

Other Attributes
NEO will also allow a fan to be applied to any of the generic attributes the system knows about. Select the attribute
from the drop down combo box and then use the spread control to fan the values.

The mode selection will adjust in what order the fan is applied to the attribute. 
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Left to Right will leave the fist fixture unchanged and fan all of the other fixtures out from the first value.

Right to Left will leave the last fixture unchanged and fan all of the other fixtures in from the last value.

Middle out will cause the middle fixture to remain unchanged and fixture either side of it to fan appropriately.

Crossed is a mixture of middle out and outside in. Each alternative fixture will be either middle out or outside in.

Outside in will cause both the first and last fixtures to remain unchanged while the fixtures in between are
proportionally adjusted towards a center value.

Hi Light - applies the Hi Light values to the selected fixtures. The purpose of Hi Light is to clear out the beam of a
fixture so that it can be identified on a visually contaminated stage.

The value that each fixture is set to when hi-light is active can be defined in the fixture library. For most attributes this
is the same as the home value. 

In addition, specific Hi Light state for individual fixtures can be stored. Just get the fixture(s) in the desired state and
the store them into the special Hi Light group. [RECORD] [HI LIGHT] [ENTER]

Highlight is a toggle option in NEO so that once the fixtures have been identified pressing the button again will return
to the previous stage look.

ON Options
Rem Dim (Solo) - this turns off all non-selected fixtures.

"Hi Light" Selection Mode - when mode is selected (button text is red) sets selected fixture to
its "hi light" mode. The specifics of the hi light mode is determined by the settings in the fixture
within the fixture library editor.

Full - takes selected fixture to 100%.

Lamp On - runs the lamp strike function to the selected fixture.

Lamp Off - runs the lamp douse function to the selected fixture.

Fixture Reset - runs the lamp reset function to the selected fixture.

The Lamp On / Off / Reset is an automated version of selecting the fixtures, taking the control
channel to Lamp On / Lamp Off / Fixture Reset, holding for 3 to 5 seconds and then placing the control channel back
to idle.

NEO NOTES & TIPS:  In System Properties > System Settings > Advanced System Settings, the Control Wait Time 
and the Lamp On fixture interval can be set to desired preferences.
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Home Options
HOME sends the selected fixture to it's default position. When used on selected fixtures, it will send the entire fixture
to it's default position. However, each attribute family can be homed individually using the syntax listed below.

(Fixture List) + [HOME] will allow home to work only on the leading fixture list.

Select the fixtures, then press [HOME] + the appropriate Attribute Family key.

.

Intensity - sets selected fixtures to the default intensity value.

Position - sets selected fixtures to the default position value.

Color - sets selected fixtures to the default color value.

Beam - sets selected fixtures to the default beam value.

Edge - sets selected fixtures to the default edge value.

Utility - sets selected fixtures to the default utility value.

NEO NOTES & TIPS:  All fixture default values are set in the Fixture Library Editor per fixture type.

+

+

+

+

+

Command Pulldowns 95



User’s Manual
Command Pulldown - Release
Park - assign the current fixture value to a locked level. This
"park"ed level will keep the fixture at its current level, will not
change it as cues are activated and it will not be recorded at this
value.

Park Options

Un-park selected fixtures - will unpark all selected fixtures.

Un-park all fixtures - will unpark all fixtures.

Park allows the user to assign a level to a fixture that will not be
controlled by a cue. It places that fixture in stasis until it is
unparked. By default, all Parked fixtures shall not be recorded.

Park selected fixtures DMX outputs (dimmers unpatched) -
allows the park feature to park the "dimmers" using the channel / fixture numbers. This is the same as typing
[DIMMER] (#) [@] (LEVEL) [ENTER] but they are addressed by the channel / fixture number.

Release selected fixtures from DMX capture - This releases the captures dimmers using the selected fixtures as the
identifier. This is similar to using [DIMMER] [DIMMER] to restore but it only applies to the selected fixtures.

Don't record parked fixtures - is a toggle option that determines if parked fixtures are stored when recording. The
default is that parked fixtures are NOT recorded.

NEO NOTES & TIPS:  This default is in System Properties > Show Defaults > Intermediate Options.

Command Line Options
[PARK] [ENTER] - will park all selected fixtures.

(Fixture List) [PARK] [ENTER] - Parks at current level.

(Fixture List) [@] (LEVEL) [PARK] [ENTER]

(Fixture List) [PARK] [DIMMER] [ENTER] - parks dimmer at current level.

(Fixture List) [PARK] [DIMMER] [@] (LEVEL) [ENTER]

(Fixture List) [PARK] [DIMMER] (ATTRIBUTE FAMILY) [ENTER] will park the selected attribute families only.

[DIMMER] [DIMMER] restores all parked dimmers.

Add [SHIFT] to any [PARK] command above and that will Unpark based on the command entered.

+
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Undo Options
Undo - will return a fixture level to its previous value. This can work for
intensity and attribute families.

Undo > Channel Selection - opens up a pullout that shows channel selection
history. The user can undo the channel selection set in order. If the undo item
selected is not at the top of the list, it will undo every item up to and including
that item.

Undo > State Change - opens up a pullout that shows channel state change
history. The user can undo the channel state change in order. If the undo item
selected is not at the top of the list, it will undo every item up to and including
that item.

Undo per attribute family is available as well. For example: [UNDO] +
[POSITION] will under the last position change.

Undo > Cue Record - opens up a pullout that shows cue record history. The user
can undo the cues recorded in order. If the undo item selected is not at the top of
the list, it will undo every item up to and including that item.

Undo > Cue Update - opens up a pullout that shows cue update history. The user can undo the cues update in order.
If the undo item selected is not at the top of the list, it will undo every item up to and including that item.

Undo > Group Record / Update - opens up a pullout that shows group record / update history. The user can undo the
group record / update in order. If the undo item selected is not at the top of the list, it will undo every item up to and
including that item.

Undo > Generic Palette Update - opens up a pullout that shows generic palette update history. The user can undo
the generic palette update in order. If the undo item selected is not at the top of the list, it will undo every item up to
and including that item.

Release Option
Release - 1st press of RELEASE will restore all selected fixtures to their default state or another control items like a
cue. The 2nd press of RELEASE will restore all remaining fixtures to their default state or their state as determined
by another control item like a cue.

Release + Attribute Families

NEO NOTES & TIPS:  Pressing [RELEASE] and any attribute family button will release that attribute families 
attributes on the selected fixtures.

+ or or or
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Release current control - releases the last control item that was advanced.

Release current control for selected fixtures - releases the last control item that was
advanced but only on selected fixtures.

Release all control - releases all channel, cue, group, effect and sub control. CL:
[SHIFT] [+] [RELEASE].

Release all control for selected fixtures - releases all channel, cue, group, effect and sub
control on selected fixtures.

Release by family - releases all channel control by attribute family. CL: [RELEASE] [+]
(ATTRIBUTE FAMILY). 

Main release button to release intensity only - a global sticky setting that changes how
the Release key works. Whether it releases everything or only intensity.

Release all general control - releases all channel control. CL: [RELEASE] [RELEASE].

Release submaster control - releases all active submasters.

Release all cue list control - knock out any value coming from a cue list.

Release all effect control - knock out any values coming from an effect.

Release all Palette control - knock out any values coming from generic palettes.

Reset cue playback on release - sticky option that allows releasing of a cue list to release all cue lists.

[RELEASE] + [SUB] - will release all active subs.

[RELEASE] + [FX] - will release all active effects.

[RELEASE] + [GROUP] - will release all active groups.

[RELEASE] + [GENERIC PALETTE] - will release all active generic palettes.
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Report (View director stack) - displays a control view debug display.

Command Pulldown - Record

Record Group - activates the Record / Update Group dialogue box in order to facilitate storing / editing a group.

RECORD GROUP OPTIONS

Add selected channels to group (Dimmer only) - brings up the Record / Update Group dialogue box to add selected
fixtures' intensity to the designated group.

Add selected channels to group (Snapshot current state) - bring up the Record / Update Group dialogue box to add
selected fixtures to the designated group. 

Record Cue - activates the Record Cue dialogue box in order to facilitate storing a cue.

or
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Remove selected channels from group - brings up a group list dialogue box to removed the selected channels from
the designated group.

RECORD CUE OPTIONS

Record active channels to cue - sets the Record Mode filter to Active and brings up the Record Cue dialogue box.

Record selected channels to cue - sets the Record Mode filter to Selected and brings up the Record Cue dialogue
box.

Record live channels to cue - sets the Record Mode filter to Live and brings up the Record Cue dialogue box.

Record selected channels to multiple cues - brings up a dialogue box to allow the user to check off cues where
selected fixtures will be stored.

Attribute family filtering is available.

Remove selected fixtures from multiple cues - initiates a dialogue box solution to removing selected channels from
multiple cues.
100 Software Configuration



NEO Lighting Control Console
Remove selected channels from multiple cues - initiates a dialogue box to allow the user to identify cues where
fixture instructions will be removed.

Update Cue - activates the Update Cue dialogue box in order to facilitate editing an existing cue.

Record FX - activates the Record FX dialogue box in order to facilitate creating a show effect.

RECORD FX OPTIONS

Add active channels to simple chase step - adds "active" fixtures to a newly created or existing chase effect
assigning each fixture to its own step in numerical order. This will activate a recording dialogue box to complete the
fx recording process.

Enter appropriate info in the presented dialogue box.

NEO NOTES & TIPS:  The effect will be recorded / edited but must be triggered manually though the FX List 
display.
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Add selected channels to simple chase step - adds "selected" fixtures to a newly created or existing chase effect
assigning each fixture to its own step in numerical order. This will activate a recording dialogue box to complete the
fx recording process.

Enter appropriate info in the presented dialogue box.

NEO NOTES & TIPS:  The effect will be recorded / edited but must be triggered manually though the FX List 
display.

Create a simple chase from selected fixtures - creates a traditional chase effect based on the selected fixtures in the
order in which they were selected. Each fixture will be assigned to its own step on a 1 to 1 basis.

Enter appropriate info in the presented dialogue box.

NEO NOTES & TIPS:  The effect will be recorded / edited but must be triggered manually though the FX List 
display.

Create a simple RGB / CMY Cycle from selected fixtures - creates a simple step based color chase. All selected
fixtures color mixing parameters will be stored into 6 steps. Cyan, Blue, Magenta, Red, Yellow, and Green.

Enter appropriate info into the presented dialogue box.
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Create a simple color wheel chase from selected fixtures - creates a simple step based color chase using the color
wheel. All selected fixtures color wheel will be stored into steps. 1 for each wheel position.

Enter appropriate info in the presented dialogue box.

Create a palette chase from selected fixtures - creates as simple step based chase with the selected fixtures where
the contents of each step is selected from a list of palettes.

Use the left and right arrows to move palettes in and out of the available palette list.

Create a standalone FX from running library fx - this takes a running library effect and creates a show specific
effect based upon that running library effect. This is a great practice in order to keep the library as a stock resource
point by not recording over it.

Enter appropriate info in the presented dialogue box.

+
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Record Palette Options - Pulldown

Record Palette - activates the Record Palette pulldown. This allows the user to select Generic Palettes or a Specific
Palette family to record.

To add selected channels to a palette:

Step 1. Set up the fixtures into the static state (dimmer, 
intensity, color, pan and tilt etc)

Step 2. Click on the "Record Palette" at the top of the 
window, this will open the Record Palette 
pulldown.

a. The option exists for recording a Generic 
Palette (best used for colors in order to apply 
to any color changing fixture that is patched 
regardless of the fixture on which this was 
stored), or recording a specific palette (or 
palettes that only apply to the specific 
fixtures on which this was stored).

b. For this option, select "Generic Palette" and the dialogue box will appear.

Step 3. Enter the palette number, name, and shortcut number to assign to the current state. Select the attributes to 
include in the palette using the check boxes provided. "Make this palette specific to selected channels" will 
essentially turn this into a standard palette.

NEO NOTES & TIPS:  This operation only creates new entries and cannot be used to add to an existing palette.

Step 4. Enter the shortcut number to assign and click the "OK" button to confirm the requested action. Clicking 
"Cancel" returns to the channel window.

Command Pulldown - Items
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FX Library - opens the FX library to allow the user to apply a pre-built effect to the selected fixtures.

Once the library effect is running, the controls for the running effect is
available on the encoders or is available in the Side Bar > Library FX
Controls.

To edit and store this for the show file, create a show FX from the
library FX so that it doesn't change the FX library.

Step 1. Select desired fixtures.

Step 2. Select FX from library.

Step 3. Press [CREATE FX] and follow the dialogue to create the show FX. 

Step 4. Name the fx and press ENTER. Now the effect is running as a standalone. Modify and store with any cue.

Edit - opens the Effects Editor.

Create - opens up the "Create effect based on…" dialogue box.

Make sure the library effect is running prior to pressing the Create
button.

Bump - bumps the FX out as a latched button. Pressing Bump again
restarts the FX.

Detach - detaches from the pulldown and allows the user to use this as
a floating window or drag the FX Library into the Advanced Docking
System.

See  "Make Database File Smaller" on page 299 for more info.

Controls - brings the FX controls into focus.

Stop All - stops all running library FX.

Channel Groups - opens the list of show built groups and palettes. Each
group / palette type will be available in it's own tab within the Channel
Groups window.

Edit - opens the Groups display for easy editing.

Release - releases selected channels from Build / HTP / LTP behavior.
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Page Up / Down - pages up / down to the next / last page of 100 buttons for each group / palette page.

Palettes - opens the list of show built Generic Palettes.

These can be selected from this quick select palette window.

Edit - pressing Edit will open up the Palette display window for palette editing.

Command Pulldown - View

Note:  If the system is in Basic Mode, many of the Advanced display options will not be present.

View - change to different viewing style for the main single monitor window. [SHIFT] + [VIEW] will also open the
View pulldown menu.

The View pulldown has the following options...

Blind View - puts the main view into Blind mode to view/edit data without outputting Live. [BLIND] will toggle into
the Blind display. [LIVE] will restore to the level screen.

Display Fixture/Complex Timing - will replace the level display with time information. [SHIFT] + [LIVE] will
toggle to the Time Display. [LIVE] will restore to the level screen.

Expanded (Verbose) - places the channel display into the Expanded format.

Compact - places the channel display into the Compact format.

Classic (default) - places the channel display into the Classic format. This is the most traditional theatrical format.

Magic Sheet - replaces the channel display with the Magic Sheet. By default, there is nothing created for the Magic
Sheet. This must be created by the user.
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Faders - places the channel display into the Fader format. 

Intelligent Lights (ML) - places the channel display into the ML format that
shows all attributes.

Edit Patch Mode - places the channel display into Edit Patch Mode.

Dockable Frame - (this is only available if the system has the “Advanced
Docking System” turned on. (System Properties > Appearances > Other
Appearance Settings: Enable Advanced Docking System). This replaces the
channel grid with a dockable frame allowing the user to dock multiple windows
within this space creating a custom screen layout.

Open New View of Channels - presents all formatting options for opening a
separate view of channels.

Open a New View of Selected Channels - presents all formatting options for
opening a separate view of just the selected channels.

Open Split View of Channels - presents all formatting options for adding a view
of channels to the bottom of the main screen.

Open Blind View of Channels - presents all formatting options for opening a
separate blind view of channels.

Open Side Bar - when checked, the Side Bar will be open to show the Cue List,
Fixture Control, FX Library Control, Cue FX and more.

Channel Formatting - presents all channel formatting options.

Display Options - presents all display options for the main screen.

Blind - the non-Live display that allows the user to view and edit data without the
data outputting on stage.

Blind allows the user to edit the data without it outputting Live.

Editing can occur as it normally would in Live using either Command Line operation or the Graphical User Interface.
The Select button options are available however features like Hi-Light, Park and Undo are not. In Blind there are
special buttons that are available for updating. 

If in Tracking Mode, selecting the button "Exit Blind (Abandon)" returns to Live and disregards any changes made.

"Exit Blind Track Fwd" - returns to Live and changes stored and tracked normally. 
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"Exit Blind Track Back" - returns to Live and changes stored and tracked back.

"Exit Blind Cue Only" - returns to Live and changes stored for this "Cue Only".

In Hybrid Mode, selecting the "Exit Blind (Abandon)" returns to Live and disregards any changes made. "Exit Blind
(Update)" returns to Live and updates so that the changes are stored.

The channel view window has six modes of displaying fixtures and channels. Change the view click on the "View"
button and selecting the desired view from the drop down menu. 

The different view modes are Expanded, Compact, Classic, Magic Sheet, Faders and ML View. There is no issue
using any views to control the lighting rig as the user may want to use conventional lights in the grid display and
intelligent fixtures in the intelligent view. NEO will switch between the views without effecting the operation of the
lights.

In the Expanded, Compact, and Classic view all of the channels and fixtures are displayed sequentially in an n x n
matrix of rows and columns. The software will automatically display the maximum number of channels it can across
the columns and provide a scroll bar to view channels that are off the bottom of the window.

It is possible to set a fixed number of columns in the View menu by selecting "Set fixed column count". If a fixed
column count is set then the column widths will automatically resize to fit across the page. Setting this to 0 will return
it to a dynamic column count.

Display Fixture / Complex Timing - displays all timing information for the selected cue. By default all channels will
have the cue time. This will appear in grey. In order to use fixture timing, type (Channel List) [TIME] (#) [ENTER].
Then update the cue. [UPDATE] [ENTER] When in the time display, the fixture timing instructions will appear in
white to indicate an instruction.

Expanded (Verbose) - The Expanded view will show all of the patched channels in an excel style grid of rows and
columns. This mode will show the maximum about of information about the fixtures and their state. Each attribute
will be listed below the fixture name and dimmer level to show its current value.
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Compact View - Use the compact view to maximize the number of channels visible on screen at once. This view will
show the least amount of information per fixture and is limited to the basic channel number and dimmer level. It will
also show graphically a moving light position and color.

Classic - the most traditional theatrical view. This identifies conventional channels with a grey box around the fixture
number. An automated luminaire will have a blue box around the fixture number. The second line displays the
intensity using a traditional theatrical color scheme.
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Intensity Levels

• Red - adjusted.

• Light Blue - levels going up.

• Green - levels going down.

• Magenta - levels staying the same. (tracked).

• White - hard instruction.

The red box around 111 indicates that fixture is currently selected. (The level of selected units can be adjusted
without reentering the fixture number(s).

Attribute Levels

• Red - adjusted.

• Blue - changed value.

• Magenta - levels staying the same (tracked).

• White - hard instruction.

• Grey - no data (default).

The (bracketed) info shows the previous level of the fixture.

Magic Sheet - The Magic Sheet view is a free form that by default has nothing on it. Before using the Magic Sheet
view, place fixtures in the desired location. Once fixtures are placed on the form they can be controlled by selecting
them in the same way as the Classic View.

When placed on the layout window each fixture is represented by a symbol of the fixture, block, or matrix, its channel
number, name and the current dimmer level. If the fixture is an intelligent fixture the position and color is also shown.
The symbol showed is defined by the "Fixture Type" in the dimmer patching window. If no type is specified the
fixture is assumed to a conventional profile.
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NEO NOTES & TIPS:  The Magic Sheet view also supports a number of multi touch gestures to help when working 
with large sets of fixtures. Use the two finger pinch to zoom and two fingers on the screen to pan around the layout. If 
fixtures are currently selected then sliding two fingers up or down the screen will increase or decrease the dimmer 
level.

Magic Sheet Tools 

The Magic Sheet provides the user with multiple tools to edit and manipulate the Magic Sheet. 

Magic Sheet: Sheets
There is a default Sheet for laying out fixtures. It is called Sheet 1. The "+" next to it creates new sheets. When
creating a new magic sheet, the user can provide a description and a Shortcut that will open up the desired Magic
Sheet number.

Magic Sheet: Up / Down
The Up / Down buttons will pan the image up / down one screen area.

Magic Sheet: Zoom
At the top of the Magic Sheet, there is a Zoom box. This allows the user
to zoom in or out.

Magic Sheet: Fit Layout To Screen
This will zoom the viewable area to the extents of the existing layout.

Magic Sheet: Navigation Button 
This button when moved will pan around the image similar to a joystick's
functionality.

When held down, a navigation popup will appear to allow inserting a
specific X,Y coordinates or to "Zero" out and pan the magic sheet back to a X:0, Y:0 location..
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Magic Sheet: Edit

Will open up the Magic Sheet editor.

Magic Sheet Editor
The Magic Sheet editor allows editing / creating of the magic sheet.

Tab Name
Allows the sheet to be named.

Shortcut
Allows the designated Shortcut to open and display the designated Magic Sheet.

Show Grid
Will display a dot grid for alignment purposes. All item placement now is based on a
snap grid. This makes it easier to line up items together.

Fixture List
The Fixture List will display all patched channels and their fixture type. Select the
channel (or multiple channels using shift and click to drag, click and drag or Ctrl and
click to add) to place on your layout.

Add
The Add button will add the selected fixtures using the symbol type set below.

Fixture Symbols
Will place a default fixture symbol based on the Fixture Type in Patch, on the Magic
Sheet layout.

Fixture Block
Will place a block symbol on the Magic Sheet layout.

Matrix
Will place a Matrix on the Magic Sheet layout.
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Misc
Allows placement of utility items on the Magic Sheet layout.

Add Picture - selects an image to be placed on the Magic Sheet layout.

Add Text - places a text box with editable font, size and color adjustments.

Add Group Box - Will allow a border box to be placed and sized around a group of fixtures
on the Magic Sheet layout. The color of the box can be adjusted.

Add Shortcut Button - Will allow adding a Shortcut button on the Magic Sheet layout.

Add SVG Graphic - Will allow selecting an SVG graphic file to be place on the Magic Sheet
layout.

Moving fixtures around in the layout - By default the Magic Sheet view is in control mode
meaning it is expecting the user wants to control and modify the fixtures output. When
clicking on a fixture it will highlight it exactly as it does in the grid display. To move fixtures
around and change the position turn on "Edit Mode". When this option is turned fixtures
cannot be selected for control as the mouse is used to move the fixture where desired. 

Click and while holding the mouse button down move the fixture to the desired location.
Release the mouse button once the fixture is placed where desired.

Magic Sheet: Customizing the Fixture's Special Tags - One of the special tags on the front
of a color mixing fixture's symbol is the color bar. The width of the color bar can be modified
per fixture type.

Use NEO's Control Panel to open the File Manager. Search for the "fixture_symbols.xml" file and open it in Notepad.
Search for "color_bar_width" for the appropriate fixture type and edit accordingly.

Note:  This file only loads on startup so a NEO software shutdown / restart is required.
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Fader View - The fader view is a simple view designed for small installations where only a few fixtures are being
controlled. Each fixture is shown as a fader.

To change the intensity levels for any channel simply drag the bar up and down the control. If the fixture supports pan
and tilt control, click anywhere in the fixture image to set its position. Select the color from the palette shown below
the image. 

Click on the "Open Control Window" to open the standard fixture control window for all other attributes.

At the bottom of this view is a page up and page down control to set the page of faders that are shown. In the view
menu is an option to set the number of faders shown on each page.

Intelligent View (ML) - The Intelligent
view (sometimes called the ML View) is
specifically designed to work with
intelligent fixtures (moving lights) and
groups fixtures by their type. Each
fixture is listed vertically with the
attributes shown horizontally. Each
fixture type is separated by a header that
displays the fixture name. Double click
on the header to collapse the grid below
it. This helps manage what is being
viewed by hiding fixtures that are not
desired.

Any of the attributes shown in this view
can be directly edited by double clicking
on the cell. An appropriate popup control will appear.

If a palette is in control of the attribute its will be shown in red under the attribute value.

To set the default row height for this view use the view menu option "Set default row height".
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Edit Patch Mode - In addition to the six view modes the user can also switch the channel view into patch mode.
Patch mode can be used to edit the fixture patching directly in the channel display window. If no channels are patched
in the system then the patch mode will display automatically.

In the patch mode channels that are patched are shown with a green border and the unpatched channels have a red
border.

To change the patch click with the left mouse button on any channel either patched or unpatched. Use the resulting
dialog to set the fixture to patch into the system.

At the bottom of the patch dialog is a spin edit option titled "Quantity for sequential patch". Use this to patch multiple
fixtures of the same type at once. 

When patching is complete, click on the bar separating the grid from the buttons to return to the previous view.

Dockable Frame - When activated, the main view of channels is replaced with a dockable frame known as the
Advanced Docking System. This can be used to dock floating windows for channel groups (via shortcuts), specific or
generic palettes and more. This is often preferred for live event environments where displaying channel data is
unnecessary.
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Open a new view of channels - opens a separate window of a
fixture display. Choose from the following list of options…

• Expanded (Verbose)

• Compact

• Classic

• Faders

• Intelligent Lights (ML)

• Magic Sheet

Open a new view of selected channels - opens a separate
window of a fixture display filtering to only display selected
fixtures. Choose from the following list of options…

• Expanded (Verbose)

• Compact

• Classic

• Faders

• Intelligent Lights (ML)

Open a split view of channels - opens a fixture window at the
bottom of the main monitors view. Choose from the following
list of options…

• Expanded (Verbose)

• Compact

• Classic

• Intelligent Lights (ML)

This will display on the selected attribute family.

Open a blind view of channels - opens a separate window of
a fixture display in the Blind view. Choose from the following
list of options…

• Expanded

• Compact

• Classic

• Intelligent Lights

Open Side Bar - the side bar is the right side section of the main monitor's screen. This displays…

• Cue List Summary

• Fixture Control

• FX Library Controls

A check mark on the left of the option indicates whether the side bar is open or closed (no check mark).
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The View > Channel Formatting pullout has the
following…

• “View fixtures used in this show”

• “View fixtures in the current cue”

• “View only changed fixtures”

• “Show only selected fixtures”

The View > Display Options pullout has
the following…

• Enter the column count – for channel 
count per row in Classic View.

• Show 3rd line of text – additional line 
of text from Patch > Position info.

• Filter ML View by selected family – 
will only show the selected attribute 
family in the ML View.

Note:  This only applies if the 
“Intelligent (ML) view grouped by 
fixture type” is NOT checked. This 
feature is available in System Properties 
> Appearance.

• Show Clock – displays clock, calen-
dar and show file name.

• Show Timecode – displays Timecode clock.

• Show Stopwatch – displays Stopwatch and it’s Start/Stop, Reset buttons.

• Show cue notes – displays any cue notes that have been added in the Cue List Display.

Show Palette Information - when on, will show Palette labels in the fixture windows.

The fixture block shows pan and tilt info referencing a position palette labeled "DCS" from the Classic view.

This shows the position palette label in the ML view where both raw data and the referenced groups label can be seen.
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Enter Column Count - allows the user to set the fixture column count width on the fixture view.

Show 3rd line of text - adds a 3rd line of text to the fixture block on the Classic view.

The fixture block shows info from the Position column in the Patch screen.

Info from the Position or Purpose column will appear here.
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Show Clock - will turn on / off the clock / showfile name / date display.

Show Timecode - will turn on / off the timecode clock.

Show Stopwatch - The Stopwatch functionality allows NEO to time an event on stage
and then use that information to help with cue timing.

The Start / Stop button will start and stop the stop watch running. The Reset button will
reset the stopwatch back to 00:00:00. 

Stop watch display shows milliseconds as a decimal, i.e. 00:00:00.00.

Use the stopwatch function to time an actor crossing the stage in order to find out how
long a cue should be. Use Start/Stop to time the actor's cross, now use that timing info to edit the cue's time.

Use Stopwatch Time for Cue Time

• [CUE] (#) [SHIFT] + [TIME] {STOPWATCH TIME} [ENTER]. The identified cue has the Stopwatch time for the 
Cue time.

Use Stopwatch Time when Recording a Cue

• [RECORD] [SHIFT] + [TIME] {STOPWATCH TIME} [ENTER] - records a new cue at the end of the cue list 
using Stopwatch time.

• [RECORD] [CUE] [SHIFT] + [TIME] {STOPWATCH TIME} [ENTER] - records a new cue at the end of the cue 
list using Stopwatch time.

• [RECORD] (#) [SHIFT] + [TIME] {STOPWATCH TIME} [ENTER] - records the selected new cue using Stop-
watch time.

• [RECORD] [CUE] (#) [SHIFT] + [TIME] {STOPWATCH TIME} [ENTER] - records the selected new cue using 
Stopwatch time.

Stopwatch Command Line Commands

From the Command Line the following commands are available for the Stopwatch. 

• (sw start) will start the Stopwatch.

• (sw stop) will stop the Stopwatch.

• (sw reset) will reset the Stopwatch.

Note:  Remember that any Command Line command be made into a Macro to put these commands on Shortcuts.
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Copy - allows Store, Recall, Swap and Copy functionality for fixture data.

The copy button on the right hand side of the channel display window will drop down a menu with a number of
options for storing and recalling the channel state. Use this to store and recall the channel state from a temporary
memory, copy from another fixture or copy the channel state form a cue.

Store current channel state into temporary memory - If half way through creating a look on stage and the user
needs to run a cue or bring up some other lighting state then this option can be used to make a temporary back up of
the current look. The state of every channel will be stored away in a separate memory to be recalled at any time in the
future. 

Recall channel state from temporary memory - Use the recall option to return the live channel state to the one
stored in memory with the previous function. If no channel state is stored then the current state will remain
unchanged.

Swap channel state with temporary memory - Use the swap function to perform both a recall and a store in a single
operation. The current state of the channels will be stored in the temporary memory and then the state that was stored
will be loaded into the live state.

Copy from fixture to selected fixtures - Selecting this option changes the mouse cursor to a hand pointer to select a
"copy from" fixture. The attribute and dimmer state of the next selected fixture will be copied to the currently
selected fixtures.

If the selected fixtures are of the same type as the "copy from" fixture then an exact copy can be performed. If not
then the software will apply the generic attributes of the selected fixtures.

Copy from cue to selected fixtures - This is a convenient option to load the state of the selected fixtures form the
information stored in a cue. Selecting a cue from the sub menus found off this menu option will set the selected
fixtures to the same settings as they appear in the cue. If a selected fixture does not exist in the cue then its values will
remain unchanged.

Copy selection list to clipboard - Selecting this option will copy a comma separated list of channels to the windows
clipboard representing the current selected fixtures. 

Store current channel state on cue GO - If this option is enabled then the "Store current channel state into
temporary memory" operation will occur before the next cue is run. 

Thumb Wheel
For systems that do not have a scroll wheel on the mouse or cursor (such as tablet or pen based systems) use
the provided on screen wheel. Click on this control and hold down the mouse button. Move the mouse or
cursor up and down to change the intensity of the channels in the same way as the scroll wheel.

Control Tabs
The Control Tabs display onscreen control for the tabbed item. These onscreen controls link to the hardware as well
as Command Line operation.
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Fixture Control
Fixture Control appears when any patched attributed fixture is selected. Attributes are collected into Attribute
Families. While the fixture library can be infinitely flexible, standard Attribute Families have been created to best
interface with the hardware.

These are Position (movement), Color (all colors), Beam (gobos, prism and all inside beam attributes), Edge (focus,
zoom, iris, shutters and all outside beam attributes).

Position Tab

The example fixture here is a VARI*LITE VL1100TSD Automated Luminaire. The Position page shows the Intensity
(Primary Dimmer), Pan / Tilt and Pan / Tilt Speed. These have shortcut buttons for On / Full / Off and edit boxes for
percentages / degrees and DMX values. The console itself has buttons for all of the Attribute Families. 

Color Tab

Slider bars appear for Color Mixing control. Again with Off (0%) and Full (the color label button), percentage value
box and DMX box. Color speed and a Color Picker is available.
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"Use Advanced Color Heuristics". When checked, NEO will attempt to map the spectrum selected color across all
color controls. When unchecked, the spectrum selected color will apply only to the 3 main colors. In this case, CMY.

Generic Color Chooser
Selecting the Generic Color Chooser allows for selecting color in any of several generic ways. The options appear as
tabs on the left side of this window.

Show - these would be show created specific color palettes.

Palette - this is a simple color picker.
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HSI - allows for Hue, Saturation and Intensity color control regardless of the fixtures color mixing parameters.

RGB - allows for Red, Green and Blue graphical color control regardless of the fixtures color mixing parameters.

CMY - allows for Cyan, Magenta and Yellow graphical control regardless of the fixtures color mixing parameters.
There is an additional option to add the "K" slider for CMYK color mixing options. This is about the "value" of the
image from color rendering of printing. The higher the value, the more toward black, the lower the value, the more
toward white.
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Filters - allows selection of gel manufacturer's color filters.

Spectrum - allows selection of color from the color spectrum.

CIE - allows selection of color from either the 1931 or the 1964 version of the CIE color chart. There are also several
different color systems from which to select.
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Beam Tab

This is for all attributes that effect the "inside" of the beam of light. Gobos, Prism and such. The VL1100 has a
Rotating Gobo, the pulldown will display all available stock gobos. Mode - if the gobo selection is in All, Index,
Rotating or other gobo movement mode. The DMX box is for the raw DMX value of the gobo attribute. Continuous
Rotation Control allows going from Index Mode to Rotation Mode by selecting CW / Stop / CCW rotation. Once
selected, the interface will adjust to show the appropriate controls. This includes RPM speed and raw DMX values.
Both are adjustable by the presented interface.

Edge Tab

This is for all attributes that effect the "outside" of the beam of light. Focus, Zoom, Iris, Shutters and such. The
VL1100 has Focus, Zoom, Diffusion and Framing Shutters. All appear here with Minimum / Maximum buttons,
slider bar, percentage edit box and DMX edit box. Diffusion has a pulldown box much like a Gobo attribute because
it has two options (Open and Frost). Framing Shutters give graphical control and percentage edit boxes.

The console hardware assigns all attributes to the 4 encoders. Pressing [EDGE] will page to the next set of encoder
assignments.
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Side Bar Cue List
This is a simple cue list summary that is a quick list of the
cues, description and basic functionality. 

It can be turned on / off from VIEW>Open Side Bar. To switch
the side bar cue list to a smaller view, select "Use compact
view for sidebar cue list".

At the top, in yellow text (so that it will stand out) is the default
information. This information is important to know "how" the
console is setup to work given the NEO's vast setup options. 

• "Record Live" identifies "what" the console is recording. 
Live, Selected, Active and Changed are the options.

• "Tracking Mode" identifies "how" the console is recording. 
Tracking, Cue Only, Trackback, Smart Block and Block are 
the options.

• "Mark Late" identifies the auto mark setting on the console. 
Mark Off, Mark Early, and Mark Late are the options.

• "FX" identifies if the record / update operation will include 
or exclude running effects. Yellow will include, red will 
exclude. Just click the text to change.

• "Sub" identifies if the record / update operation will include 
or exclude active submasters. Yellow will include, red will 
exclude. Just click the text to change.

• "Pal" identifies if the record / update operation will include or exclude palettes that are in use. Yellow will include, 
red will exclude. Just click the text to change.

• "Master (A / B) Cue List" identifies the selected playback. Pressing the appropriate "Select" or "PB#" button will 
select the desired playback.

Note:  New for software version 3.8, the text has been formatted for better visibility. This has reduced the number of 
visible cues. The legacy format is under View > Display Options : Use Compact View for Side Bar Cue List.

On the cue list itself, the yellow border identifies the "Active" cue which is the cue outputting on stage. The blue
background identifies the "Selected" cue which is the cue that commands will affect. For example, type [CUE]
[TIME] (#) [ENTER] to change the time of the "selected" cue or the one in blue.

Focus on the cue list by selecting any cue. Now the Up / Down arrows move the selected cue to the desired location.

The Cue List pulldown allows the selection of the desired cue list. Scroll, select and double click to GO with simple
touchscreen functionality.

Clicking on the cue number itself reveals the cue pop up window for additional
functionality through the graphical interface.

In View > Channel Formatting, if any of the channel formatting options are selected, an
indicator will appear above the side bar.

When an autofollow cue is being calculated for the countdown to be triggered, there is
a purple progress bar that indicates the remaining time. If the cue is manually triggered,
that progress bar will immediately be removed.

NEO NOTES & TIPS:  In System Properties > Appearance > Other appearance 
settings - Use dark styling. If dark styling is turned off, the Side Bar Cue List displays 
in the legacy format. This allows consistency with the playback window for colors etc.
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NEO NOTES & TIPS:  The full cue list detail window can be displayed by selecting Cue Lists or F4 or the NEO 
display button [CUE LISTS].

Clock
The clock is a display option under View. This will also display the showfile name and date.

Split View
This displays a second view of patch fixtures. The sample screen above shows ML Attributes as the selected view for
the second view. This gives the user a main window to see a more traditional view of intensities and a ML attribute
window that displays all attributes. The ML Attribute window also gives the user the ability to program attributes
directly from that window so it's functional too.

NEO NOTES & TIPS:  Can be turned on / off under View > Open Split View of Channels > ML Attributes.

Library FX Control
When fixtures are selected and a library fx is applied, Library FX Control parameters are available in the Side Bar for
adjusting the effect.

The FX attributes will also be automatically assigned to the encoders for quick access from the NEO console.
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2. NEO Console Configuration Status

Press the NEO icon and the Fixture Grid will be replaced with the Configuration Status screen.

This displays the connectivity of the console configuration.

Press the NEO icon again to restore to the Live display.

Command Line

The Command Line is the main point of entry for all NEO key press entry. Command Line entry has been around for
decades and remains the main focus for programmers as the fastest way to achieve the desired results onstage. When
a NEO key is pressed, it will populate on the Command Line.
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On NEO, there is a fresh approach to Command Line. NEO is not limited to pre-built commands. Touch typing is
available. R E C O R D for record. Any command. even type group names for selection. If there is a group named
"Front Light", typing FRONT LIGHT @ 100 ENTER to turn that group on. It's very fluid and functional.

Master Fade Time

The master fade can be set for all channels by entering a value into a fade edit box to the left of the shortcut controls.
Once desired fade is set, all changes made to the fixture will apply over this time.

[TIME] [SHIFT] + [TIME] will place MASTER FADE TIME on the Command Line for adjustment. Just complete
with (#) [ENTER] where the # sign is a numerical value in seconds.

The default fade time specifies the time a channel will take to get from its current value to the new value. Internally
this value will be overridden by the show and effects controls so it is not necessary to have the default fade at zero
when running shows.

3. Shortcuts

Shortcuts are designed to provide quick access to a number of functions within the software. Some of the assignments
that can be made to shortcuts include:

• Channel selection

• Channel Group Selection

• Cue Go / Back / Pause / Reset

• Execute Fixture Properties

• Effects Run / Pause / Reset

• Execute level groups

• And many more…

As with submasters, shortcuts can be accessed through an on-screen display or by the NEO console hardware. On-
screen shortcuts also have the added feature of being designed for use with a touch screen display.
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NEO provides 100,000 user-assignable shortcuts that are accessed through 100 pages. Access to the on-screen
shortcuts is obtained by clicking on the button to the right of the shortcut page selection.

On-Screen Shortcuts
The shortcut window is a grid of 100 buttons each tagged with a number, description, and color.

If a shortcut is not assigned the button will appear greyed out and cannot be selected. When a shortcut is assigned a
default description is created and appears below the shortcut number.

NEO NOTES & TIPS:  [SHORTCUT] [ENTER] will now open the Shortcut display. This is great for a macro or 
hard shortcut button.

Figure 8:  On-Screen Shortcuts

There are two (2) view modes that can change the display of the on screen shortcuts. Switch between the modes by
clicking on the button to the left of the "Full Screen" button. The label of this button will toggle between "Normal"
and "4 UP" depending on the current mode. In "Normal" mode the shortcuts appear as a 10 x 10 grid with the
shortcuts numbered with 1 in the top left corner and 100 in the bottom right corner. In "4 Up" mode the shortcuts will
be arranged in to 4 groups. Each of the groups will have a user definable heading that will default to Color Palettes,
Beamshape Palettes, Positions and Groups.

Open on-screen shortcut page

Shortcut Page
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To change the label for each of the groups in "4 Up" mode click anywhere in the heading.

Figure 9:  Shortcut Grouping Title Edit

Enter the new name of the group into the box provided and click "OK" to save the change. The new label will be used
for all pages of shortcuts.

Options
To change the global display options for the shortcut window click on the drop down menu on the right of the mode
button.

Figure 10:  Shortcut window display options

Use 3D buttons - (Default on) Use this option to change how each button is displayed. When this option is on the
buttons will have a 3D style gradient.

Set font size - Use this option to change the overall size of the text in each of the shortcuts.

Set mode and labels per page - When this option is turned on the 4Up and normal mode can be set for each page.
The labels will also be remembered for each page separate to each other.

Auto Select page based on fixtures selected - With this option turned on the shortcut page will change if a palette
page is setup for the fixture. This works on the name of the shortcut page. If a single fixture type is selected then NEO
will search through the page labels to try and locate one that matches the fixture name. If a page name match is found

4 Up Mode Normal Mode
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then the page will automatically switch. This is a convenient way for the window to always show the shortcuts related
to the selected fixture.

Set shortcut grid size (Columns x Rows) - Select this option to set the number of rows and columns to appear in the
shortcut grid. This can be a useful option to set the on-screen shortcuts to match any physical hardware used.

Right Click Options
Right clicking on any of the active shortcuts produces a pop-up menu to edit the
description and change the button and text color, add an image or jump directly to
the appropriate edit window of the shortcut.

Right clicking on any unprogramming shortcut will produce a pop-up to add a
quick command macro.

Add Quick Command Macro
The Quick Command Macro adds a macro to the
desired Shortcut.

Macros can be assigned to both the down action and/or
the up action on a SC button press. If the Mode is set to
Momentary, the Up Command will be triggered when
the SC is released. If the mode is set to Latched, the UP
Command will be triggered with the SC is pressed a
second time or unlatched.

Down Command - Insert the Command Line
command that is desired for the initial pressing of the
SC button. There is a "SP" button for adding the ASCII

string of "%32" that is the ASCII command for a Space should that be needed within the macro. The macro can also
take direct text from the keyboard as apposed to Command Line entry.

Up Command - this is the action that occurs when the button is release. Programming is the same as the Down
Command.

Description - Insert the macro's desired description.

Color - Select any non-default color from the pulldown list for the Shortcut's background color.

Use the popup menu to copy and paste the formatting (color, text color etc) of the shortcut to other shortcuts.

NEO NOTES & TIPS:  Changes made to the description or color will remain until the shortcut is reassigned.

Edit Description - Select this option to change the label displayed on the shortcut button.

Cut / Copy / Paste Format - These options copy and paste the background and text colors to other shortcuts. The
"paste to many" option is a convenient way to set the colors of multiple shortcuts at the same time.

Background and Text Color - The background color and the text color can be changed for each shortcut. To reset
either of these to default use the "Reset background color" and "Reset text color" options.

Images - Each shortcut can have an image assigned that will be displayed to the left of the label. Use the "Set image"
option to select an image from the user’s system by bringing up a familiar image selection dialog. Use the "Set image
from fixture" option to select any of the images stored within the NEO fixture library. 

Edit Image - The edit image option opens a paint window to modify or paint any image.

Edit Shortcut - Select this option to open the editor window associated with this shortcut.
132 Software Configuration



NEO Lighting Control Console
Move Shortcut - When selecting the move shortcut option, the mouse pointer will change to a small hand. Click on
any unassigned shortcut to move the original to this cell.

Lock / unlock shortcut - A locked shortcut will remain on screen regardless of the page change. This is useful for
keeping some operations on screen all of the time.

Add Quick Command (macro) - Right click on a shortcut that is not assigned to open a single menu item "Add
Quick Command". This is a special function for assigning a single command function to the shortcut key. Think of
this as a one line macro that is assigned directly to the shortcut key. 

After selecting this option a dialog appears asking the user to enter the command to assign. The command can be any
valid command line text (Test a command in the command line window before entering it here). Once entered click
on the "OK" button to assign the new command. The command entered will become the description for the shortcut. 

NEO NOTES & TIPS:  Clicking on the shortcut will cause the command to be immediately executed in the 
command line window.

The full screen button to the right of the text size edit box toggles the window into a border-less full screen mode.
This can be useful when using the shortcuts page with a touch screen monitor. The window can be returned to its
original size by clicking on the same button.

Removing Shortcuts

Right click on any Shortcut Page's tab and there are the following 
options...

Set page description / color - allows the customization of the description
and color.

Reset page properties - resets all properties back to default.

Clear all shortcuts on this page - removes all programmed shortcuts. This
is an easy way to remove auto-palettes.

4. Submasters and Submaster Pages

Submasters are faders that are assigned to Groups. See the Groups Display section of the manual for programming
options.

In System Properties > System Settings > Intermediate Options there are a number of options for configuring NEO
Submasters.

On-Screen Submasters
The on-screen submasters can be viewed as either a slider control or a grid similar to the channel display. The slider
view will provide access to up to 30 submasters per page. Each of the submasters per page is represented by a single
slide control and spin edit box. The grid view will display as many submasters per page as set in the system
properties. Each submaster is represented as a square in the grid that can be selected and modified using the scroll
wheel on the mouse.

Open Submaster Page

Submaster Page Control
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NEO NOTES & TIPS:  NEO can support up to 100,000 submasters by connecting external hardware to the system. 
Not all submasters can be viewed on screen when in fader mode. If more than 30 submasters are configured per page, 
then only the first 30 will be visible in this mode.

To switch between the fader view and the grid view click on the button to the right of this window. Clicking on this
will toggle between each of the views.

At the top of this window is a series of buttons to change the submaster page. Changing the page in this window will
not change the page number on the main window as it is possible to have the on-screen submasters set to a different
page to any external hardware used.

Fader Mode
Setting a submaster can be done by using the mouse to click-and-drag the slide control, or by typing a value in the
edit box below the slider. If the slide control is moved, the value in the edit box will change to reflect the new position

and changes to the edit box will be reflected in the slide position.

Figure 11:  Submaster Window - Fader Mode

The "Flash" button at the bottom of each submaster can be used to temporarily set the submaster to full. Once this
button is release the submaster will return to its previous state. 

Selecting the "Latch flash buttons" option at the top of the window changes the behavior of the flash button so there is
no need to hold down the mouse button. With the toggle option on, clicking and releasing the flash button will take its
position to full. To return to the previous state click the flash button again.

NEO NOTES & TIPS:  If hardware submasters are being used, the user will also see the slide position and edit box 
value change to reflect the hardware.

Right clicking on a submaster will bring up additional options to help identity each fader. 

Change Description - Use this option to label the submaster. The label will appear along the top of the fader.

Set Description Color - The color of the description can be changed by selecting it form this option.

Reset Description Color - Select this option to return the color of the description back to its original color.

Lock / Unlock Submaster to all pages - A locked submaster will remain on screen regardless of the page change.
This is useful for keeping some operations on screen all of the time. 

When a submaster is locked to all pages a small yellow padlock will appear in the top right corner of the slider
control.

Submaster Wheel
On the right hand side of this window is a large wheel that can be used to move all of the submasters on this page at
once. Click on the wheel and while holding the mouse button down, move the mouse up or down to raise or lower the
levels. All of the submasters on that page will raise and lower with the mouse movements.

Select what submasters the wheel will operate on by clicking to the left of the slider for each of the submasters. The
master wheel will operate on all submasters that have the small green tick in the bottom left corner.
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Grid Mode
Setting submasters in the grid mode is similar to setting channels in the channel display. Each submaster is
represented by a cell in a two dimensional grid.

Figure 12:  Submaster Window - Grid Mode

Submasters can be selected by simply clicking on the desired grid cell. Hold the left mouse button down to drag an
area of the grid to select multiple submasters. Once selected, use the mouse wheel or the spin wheel on the right to
change the value.

Right click on any of the cells in the grid for additional options.

Clear selection - Select this option to unselect all submasters.

Select active submasters (all pages) - All of the submasters currently above zero will be selected.

Clear selection when changing pages - Check this menu item so that all of the submasters are automatically
unselected when the page is changed.

Inclusive selection mode - This is toggle option that will have a small check mark next to it when turned on. If the
"inclusive selection" option is active then each selection made will be added to the previous selection. All submasters
currently selected will remain selected unless they are in the new selection area. Any selection will toggle the
selection state of a channel.

On the right hand side of the submaster page are the split playback faders for the primary cue list. This includes a
Stop / Back and GO buttons.
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Submaster Wings
The optional submaster wing adds 20 non-motorized submaster faders to the NEO console. NEO can support up to 3
wings in total. 

Each panel (top or bottom per wing) has the ability to change paging assignments.

The top row of faders pages from the Page Up / Down buttons on the left side of the wing. The bottom row of faders
pages from the Page Up / Down buttons on the right side of the wing.

Submaster Wings Screens
Each pair of submasters from both the top and bottom rows have a color screen to identify it's contents.

• Page Assignment

• Submaster Number

• Submaster Label

• Submaster Level

Playback Page
This identifies the playback page assignment for NEO’s five multi-function
faders to the left of the primary cue list playback faders.

Page Assignment

Submaster Number

Submaster Label
Submaster Level
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Playback Wings
The optional playback wing adds motorized faders (10 single button faders commonly known as submasters and 5
three button faders or playback faders) to the NEO console. NEO can support up to 3 wings total.

Each panel (top or bottom per wing) has the ability to change paging assignments.

The top row (submasters) pages from the Page Up / Down buttons on the left side of the wing. The bottom row
(Playbacks) pages from the Page Up / Down buttons on the right side of the wing.

Just like on the console, pressing the Select button above the playback fader allow the user to assign a Cue List or an
FX to the playback fader.

When a Cue List is assigned to the wing's playback, the Cue List info will appear on the appropriate screen.

When an FX is assigned to the wing's playback, the FX info will appear on the appropriate screen.

Group Masters
An exciting new feature for the entertainment lighting industry has been added to NEO. It is called Group Masters.
Group Masters allows the user to apply groups to the Live state and the "Group Master" faders will be activated. Each
newly applied group will be assigned to the next available Group Master (it uses the PB faders) and the screen will
identify the group that it is assigned to.

Once assigned, adjustments to the groups can be made from the Group Masters themselves rather than going back to
Command Line entry. This is designed to speed up the cue writing process when using groups, especially when the
operator is also the designer.
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To activate the Group Masters feature, just turn on the Group Master switch to the right of the Command Line area on
the Live screen.

Once turned on, the Playback wing's Playbacks are now Group Masters. This does not affect the Playbacks on the
NEO console itself.

In addition to this, when running through the show's cues, the Group Masters track and follow along and adjustments
can be made on the fly to the group.s outputs. Just remember to update the cue to store the changed information.

Master's Contents

The example shows 1 thru 5 stored as Group 11 labeled Front Light, 6 thru 10 stored as Group 12 labeled Blue Bxs
and 11 / 15 stored as Group 13 labeled Pipe Ends. Each of the groups have been activated Live by typing [GROUP]
(#) [@] (Level) for each of the groups and then the GM faders have been modified by moving them up / down. Once
the Group Masters have been applied, just record / update a cue. When going back to the cue at a later date, the Group
Masters will be restored.

Modifying the Group Master's Contents
With a Group Master assigned, press the top button or Select button to automatically expand the group’s contents to
the submaster faders above. This button is a toggle. When toggled on, the submaster faders will identify with each of
the groups individual channels thus allowing individual channel level adjustment. Once the adjustments are complete,
just toggle the Group Master's select button off and all individual assignments will collapse back into the Group
Master.

Paging Group Masters
The Page Up / Down buttons on the right side of the wing are backlit red when in Group Master mode. These will
page the Group Master faders.
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5. Display Options

The display options will access the various console displays that are available to view either over the top of the main
view screen / monitor or easily on another monitor.

Options

Showfile based options, system properties and advanced items like external trigger, scheduled tasks and user
permissions are here.

Loading and Savings Shows
 It is important to understand some changes that have been made to the
showfile saving system. The show will always be safe and these
changes further enhance the security of the show file to protect it
against unintended changes. The current show in the active memory of
the console will always be up to date and it will be retained even if the
console is powered off. These new changes allow saving copies of the
show file while maintaining an archive of the data as needed. NEO
show files have a new extension - .NEO.

Starting a New Show - When a new show is started, if there is a show
file in the console’s active memory and it has been changed, there will
be a prompt to save it. If the showfile has not changed, then a new
show file will be started immediately.

Loading a Show - Prior to loading a show file, a prompt will appear to
save the existing show file before the selected show is loaded into the

NEO’s Current Show. When a prior show is opened (.FDB), a prompt will appear allowing NEO to convert it to the
new format (.NEO). A show file can now be loaded directly from an external drive or USB drive without any prior
need to copy it to the console.

Saving a Show - If changes to a show file have been made, an archive copy is created at the moment the saving
occurs. (Showfile Name_REV1.NEO) It is then safely stored away, allowing a restoration back to that version at any
time. The show remains in active memory regardless allowing continued work on the file. As programming continues
and manually saving the last 10 show files will be maintained on the hard drive.

Using “Save As” - This is identical to saving a show except that it’s under a different name. This is especially useful
for keeping multiple copies of the show file to be able to go back to earlier versions.

The show name displayed in the side bar now has a * to indicate that data has been changed and needs saving. Once
saved, the * will be removed until another change has been made.
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New Show - Creates a new blank show file on the hard drive and loads this as the current
show. There is a setting in System Properties > System Settings > Intermediate Options:
Start new shows with nothing patched. This setting determines if creating a blank show
starts with nothing patched or with a default patch.

When selecting this option, a standard Windows save dialog requests a file name to save
the new show under. The new show file will be given an extension of ".FDB".

Enter the name for the show file in the "File Name" field and click save to proceed with
creating the show.

Open a Saved Show
When starting up NEO, the "current show" loads automatically. Any programming or
changes made are applied and saved to this "Current Show". Opening a saved show will
make the selected show file the "Current Show".

A standard windows "open file" dialog will appear when this option is selected.

NEO NOTES & TIPS:  NEO always has the "current show" loaded. All changes made to the system such as 
creating a new cue or effect is automatically saved to the current show.

Pack Show File and Settings
Accessed from Options > Pack show file and settings, this feature saves the showfile, system settings, and all related
media files (images, videos and MyInterface layouts) to a single .NPS file. With this feature, it is now possible to
clone one NEO console show file, support files, and settings to another console.

Note:  Packed show files (.nps) include media used in the show which can takes time to pack together and can result 
in very large file size.
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Load a Saved Show (from a Packed Show File)
Once the file is packed and saved, it can be transported to another NEO
family console and opened there where all files and settings will be
transferred. Go to Options > Pack show file and settings > Load
packed show and select the correct .NPS file. The “Loading packed
show file” dialogue box will appear. By default, the following options
are on and will be imported and changed on the importing NEO family
console system.

• Show File

• Media Files and Settings

• Interface Builder Layouts

Other options that are NOT on by default…

• DMX Input / Output Settings

• System Settings

• External Triggers

• Appearance Settings

• User Security

• FX Library

• Gel Filters

• Default Fixture Symbols

Open a Server-Based Show File
NEO can connect to a remote show file to allow multiple users to manipulate the same show. Opening a remote show
file is very similar to opening a local show file with the additional requirement of the remote server name.

If the current show file is a remote then the show name is now shown RED in the side bar in Live Screen.

Note:  Be aware of external drives that hide the fact that they are removable drives. NEO looks for these and if 
identified as a removable drive, will not allow the opening of the showfile that is on a removable drive and return to 
the current default show.Please copy any showfile to a legal drive prior to opening.

After selecting this option the dialog below will appear:

Connecting to a remote show is similar to the opening a regular show file. Enter the name of the remote system in the
"server name" field. This can be either the machine name or the IP address.

In the show name field enter the full path on the remote system to the file. Unfortunately Firebird does not provide an
ability to browse for the file name so the full path and name must be entered manually.

The "preferred interface" option can be used to set the network interface that should be used for communication
between NEO systems. It is highly recommended that the user not use the same network interface as the DMX output
(assuming Ethernet based DMX) as this may affect the DMX performance.
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NEO NOTES & TIPS:  If using NEO on the same host computer as the firebird system, the user must still connect 
in the same way. Using the regular "Open saved show" option will not open the file and all remote users will be 
locked out.

Once all settings are entered, click on the "OK" button to connect to the show. If successful, the show file will open
normally.

Save (Show) as…
Saving a NEO show will make a new show file that contains all the same data as the current show. There should be no
change to the data the user is actively working on in the system.

When selecting this option, a standard Windows save dialog prompts the user for the file name to save the new show
under. The new show file will be given an extension of ".NEO".

Pack Show File and Settings
Accessed from Options > Pack show file and settings, this feature saves the showfile,
system settings, and all related media files (images, videos and MyInterface layouts) to a
single .NPS file. With this feature, it is now possible to clone one NEO consoles show file,
support files and settings to another console.

WARNING!  Because packed show files (nps) include media that may have been used in 
the show, the size of these files can be very large and take time to be packed together.

NEO NOTES & TIPS:  If selecting an existing show, all information will be overwritten 
by the "current show". A warning dialog will display if overwriting an existing show is 
about to occur.

Import from an existing show file - Use this option to load elements from another show
file and merge them into the current show. When selecting this option, a standard
Windows open dialog prompts the user for the file name of the show file from which to
import.
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Once opened NEO will read all of the information about the show and allow selection of the desired items to import.
Select to import Channel Groups, Cue Lists, Effects, Palettes, Macros and Patch information.

To select the elements of the show to import. use the check box on the right of each line. There are 6 tabs on the left
that separate out the different parts of a NEO show. 

If a name conflict is detected when importing any part of the show the imported element will be renamed as "Copy of
previous name".

Once the elements are selected, click on the "Import" button to proceed.

Import from USITT ASCII Cue Format - imports an ASCII file and places it into current memory.

Backup Now - Will perform an immediate backup based on backup folder locations set in System Properties >
System Settings.

Restore Show From Backup - restore sa showfile from a previously created backup file.

System Properties - a series of options to configure hardware, database, default settings, and change licensing
information. 

More information on System Properties will be outlined in the  "Display Options" on page 139.

6. External Triggers

NEO provides the ability to connect external triggering devices to control the running of shows. This feature allows
set up of shows that run without user interaction.

External triggering is designed to trigger the "Cue Go" function in shows, however NEO can also use the MIDI and
Timecode triggers to execute any shortcut.

Configuration of the external triggers can be found in the file menu.

When MIDI / SMPTE is being used, there are status LEDs on the
back of the console to help identify and understand the traffic that is
transmitting on this card. The MIDI / SMPTE device is engineered
onto the DMX card. Look on the Console Debug Window (More >
Console Debug Window) to see a listing for the DMX card and it's
firmware. The firmware version number is #.##.###. The first two
sets of numbers are for the DMX card firmware version. The last
set of numbers is for the MIDI / SMPTE card firmware version.
(For example: 1.23.102). MIDI / SMPTE firmware version 102 is
the first version to have the status light feedback. The LEDs will blink in different patterns to indicate receive /
External Triggers 143



User’s Manual
transmit (Rx / Tx) signal status. Status light indicator information is found in  "DMX512 Output" on page 33 and 
"MIDI / SMPTE" on page 33.

7. MIDI

In addition to receiving MIDI commands, NEO can send commands to external systems. The basic form of a MIDI
message is:

[MIDI] {DEVICE ID}.{CHANNEL NUMBER} [MESSAGE TYPE] [DATA 1] [DATA 2]

A MIDI connection can support up to 16 devices (0-15). The device ID specifies which device will receive the
message.

The message type is one of the following keywords: ALLNOTESOFF, NOTEOFF, NOTEON, KEYAFTERTOUCH,
CONTROLCHANGE, PROGRAMCHANGE, CHANAFTERTOUCH, PITCHBEND, SYSTEMMESSAGE,
BEGINSYSEX, MTCQUARTERFRAME, SONGPOSPTR, SONGSELECT, ENDSYSEX, TIMINGCLOCK,
START, CONTINUE, STOP, ACTIVESENSING, SYSTEMRESET, FIRE (#).

The data fields will contain values relevant to the message type. Knowledge of the receiving system is needed in
order to construct proper messages for it. 

MIDI Control
MIDI is a flexible musical instrument-to-PC protocol
that provides a number of different messages in the
form of notes.

To enable the MIDI functions, turn on the "Enable
MIDI Events" option.

The "Debug Messages" tab can be used to help identify
any problems with receiving MIDI messages. To
display more information about incoming MIDI data
turn on the "Verbose debug messages" option at the
bottom of the window.

MIDI Learn
To make it easier to setup MIDI triggers NEO can learn events live.

Click on the "START LEARNING" button begin listening for MIDI events. As soon as a MIDI event occurs in the
software the "Found MIDI event" options will be shown.

Use the ACTION options to determine what the MIDI event will do. To the right of the action options will appear any
required additional parameters. For example, to fire a shortcut set the shortcut number.

Once the event is properly programmed, click on the Save button. 

Click on the Cancel button to return to the "Start Learning" state.
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Use the "Save & Start" button to save the event action and return to the learn state.

MIDI Show Control - MSC
NEO can receive a MIDI Show Control signal of MSC CUE GO
or MSC CUE STOP and the console will respond by activating
a GO or STOP on the Master Cue List.

Go to Options > External Triggers > MIDI then check the box
"Enable MIDI Events". This exposes the box to "Enable MSC".

Note Triggers
The "Note Triggers" tab provides the ability to add any number of note triggers to the system. Click on the "Add"
button to create a new line in the list of triggers. To remove a trigger, select the row to remove and click on the
"Remove" button.

Each trigger requires the following settings;

Description - This provides a way to identify the trigger by entering a description for reference.

Channel - Identify the MIDI Channel to listen on (1-16)

Device - Device number to listen to (default 0)

Note - This is an instrument note that will trigger the event.

On / Off - Determine if the system will trigger by a note on or note off event.

Octave - An interval between two notes that are seven steps apart on a musical scale.

Action - Each trigger can either execute the "cue go" operation, execute a system shortcut or run a command. Use the
drop-down combo to select one of these options.

Shortcut / Command - If the action is set to "shortcut", this field is used to specify the shortcut number this trigger
will execute. If set to command enter the command syntax into this field.

Import / Export - To help manage a large number of MIDI note triggers the user can import this information from a
coma separated text file (csv). Click on each of these buttons to open a standard windows file dialog to select the file
to import or export.

When choosing the import option, a dialog will pop up asking to remove existing entries before importing the new
data.
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Note Velocity
The "Note Velocity" events can be used to directly control submasters within NEO. Click on the "Add" button to
create a new line in the list of velocity triggers. To remove a trigger, select the appropriate row and click on the
"Remove" button.

Description - This provides a way to identify the trigger by entering a description for reference.

Channel - Identify the MIDI Channel to listen on (1-16)

Device - Device to listen to.

Note - This is an instrument note that the software will listen for and translate the velocity into a submaster value.

Submaster - Set the submaster number that will be applied when the note is received.

Import / Export - To help manage a large number of MIDI note triggers, import this information from a comma
separated text file (csv). Click on each of these buttons to open a standard windows file dialog to select the file to
import or export. When choosing the import option a dialog will pop up asking to remove existing entries before
importing the new data.

Control Change Events
The "Control Change Events" tab allows setup of NEO to respond to control change events.

Submaster & Shortcut Channel # - Set this option to determine the channel number that will be listened to for
control change events.

Submaster Device - MIDI devices can also be used to control NEO submasters in the same way as the DMX input
option. Low cost MIDI fader devices can be connected to provide this functionality. To activate this function select
the device from the combo box provided.
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NEO will listen for "Control Change" messages and apply the received "Value 2" to the submaster defined by the
"Value 1". To set the first control change identifying number use the "First Control #" option to the right of the device
selection box. 

When submaster's are changed in NEO the software will also send MIDI messages to the selected device to activate
motorized faders (if supported).

Shortcut Device - The same function as above can also be applied to shortcuts. Select the device to listen to for
control change messages and set the start message number to correspond to shortcut 1 in NEO.

Send submaster change MIDI messages - If the device supports motorized faders then NEO can send MIDI control
messages back to the device to change the physical slider. This is useful when changing the submaster page in NEO
or to make an on-screen change to a submaster. The physical sliders will move with the changes made. If the device
does not support motorized faders then it is recommended to turn this option off.

Ignore shortcut up messages (127) - Some external MIDI devices send 2 messages for a button press. One message
for down and one for up. This can trigger the shortcut twice and is undesirable. If problems are experienced, turn this
option on to ignore all message except 127.

Wide Mode - Wide mode will automatically map the maximum number of incoming MIDI control change messages
to submasters. 

Control Change mapping - Below the primary options is a grid that can be used to map control change message
directly to shortcuts, submasters or encoders. Use the Add button to create a new event listener and set the channel,
device and control change number to listen for.

Use the action field to set what will happen when the CC message is received. The options for this field are Shortcut,
Submaster, Command or Encoder.

As with the MIDI note message the Import and Export options can be used to save and load the setting to and from a
CSV file.

Timecode (MTC) / Clock
The "Timecode (MTC) / Clock" tab allows setup of NEO to listen to incoming MIDI timecode data and MIDI clock
signals. The MIDI timecode read by NEO can be used to trigger timecode events.

The MIDI clock signal can be used to setup the tap tempo function in the software and synchronize the show to a
common tempo.

NEO now supports an internal timecode generator that can run independent of any media playback. To enable
internal timecode enable the option in the timecode tab of the "External Triggers" window.

TC RESET - This command will reset the internal timecode back to 00:00:00:00.

TC PAUSE - The internal timecode will stop in its current position.

TC CONtinue - Timecode will continue from where it was paused.
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TC {time value} - Use this to set the timecode to a specific value.

NEO NOTES & TIPS:  TC PAUSE - Pause the internal timecode at its current position.

NEO NOTES & TIPS:  TC 00:20:03:15 - Set the timecode to 2 minutes, 3 seconds and 15 frames.

NEO NOTES & TIPS:  TC CON - Start the internal timecode from a paused state.

Timecode Device - Select the device that timecode data will be read from or sent to. A separate device can be
selected for input and output.

Receive MIDI Timecode (MTC) - Enable this check box to begin receiving MIDI timecode form the selected
device. When turned on the Send option below it will automatically be turned off.

Receive MIDI Clock - Enable this check box to begin processing of MIDI clock data. The incoming clock messages
will be used to set the timing of the tap tempo within NEO. If the timing of the incoming clock changes the tap tempo
will automatically be updated.

MIDI Clock Divisor - The value of the MIDI clock divisor is used to slow down the internal tempo relative to the
incoming clock signals. The incoming beats per minute will be divided by this number when calculating the actual
Tap Tempo. For example if the incoming clock is running at 120 beats per second and the divisor is set to 2 then the
Tap Tempo will register 60 beats per minute.

Send MIDI Timecode (MTC) - If this option is turned on then the receive option will be turned off. When using any
of the other four timecode options (found in the timecode tab) the timecode will be sent to the selected MIDI device
to allow other systems to synchronize with NEO.

Sending MTC Type - If sending MIDI timecode from NEO, set the frame rate to generate. This is typically defined
by the application (film, NTSC / PAL television). If unsure, set the frame rate to 25 fps.

Changes to the frame type will apply immediately so different settings can be tried to see how it effects other
equipment that might be reading the timecode NEO is generating.

PC Line-In
The Line-in triggers can use any audio source to control NEO. An audio event can trigger a cue GO, fire a shortcut,
flash a submaster or run a command.

The "Line In" tab provides the ability to set the audio source and then create multiple events. Each event is
determined by the frequency range, trigger level, level type and minimum time between events.

For NEO to listen to the selected audio source, enable it by clicking on the "Enable Audio Line In Control"
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Above the event grid is a graphic display of the incoming audio frequencies. This is known as the audio spectrum that
shows the response to frequencies from 0 to the maximum frequency set. 

Input Audio Device - Select the audio source device to use to trigger the system. This is the system device that will
be listed to and shown in the display.

Maximum Frequency - The maximum frequency determines the upper sample limit the software will listen to. The
default is just over 5kHz. A higher maximum frequency will require more CPU to sample continuously.

Creating an Event
An event in the audio trigger system is a list of conditions that when met will trigger the event. The event itself will
also have settings that determine what will happen.

Frequency Range (Low Freq, High Freq) - The frequency range for the event will limit the area of the spectrum
that is listened to. This is best understood by looking at the red lines in the spectrum display. The lower red line is the
low frequency and the upper red line is the high frequency. Use the mouse to click and drag either red line to adjust
the frequency.

Trigger Level - Select the audio level in percentage of the maximum that will trigger the event. This is represented as
the yellow line running across the spectrum display. Use your mouse to click and drag to move the line and adjust the
level.

Level Type - Use the level type to select how the trigger level is used. Select between "Average Frequency" or "Any
Frequency". If the level type is set to average frequency then all of the levels between the frequency range specified
are averaged. If the average exceeds the level set then the trigger is fired. If the level type is set to any frequency then
the trigger will fire if any level between the frequency range exceeds the level.

Min Time Between - Set the minimum time between trigger events. This options stops the trigger from firing
continuously if the level is exceeded for a long period of time.

Action - The action setting specifies what will happen when the trigger happens. This can be set to Global, Shortcut,
Submaster Flash or Command. Setting this to Global will run any cue that is primed with "Line in" as its trigger.
Shortcut will run the shortcut specified in the Shortcut / Submaster field. Submaster Flash will set the specified
submaster to full for the Flash Duration and then return it to its previous level. Command will execute the command
line text specified in the Command field.

Timecode
The timecode configuration provides the ability to set up shortcuts that are triggered by the timecode values being
reached. It is possible to set up a cue list and provide timecode values to each cue. Cues can then be automatically
triggered when the timecode value is reached.

NEO NOTES & TIPS:  There is no configuration required for using timecodes to trigger "cue go".
MIDI 149



User’s Manual
To enable listening to timecodes, check the box marked with the appropriate timecode device.

• DirectX timecode - Uses the internal windows timecode functions provided by the DirectX components.

• Winamp timecode - Winamp is a popular free media player that is capable of playing video and audio files. NEO 
can read timecode directly from this software when running on the same PC.

• Adrienne Timecode - The Adrienne devices are a collection of internal and USB devices that support a number of 
timecode formats. For more information visit http://www.adrielec.com

• Internal Timecode - LightFactory can also read its own internal timecode produced by the media playback 
effects.

• Generate Internal Timecode - This option will start the internal timecode generator. As soon as this option is 
checked, the timecode clock will start counting.

If using the internal timecode generator, an optional shortcut can be set to reset the clock back to 00:00:00:00.

To add a new timecode trigger, click on the "Add" button and edit the fields provided. To remove any trigger, select
the event from the list and click on the "Remove" button.

Description - This provides a way to identify the trigger by entering a description for reference.

Timecode - Set the time code in the format HH:MM:SS:FF that will trigger the shortcut. The shortcut will only
trigger once when the time is reached.

Shortcut - Use this field to specify the shortcut number this trigger should execute.

Command - To execute any other system command, simply type the command into this field.

Global Offset - If the timecode being received does not start at zero, apply a global offset. The offset will be added to
the incoming timecode value at every frame. Use negative values to remove time from the incoming values.

Reset all events if the previous timecode is greater than the current - When this option is turned on all events will
be flagged as "waiting to fire" if the timecode loops or the previous timecode received is greater than the latest
timecode received.

Import / Export - To help manage a large number of timecode events, import this information from a comma
separated text file (csv). Click on each of these buttons to open a standard windows file dialog to select the file you
want to import or export. When choosing the import option, a dialog will pop up asking to remove existing entries
before importing the new data.

Timecode commands that can be used...

TC RESET - This command will reset the internal timecode back to 00:00:00:00. TC PAUSE - The internal
timecode will stop in its current position.

TC CONtinue - Timecode will continue from where it was paused.

TC {time value} - Use this to set the timecode to a specific value.
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mySQL Interface
The mySQL interface provides the ability run NEO macro scripts from a mySQL server. mySQL is an industry
standard database often used by web servers. This option will trigger NEO from a web site or any external
application.

The mySQL interface is designed for advanced use of the software in specific applications. Please contact NEO
support (entertainment.service@philips.com) for more information about this option.

Vision.net

NEO can communicate with Vision.net over 2 different serial ports and over Ethernet. They allow NEO to listen to
Vision.net Presets, Slider moves, and toggles. Properly configured, a Vision.net Slider move can trigger a NEO
Submaster and a Vision.net Toggle can trigger a NEO Shortcut or Macro.

Configuration options allow the selection of communication over either serial port, just check the appropriate box and
select the correct COM port, or check the Ethernet box, assign the correct Vision.net Area number and select the
correct network interface card.

Start Learning - puts NEO into a mode so that the next VN message received will ask the user what they want it to
do.

Enable Learn Preset - This allows NEO to learn a preset when the preset learn is triggered from a connected
Vision.net device. This is a switch in the Vision.Net tab of the external triggers (default on). When enabled, any
incoming "learn" commands from VN will trigger a group record. The channels included in the group is filtered by
the new "Room" and "Area" settings in the patch. Note that if the "Area" is left blank in the patch then it is ignored
and only room is uses as the filter parameter.

Assign Learn Preset to Toggle SC - When a preset is learned this allows the learned preset to assign itself to a toggle
shortcut. If the box is checked, the shortcut that it is assigned to will be an "apply" shortcut instead of a "toggle"
shortcut.
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NEO NOTES & TIPS:  When a VN Preset is learned the system will choose the next available shortcut starting at 
1001 rather than 1.

As Presets, Sliders and Toggles are added and assigned to Rooms, display tabs will appear at the top. These allow
filtering of items per room for display purposes only. This makes it easier to manage larger systems. The "All Rooms"
tab will always display all VN items.

Presets
For Presets, the Room is the VN Room designation. The Preset is the VN Preset that is triggering. The Shortcut or
Macro is the SC/Macro that the VN Preset triggers on NEO.

Submasters
For Submasters, the Room is the VN Room designation. The VN Submaster maps to the VN Submaster that it
activates. The NEO Submaster is the NEO Submaster that is triggered by the VN Submaster. So the VN Submaster is
linked to the NEO Submaster. Group Rate Control allows the VN Slider to control the programmed Group's Time
value. The time range is between 0 seconds and 60 seconds on the following scale.

10% = ~0.5 seconds

20% = ~2.4 seconds

50% = ~15 seconds

70% = ~30 seconds

100% = 60 seconds

Toggles
For Toggles, the Room is the VN Room designation. The VN Channel is the VN Channel that will be triggering. SC
Down is the Shortcut that will be triggered on the down action. SC Up is the Shortcut that will be triggered on the up
action. Return Script Down is the Script that will be returned on the down action. Return Script Up is the Script that
will be returned on the up action. Radio Groups allow the ability to have only one toggle be active within a collection
of toggles that are assigned to the same Radio Group.

Vision.net Commands
NEO understands Vision.net commands and can send them back to Vision.net. This allows NEO and Vision.net to
work together in very powerful ways. There are 2 ways to setup a facility with NEO and Vision.net. The first option
is for Vision.net AND NEO to have output capabilities. Vision.net has it's own output control of the lighting system
as does NEO. This allows for redundancy and the ability for Vision.net to function without NEO. The second option
is for NEO to be the fade engine and have Vision.net trigger NEO. Now there is a much more powerful theatrical
engine controlling the lighting states but there is no redundancy. There are advantages/disadvantages to both systems.

The power between Vision.net and NEO is in the tools that allow the two systems to communicate.

Take any basic Vision.net command and add either VISION.NET or VN in front of the Vision.net commands, listed
below, when inputting from the NEO Command Line.
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Example: Syntax is VISIONNET or VN {command} {data 1} {data 2} {data 3}. e.g. to send a message to preset 3 in
room 2: VISIONNET PRESET 2 3 0 or VN PRESET 2 3 0 (actually the 0 on the end is optional for preset commands
as it will use 0 as the default).

• If a Vision.Net TD, TU, SN or SF message is received then the shortcut list is scanned for a matching quick com-
mand and the indicator light toggled appropriately.

• Vision.Net - when a SP command is received the system will now toggle any matching latched SP shortcuts.

• "VN RESET ROOM LINK". resets Vision.Net room link table.

• Vision.Net - CL (#24) messages search for a matching CB message in the quick commands to correctly toggle the 
status.

• "SHOW ROOM LINK" displays the VN room link table on the command history window.

• Vision.Net - SB (#17) messages linked to the submaster/slider table.

• Vision.Net - CB (#23) messages linked to NEO shortcuts. The room number is mapped to the shortcut page.

• Vision.Net - CL (#24) messages will now search for a matching SN or SF message in the quick commands to cor-
rectly toggle the status.

• Vision.Net - SL (#4) and SC (#19) are mapped to the NEO patch VN Room and VN Channel columns.

• Vision.Net - SM (#21) now remembered by NEO for both the mode and state. This can now be referenced in the 
real time events tab of the macro system to trigger a macro when the mode or state is changed.

• Vision.Net - Messages sent to Room 0 applies to all rooms.

• Metro dialog boxes for the Vision.Net learn functions allow the console keyboard to be used.

• TAB key on the Vision.Net grids of the External Triggers window allows for navigation of cells.

Vision.Net, Submasters respond to message ID 19 (SC - Set Channel). 

ASCII Codes
ASCII Code for Vision.net Show Control Protocol.

Designer Commands ASCII RS232 Notes

Print Command Help Page HH<cr>

Start Preset SP rrr pp tt<cr>
rrr = Room (1 - 255), pp = Preset (1-32, 0 = Off), tt    Rate Index (see 

"Rate Index" on page 155)

Toggle Down TD rrr ccc<cr>
rrr = Room (1 - 255), ccc = Channel (1 - 127)

Toggle Up TU rrr ccc<cr>

Learn Preset LP rrr pp<cr> rrr = Room (1 - 255), pp = Preset (1-32, 0 = Off)

Slider Level SL rrr ccc lll<cr> rrr = Room (1 - 255), ccc = Channel (1 - 127), lll = Level (0 - 255)

Learn Submaster LS rrr ss<cr> rrr = Room (1 - 255), ss = Submaster Index (1 - 16)

Manual MN rrr ggg lll ... lll<cr>
rrr = Room (1 - 255), ggg = Grand Master Level (0 - 255)x, 

lll = Level (0 - 255)

Expander Group EG rrr ee ff lll ... lll<cr>
rrr = Room (1 - 255), ee = Expander Group (0 - 15), ff = Index of First 

Channel, lll = Level (0 - 255)

Start Raise RA rrr qqq<cr> rrr = Room (1 - 255), qqq = Coded Channel (0: Reserved, 1- 127: 
Channels 1 to 127, 128: All Channels in Room, 129 - 255: Channel 

in Preset 1 - 126, 255: Current Preset Channels)
Note: Sending a second <cr> after a RA or LW command will 

automatically send the proper ST command.

Start Lower LW rrr qqq<cr>

Stop Raise / Lower ST rrr qqq<cr>

Record Blind RB rrr pp ggg lll … lll<cr>
rrr = Room (1 - 255), pp = Preset (1-32, 0 = Off), ggg = Grand Master 

Level (0 - 255), lll = Level (0 - 255)
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Lock Button LB idd n<cr>

idd = ____________________ , n = Button / LED (1-255)
Unlock Button UB idd n<cr>

Smart On SN idd n<cr>

Smart Off SF idd n<cr>

Define Room Link DR x fff rrr ... rrr<cr>
x = Links (0: Clear All Links / 1: Do Not Clear), 
fff = First Room (1-255), rrr = Room (1 - 255)

Submaster Level SB rrr ss lll<cr>
rrr = Room (1 - 255), ss = Submaster Index (1-16),

lll = Level (0 - 255)

Take Control (sub) TC rrr ggg lll … lll<cr>
rrr = Room (1 - 255), ggg = Grand Master Level (0 - 255),

lll = Level (0 - 255)

Set Channel SC rrr ccc lll tt<cr>
rrr = Room (1 - 255), ccc = Channel (1 - 127), lll = Level (0 - 255), 

tt = Rate Index (see "Rate Index" on page 155)

Set Mode SM mm<cr> mm = Mode (0 = All Modes)

Send Mimic MC idd n a<cr>
idd = ____________________ , n = Button / LED (1-255), a = Action 

(0 / 1= Off / On or Button Up / Down for Send Mimic Command)
 (0 / 1= Button Down / Up for Console Button Command)

 (0 / 1= LED Off / On for Console LED Command)

Console Button CB idd n a<cr>

Console LED CL idd n a<cr>

Designer Commands ASCII RS232 Notes
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Rate Index
For use with codes as called out in  "ASCII Codes" on page 153.

Contact Closures
NEO's serial ports can be used as contact closures.

Once enabled by checking the box for "Enable Contact Closure", the Com Port can be configured by selecting an
available COM# from the pulldown.

For this wiring we are using the RTS (ready to send) line as the 5V source to complete the closure on the other pins.
RTS is set when the COM port is opened and should remain high.

Value Meaning

0 Instant

1 1 second

2 2 seconds

3 3 seconds

4 5 seconds

5 7 seconds

6 10 seconds

7 15 seconds

8 30 seconds

9 1 minute

10 5 minutes

11 15 minutes

12 30 minutes

13 60 minutes
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Blue = CTS (Clear to send)

Orange = Ring Indicator

Green = DSR (Data set ready)

Black = CDC (Carrier Detect)

The wiring interface can be easily build from this drawing.

Once the wiring interface is connect, just configure the appropriate contact closure shortcut so that when that contact
is closed, the configured shortcut will be triggered.

For example, use the CTS (Blue) contact and configure that to trigger SC 1 when the contact is closed by putting a 1
in the CTS Closed cell. For CTS Open to trigger SC 2, place a 2 in the CTS Open cell. Repeat for any other contact
closure circuiting that is used.

Open Sound Control (OSC)
networking sound synthesizers, computers, and other multimedia devices for purposes such as musical performance
or show control. This protocol can be used to trigger events in NEO or for NEO to trigger events on other software or
hardware.

 

The “Enable Open Sound Control (OSC) Interface” must be checked to enable this communication feature.

The default Send/Receive Ports are set to 8000/9000.

The default Send IP Address is 255.255.255.255. 

Each of the following NEO items can be enabled to send or disabled to not send.

5

4

3

2

1

9

8

7

6

GND

DTR

TxD

RxD

CD

RI

CTS

RTS

DSR

RS-232
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If these events are turned on then the event is set onto the network in an OSC message. When a submaster is changed
(for example) an OSC message is set with the address “/NEO/Submaster/{submaster number}” the data in the
message will be the submaster level.

If these events are enabled the data is sent without any further input from the user. 

If the receiving device requires a different address structure, edit it in the field provided. In the case of submasters and
shortcuts use the % as a placeholder for the shortcut or submaster number.

There is a checkbox to “Send Submaster number as first argument”. If this is turned on then the submaster message
will contain 2 data field – the submaster number and the level. If this is turned off then only the level is supplied in the
OSC message.

Incoming Message Processing

When NEO receives an OSC message on the network it will process the address field to work out what to do with it.
The following addresses are recognized by NEO and directed accordingly.

“/NEO/Submaster/#” – Set a NEO Submaster. If the argument count is 2 then the submaster number is Unassumed to
be the first argument and the number can be excluded from the Address.

“/NEO/Shortcut/#” – Fire the NEO Shortcut specified.  The Shortcut number can be specified at the end of the
Address (as shown) or as the first argument in the message.

“/NEO/CUE” – Run the cue number specified in the argument.  If the argument count is 2 then the first argument is
taken as the cue list name or the playback number. The cue number argument can be replaced with GO, BACK, STOP
or RESET.

“/NEO/Command” – Run the command specified in the argument.

To facilitate custom OSC messages, use the OSC command on the command line or in a macro. New command is:
OSC {Address} {list of parameters} e.g. OSC \CUE\GO 2.5.

Typing this command or running this in a macro will package the address and list of parameters into an OSC packet
and send it out over the Ethernet network to the address specified in the “Send address” field.

8. Scheduled Tasks

Scheduled tasks allow the user to setup recurring lighting events using the real time clock of Windows. Each task can
be scheduled to run daily, weekly, monthly, one-time only, every hour, or every X seconds. Each task executes a NEO
shortcut.

The following tasks are frequently performed when the user wants to schedule a task to run on the computer. 

NEO Items Address

Send Submaster Changes /NEO/Submaster/%d

Send Shortcut Events /NEO/Shortcut/%d

Send Cue List Events /NEO/CUE
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Create a Scheduled Task
Before a task can be scheduled to run, one or more tasks must be created. To create a new task click on the "New
Task" button at the top left of the window.

Task
• Enable/Disable Switch – to enable or disable the scheduled task. Disable or enable a scheduled task using the 

“SCHedule” command. The syntax for this is: SCHedule {schedule name/ID} PAUSE/RESUME

• ID – the Task number.

• Priority – a Priority can be set to any task. If multiple events have the same time, then the highest priority event 
would run and any lower priority even would not run. 0 is the highest priority with no practical limit on the number 
of priorities.

Action
• Shortcut – this is the item than the task will trigger when the event occurs.

• Macro – this is an alternative item where a direct command can be issued to trigger when the event occurs.

Trigger
• The trigger can be set by the Days of the week, Months of the year and Days of the month and Weeks of the month.

• Start Time can be a fixed time on a 24 hour clock or it can have the following options…
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• Sunrise – the moment when the sun breaches the horizon in the morning.

• Sunset – the moment when the sun disappears below the horizon in the 
evening.

• Sunrise / Sunset Civil - this is the brightest of the 3 twilight phases. The 
Sun is just below the horizon, so there is generally enough natural light to carry 
out most outdoor activities.

• Sunrise/Sunset Nautical - this is the second twilight phase. Both the 
horizon and the brighter stars are usually visible at this time, making it possible to 
navigate at sea.

• Sunrise/Sunset Astronomical - this is the darkest of the 3 twilight 
phases. It is the earliest stage of dawn in the morning and the last stage of dusk in 
the evening.

• Time – this is the clock hour, minutes, and seconds.  If the Start Time is set to one of the Sunrise/Sunset options, 
then the Time box switches over to Offset.

• Offset – relative time adjustment for Sunrise/Sunset options. 

• Minus - This box allows setting of a relative time to trigger the task before the selected Sunrise/Sunset option.

Additional Options
• Start Date – allows the setting of a starting calendar date.

• Clear – removes a start date.

• End Date – allows the setting of an ending calendar date.

• Clear – removes the end date.

• Delay Start up to: - will delay the startup (in seconds)

• Repeat Every: - sets a repeat time based on hours, minutes and seconds.

• Until: - defines the end of the repeat cycle.  The options are…

• Indefinitely

• Fixed Time (insert the time into the box on the right).

• Sunrise – the moment when the sun breaches the horizon in the morning.

• Sunset – the moment when the sun disappears below the horizon in the evening.

• Sunrise / Sunset Civil - this is the brightest of the 3 twilight phases. The Sun is just below the horizon, so 
there is generally enough natural light to carry out most outdoor activities.

• Sunrise/Sunset Nautical - this is the second twilight phase. Both the horizon and the brighter stars are usu-
ally visible at this time, making it possible to navigate at sea.

• Sunrise/Sunset Astronomical - this is the darkest of the 3 twilight phases. It is the earliest stage of dawn in 
the morning and the last stage of dusk in the evening.

• Include Special Days. Will add these special events to the task.

• Easter Sunday

• Good Friday

• Hanukkah

• Passover Saturday

• Ramadan End

• Ramadan Start

• Thanksgiving (US)
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• Exclude Special Days. Will remove these special events from the task.

• Easter Sunday

• Good Friday

• Hanukkah

• Passover Saturday

• Ramadan End

• Ramadan Start

• Thanksgiving (US)

Modify a Scheduled Task
Created scheduled tasks can be modified. Modify the shortcut to run, the schedule, or the specifics of a particular
task. To modify a task double click on the desired entry or click once and select properties from the option at the top
of the window.

Follow the same procedure to change any of the option or click cancel at any time to return to the task scheduler
window.

Remove a Scheduled Task
For scheduled tasks that are no longer needed, remove them entirely by selecting the corresponding row and clicking
on the delete button at the top of the window.

Temporarily Turn Off a Scheduled Task(s)
Temporarily turn off or pause scheduled tasks from running using the pause button provided. The status field will
show paused tasks. To turn a task back on simply slick on the pause button again.

In the special shortcuts (System Properties) assign a shortcut to toggle the pause state of all schedule tasks.

There is the Command Line ability to edit and control scheduled tasks. The syntax is:SCHedule {schedule name}
{shortcut} / PAUSE / RESUME / GET {Schedule}

This command is used to control the task scheduler. If for example I have a task called "End of day" then the
following commands can be used.

• SCH "End of Day" PAUSE - Stops the task from running

• SCH "End of Day" RESUME - Starts the task if its been paused

• SCH "End of Day" 12 - Sets the shortcut that the task will fire

• SCH "End of Day" GET - Will display a readable text of the schedules task. e.g. Daily at 3pm

• SCH "End of Day" 12 "Daily at 3pm" - Create or change a task called "End of day" to run shortcut 12, daily at 
3pm.
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9. User Permissions

To control access to various parts of the software, set up users and passwords from the "Edit User Permissions"
window.

Once a user has been added to the software the security feature will become active and require a login each time the
software starts. By default no users will exists in the system. An empty user list is the equivalent of turning off the
security feature.

NEO NOTES & TIPS:  The software will not allow the user to disable the "Edit Users" option if the selected user is 
the last one with this privilege.

To create a new user click on the "Add User" button in the bottom left of the window. A new line will appear in the
grid above with the default name "New User". Once the user has been added the user can edit the name, password and
define the security privileges.

Most of the security features center around allowing or denying access to the various windows within the software.
For example, to prevent a user from opening the "Cue List" window uncheck the option to the right hand panel of the
window. The "Record" privilege is a special option that can be used to prevent a user from modifying the show while
still providing access to windows like the "Show Runners" and "Channel" view.

By default a new user will have all privileges enabled. Use the "Uncheck All" to remove all access to the user. Add
access to the user as required.

Once a user is set up in the software, the security will become enabled. The next time the software starts, a username
and password will be required.

The user name will default to the last name used to login to the software and will automatically place the cursor into
the password field. Enter the password for the user and press the enter key or click "login" to proceed to the main
interface.
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• "Delete Cue" button in the sidebar is disabled if "Record" rights are removed from the user security.

• "Delete" command line instruction fails if the user does not have record rights.

Lock System - locks the console faceplate. [SHIFT] + [HELP] is the Command Line solution for locking and
unlocking the NEO console.

Open NEO Manual - Opens the NEO console user’s manual (this document).

Open NEO Quick Start Guide - Opens the NEO console Quickstart reference guide.

About NEO - Shows the about screen for copyright message.

Restart - restarts the NEO console.

Shutdown - will shut down the NEO console. Once complete, DMX is held and the power switch needs to be toggled
off to complete the shutdown process.

+
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10. Live Display

This is the traditional Live display single window for the main monitor screen. Pressing the Live Display button will
always open the Live display or bring it forward into focus.

See “Software Configuration” on page 88 for a breakdown of this screen.
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11. Blind Display

Shows the Blind (or Preview) display. The Blind display will show the data in Blind or Preview where it can be
viewed or edited one cue at a time without the need for having the cue output on stage.

Select the appropriate cue in the Side Bar Cue List or once the focus is in the Side Bar, use Up / Down Arrows to
select the desired cue. Make adjustments as necessary to the cue that is selected. When changes are complete, going
back to LIVE will stored the changes using the default recording method. (Cue Only, Tracking and so on).

"Ch Group" drop down now available for use in blind mode. Allows the user of the Ch Groups to apply groups and
Palettes while in Blind.

Pressing BLIND when already in blind mode will return the selected cue pointer to the current live cue.

[CUE] (#) [BLIND] - takes the user from Live or Blind into a specific cue in Blind. The is a great way of dealing
with looking at a cue in Blind that is not near the current cue.

[CUE] (#) [ENTER] - selects the designated cue number's instructed channels. This allows the adjusting of channels
by selecting them from the cue number rather than having to know the channel list that has instructions in the cue.

[CUE] (#) [@] (level) - selects the selected cues' channels and apply them proportionally. If channel 1 is at 30% in
cue 1 and while in Blind in another cue, type [CUE] [1] [@] [50] [ENTER] channel 1 will be applied at 15% because
15% is half of 30%.

To store the changes other than in the default tracking mode, do so via the Command Line.

[UPDATE] [TRACKING OPTIONS] and pressing as many time as needed until the proper setting appears
(depending on the default tracking mode, cycle thru Cue Only, Cue Only (Int) / Track (Atts), Track, or Trackback)
then [ENTER].

(Channel List) [@] [LIVE] [ENTER] will pull the live values into blind.

(Channel List) [@] [LIVE] [INTENSITY/POSITION/COLOR/BEAM/EDGE] [ENTER] will pull the family filtered
live values into blind. The Attribute Family selection can go on either side of the @ LIVE command so (Channel
List) [@] [LIVE] [INTENSITY/POSITION/COLOR/BEAM/EDGE] [ENTER] or 

(Channel List) [INTENSITY/POSITION/COLOR/BEAM/EDGE] [@] [LIVE] [ENTER] works.

Added the ability to set fixture/complex timing in blind mode.
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Disabled Active Selection Mode, Hi Light and Lo Light when in blind mode.

[SELECT CHANGED] + [+] in Blind will mark all selected fixtures as changed (red) but it now keeps any Palette
reference.

In Blind, (Channel List) [TIME] (#) [ENTER] will apply fixture time in Blind.

In Blind, (Channel List) [DELAY] (#) [ENTER] will apply fixture delay in Blind.

[SELECT CHANGED] + [+] now working in blind mode. On selected channels, this will mark all parameters as
adjusted. 

At the top of the Blind screen, there are options for...

• Exit Blind (Abandon) - disregard changes.

• Exit Blind Track Fwd - updates using traditional tracking.

• Exit Blind Track Back - updates and tracks the changes back up the cue list until each channel see an existing 
instruction.

• Exit Blind Cue Only - updates for this cue only.

12. Groups Display

Channel groups (Groups, Subs and Specific Palettes) are a convenient way to manipulate a number of channels and
fixtures with one control. Channel groups can operate on any number of fixture attributes and do not need to operate
on the intensity. Add channel groups into cues, thus creating stage looks that can be altered in one location and
applied across all cues.

Channel groups can also be used to aid with selecting fixtures in the channel display. By assigning a selection
shortcut the channels contained in the group can be selected or de-selected using either the shortcut or the menu
option on the channel display window.

Channel groups are most commonly associated with traditional scenes or submasters, however submasters are not
needed to use channel groups. A channel group is a snapshot of a lighting state where the output of each channel in
the group is a proportion of the group value.
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[GROUP] (#) [GROUP DISPLAY] will select and display the selected group. The [GROUP] [#] [GROUP
DISPLAY] logic will apply to attribute family modifiers. e.g. [GROUP] [POS] (#) [GROUP DISPLAY] 

Note:  When this command is used it also sets focus to the group command interface so the user can start typing 
group commands. 

To create a new blank group in blind, click on "New Group." This will create a group without any channels assigned
and all fields set with default values.

To remove a group from the system, click on the row containing the group and click on the button "Delete Group." A
dialog box will prompt the user to confirm removal of the group. Click on the "OK" button to remove the group or
"Cancel" to return to the previous window.

Special Groups (Grand Masters, Home, Hi Light and Lo Light)
These groups have special functionality.

• Grand Master Groups allow the user to determine what channels / fixtures are associated with each Grand Master.  
Just set the channels to the state desired and [RECORD] [GM1 / 2] to record to the appropriate Grand Master 
group.

• The Home Group allows the user to determine the state that the stored channels / fixtures will go to when the 
"Home" button is pressed. Just set the channels / fixtures to the state desired and press [RECORD] [HOME] 
[ENTER] to override the default Home state from the fixture library.

Note:  This will only override for the channels / fixtures that were stored in the Home group. All others will use the 
fixture library's home state.

• The Hi Light and Lo Light groups allow the user to determine the state that the stored channels / fixture will go to 
when the "Hi Light" button is pressed. Just set the channels / fixtures to the state desired and press [RECORD] [HI 
LIGHT] [ENTER] to override the default Hi Light state from the fixture library.

• Lo Light is a show only special group that allow user to determine the state the stored channels / fixture will go to 
when the Lo Light state is activated by pressing [SHIFT] + [HI LIGHT]. Just set the channels / fixtures to the state 
desired and press [RECORD] [SHIFT] + [HI LIGHT] {LO LIGHT} [ENTER] to create a Lo Light state for the 
selected fixtures in the showfile.

Note:  All special groups' data can also be adjusted without outputting live by editing the data in the Groups Display 
Details. 

Group Type
The group type is set for the palette or attribute family type that which this has been stored. The default types are...

Group - intensities only that do not reference as a palette would.

Intensity - intensities only that reference as a palette.

Position - position parameters that reference as a palette.

Color - color wheel and color mixing parameters that reference as a palette.

Beam - gobo, prism and other imaging parameters that reference as a palette.

Edge - zoom, iris, shutters and other perimeter parameters that reference as a palette.

Utility - control and other maintenance parameters that reference as a palette.

The default types can be modified per show as well as custom types can be created.

Group Number
The group number is the numerical ID of the group. 
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Group Name
The group name is a description field that provides easy identification of the group. Enter a meaningful description
for future reference.

Channels
This is a list of the channels included in the group. This list can be edited by entering the channels using Command
Line. Enter channels using the same syntax as the command window.

[1] [+] [3] [+] [9] [ENTER] will add channels 1 and 3 and 9 to the editing group.

The channels included in the group can also be edited by clicking the (...) button to the right of the field or by double
clicking on the grid cell. This will bring up the "Channel Group Details" window. This window provides greater
control over the maximum value the channel will reach when the group is at 100% and provides access to intelligent
fixture attributes.

This window has five tabs down the left hand edge that correspond to the different information to edit.

In channel groups the attributes can have an "Off" value. Cells that are in this state will also be greyed out to make
them easily identifiable. To set a value to the "Off" state simply types an O into the cell or any non-valid character.
"Off" values will be ignored when the channel group applied.

The values set in the overview and DMX tabs will determine the maximum value that the attribute will reach when
the group is at 100%. For example if a channels dimmer value is set to 50% in the channel group detail window then
when the group is at 100% the channels dimmer will be set to 50%. If the group is set to 25% then the channels value
will be set to 12.5% (25% of 50%).

Overview
The overview tab will show the attributes values as real world information. Most values will be shown as percentage
information but some values may show other data. A gobo control for example will show an image of the gobo
selected and the color controls will show the color that is currently assigned. 

This tab also provides optional time and delay for the individual channels. For attribute level timing see the "timing"
and "delay" tabs.

Each of the attribute tabs also provide helper controls that can be accessed by double clicking on the cell. For the
color cells the standard NEO color picker will appear. Once finished modifying the value, use the helper control to
click anywhere in the previous window to close it.
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DMX
The DMX tab will show all of the same information as the over view tab but all of the values will be shown as DMX
values. This provides the maximum resolution when modifying the data in the group. For example in the overview
tab the dimmer is shown as a percentage giving 100 possible values but the underlying DMX associated with the
dimmer has 255 possible values. When the percentage is changed is converted to a DMX value for storage in NEO.

Timing
To set an individual fade time for any attribute use the timing tab to enter a time value in seconds. If the value shows
"Not set" then no independent fade time exists. Any fade time set here will override the channel fade time and the
group fade time when the group value is set or the group applied.

Delay
To set an individual delay time for any attribute use the delay tab to enter a time value in seconds. If the value shows
"Not set" then no independent delay exists. Any delay set here will override the channel delay when the group value
is set or the group applied.

Channel Grid
The channel grid view displays the channels in the grid as they would appear in the channel display window. Switch
between the various view modes used in the main channel display by clicking on the "View" menu - this includes
expanded, compact and Classic views. In the same view menu, choose to display only the channels currently in the
group or all channels in the system. If all channels are shown then the ones not currently included in the group will be
display with a light grayed text.

In this view selected channels can be removed by clicking on the "Remove Selected" button and if all system
channels are shown, add selected channels using the "Add Selected" button.

Matrix
Use the matrix view to work with the channels in the group as they are laid out in the pre-defined matrix. For more
information about using this view see the section "Matrix View" in the Cue list details section.
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Add / Delete
The final tab provides convenient options for adding and removing channels from the group.

This window is divided into two halves. On the left hand side is a list of all the channels in the system. Additional
information such as purpose, positions etc are also provided to help identify channels. The right hand panel is the list
of channels that are included in the group. 

Along the bottom of this tab are the add and remove buttons.

Select the desired channels in the left hand panel to add to the channel group and click on the add button (right arrow)
at the bottom of the page.

To remove select the desired channels from the right hand panel and click on the remove button (left arrow).

Use the channel syntax box to enter channels to be added. If text is entered into this edit box it will take precedence
over the selected channels when the add button is pressed.

NEO NOTES & TIPS:  In any of the tabs, enter data into multiple cells by highlighting the cells to change and then 
type the new value. The value will only populate the first cell. Press the enter key after typing is complete to copy the 
value to all of the highlighted cells.

Channel Syntax

Remove

Add Clear Selection
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Group Display Command Line

At the bottom of the Channel Groups Detail is a Command Line entry box.

This allows the ability for the Groups display to have a Command Line separate from the Live screen Command Line
to enter channels and intensity values for editing Groups in a more theatrically traditional way. Any changes made
here are made to the data and will not output live until the next time the group data is accessed live.

Value
This is the current output state of the group and is a percentage value between 0 and 100%. By default this cell is
drawn as a graphical bar representing the value. Activating the edit control by clicking in the cell or starting to type a
value when the cell is current will cause the graphical bar to disappear and a standard edit box to appear. The cell will
return to the graphical bar once the user has completed editing. 

This value can be set directly by entering a number into the field or by selecting the row and using the mouse wheel
controls to raise or lower the value. The resulting output of each of the channels will be determined by the "max
value" for each of the attributes in the included channels

NEO NOTES & TIPS:  If a submaster is assigned, the value will directly reflect its current position and will change 
in real-time with the control.

Fade Time
The fade time (in seconds) specifies how long the system will take to go from the current value to a new value.
Whenever the "Value" field is changed the fade time will affect how long it takes to reach this new value.

The fade time can be modified by clicking in the field and changing the value directly or by clicking on the up / down
buttons to the right of the field.

A channel fade time or an attribute fade time will override any value set in this field.

Behavior
A channel group can behave in one of six ways when setting the actual output values. To change the behavior of a
group select the desired option from the drop down menu accessed by clicking on the small arrow to the right of the
field.

Override (LTP) - Also known as "Latest Takes Precedence". This is the default behavior of channel groups. This
behavior will apply the channel levels set in the group to output channels and take over control of that channel. As
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soon as something else sets the channel value the group value will get overridden. Likewise as soon as the group
value changes it will override the existing values set in the channel.

Build - The values set in the channel group will be added to the current output value of the channels.

Exclusive - values stored will be affected by this group only.

NEO NOTES & TIPS:  Using [SHIFT] + [RELEASE] to release all control will ignore all Exclusive Submasters.

Highest Takes Precedence (HTP) - When a group value is set with HTP behavior the output on the channel is
determined by what has a higher value. If the value set in the group is higher than the value in the channel then the
group will control the channel. If the value in the channel is higher than the group value it will remain unchanged.

Independent - Channels in an "Independent" group will override all other requests to modify the channel value. As
soon as the group level is above 0, channels within this group will be controlled by the group values. 

Inhibit - With an inhibit group the value masters all channels that are in the group. The output value of the channel
will be scaled by the value of the inhibit group it belongs to. 

Hue LTP - This behavior type will only work with fixtures that have color mixing capabilities. As the submaster is
raised from 0 to 100% the output generated will be a position in the HUE color space between 0 and 360 degrees.

Subtract - Similar to the "Build" behavior this option will subtract the value set by the group from the output value of
the channel and attributes.

Intensity HTP / Attributes LTP - this behavior type treats intensities Highest Takes Precedence and Attributes are
treated Last Takes Precedence.

Submaster
To assign a submaster to a channel group, enter a valid submaster number (1 - 100,000) into this field. Once entered,
the submaster will automatically be assigned and become active.

Submasters are split into pages of up to 100 possible submasters. The number of pages and the number of submaster
per page can be defined in the system properties. If the system is defined with 100 submasters per page then use the
page number as the first digit followed by the submaster to assign. To access the submasters the first page (page 0)
simply enter the number between 1 and 100. For the second page (page 1) enter submasters 101 through to 200.

NEO NOTES & TIPS:  The value of the group will not change until the next time the submaster changes. To learn 
how to use a submaster once it has been set up, see “Submaster Options" on page 155.

Selection Shortcut
The selection shortcut is a convenient way to select fixtures in the channel display by pressing a shortcut button. In
this operation only the channel numbers are used as the selection criteria. Nothing is changed in the group -
specifically the group value remains unchanged.

To assign a selection shortcut to a channel group, enter a valid shortcut number into this field. Once entered the
shortcut will automatically be assigned and become active. There are 100 shortcuts per page and 100 pages
(beginning at 0) of shortcuts. Use the page number as the first digit followed by the submaster to assign. To access the
submasters the first page (page 0) simply enter the number between 1 and 99 (note that shortcut 0 is reserved). For the
second page (page 1) enter submasters 100 through to 199.

Toggle Shortcut
A toggle shortcut can be thought of as a switch in the system that turns a lighting state on or off. When the assigned
shortcut is first pressed the channel group will be set to 100% (full) and the channels and attributes will go to their
respective values. Pressing the toggle shortcut again will cause the group to turn off (0 value).

Changing the value of the group between pressing the toggle shortcut will not change its behavior. If for example the
group is turned on by a toggle shortcut and the value to then changed to 40% clicking the toggle shortcut will cause
the group to turn off. 
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To assign a toggle shortcut to a channel group, enter a valid shortcut number into this field. Once entered the shortcut
will automatically be assigned and become active.

Apply Shortcut
Pressing an apply shortcut will apply the groups setting to the channels and fixtures using the fade time set in the
group. When using apply shortcuts the ability to set individual attributes and properties to an "Off" state is very
important. For example, if the user sets up a channel group with pan and tilt information for each fixture and have all
other attributes (dimmer, color, etc) set to off then channel groups become a position preset that can be called up at
any time. This is a useful feature for both on-the-fly control or when pre-programming shows away from the final
venue.   

To assign an apply shortcut to a channel group, enter a valid shortcut number into this field. Once entered the shortcut
will automatically be assigned and become active. 

To learn how to use a shortcut once it has been set up, see "Shortcut Options" on page 161.

Snap Attributes
This pulldown reveals three options. 

Manual - will rise and fall as a proportion of the group value when applied.

Snap off zero - attributes will snap to full when the group is activated at any level above 0.

Snap at full - attributes will snap to full when the group's activation reaches 100%.

Effects
Allows the addition of an effect to a submaster. Click on the Effect column's "..." and it will launch the effect's editor
where the desired effect(s) can be selected.

Release Check Box
This determines whether the sub maintains control over HTP behavior. For example, if the Release box is checked,
then the value controlled by the submaster will function normally and allow the fixtures output to respond HTP. With
the Release box unchecked and a submaster is brought to zero, it will hold the programmed intensities at the zero
value. This essentially gives the sub a higher priority than a another item's value.

Radio Groups
Radio Groups identify a set of groups and only allow one to be active within that set. Much like the radio buttons
worked on analogue car radios. Also like Radio Buttons on a webpage survey. Only one can be active at a time. Radio
Groups is applied to Submasters, Apply Shortcuts and Toggle Shortcuts.

Scenario: With three submasters that have the same LEDs on each of those three subs but the LEDs are in different
colors. Sub 1 has the LEDs in Magenta, Sub 2 in Blue and Sub 3 in Lavender. Then set them as part of the same Radio
Group (say 1 in this case), then you raise Sub 1 to Full. Great as all LEDs are in Magenta. Now if Sub 2 is raised to
Full, Sub 1 will go out. This ensures that even crossfading between LED colors as provided from the submasters.
Without using the Radio Group feature, the attributes will respond LTP and once two submasters are up together,
when the user goes back to touch the first one, it will jump to it's newly adjusted value (remember LTP rules) and that
is likely not desired.

Bump Action Options
1. Disabled - does not function.

2. Flash (default) - sets the submaster's value to the full value that is stored into the corresponding group for the
duration in which the button is depressed.

3. Solo - Pressing the bump button leaves the output of the submaster the same. All other (non-bumped) submasters,
as well as effects, cues and channel control, are set to zero.

4. Flash + Solo - pressing the bump button sets the sub's value to the full value that is stored into the corresponding
group for the duration in which the button is pressed. All other (non-bumped) submasters, as well as effects, cues and
channel control, are set to zero.
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5. Latch - pressing the button will set the submaster's values to full value that is stored in the corresponding group and
lock those values there until the bump button is pressed again to unlatch the command.

6. Latch + Solo - pressing the bump button shall set the sub's values to the full value that is stored into the
corresponding group and lock those values there until the bump button is pressed again to unlatch the command. All
other (non-bumped) submasters, as well as effects, cues and channel control, are set to zero.

7. Shortcut - disconnects the bump button from slider control. Allows the bump button to trigger a shortcut. The
shortcut that it triggers shall be configured in another column in the group details window.

8. Select - pressing the bump button will "select" the channels that are stored in the group.

Bump Shortcut
When the Bump Action is set to Shortcut, this is where the Shortcut number is identified.

13. Options

Displays the Options pulldown for the Groups display. 
Options 173



User’s Manual
Edit Palette Type

The Palette Types allows the customization of the attribute families for the purposes of recording specific and generic
palettes. Maybe the user wants Groups to include more than just intensity or Position to include Zoom or maybe all of
the Edge family parameters.

The table is built upon patch fixtures so if the user does not pan/tiltin the Attributes list, then there isn’t a moving light
patched. This feature allows the table to be configured for each showfile.

If the cell is green for each attribute family (determined by the column), then it is included. Grey cells are not
included. 

The top portion is called Families. If you add/delete a family, then all of the attributes of that family will be included/
excluded. 

The bottom portion is called Attributes and only affects individual attributes. If Iris is selected, then it will only add
Iris. 

Add - adds a custom attribute family.

Save - saves all adjustments.

Save as defaults - saves all changes as the default.

The default for Groups will have all attributes available. If the user is a more traditional theatrical user, it may be
more appropriate for Groups to only store intensity. If this is the case, then just turn all Attribute Family cells that are
Green to Grey under the Groups column.

Add Selected Groups to a Cue

To create a new cue or add groups to an existing cue:

1) Select the groups to add to the cue by clicking on the row to highlight it. Use the shift or control key to 
select multiple groups. 
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2) Click on the options button and from the resulting drop down menu select "Add selected groups to cue".

3) The "cue selection" dialog will pop up to select the cue into which the user wants to add the group. Set the 
"cue list" and "cue" number to add the channels to. 

4) To add a short description to the cue being created, enter this into the field provided.

5) Select "OK" to complete this operation.

NEO NOTES & TIPS:  The "cue selection" dialog will default to the last selected cue list and the next available 
(integer) cue number.

To cancel the operation and return to the channel window click on the "Cancel" button.

Add Active Groups to a Cue
This operation will work exactly as the above option with active groups (groups with a value above zero) added to the
cue rather than selected.

Snapshot When Adding Groups
Toggle the "Snapshot when adding groups" option to record the current channel state into all newly added groups.

Print Channel Groups
Click on the "Print" button to print out the channel groups in this show. 

A drop down menu can be accessed by clicking on the right of this button. The resulting menu will provide access to
a preview window and the printer setting control. 

Import / Export to CSV
The drop down menu also provides the ability to import and export the channel group list to a standard comma
separated (CSV) file format.

14. Working With Groups

The theatrical definition of a Group is a collection of channels / fixtures as a
given intensity. This allows the group to not only be used as a fixture
selection option but also allows the user to apply the group as a custom set of
levels.

Select Inactive Groups - selects all of the groups where the value is
currently 0%.

Select All - will select all groups.

Unselect All - will unselect all of the currently selected groups.

New Group - add a new empty group to be configured within the Groups
window.

Delete Group - deletes the selected group.

Group Display - Display Options

All remaining buttons are display toggle buttons.

All - will toggle on / off displaying all groups, subs and specific palettes.

Submasters - will toggle on / off displaying all groups with submaster assignments only.

Selection Shortcuts - will toggle on / off displaying all groups with selection shortcut assignments only.
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Toggle Shortcuts - will toggle on / off displaying all groups with toggle shortcut assignments only.

Apply Shortcuts - will toggle on / off displaying all groups with apply shortcut assignments only.

Group - will toggle on / off displaying all groups only.

Intensity - will toggle on / off displaying of intensity specific palettes only.

Position - will toggle on / off displaying of position specific palettes only.

Color - will toggle on / off displaying of color specific palettes only.

Beam - will toggle on / off displaying of beam specific palettes only.

Edge - will toggle on / off displaying of edge specific palettes only.

Utility - will toggle on / off displaying of utility specific palettes only.

NEO NOTES & TIPS:  Any custom palette types will show up after the screen is refreshed by closing and 
reopening.

Building an Intensity Group
Select the channels / fixtures and apply a level. [1] [THRU] [5] [@] [75] [ENTER]

Record the Group

Using one of the following methods...

1) GUI: Press the Record Group button on the Command Pulldowns section at the top of the main window. 
Enter a name. Assign a Submaster number. Allow it to assign a Shortcut number. Determine if are 
Recording Changed or Selected. Select the Attribute Families to be included. Then ENTER to complete.

2) Press and hold [RECORD] + [GROUP]. This will call up the Record Group dialogue box. (The same as 
pressing the Record Group button on the Command Pulldown.

3) Command Line: [RECORD] [GROUP] (#) [ENTER]. When [GROUP] is pressed, it will say either 
Selected/Changed/Live on the command line. This will identify that it will record either selected fixtures or 
changed values. For the other options, just press GROUP again and it will toggle to the other option. 

Applying a Group

A group can be applied two different ways....

1) Apply the Group as built. If the group has fixtures at less than full, [GROUP] (#) [FULL] will apply the 
fixtures at the stored value. In the example above, 1 thru 5 would be at 75%.

2) Select the Fixtures in the Group. To just use the group to select the fixtures and then apply an absolute value, 
type [GROUP] (#) [ENTER] [FULL]. Group # Enter will select the fixtures. Then FULL will set their level 
at full. Apply any level after the fixtures are selected.

When an intensity group is applied, the Group label is abbreviated to "G #" from "Group #".

Building a Specific Palette
Select the channels / fixtures and apply a level. [1] [THRU] [5] [@] [75] [ENTER] where 1 through 5 are moving
lights.

Now change the attributes values. For example, change pan and tilt.
176 Software Configuration



NEO Lighting Control Console
Record the Specific Palette

Using one of the following methods...

1)[RECORD] (Bump) where (Bump) is touching an open specific palette button. 
Note: First, press [SHIFT] + [PALETTE] display key and select / open the desired 
specific Palette window (Position, Color, Beam, Edge, Utility) from the pulldown. 
Once the appropriate Specific Palette window is open, just [RECORD] (Bump) to 
store to the desired palette. Then a window will pop up to add a label and change 
other properties. Make all necessary additions / adjustments and press [ENTER] to 
complete.

NEO NOTES & TIPS:  When recording Specific Palettes, the attribute filtering 
will be determined by the Palette Type filtering. This is available in the Groups display > Options > Edit Palette 
Types pulldown.

2) Press and hold [RECORD] + [GROUP]. This will call up the Record Group dialogue box. (The same as 
pressing the Record Group button on the Command Pulldown.

3) Command Line: [RECORD] [GROUP] (#) [ENTER]. When [GROUP] is pressed, it will say either 
SELECTED or CHANGED on the command line based upon the default setting in the System Properties > 
Show Defaults > Intermediate Options - Group Record Changed (Off = Selected). This indicates that it will 
record either selected fixtures or changed values. For other options, just press GROUP again and it will go 
through all available options. They are Selected, Changed or Live. 
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Stored Palette Window Options
Any stored palette within the window can be modified by hovering over the stored
palette and right clicking.

The following options appear...

• Edit Description - edit the name.

• Set Background Color - edits the color of the background.

• Reset Background Color - defaults the color of the background.

• Set Text Color - edits the color of the text.

• Reset Text Color - defaults the color of the text.

• Set Image - allows adding an image to the background.

• Set Image from Fixture - allows adding an image to the background from the 
fixture.

• Clear Image - remove the background image.

• Edit Image - change the background image.

• Move - allows the user to move the palette. Once Move is selected, the next 
click of the mouse will move to the selected location.

• Insert - move palettes down by 1

• Delete - allows removal of a palette from the active show. A confirmation dia-
logue box will follow.

• [SHIFT] + (Any Palette) - will select all channels/fixtures that have data in the 
palette and apply it. This is an excellent solution for checking focus for all fix-
tures in a given position palette.

A touch friendly display is available as the right click option when editing any palette.

NEO NOTES & TIPS:  To open the right click menu using a touch screen press and hold for 2-3 seconds. A round 
circle appear around the touched point indicating the long press function.

Applying a Specific Palette
A specific palette can be applied different ways. Usually fixtures are selected first.

1. [@] [DC] [ENTER]. Since alpha keys are needed, use the keyboard.

2. Open the "Ch Group" Command Pulldown and select DC.

3. Open the Shortcuts Window, select Page 0. Select the "4 UP" display option to divide the 100 buttons into 4 groups
of 25. These are Groups, Colors, Beam / Edge and Position.

4. [@] [POSITION] [DC] [ENTER]. use the Position key before the label info.

NEO NOTES & TIPS:  If fixtures are selected and a Specific Palette applied, then the group applies to the selected 
fixtures only. If a Specific Palette is selected from the Ch Group Command Pulldown without first having fixtures 
selected, the entire groups content will be applied to the fixtures.
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15. Cue List Display / Editor

To access the cue list editor click on the "Cue List Editor" button on the Command Line interface window or press F4
on the keyboard.

Shows consist traditionally of a list of cues each of which contains a defined lighting state and / or effect sequence. A
cue can be considered any point in a live show when a signal is given for a lighting change to take place. When a cue
is triggered, the lighting state becomes active and channels attached to the cue will be set to their preset levels.

16. Cue Lists

NEO provides the ability to create multiple cue lists to help manage and run complex shows. A "cue list" is a way to
collect a number of cues and assign a name or short description.

Examples of how cue lists can be used include;

• Separate different "Acts" within a show.

• Manage a number of shows all running in a single venue.

• Create separate shows for a number of songs likely to play in a concert or venue.

To create a new cue list click on the "Options" drop down menu and select "Create a new Cue List" from the resulting
options. A dialog will appear titled "Create New Cue List".

Enter the name of the cue list and click "OK" to continue.
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To change the name, right click on the cue list name and select "Edit Cue List Name". A dialog will appear that is
used to not only set the name nut also change the behavior of the cue list during playback.

Behavior
Each cue list can be assigned a behavior type that is used when the cue list is played back. By default this is set to
Latest Takes Precedence (LTP) however you can change this to Build, Highest Takes Precedence (HTP) or Exclusive.
LTP is also called "override" in the channel groups as the output of this behavior will override whatever the channel is
currently set to and apply the new value.

The behavior set by this option will result in playback of the cue list following the same rules as the behavior set by
channel groups. See "Behavior" on page 213 for further details.

Cue List Security
If the user has security enabled then a security option will be visible. Click on the security button to open the security
list. This is a list of users in the system with a check box indicating if that user can modify the cue list. Any user can
view and run a cue list but only those allowed can modify it. To prevent a user from viewing or running a cue list use
the security options in the main User Security window found in the Options menu of the Command Line interface.

To remove a cue list select the desired cue list from the list (Selected cue lists will be highlighted) then click on the
"Options" drop down menu and select "Remove current cue list".

A confirmation box will appear to confirm the operation. Click the "OK" button.

Active vs. Selected Cue Lists
A selected cue list is the cue list that is currently being editing. The name of the cue list is highlighted to identify that
it is selected. To select a different list simply click on the desired cue list name. The selected cue list is always the one
shown in the right hand panel of the window. 

The active cue list refers to the play controls in the bottom right of the window. The active cue list is the cue list
currently loaded into this master playback and is identified by the green triangle to the left of the name. The currently
active cue within the list is also highlighted in the same color if that cue list is showing. 
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Cue List Options Menu
As well as creating and deleting cue lists the options menu has
several other functions to make working with cue lists easier.

Edit Cue List Name
This allows the user to change the name and behavior type to the
cue list.

Create a New Cue List
This allows the user to create a new cue list.

Remove Current Cue List
Will delete the selected cue list.

Copy Current Cue List
Use this option to make a duplicate copy of the selected cue list. The
new cue list will be named "Copy of" followed by the original cue
list name. 

Blocking & Mark
Selecting the "Blocking & Mark" option in the menu will open up the submenu for globally setting the flags inside
the cue list. 

Set "Block" on all cues - This option will check all blocking flags in the selected cue list.

Un-Set "Block" on all cues - This option will un-check all blocking flags in the selected cue list.

Set "Mark" on all cues - This option will check all mark flags in the selected cue list.

Un-Set "Mark" on all cues - This option will un-check all mark flags in the selected cue list.

Note:  Must not be the active cue list.

Cue List Behavior
The cue list behavior sets defines how the cue list interacts with other parts of the software at the time of playback. By
default this is set to Latest Takes Precedence (LTP) however this can be changed to Build and Highest Takes
Precedence (HTP). LTP is also called "override" in the channel groups as the output of this behavior will override
whatever the channel is currently set to and apply the new value.

The behavior set by this option will result in playback of the cue list following the same rules as the behavior set by
channel groups. See “Behavior” on page 170.

Build will add the output from the cue list to whatever the output currently is set in the channels. HTP will only apply
the channel output from the cue list if that output is higher than what the channel is already outputting.

To set the behavior for the cue list select it from the sub menu from this option. The behavior will apply to all cues in
the cue list and across all playbacks that are using this cue list.

Open Tracking Sheet
The tracking sheet is a convenient way to view how channels are changing between cues.
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[SHIFT] + [F4] will open the track sheet.

The view consists of a channels vs. cue grid. The channels used in the entire cue list are listed in each row while the
cues travel across the columns of the grid as above.

If there are intelligent fixtures recorded into cue a small "+" sign will be visisble at the start of the row. This indicates
that there is more information about the channel available. When clicking on the "+" symbol the rows will expand to
show all of the attributes for that fixture and which values are set for each cue. After clicking on this the "+" will
become a "-" and can be used to collapse the view back down to the dimmer only.

The "Collapse All" and "Expand All" buttons at the bottom of the window can be used to open and close all if the
intelligent fixtures listed.

The "Channel Range" edit box can be used to enter a range of channels that will filter the view. Use the standard
channel select syntax to filter the channels shown. 

For example, 1 / 20-7 this will show only channels 1 thought to 20 except 7.

Check the "Show tracked values" to view what the channels will be in each cue if full tracking is turned on in the
system properties.

Use the "Show unused channels when range set" to view all of the channels regardless of if they are used by the cue
list. By default the track sheet will only display the channels that are used in the cue list to help minimize the
information presented. This however limits the ability to add channels that are not used. By trying this option on and
applying a "Channel range" a channel can be added to the cue list by simply entering a value into the appropriate
column.

Printing & Exporting - Pressing the print button will print the track sheet to the selected printer. Use the drop down
menu to the right of this button to change the print settings or preview the output. An Export option will save the
contents of the track sheet to a comma separated file format (CSV).

Find - allows the user to search for a channel number.

Channel Range - limits Tracksheet to display for channels in the range selected.

Show tracked values - When checked, redundant values will show, when unchecked, only changed values will
appear.

Show unused channels when range set will occur when the box is checked. When the box is not checked, the range
will only show used channels.
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Open Visual Timecode Editor
To make working with timecoded shows NEO provides an advanced visual editor. For each timecoded section of the
cue list can be viewed as an audio waveform with each timecode point represented by a line in the display.

To use this window select any cue that contains a media track. A "working…" dialog will appear while the software
builds the waveform display. Once this has been displayed it will only be regenerated if a different media track is
selected.

NEO will automatically calculate the first and last cue for this section of the show based on the media track. The first
cue that contains this media is shown on the right hand panel as with the last cue with this media.

The "Next Cue" and "Prev Cue" buttons can be used to traverse through the cue list or use the keyboard shortcut of
ALT-P and ALT-N.

For each of the cues in the range selected a gray line will be shown representing each of the timecode points. Note
that these will only show if the trigger is set to "Timecode".

At any time , play the media using the playback buttons at the top of the right hand panel.

Once the media is playing you can pause the track and move the play head by using the mouse to click and drag the
yellow line. As you move the line the audio is herd so that you can precisely work out the correct point to place a
timecode point.

To move a timecode point visually select the corresponding cue you want to edit. The line representing this cue will
be highlighted in green and can be dragged using your mouse left and right along the timeline. As the position of the
line changes the timecode value shown in the grid will also change.

To insert a new timecode point right click on the position in the waveform display and select "Insert new cue here"
from the resulting popup menu.
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Report
Channels Used In Cues - shows a list of cues and the channels stored in them.

Palettes / Groups Used In Cues - shows a list of Palette and then Groups with the cues that reference them.

Use Primary Playback
Check this option if you want that master playback on the external playback wing to be used to control the master cue
list playback.

You can also access this using a programmable keyboard in the same way as shortcuts. The key sequence to run this
special playback:

• Cue Go: control - q followed by "A1"

• Cue Back: control - q followed by "Z1"

Safety Playback Mode
Safety playback mode is designed to prevent accidental triggering of cues during your show. When this option is
checked the "GO" button will not immediately execute the next cue when an existing cue is running or the cue is set
to follow on.

If the previous cue is still running or the next cue is setup to be a follow on cue the "GO" button will be re-labeled
"Enable". Clicking on the "Enable" will change it to "GO" and a second press will force the cue to be executed. 

This mode ensures that the button must be pressed twice if the use wants to skip over the normal execution rate
programmed.
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Keyboard Playback Options
Use the submenu under this option to turn on various keyboard options for running cues.

Use "Space bar" for cue go - With this option on pressing the space bar on your keyboard will execute a cue go.
This will only work if the cue list window is currently active. 

Use numeric "Enter" for cue go - With this option on pressing the enter key on the numeric section of your
keyboard will execute a cue go. This will work globally to the software - it does not matter what window is active for
cue execution.

Use numeric "+ / -" for cue go / back - With this option on pressing the plus (+) or minus (-) key on the numeric
section of your keyboard will execute a cue go and a cue back. This will work globally to the software - it does not
matter what window is active for cue execution.

Use right "ALT" for cue go - With this option on pressing the right ALT key on the keyboard will execute a cue go.
This will work globally to the software - it does not matter what window is active for cue execution.

Selected Cue to Follow Current Cue
This option is useful if you have the cue list channel detail window open or docked to the cue list. As the cue list is
advanced the current selected cue will automatically follow the cue currently active on stage. The channel detail,
effects and groups window will automatically advance to show the information for that cue.

Cue Go to Always Apply to the Current Cue List
When this option is enabled pressing the GO button will always run the current cue list even if the current cue list is
not the active cue list. The active cue list will automatically be switched to the current cue list.

Edit Cue Channels Live
With this option turned on any changes made to the channels in the current live cue will automatically be reflected on
stage. With this option turned off (default) the cue list channel detail window is a blind editor meaning that changes
are not seen until the next time the cue runs.

Record Current Channel State When Adding Cues
Check this option to record the currently active channels in to the cue when a new cue is added from the button on
this window.

Show / Hide Search Bar
Check this item to turn on or off the search bar at the bottom of the cue list.

Print
The print option will output the currently selected cue list to the selected printer.

Print Preview
Select the preview option to open a window that will display the printed page. From this window you can choose to
print.

Printing Settings
This option will open the page setting for printing the cue list.

Export To CSV File
This feature will export the cue list data to a CSV formatted file.

Export to CSD (CUESERVER) File
This feature will export the cue list data to a CSD (CueServer) file format.
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NEO NOTES & TIPS:  Point cues cannot be exported to a CSD file. Use the option in the cue menu to renumber as 
whole cues before proceeding with export.

Reset Grid Layout to Default
If you have resized or moved columns in the cue list grid you can restore the default positions and size by selecting
this option.

Visible Columns
Selecting the "Visible Columns" option in the menu will open up the submenu that will list all
of the columns in the cue list window. Select each one to turn the column on or off in the grid.

Cue List
The "cue list" is a series of cues each numbered between 0.000 and 999999.999. The cue
number determines the default order that cue will be run; however, the strict order is
determined by the "next cue" field. 

To create a new cue:

1) Click the "Add Cue" button below the cue list editor.

2) The newly created cue will be added to the end of the list with a cue number one 
integer value above the last cue e.g., if the last cue number was 2.35 then the newly 
created cue will be 3.00.

3) NEO will assign the "next cue" field to the first cue, thus creating a show that will 
automatically wrap around. As the new cue is the last one in the sequence, NEO will 
also change the previous cue and set its "next cue" value to the newly created cue.

NEO NOTES & TIPS:  Double clicking on a cue will automatically make it the currently 
active cue and make this cue list the currently active cue list. If a cue within this cue list is 
active then it will appear highlighted light green.

To remove a cue:

1) Select the cue from the cue list.

2) Click on the "Delete Cue" button.

3) A confirmation dialog will prompt you to confirm this operation.
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Cue Options

To assist with many tedious tasks the "Cue Options" drop down menu provides several convenient options related to
creating and managing cues. 

Copy Selected Cue (Added to the End of the Cue List)
Selecting this will create a new cue at the end of the cue list. The cue number will be the next available integer value.
All of the properties of the current cue (channels, trigger, etc) will be copied from the cue at the position of your
mouse.

Copy Selected Cue to Another Cue List

Selecting this will create a new cue to the selected cue list. The shown dialogue box appears to give you options.

Insert a New Blank Cue Below
This option will create a new cue directly below the cue at the position of you mouse. The cue number will be exactly
half way between this cue and the next. The properties of the cue will be set to the system defaults.

Insert a New Cue Above (Copy This Cue)
This option will create a new cue above the current cue. The cue number will be half way between the previous cue
and the current cue. All of the properties (channels, trigger, etc) will be copied from the current cue to the new cue.
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Insert a New Cue Below (Copy This Cue)
This option will create a new cue below the current cue. The cue number will be half way between the new cue and
the current cue. All of the properties (channels, trigger, etc) will be copied from the current cue to the new cue.

Insert a Scene Break Below This Cue
A scene break is a description only row that can be added to your cue list to help remember what is happening at this
point in the cue list. Scene breaks are not cues and do not execute any lighting operation. It is a convenient way to
label your cue list at key points and assist with cue list management.

After selecting this option the software will prompt you for the name of the scene you want to label. Enter the name
or description into the edit box provided and click "OK" to add the screen break. In the example below a scene break
has been added below cue 6.5.

Undo
Use the undo function (alternatively you can use control-z) to undo the last change made to the cue list. In the case of
the cue list channel detail window the undo command will revert back to the channel state when the cue was selected.

Open Cue Update History
The cue update history is a powerful system that remembers every state that has ever been recorded for this cue.
Whenever a cue is updated or changed the cue update history is added to. You can then use this window to try and
revert to a previous cue state. 
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When a cue is reverted to a previous state the current state is also added to the history table so that no state is ever
lost.

Use the preview button to apply on stage what the cue looked like at the specified date and time. Click on the apply
button to set the state of the current cue to what it was at the selected date and time.

Toggle Blocking on the Selected Cues
When running in full tracking mode you can set an entire cue to be a block cue. A block cue will use the cue as the
absolute state that is expected. If a channel does not exist in the cue then it will be turned off. Use this option to toggle
the "block" flag for the cues that are currently selected.

Block Cue
This will open up the submenu for globally setting the flags on all fixtures inside the selected cue. 

Set "Block" on all cues - This option will check all blocking flags in the selected cue.

Un-Set "Block" on all cues - This option will un-check all blocking flags in the selected cue.

Mark Cue
Set "Mark" on all cues - This option will check all mark flags in the selected cue.

Un-Set "Mark" on all cues - This option will un-check all mark flags in the selected cue.

Set Trigger (Selected Cues)
To modify the trigger setting of multiple cues select the rows you want to change, right click and select the trigger
from the sub menu. You can select the rows by clicking on the very left of the row where the current row indicator is
shown. Hold the control and shift keys while clicking with the left mouse button to select more than one row.

If you have the "trigger" column selected then this menu option will apply to every cue in the current cue list.

Timestamp on Cue Go
Turn this option on to learn the timecode for a show by running it in real time. Every time the "Go" button is pressed
in the playback controls the timecode will be record for the next cue with no timecode recorded.

Timestamp on Doubleclick Timecode Field
Turn this option on to learn the timecode when you double click on the timecode field.

Lock 1st Column
This locks the first column from editing.

Lock Row Height
This locks all row heights.
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Cleanup "Next Cue" Numbering from this Point
If you have got the "next cue" column out of sequence you can easily return it to the default sate (next cue always
follows the cue number) by selecting this option. The cleanup will happen from the currently selected cue down. To
clean up the entire cue list select the first cue before selecting this option.

Re-Number as Whole Cues from this Point
If have a lot of point cues in the cue list from inserting cues or rearranging the order of the cue you can use this option
to quick re-number. After this operation every cue will be a whole number with no decimal part to it. 

The re-number will happen from the currently selected cue down. To re-number the entire cue list select the first cue
before selecting this option.

Timestamp Next Non-Zero Cue
When working with timecodes it is often useful or convenient to create your cue list without any timecode values
loaded. Once you have created the cue list you must then go back and assign timecode values manually.

To aid with this operation NEO provides the ability to timestamp cues with the last read timecode. Once you have
created the cue list you can then play back the timecode track and stamp each cue in real time. Because using the right
click menu is not a quick enough operation when playing back media in real time a shortcut (control - t) is also
provided. Playback the timecode track and press the control-t to stamp the next non zero cue at the appropriate times.

Clear Notes for the Selected Cue
Use this option to empty the cue notes field for the selected cues.

Reset All Effects in the Selected Cue
The reset effects option is used during playback of the cue list. If the cue contains effects you can manually stop the
effect execution without stopping the cue using this option.

Force Resave of this Cue List
Use this option to force a resave of this cue list.

Visualizer Preview Options
This sub menu can be used to view the state of a cue in the attached visualizer without having to run it live.

Preview this cue in visualizer - Select this option and the currently selected cue will be shown in the visualizer
output. The live output will be blocked until you release it.

Release visualizer preview - Use this release option to return control of the visualizer back to the live output. 

Always preview the next cue in the visualizer - This options can be toggled on or off. If this option is on and a cue
is run the next cue will be shown in the visualizer and the live output will be blocked until this option is turned off or
the release option is selected.

Run Cue
To the right of the cue options menu is the run cue button. The
function of this button will change depending on the setting.
Options are…

Run Cue - triggers cue to run in recorded time.

Goto Cue - triggers cue using the default Goto time. Goto time is
set in System Properties>Show Defaults.

This button performs the same operation as double clicking on the
"status" field of the cue list. It also provides an easy indication of
what double clicking on a cue will do.

Add Cue
Adds a cue at the end of the cue list.
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Delete Cue
Deletes the currently selected cue. There is an option here to delete the cue Cue Only. Otherwise, the cue will be
deleted Tracking.

Cue Controls
On screen cue controls are available in the Cue List display.

GO - triggers the cue to run in the recorded time.

STOP - will pause the running cue.

BACK - will return to the previous cue.

RESET - will reset to the top of the cue list.

Cue Number
The cue number represents the order that the cues appear in the list and by default, it also determines the run order of
the show. Cue numbers can be set to any number you want by clicking within the field and typing the new value.

Cue numbers must be between 0.000 and 4294966.999. When editing cues it is not necessary to enter the decimal
number if all you want is an integer value.

NEO NOTES & TIPS:  NEO will automatically re-order the cue list as soon as you exit the field and thus save the 
new value. The "next cue" value will not be changed if you edit the cue number so you must manually ensure that the 
show follows the desired sequence.

The most common use for editing the cue number is to insert a new cue between two existing cues. To do this, change
the cue number to a valid number between the two cues.

Example…

To insert a new cue between cues 2 and 3 we would create a new cue and change its number to 2.5. To ensure that the
show follows the sequence 2, 2.5, 3 we would need to change the "next cue" number of cue 2 to 2.5 and the "next
cue" of 2.5 to 3.

NEO NOTES & TIPS:  Changing the cue number can also be used to park a cue for use later. To do this, simply 
change the cue number to a high value and ensure that none of the other cues have the "next cue" set to this value.

Description
This field is for your own reference and provides the ability to describe the lighting state contained in the cue. By
default, this description contains the cue number. This can be changed by clicking within the field and entering the
new description.

Channels
This is a list of the channels included in the cue. This list can be edited by entering the channels separated by a coma
(,) or a space. To edit, click inside the field and type the desired channel list or edit using left and right arrow keys.
You can also enter channels using the same syntax as the command window.

Examples:

[1] [+] [3] [+] [4] [+] [1] [0] [/] [2] [0] [-] [1] [5] [ENTER]

This will add channels 1, 3, 4 and channels 10 through to 20 excluding 15 to the cue.

[1] [/] [1] [0] [-] [5] [@] [2] [ENTER]

This will add channels 1 through to 10 excluding 5 into the cue and set the level to 20%.

The channels included in the cue can also be edited by clicking on the (...) button to the right of the field or by double
clicking on the grid cell. This will bring up the "Cue List Detail" window. This window provides greater control over
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the maximum value the channel will reach when the cue is executed, and provides access to intelligent fixture
attributes.

From version 2.9 onward the "Cue List Detail" window will default open and docked to the bottom of the cue list
window. You can undock it at any time by clicking and dragging the bar (below the x) running down the left of the
panel.

This window has seven tabs down the left hand edge that correspond to the different information you may want to
edit.

If a channel does not have an attribute for a displayed column the cell will be greyed out and cannot be edited. An "n
/ a" will also appear in the cell.

The values set in the overview and DMX tabs will determine the value that the attribute will reach when the cue is
executed. 

Tricks for Editing Multiple Cells at Once
This window provides a few hidden techniques to make entering large amounts of information easier.

The first step to using these features is to select multiple cells at once. By holding down the mouse button you can
click and drag over any number of cells in the grid and all of the cells will become selected. You can select multiple
cells but selecting the first one and then holding the shift key down and selecting the last one. You can select multiple
cells in any number of columns however it may not make sense to edit some columns together.

Once you have selected the cells you want to edit enter a value into the first cell and press the enter key. As soon as
you are done all of the highlighted cells will receive the value you have entered.

Time and Delay fields - The time and delay columns will also accept the same technique for entering values into
multiple cells. These fields however also support additional syntax for spread timing. You can enter a range of times
using the / as a through command.

Examples:

1 / 10 - This will put time values into the selected cells spreading them between 1 and 10 seconds. The first cell will
receive 1 second and the last cell 10 seconds. Every other cell will receive a value between 1 and 10second depending
on their position.

2 / 15 / 3 - This is similar to the above example but the middle value will be placed into the middle cell of the selected
range. So that the first cell will receive 2 seconds the middle cell will receive 15 seconds and the last cell 3 seconds.
All other cells will receive a proportion of the range entered.

r 10 - the "R" is a special modifier that means "random". Using the r in front of the value means that the result will be
a random number between 0 and 10. All of the selected cells will receive a different random number.

Overview
The overview tab will show the attributes values as real world information. Most values will be shown as percentage
information but some values may show other data. A gobo control for example will show an image of the gobo
selected and the color controls will show the color that is currently assigned. 

This tab also provides optional time and delay for the individual 1 / channels. For attribute level timing see the
"timing" and "delay" tabs.

Block - Check the "Block" check box to force this channel to not follow tracking instructions. All of the values set in
the cue will be applied to the live output regardless of the previous cue execution.
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Mark - A marked cue will execute most of its attributes in the previous cue if the channel does not exist in that cue. It
uses the fade in and dwell time of the previous cue as the time the fixtures will change. You can also override this
operation by setting a non-zero value into the "default mark time" found in the "System Properties."

Each of the attribute cells also provide helper controls that can be accessed by double clicking on the cell. For the
color cells the standard NEO color picker will appear. Once you have finished modifying the value with the helper
control click anywhere in the previous window to close it.

DMX
The DMX tab will show all of the same information as the overview tab but all of the values will be shown as DMX
values. This provides the maximum resolution when modifying the data in the cue. For example in the overview tab
the dimmer is shown as a percentage giving 100 possible values but the underlying DMX associated with the dimmer
has 255 (or in some cases 65535) possible values. When the percentage is changed is converted to a DMX value for
storage in NEO.

Timing
To set an individual fade time for any attribute use the timing tab to enter a time value in seconds. If the value shows
"Not set" then no independent fade time exists. Any fade time set here will override the channel fade time and the cue
timing.

Delay
To set an individual delay time for any attribute use the delay tab to enter a time value in seconds. If the value shows
"Not set" then no independent delay exists. Any delay set here will override the channel delay when the cue timing.

Profile
The profiles tab is reserved for a future version of NEO. This feature is not currently supported in this version. 

CH Grid
The channel grid view will show the channels in a similar view to the channel display window. Editing channels in
this view is similar to the channel display. You can select the channels using the mouse and control the dimmer value
with the scroll wheel.

The view menu can be used to change the way each channel is displayed. See “Channel Grid” on page 168 for
information on the different view styles.
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In the view menu you can toggle between showing only the channels that are recorded into the cue and showing all of
the channels in the system using the "Show only channels included in this cue". If this option is turned off the
channels not recorded into the cue will be displayed in a light gray. With this mode turned on you can use the "Add
Selected" button to add channels into the cue. 

Use the "Remove Selected" button to remove channels from the cue.

Palettes
Palettes are a powerful way to manage fixture data in a large show. We can think of palettes as references to other
objects that have already been programmed in the software. The best example of the usefulness of palettes is position
palettes. Position palettes are a list of pan and tilt positions for each fixture in the show. When we record a cue we
could set a fixture to a specific position on stage and record the value to the cue. However if at a later time the
position gets moved someplace else we need to go through the cue list to find all of the places that the position was
used. 

Instead we could record that position into a position palette at the beginning and instead to recording the same
position into the cue we would reference the position palette we have just made. If the physical position changes at a
later time all we need to update the position palette and all of the cues that reference that information will be updated
automatically.

This is only one simple example of using palettes as reference values in a cue, we could do the same thing with color,
gobos, focus etc.

In NEO there is two types of palette references that can be used in a cue. 

A specific palette can be used in cases where each fixture in the reference needs to have a different value. The
position palette group above is an example of this as every fixture although pointing at the same spot on stage may
have slightly different pan and tilt values.

A generic palette is used in cases where we want to apply an abstract value to an attribute. Color is an example of this
type of reference as NEO is capable of working out how to set the color on a fixture regardless of its type or place in
the rig.

NEO NOTES & TIPS:  When an attribute has a palette reference assigned to it the value displayed in the overview 
and DMX tabs will show in red. The software still remembers the "hard" values that were recorded but is indicating 
that the values shown are not going to be used unless the palette reference is removed.

Matrix
A cue can also be viewed as a pre-defined matrix and edited in a painting style. See “Generic Palettes, Specific
Palettes, and Virtual Palettes” on page 231 for more information.

Fixture Detail - Matrix view
Select the matrix you want to view the cue as using the drop down box at the top left of the window. The Matrix tab
shown above will appear if any matrices have been defined in the software. The two dimensional grid will show a
representation of the matrix definition. You can then paint to the matrix by selecting the pen color and then clicking
anywhere in the grid. Use the "Load from Image" button to map any bitmap or jpeg onto the matrix. 
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If the channels connected to the matrix cell do not exist in the cue they will be automatically added as soon as you
paint to it and the appropriate color will be set. If the channel already exists in the cue then its color will be changed
to reflect the painted color.

Additional controls allow you to tweak the brightness, red, green or blue content of the matrix.

Add / Delete
The final tab provides convenient options for adding and removing channels from the cue.

This window is divided into two halves. On the left hand side is a list of all the channels in the system. Additional
information such as purpose, positions etc are also provided to help identify channels. The right hand panel is the list
of channels that are included in the cue. 

Along the bottom of this tab are the "add" and "remove" buttons.

Select the desired channels in the left hand panel to add to the cue and click on the add button (right arrow) at the
bottom of the page.

To remove select the desired channels from the right hand panel and click on the remove button (left arrow).

You can also use the channel syntax box to enter channels to be added. If text is entered into this edit box it will take
precedence over the selected channels when the add button is pressed.

NEO NOTES & TIPS:  In any of the tabs you can enter data into multiple cells by highlighting the cells you want to 
change and then typing the new value. As you type the value will only populate the first cell. Pressing the enter key 
after you have finished typing will copy the value to all of the highlighted cells.

Trigger
The cue trigger specifies what causes the cue to execute. By default, this is set to "Cue" indicating that the software is
waiting for the "Cue Go" button to be pressed. The previous cue will remain active until the trigger is activated.

To set the cue trigger, click the drop down combo button to the right of the field and select from the following
options;

Cue Go - The user must physically press a "Cue Go" button either in a show runner or on the show editor window.

Auto (Follow) - Cues set with the auto trigger will execute immediately after the previous cue has completed its
delay, fade in, and dwell time. An auto cue will not wait for the fade out time so that cross fades can be achieved.

MIDI - The cue will be triggered by an external midi event occurring. See page 134 for information on how to set up
MIDI triggers.

Channel Syntax

Remove

Add Clear Selection
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Line In - The cue will be triggered by the line-in audio source. 

Timecode - The cue will trigger when the specified timecode is reached. If the timecode has already passed when this
cue is reached the software will trigger the cue immediately. Enter the timecode value into the field provided.

Effects (FX)
Effect sequences are an automated sequence of lighting states that run without user interaction. For more information
and detail on how to create effects, see "FX List (Effects Editor)" on page 200. A simple effect may be a traditional
chase sequence or a more complex effect may perform a series of moving light changes.

Often when a cue is executed, it is desirable to run an automatic sequence until the next cue is triggered. NEO allows
you to add any number of effects and chases into any cue.

On the left of this window is the list of available effects in the system. If you have a large list of Fx's you can filter
what is shown by clicking on the effect type tab on the left of the window or by selecting a filter from the combo box
at the top of the list.

The effect window tabs will also filter what included effects are shown in the right hand panel.

To add all of the effects from the previous cue click on the button in the top right of the window labeled "Add FX's
from previous cue".

To add an effect to the cue, select the desired effect from the available list and click the "Add to cue" button at the
bottom of the effects list. To remove an effect from the cue click on the "Remove" button at the far right of the effect
row. You may need to scroll the grid to the right for the button to be visible.

The "Delay" field allows you to set a time for the system to wait before starting the effect after the cue executes.

"Fade In" and "Fade Out" 

These options allow you to set a different fade in and out time for each effect. This will only apply to the dimmer if it
is used in the effect. Some effects do not use the dimmer at all and on this type of effect the fade in and out will not do
anything.

When the cue exits (i.e., the next cue is triggered), all effects will be terminated.

Available Effects Included in Cue
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Timeline, Profile, and Matrix Effects
Select the "Loop" check box so that the effect will play continuously while the cue remains current. If this is un-
checked, the effect will play once and then stop.

All effects have a default length when the effect is created. To override this default time, set the "Override length"
field to the desired value. The effect will automatically be rescaled to run within the specified time.

The "Stagger Direction" option is only used for property / attribute effects and set the way the stagger is setup. 

Simple Chases
The "Direction" field specifies how the chase steps will play. Select from forward, backwards, bounce, or random
from the drop down.

The "Run times" field allows you to specify how many times through the chase will run before stopping.

"Step time" and "Fade time" is provided to override the default values when running the chase in a cue. Set the step
time to 0 to run the chase manually using a step shortcut.

Setting the "Step Shortcut" will allowing you to manually step the chase. This shortcut will be loaded when the cue
enters and removed when the cue exits. This allows you to use the same shortcut in several cues.

"Fade" and "Step Submasters" are also loaded when the cue enters and unassigned when the cue exits. This allows
you to setup a submaster to manually control the fade transition and step time while the chase is running.

Cue List Shortcuts
Each cue can also execute any number of shortcuts when the cue runs. This allows you to run more complex
operations such as executing macros, selecting channels, or jumping to another cue list.

Shortcuts can be added by simple typing a comma (,) delimited list of shortcuts. Alternatively you can click on the
button ( ) to the right of the field or double click to bring up the edit window for "Cue List Shortcuts".

To add a new shortcut using the "Cue List Shortcut" window click on the "Add" button in the first cell of the last
row in the grid. A new line will appear in the grid and the "Add" button will move down one row. 

Use the remove buttons on the right of the grid to delete an entry form the grid.

In this window you can also specify a delay before running the shortcut. The system will then wait for the specified
time before the shortcut executes.

To run the shortcut on a recurring bases enter a time between execution in the "Fire every" field.

To run the shortcut when the cue exits, tick the check box in the column "Fire on leaving"

Channel Groups
By adding channel groups to a cue you can setup "stage looks" that can be edited in one place and applied to any
number of cues. The channel groups become building blocks for the show and can make programming the entire
show a lot faster by reusing common "stage looks".
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Channel groups can be added by clicking on the button ( ) to the right of the field or double clicking to bring up the
edit window for "Cue List Channel Groups".

You can add any number of channel groups to a cue. To add a channel group to the cue, select the desired group from
the available list and click the "Add to cue" button. To remove a group from the cue click on the "Remove" button to
the right of the row you no longer want in the cue.

Inc Channels Only - This option can be used to set the behavior of channel groups in relation to the channels added
to the cue itself. If this option is turned on then the channels in the group will not be applied unless they also exist in
the cue. For example, if you have a position preset group with 10 fixtures in it you may want to use only a subset of
these fixtures in a cue. To achieve this you would add the subset of channels into the cue normally and also add the
group into the cue.

Dimmer % - Set the dimmer percentage when using channel groups as scenes that you want to add into the cue. You
can use this option to have the same group in many cues but with different weighting on the dimmer.

Follow Time
If the cue is set to "Auto" trigger then by default the cue will execute after the delay, fade in and dwell times have
occurs. If the follow time is set then this will override the length of time before the cue executes.

Cue Delay
To specify a delay before the cue will execute, enter a valid time (in seconds) into this field. Internally a cue has
finished just before the fade out executes to allow for cross fades between two cues. The delay can be used to stop this
behavior by setting its delay time to the previous cue's fade out time.

Cue Time
The fade out field determines the time (in seconds) that the cue takes for each channel to go from the value contained
in the cue to the value contained in the next cue. If the channel is not contained in the next cue then it will fade to 0.
The fade time will apply to all fixture properties that are set within the cue.

If running the software in fade up / down mode then this value will determine the time taken for channels and
attributes that are decreasing in value.

NEO NOTES & TIPS:  An override fade time for individual channels can be set in the Cue List Details window on 
the "Timing" on page 168.

FX Delay
To specify a global delay before effects are started enter a valid time (in seconds) into this field.

Timecode
When timecode triggers are being used, this field will specify the timecode value that the software will wait for. See
“Timecode” on page 149 for more information.
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Link (Looping)
The Link field indicates what cue will run next and can be used to change the order that cues run.

In addition to this the user can specify the number of times that a loop will occur and also what cue will be executed
when the loop ends or the cue GO is executed.

For example a cue can loop back to a previous cue and loop a specific number of times and then execute a different
cue when finished. If the cue GO is pressed at any time though this loop then the exit cue will be run. If no loop count
is specified then the system will loop indefinitely however pressing the GO will exit the loop to the specified exit cue.

To set the loop information enter the details with the following syntax…

Cue number to loop to, Number of times to loop, Exit Cue Number

Example…

Notes
Use the cue notes to record any additional information about the cue that might be useful later. This is a free form
field that can hold almost any amount of data. The user could for example use the notes field to store the script pages
associated with the cue.

Double click on the notes field to open the "Cue Notes Editor". This form is a very simple text editor that allows
changing text fonts, setting alignment, copying and pasting.

In the top menu of the Cue notes editor are options to move to the next or previous cue. As options are selected the
cue notes will change to show the notes corresponding to the selected cue.

Playback Options
When a cue is executes NEO will display the cue notes in a non-editing window. The playback options at the top of
the window can be used to set other features during cue execution.

Send Notes to Telnet Sessions - If this option is on then when a cue executes the notes will be sent to all telnet clients
that are currently connected.

Read cue notes on execute - Using the build in speech engine of windows the software will read the text in a
computer voice out the standard audio port of the computer.

4,10,8 Loop to cue 4, 10 times and exit to cue 8

4,0,23 Loop to cue 4, loop indefinitely and exit to cue 23 when the GO button is pressed
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Clear display if cue notes are blank - If this option is off then the last notes displayed will remain on screen until the
next cue with valid notes is executes. With this option on the cue notes screen will be cleared.

Preview notes for the next cue on execute - With this option on the playback of cue notes will always be one cue
ahead of the current cue.

Automatically close when empty - if a note has no data, then it will automatically close and not remain open.

Testing a Show
The "Cue List Editor" window provides convenient controls to allows running and testing a show. The four controls
are the same as each of the cue list playbacks and operate exactly the same way. If the show only one cue list there is
no reason to use any of the additional playbacks and can run the entire show from the cue list editor window. See
“Cue Playbacks” on page 263 for more information.

Cue Go
This will execute the next cue in the active cue list. If there is no current cue active the "cue go" button will execute
the first cue in the list. As soon as this button is pressed, the cue will start and a cue progress will be displayed in the
status field of the cue

NEO NOTES & TIPS:  If the cue is triggered by some external event, such as a timecode, then the "cue go" will 
override this and execute the cue immediately.

Cue Stop
This will stop the execution of the cue immediately. Any fades or waits will terminate and the current lighting state
will be maintained. The will also stop the next cue from being executed regardless of its trigger.

Cue Back
The "cue back" button will execute the previous cue (the cue whose "next cue" value is the current cue) and terminate
the current cue.

Cue Reset
"Cue Reset" resets the entire cue list and sets the current cue to nothing. Pressing the "cue go" after a reset will cause
the first cue to start. Resetting the cue can be thought of as a "rewind to beginning" function. This will also release all
of the channel from cue control.

17. FX List (Effects Editor)

An effect sequence is an automated sequence of lighting states that typically runs
without user interaction. There are seven types of effects supported in this version of

NEO. 

Simple Chase - Simple chases, contains a number of lighting states and are similar to a
basic cues list.

Timeline - This effect contains a list of fixtures each assigned a number of timed segments. All effects have a default
length of time (in seconds) that they will run for.

Attribute / Profile - This effect allows assignment of a profile path to specific attributes of the fixture. As the effect
runs over a set time the attribute follows the defined profile path.

Cue List Editor controls for testing a show
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Matrix / LED - Specifically designed for use with LED or grid lighting this effect provides an easy way to deal with
a large number of lights.

Paint Box - To apply color FX across a number of LED fixtures utilizing an unlimited color path. 

Media Playback - To playback media files, flash animations, or control a DV desk.

DMX Input Recorder - The DMX recorder will use the DMX input system of NEO to record a continuous stream of
data that can be played back at any time.

To access the effects editor, click the "Effects Editor" button on the Command Line interface window or press the F5
key on the keyboard.

Effect Filters
NEO provides the ability to set filters with every effect to make managing a large number of effects easier. Double
click on any of the effects to edit the list of filters that describe this effect. For example a moving light effect that does
a circle might be given the filters - Movement, Intelligent Lights, Rear truss.

Use the combo box at the top of the effects list to select the filter to apply. The effects list will now only show effects
that match these criteria.

The tabs on the left of the window can also be used to only show effects of a particular type. By default all of the
effects are shown but if only media effects are desired this can only be selected in this tab.

The last tab on the left of the window is different to the others in that it will switch to showing the effects stored in the
Library. Library effects do not get deleted with a new show and can be used to create other effects.

Creating New Effects
To create new effects click the "Add Effect" button. As soon as the user clicks on the add button the effect creator pop
up window appears.
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New Effects Builder Opening Page
Choose the type of effect desired. For help selecting the effect, choose the "Run Effects Wizard".

This first page asks the user to define the desired effect. Select the type of effect to create and click "Next" to
continue.

Simple Lighting Chase
A simple chase is a step based effect similar to an automated cue list. Each step contains a list of fixtures each in a
specific state.

To complete building the effect, enter a name to identify the chase and set how many steps to include in the effect. 

To set the default step time (the time the system will wait before executing the next step) or fade time enter the values
into the fields provided.

Click on "Finished" to create the new chase and open the chase editor. The newly created chase will immediately
become visible in the right-hand side of the effects editor.

Timeline Effect
Timeline effect provides the ability to build the effect by viewing its behavior over a timeline. The effect has a fixed
length and each fixture can be given a specific behavior over that time.

New Effects Builder, Simple Chase
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New Effect Builder, Timeline
To complete the creation of an effect enter the name to identify the effect and set the length (in seconds) for the effect
to run.

Set the fixtures to include in the effect by setting the starting fixture number and specifying how many fixtures after
that to include. Alternatively provide a range of channels using the command syntax in "Channel Range" field.

Click on "Finished" to create the new effect and open the effect editor. The newly created effect will immediately
become visible in the right-hand side of the effects editor.

Profile Effect
This effect type is based on time vs. level path that is assigned to a list of fixtures and specific attributes or properties.

Enter a name to identify the effect and set the default length. The channels or fixtures can be set using either a channel
range (using Command Line interface syntax) or by setting the start channel and number to include.

When the effect is created with more than one fixture the wizard can place all fixtures into one path or create a
separate entry for each. Use the "All fixtures will use the same path" option to set how the fixtures in the effect are
organized.

Click on the "next" button to move to page 2 of the effect wizard. Here the user can specify the attribute that the effect
will be applied to and the default path it will use. The predefined paths (sin, cos, saw, pwm) cannot be edited or
changed. To create an effect using a one of these paths as a base that is will be changed select the option "Create a
copy of this path for editing"

Click on "Finished" to create the new effect and open the effect editor. The newly created effect will immediately
become visible in the right-hand side of the effects editor.

New Effect Builder, Prop/Attrib Effect (Page 1)

New Effect Builder, Prop/Attrib Effect (Page 2)
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Matrix / LED Effect
The matrix effect is specifically designed for use with large arrays of lights such as LED fixtures.

To create a matrix effect the fixture matrix must already be defined in the dimmer patching window (See “Edit
Matrices” on page 262).

To complete the creation of an effect enter the name to identify the effect and set the light matrix to use.

Click on "Finished" to create the new effect and open the effect editor. The newly created effect will immediately
become visible in the right-hand side of the effects editor.

Paint Box Effect
The paint box effect allows color FX to be applied across a number of LED fixtures utilizing an unlimited color path.
The color path can then be manipulated for direction, length, and the amount of spread that is applied across a Matrix.

Open the FX List, select “Add Effect” at the bottom and select Paint Box from the pop
up menu. Once created, just click inside the color bar at the bottom. It will add a color
point into the Paint Box. 

Select the point’s color and opacity. There is a color point at the beginning and one at
the end of the color path. Adjust those as needed. Add as many color points as are
needed. A Matrix needs to be predefined (More > Edit Matrices) to create a Matrix.
Once done, select Matrix Definition, assign a Length and Spread. The arrows allow 1 of
10 directions to be assigned. Then hit Play (Arrow).

This can then be applied to a cue by recording a new cue with the FX running or it can
be applied to an existing cue by Command Line [CUE] (#) [FX] (#) [ENTER]. To
remove it from a cue using Command Line [CUE] (#) [FX] [-] (#) [ENTER].

New Effect Builder, Matrix Effect
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[FX] (#) [COLOR] (#) [@] (#.##) on a Paint Box FX will set the color points color to the identified gel color.

Example: Where a Paint Box FX (FX #1) has 3 color points (one added in the middle of the two end default points),
the 2nd color point is one in the middle, [FX] [1] [COLOR] [2] [@] [4.68] [ENTER] will change the middle color
point on FX 1 to be R68. This feature could be used for programming the effect or it could be placed in a Macro to
change the color of the Paint Box FX on the fly.

When the FX is created, its Behavior can be set using the pulldown menu. The options are:

• Override

• Build

• HTP

• Inhibit

• Exclusive

• Subtract

After the effect is created, its Behavior can be adjusted by right clicking on the FX in the Effects Editor and selecting
“Rename this effect” if needed.

Media Playback Effect
Use the media playback effect to play simple video and auto files directly from with NEO.

To complete the creation of an effect enter the name to identify the effect and set the media type to use.

Click on "Finished" to create the new effect and open the effect editor. The newly created effect will immediately
become visible in the right-hand side of the effects editor.

NEO NOTES & TIPS:  This effect type requires the latest version of Microsoft DirectX runtime. Please visit http://
www.microsoft.com/windows/directx/default.mspx for more information.

New Effect Builder, Media Effect
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DMX Recorder
The DMX recorder will perform a real-time read of the incoming DMX channels and record this into the software.
The record DMX stream can then be played back to any DMX universe on an LTP bases. Only DMX channels that
have changed will be applied meaning that the user can mix a recorded DMX stream with other NEO functionality.

To begin recording click on the "Record" button in the top right corner of the window. The button will change to red
and the length display will begin increasing in time. Click on the button again to stop the recording.

Clicking on the record button again will cause a dialog to appear asking to clear the existing recording and start again
or append to the existing recording.

Use the output universe setting to determine the DMX universe to play the stream back on.

DMX Recorder
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Effect Library
The effect library is a convenient way to save and recall favorite profile effects. Once the effect has been created, it
can be copied to the library and will not be removed when creating a new show.

A library effect looks exactly the same as the profile effect however it is missing the channels that the effect will use
to run. The selected library is highlighted in green and the heading along the top of the right hand of the window will
display the library name.

To add an existing profile effect into the library simply select it from the list, right click and select "Add to library".
The name given to the effect will also become the name of the library item.

A blank library effect can also be created by selecting "Create new library effect" from the "Add Effect" drop down
menu. A dialog will appear asking for the name of the new library effect. Enter an appropriate name and click "OK"
to complete the operation. Click on "Cancel" to return to the effects window without creating the new item.

To remove an entry from the library use the right click menu again and select "Delete" from the available options. A
dialog will appear asking to confirm the deletion.

Effect Playback Controls
Along the bottom of the effect editor are the three playback controls for testing and debugging effects. When the
effect is played, a progress line will follow the execution through the effect.

Play

Use the play control to start the effect running. In the case of simple chases the play control is also used to step
through the chase.
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Pause

Pausing an effect will stop its execution immediately but keep the position pointer at the current location. If starting
the effect again (press "play" button), the effect will continue from this location.

Rewind

Pressing the rewind button will stop the effect and resets its position back to the start. If the effect is restarted, it will
start from the beginning. This will also release the channels used in the effect.

Selecting a Different Effect
To change the current effect being edited click on the desired effect name in the list on the left of the window. The
name of the currently selected effect will appear at the top of the effects grid to show which effect are being worked
on.

Deleting an Effect
To remove an effect form the system select it form the list and click on the "Delete" button at the bottom of the
window. A confirmation dialog confirms removal of the effect. 

Right Click Options
Right click on any of the effects for options to rename the effect, make a copy of the effect, create an effect playback
or add the effect to the library (profile effects only).

These options can also be accessed from the "Options" button at the bottom of the window.

Note:  This list may vary depending on the effect type selected.

Rename This Effect
This assigns a different name to the selected effect.

Make a Copy of This Effect
This copies the selected effect when it's easier to start from an existing effect.
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Make a Copy of This Effect (Offset Fixtures)

This copies the selected effect when it's easier to start from an existing effect and gives the opportunity to offset the
fixtures.

Find and Replace Media Paths
Use this option to conveniently update the location of media on the HDD in one step. If a media effect is already
selected when choosing this option then the path used in that effect will automatically be used as the "Path to replace"
field.

Adjust Chase Brightness
This will adjust the fixture's intensity in the effect by a relative
amount.

Adjust Color Levels
This will adjust the fixture's color intensity in the effect by a
relative amount.

Adjust Red Levels
This will adjust the fixture's red level in the effect by a relative amount.

Adjust Green Levels
This will adjust the fixture's green level in the effect by a relative amount.

Adjust Blue Levels
This will adjust the fixture's blue level in the effect by a relative amount.

Create an Independent FX Playback
Once the effect has been created, quickly add the effect to a playback control using the "Create Playback" button at
the bottom of the effect list. A new playback will appear in the "Effect Playbacks" window that can then be used to
run the effect outside of the effects editor.
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Add the Selected FX To Multiple Cues

This will add the selected effect to multiple cue as selected in this dialogue box.

Simple Chase
A simple chase is a series of steps each containing a specific lighting state. Each step can contain any number of
channels each in a different state. A chase can either run automatically or wait for a trigger before stepping onto the
next state.

Clicking on each step will show the detailed channel state in the right hand panel.

To add a new step click on the "Add Step" button found below the step list. New steps will always be added to the end
of the list. To remove a step click on the entry, click "Delete". A dialog will ask for confirmation. Click "Yes" to
complete this operation or "No" to cancel.

The default step time specifies the time waited before the next step will be executed. If this is set to zero (0) then the
step will wait indefinitely so that the chase can be stepped manually using the play control.

The default fade time specifies the time it takes to transition from step to step. Simple chases will always cross fade
between steps by the time specified in the default fade time.

Effect Editor, Simple Chase
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The fade out time can be used to specify the time it takes for the previous step to fade out. By default this will be the
same value as the fade time.

Setting the Chase Behavior
Simple chase effects can be run with different behavior types as with the channel groups. By default this is set to
Latest Takes Precedence (LTP) however the user can change this to Build or Highest Takes Precedence (HTP). LTP is
also called "override" in the channel groups as the output of this behavior will override whatever the channel is
currently set to and apply the new value.

The behavior set by this option will result in playback of the chase following the same rules as the behavior set by
channel groups. See "Behavior" on page 10 for further details.

Build will add the output from the chase to whatever the output currently is set in the channels. HTP will only apply
the channel output from the chase if that output is higher than what the channel is already outputting.

To set the behavior double click on the name of the chase in the left panel or right click and select "rename" from the
popup menu.

Use the drop down combo to set the desired behavior when running the effect.

Right Click Step Options
Use the right mouse button on the "Chase Steps" panel will open a menu related to the steps of the chase.

Copy step - Select this option to copy the currently selected step to the end of the chase.

Reverse step order - Select this option to reverse the order that the steps run.

Insert a step below the current step - will add a step below the currently selected step.

Adding Channels to a Step
Along the bottom of the chase editor panel is an edit box and the "add channels" button. Enter the channel list into the
exit box provided using the standard channel selection syntax. Press enter or click on the "Add Channels" button to
add the channel to the chase step. e.g. "1 / 5@30" will add channels 1,2,3,4 and 5 to the step with their value set to
30%.

Standard Command Line entry for level changes will work provided that the cursor is inside the Command Line box
for chase effects.

Removing Channels From a Step
To remove channels from the group, select the channel in the grid above and click on the "remove channels" button.
To select channels use the same techniques described in the channel display window.
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Editing Channel Values
To edit the dimmer or attribute values of the channels in the chase step use the same technique as the channel display.
Select the channels to modify by clicking on the desired channels (hold down shift or control to select multiple
fixtures) and then use the scroll wheel on the mouse to modify the dimmer values.

If the fixture has more attributes the fixture control window will be display as it does in the channel display.

The step channel display panel will only show attributes that are included. Until an attribute is modified it will default
to the off state.

To clear an attribute form the selected fixtures use the drop down menu on the end of the "Remove Channels" button.

Options 
The options menu in the bottom right of the window provides additional features. 

Select All - Sets all of the channels in the step to a selected state.

Set fixed column count - By default the number of channels shown across the grid will dynamically change
depending on the width of the window. Use this option to set a fixed number of columns to be shown regardless of the
window size. Set this to 0 to return to a dynamic column count.

Undo last action on this step - If a mistake is made, use this undo function to restore to the previous state of the step.

Right Click Menu 
Right clicking anywhere in the channel grid will bring up the context menu for this window. This is the same menu as
the dropdown off the "Remove Channels" button.

Copy selected channels to another step - Use the sub menu to select a chase step to copy the current selection to.
The state of the channels will also be copied.

Turn off attributes - To remove an attribute type from the step, select the channels and then select the item from this
menu. In the case of color mixing use the submenu to select individual colors or remove all colors.

Random - Use the submenu to set an attribute type to random values for the selected fixtures.

Turn off in all steps - To turn off attributes in all fixtures and all steps use the sub menu to select the type.

Matrix View
An alternative way to view a chase step is the matrix view. Switch between the matrix view and channel view by
using the buttons in the top right of the window.
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In the matrix view the step is shown as it looks from the point of view of a defined matrix.

Use the drop down combo to select the matrix to view as the chase step. Work with as many matrices as desired and
each will work independently of each other. Because the matrix view is just another way to edit the underlying
channels, switch matrix at any time and no information will be lost.

This view works like a painting canvas with each grid cell being a position in the matrix that can be set to a color. Use
the "Pen" option to select a color and then click anywhere in the matrix grid to paint the color. As soon as a color is
painted the channel will automatically be added to the chase step. If the channel already exists then it will be updated
to reflect the pained color.

The eye dropper tool to the right of the pen option can be used to select an existing color from the matrix to set as the
current pen color.

Load from image - Click this button to map any image to the matrix.

Copy from previous step - Use this to copy the state of the previous step to this step. 

Additional controls allow tweaking of the brightness, red, green or blue content of the matrix.

Timeline Effects
An effect segment has a start offset time, start state, length and end state. When an effect runs it will progress through
the list of segments executing each one in turn. If for example the first segment has an offset of 10 seconds, the
segment will execute 10 seconds after the effect itself has started.

When a segment is executed, its start lighting state will be set immediately. The fixture will then perform a fade for
the length of the segment to its end lighting state. If a segment is for an intelligent fixture then all of the attributes
(excluding dimmer) will be pre-fetched and set up for the start state at the end of the previous segment. If for example
a moving light will start in a different position for the second segment then it will be moved to this new position at the
end of the previous segment. When the effect starts, intelligent fixtures will be set to the start state of the first
segment.

Timeline effects are viewed in NEO as a Fixture vs. Time graph. Along the top of the effect view, a time scale from 0
to the length of the effect can be seen. On the left of the effect view is a list of the fixtures included in the timeline.

Chase editor, Matrix View
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NEO NOTES & TIPS:  Each segment of an effect cannot overlap any other segment.

Along the top of the view is the number of lines in effect. This can be used to add or remove fixtures. If this number
is increased, new lines will be added when the "Apply" button is pressed. Each line can have as many fixtures
needed. Use the standard channel selection syntax to enter channels into the fields provided. If more than one fixture
is added to a line then all the fixtures in that line will do the same thing when the effect is run.

Each line can also reference channels in a channel group. Select the channel group using the drop down box to the
right of this field. The channels contained in group will automatically be used for the effect.

Also along the top is the "Effect Length" edit that determines the default duration of the effect. Changing the effect
length will change the time bar and increase or decrease how long an effect takes to run. To change the length of the
effect enter the desired time and click on the apply button.

By default, changes to the length of an effect will not change any of the existing segments. If the effect is shortened,
any segments that go beyond the new length will be truncated. Use the "Rescale" check box to ensure that all
segments are rescaled to any length changes. If this is checked and the effect is shortened, all of the segments will
also be resized by the same proportion.

Effects Editor, Time vs. Fixture Effect

Sets the number of fixtures in this effect

Sets the length the effect will run

Start offset control
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To the right of each fixture there is a small X for deleting the line from the effect. Clicking on the small X will remove
this line (fixture) from the effect. A confirmation dialog will appear asking the user to confirm deletion of the fixture.
Click "OK" to confirm or "Cancel" to return to the effects editor.

Start Offset Field
Use this field to specify a delay (in seconds) before starting this part of the effect. This allows execution of the effect
to be staggered across all of the lines. 

Zoom
Use the zoom control to adjust how much of the effect is visible in the frame. A zoom setting of 1 will show the entire
effect length in the editor window. As the zoom increases less and less of the effect will become visible but each
section of the effect will become larger for more detailed editing. A scroll bar along the bottom allows movement
within the zoomed effect.

Load Audio Track
A convenient use of the timeline effect is to accurately apply lighting changes to match music. Use the "Load Audio
Track" button to render a waveform of the selected audio above the timeline. When the effect is played the audio
track will play with it and an accurate position in the audio can be seen.

If the length of the audio track is different than the length of the effect, the a dialog asks the user to adjust the effect
length. If the user clicks no to this option the audio track will be truncated to the length of the effect.

To clear the waveform click on the "Clear" button on the right hand side of the view.

The waveform is stored with the effect to make rendering it quicker however the actual audio track will remain as a
file on the hard drive. If the original audio file is removed, the waveform can still be rendered but the audio will not
play with the effect.

The audio track display can be resized by moving the mouse between the bottom of the audio display and the top of
the first timeline. The mouse cursor will change to a size control when in the correct location. Click and while
holding the mouse button down mouse the line up and down to increase or decrease its size.

Creating and Editing Segments
The graphical view of the effect allows easily viewing when the fixture is doing something. Each segment shows us
at a glance that the fixture is changing state. The software will automatically set up intelligent fixtures between
segments to their next state; hence, we need not be concerned with fixture attributes between segments. For example,
often we may want the color of a fixture to be set before the light becomes visible. In the NEO effects engine, this will
be done automatically for us if the next segment has this attribute set.

To create a new segment simply click inside the space provided to the right of the fixture, hold the mouse down and
drag the segment to the desired length.

NEO NOTES & TIPS:  By default, the newly created segment will have its start and end states set with the dimmer 
at full (100%) and all other properties set to zero.

Click here to start (holding
down the left mouse 

Drag mouse to end positionExample: Creating an Effect Sequence
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The size of a segment can be adjusted by clicking and holding the mouse button down at either end of the bar and
dragging it to the new length. When the mouse is moved over the end of the bar, its cursor will change to indicate the
resize operation.

To move a segment to a different start position (offset), hold the mouse button down over the center of the bar and
drag the bar to its new position. 

To adjust the start and end state of the segment, click once on the bar to bring up the state editor panel.

The segment state editor panel will show all of the generic attributes that can be set for the segment. Each one has a
start state and an end state. To edit any of these values click on the cell and enter the desired value.

At any time double click on the heading of the row to load values from the fixtures current state.

For the pan, tilt and color entries double click to open a helper box to select the values.

If the end state of a property is zero, changes made to the start state will automatically be copied to the end state to
assist with creating new segments.

Alternatively set a profile for each of the attributes. When a profile is select the start and end values will become
disabled and the profile used to determine the output during the segment. The profile is a path that the values will
apply during execution. To set a profile click on the appropriate column and select the profile from the list presented.

At the right of the segment state editor the pan and tilt path is displayed for the selected segment. A moving light path
applies to fixtures that have both pan and tilt control, and allows creation of a continuous movement that will follow
a defined curve.

NEO provides an advanced path editor that can be used to define the minimum number of points. A spline curve will
automatically create the best-fit curve between each point. Two control points are automatically created to provide the
ability to control the curve entering and leaving the first and last point.

The "Elasticity" figure below the time value is an advanced feature allowing control over the spline cure and
determines the obtuseness of the curve.

Segment State Attribute Editor

Moving Light Path Editor
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To change the size of the curve created use the resize buttons provided to the right of the edit space.

These buttons will move all of the points toward or away from the center of the effect, thus rescaling the distance the
light will move while moving through the path.

The four arrows below the resize control allow repositioning of the path around the pan and tilt space.

Pan and tilt can cover a large stage area. Often the user only wants the path to occur in a small section of the full range
of the light. Clicking on these buttons will move all of the points in the direction clicked. If a point is at the edge of
the edit space, it will not be moved.

Once the user is satisfied with the shape created, commit it to the selected effect segment to edit the path. Clicking on
the "OK" button will commit the new path to the selected segment.

NEO NOTES & TIPS:  If the user sets the elasticity of the path to 1 then a straight line will be created between 
points (not a curve) and the software will create a single segment for each line.

Click on the "Cancel" button to return to the effect editor without committing the new path.

Create a similar path for determining the color during the segment by click on the color path area of the right of the
segment state editor.

Color Path
Color Paths are the ability to create a specific path for a fixture to follow when changing color in either a Cue (Cue
List Details) or in a Timeline FX.

• When creating a cue color path the system will now automatically take the tracked position of the previous cue as 
the first point and the position recorded into the cue as the last point.

Moving Light Path 
Resize Buttons

Moving Light Path 
Repositioning Controls

Color Path Editor
FX List (Effects Editor) 217



User’s Manual
• Insert points between others using cue color paths 

• Insert points between others using cue movement paths.

Movement Path
Movement Paths are the ability to create a specific path for a fixture to follow when moving in either a Cue (Cue List
Details) or in a Timeline FX.

When creating a cue movement path the system will now automatically take the tracked position of the previous cue
as the first point and the position recorded into the cue as the last point.

Options
Clicking on the right mouse button while over a segment of the effect will bring up a number of advanced options to
assist with creating effects.

Delete Segment
Click on the "Delete Segment" option to remove the currently highlighted segment from the effect. A confirmation
dialog asks for confirmation of this operation before the segment is deleted.

Delete All Segments
Click on the "Delete All Segments" option to remove the segments for this fixture. A confirmation dialog asks for
confirmation of this operation before the segment is deleted.

Cut, Copy, Copy All, Paste Segments
The cut, copy, and paste functions operate exactly as they do in most applications within Windows. Cutting a segment
will remove it from the effect and put on the clipboard for pasting somewhere else, while copying places a copy of the
highlighted segment on the clipboard without removing it from the effect.

"Copy all segments" ignores the currently highlighted segment and places all of the segments associated with the
fixture onto the clipboard.

To place a copied segment or segments onto a fixture, select the "Paste" option while the mouse is over the fixture to
paste to.

NEO NOTES & TIPS:  When pasting, if a segment conflicts with segments that already exist for this fixture being 
pasting to, nothing will happen.

After a paste operation, the segments will remain in the clipboard to allow pasting segments to as many fixtures as
desired.

This feature is useful after creating a moving light path to copy the newly created path to all of the other fixtures in
the effect. To do this, create a path for the first fixture and then select the copy all function. To create the path for all
of the remaining fixtures simply paste to each one in turn.
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Profile Effect
Create this type of effect to assign a time vs. profile path to specific attributes of fixtures. When the effect runs the
selected attribute will apply the set values over a set time. Profile effects are a very powerful way to create complex
effects with minimal effort. Once comfortable wutg using this type of effect the user will find it the most common
effect system to use.

In the above example a profile effect has been created to operate in fixtures 200 through to 204. There are two
elements in this effect, the first is a "sine" wave working on the pan property and the second is a "Inverse cosine"
wave on tilt.

For each attribute the user wants to apply a profile path to, create a separate line in the items table. In the above
example 2 entries are required to create a circle with the fixtures. The first entry controls the pan property and the
second the tilt. If the desired effect was a ballyhoo we might only require one entry applying a profile to the tilt
property.

To add an entry in the items table simply click on the "Add Line" or "Copy Line" button. This will create a new line
with either blank values or the same values as the previous line. To delete an entry click on the "Remove Line"
button.

Channels / Fixtures
This is a simple list of fixtures that the profile and attribute will operate on. Use the same channel syntax as the
Command Line interface to enter the channel list. By default channel will remain in the order they were typed. To sort
the list of channels right click and select sort from the popup menu. The order that the channels are listed in is
important for the stagger operation.

Right click on the channel list and a list of advanced options will appear...

Sort - list in numerical order.

Reverse channel order - invert the channel order.

Randomize - put channels in random order.

Center Out - sort from middle of channel list out in both directions.

The Add, Replace, Remove will turn into pullouts if there are Selection Shortcuts programmed.

Add - will populate the list of channels from the Selection Shortcut chosen.

Replace - will replace the list of channels from the Selection Shortcut chosen.

Remove - will remove the list of channels from the Selection Shortcut chosen.

Effects Editor, Property/Attribute Effects - Sine and Inverse Cosine
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Attribute
This value specifies the attribute of each of the fixtures that values will be applied to. Use the drop down menu to
select from a generic attribute list the attribute to use. The user can also enter a number corresponding to the attribute
for a specific fixture type. If using an attribute number then all of the fixtures should be of the same type. If different
types exist then strange results may occur. The generic attribute can be used on any mix of fixtures. If the fixture does
not support the selected generic attribute then any applied values will be ignored.

Profile
The profile is the key to this type of effect as it defines exactly what the selected attribute of the fixtures will do. As
the effect plays, the output value (DMX value) is derived from a point in the profile path. A "sine" wave for example
will output the DMX values 127 at time 0, 0 at ¼ of the way through the effect and full (255) at ¾ of the way through
the effect. The selected profile is shown graphically in each line of the effect

To change the profile, click on the profile column of the line to change. A drop down box will appear listing all of the
profiles that exists in the system.

The profile chooser will display four profiles access to maximize the number that can be seen. The profile currently
assigned to the line will be highlighted with a red border. Use the scroll bar on the left hand side to find other profiles
not visible on the page.

To select a profile click the appropriate image and the profile picker will close automatically. The selected profile will
be shown in the line the user is working on. To close the profile picker without changing the selection click on the
close button in the bottom right of the window.

Prop Effect Channel List Menu
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To modify a profile click on the "Open Profile editor" button at the bottom of this window. This will open a new
window to modify or create profiles. See “Profile” on page 244.

Length
The length specifies how long the path will play for. The length of the effect is the length of the longest item. If the
length of an item is less than the longest path then the speed that the path will play is made proportionally faster.

Offset
Offset sets where the DMX output values start from. When the path is at 0 the actual output will be the offset value.
All resulting values from the path will be added to the offset up to a maximum of 255.

The offset can also be set to "Relative" by entering an "R" into this field, HTP (Highest Takes Precedence) or LTP
(Last Takes Precedence). Note: These 3 options don't always appear. Only the ones that are appropriate for the
selected effect will appear when relevant. This is also its default value when a new effect is created. Relative offsets
mean that the offset will be whatever the fixture is on when the effect starts. This creates a single effect the can be
used in different parts of the stage throughout the show. 

If adding the effect into a cue then NEO will setup the fixture based on the data in the cue and then apply the effect
over top. With this, two adjacent cues can both use the same effect but run completely differently.

NEO NOTES & TIPS:  If running this effect on Pan & Tilt then a couple of special conditions apply. Firstly the 
current position of the light becomes the center of the path. If (for example) we are doing a circle then the offset is 
automatically setup for us to make the current position the center. Secondly, when this type of effect is running use 
the pan and tilt controls in the channel view to move the position of the effect.

Scale
The scale is a percentage value that will be applied to the final output. A scale of 50% causes the resulting values
from the path to be halved. The combination of offset and scale can be used to restrict the output to a smaller range. 

Start Position
The start position is used to specify the point in the path that will be used when the effect begins.

Stagger
Staggering a path is a powerful way to make an effect more interesting. The stagger value either specifies how many
fixtures the effect will be staggered across or the percentage across the path each fixture will be. 

A stagger number (Stagger #) of 4 means that fixtures 1 through to 4 will be equally spread across the path so that
each fixture starts in a different position. Fixtures 5 though 8 will also be staggered in the same way so that fixture 5
will mirror fixture 1 and fixture 6 will mirror fixture 2 etc.

A stagger percentage (Stagger %) of 10% means that each fixture will be 10% further along the path than the fixture
before it. If the total length of the path is 10 seconds then when the effect is at 0 seconds fixture 2 will be at 1 second,
fixture 2 will be at 2 seconds etc.

This results in the fixtures all working slightly different. Making a number of moving lights all perform a simple
circle can look good but then to add variety we can use the stagger feature to make each fixture start at a different
point in the circle.

Soft Start
The "Soft Start" option for each profile effect determines if the effect starts abruptly or slowly. When an effect is set
to start slowly (soft) then it will ramp up the scale from 0 to whatever value is set over one complete cycle of the
effect. If this option is turned off the effect will immediately start at the scale factor set.

Matrix Effect
This effect type is specifically designed for large arrays of lights and LED fixtures. Every LED fixture provides a
different way to control all of the individual lights contained in it. To define the layout of the lights use the "Edit
Matrices" option. See “Edit Matrices” on page 262. 
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Once the user has created the effect, define the background that the effect will operate on. The background can be a
jpeg, bitmap, or video (AVI) file. To set the background either enter the filename into the "Image or Video File" edit
box or click on the button to the right to bring up the open file dialog box. 

A default background image is always available by clicking on the "Default" button in the top right of the window.
The default image created simple color fades by providing a pinwheel of the color spectrum. When a new effect of
this type is created the default image is always set.

Once the background has been set, define a path that the matrix will use to play the effect. In the example above the
matrix is defined as a red box and the path is the black line tracking around the image.

To add a point, click on the desired location and the path will now trace to the newly created point. To
move an existing point click on the point (holding the mouse button down) and drag the mouse to the
desired location.

To remove the last point in the path click on the remove point button (shown right) in the top left corner
of the window. 

At any point right click to edit the details of the point.

Effects Editor, Matrix/LED Effect

Matrix Effect, Right Click Menu
222 Software Configuration



NEO Lighting Control Console
To remove any other point in the path right click on the desired point and select "Delete" from the resulting popup
menu.

To change the rotation of the matrix at a point select "Edit Rotation" from the right click menu and enter the desired
value (in degrees) into the edit box that appears. 

To change the scale of the matrix at a specific point select "Edit Size" from the right click menu and enter the desired
value into the edit box that appears. When the effect plays the scale of the matrix will transition between values
across the length of the path.

Use the "Show point information" option (toggle) to turn on or off popup balloons that show the rotation and scale
settings for each point. The balloons will appear as the mouse hovers over each point in the path.

When the effect is played from the editor the red box will track the path over the specified time. As the effect runs
NEO will map the contents of the red box onto the defined matrix. The color of each fixture will be mapped to the
color on the image or video clip. The preview button (shown below) can be used to see the resulting output on screen.

Click on the "Show only assigned fixtures" to apply a mask over the preview that represents the fixtures in the real
world.

Effect Length
The length defines how long the effect will play for and can be any value up to 1 hour. If a video file is selected the
software will prompts the user to set the length of the effect to the same length as the video. If the length of the effect
is shorter then the video the video clip will be truncated.

Zoom Matrix
To change the size of the area that the matrix will use to generate output set the zoom field. When playing back the
effect the image will be rescaled to the zoom setting to apply the correct color.

 
Preview Button
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18. Media Effect

The media playback provides an easy way to trigger audio and video clips from with NEO. Use this feature to
playback sound effects or video clips within a cue lists.

Once the effect exists, modify the file that will play, where the file starts playing (in seconds) and how long it will
play for.

File Name: This is the actual media file located somewhere on the system. Use the button at the end of the edit box to
open a file dialog for locating media.

Start Time: Set the time in HH:MM:SS:MS for the media clip to play from. If (for example) the user wants the clip
to play 1 minute and 23 seconds into the file then enter 00:01:23:00 into the edit provided.

Play Length: Set the length in decimal seconds that the clip will play for before either stopping for playing again
from the start position. A play length of 3.5 will play for 3 and a half seconds each time it runs.

Volume: This value will override the volume of the effect when it is played back.

Don't generate internal timecode: The internal timecode will always read the last played effect time. To play other
media while using the internal timecode of a master track turn this off for all of the audio tracks other than the one the
timecode should be read from.

The system relies on the correct codec's for the media to be played back. If the codec is not available on the system
then an error may occur when attempting the playback.

There are a number of global media playback controls that can be set in the "System Properties". See “Media” on
page 312.

Pressing "Play" within the Effects Editor will preview the video effect. This will function as a blind editor for
programming. In order to actually see the media effect outputting to the configured monitor, the effect must be run in
an FX Playback.
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Running a Media FX
After the Media FX is created, press the "Create Playback" button. This will take the existing effect and create an FX
playback in which it will run.

Press "Play" in the Effect Playback and the Media FX will output to the designed monitor. (Monitor 2 is default.)

If the user attempts to play a video file and have only a single monitor connected then the software will only show the
video in a window on the primary display. In a multi monitor situation the system will default to use the 2nd display
as the full screen output of the video clip.

The effects editor will show a preview of the video clip in the black box. Only when the effect is run in an effect
playback or cue list will it play full screen.

19. Creating Generic Palettes

Color palettes are a very common use for generic palettes. Generic palettes don't care
what patched fixture they are applied to so this gives the opportunity to record a mixed
color to one fixture and then use it later by applying it to any color adjustable fixture
that is in the patch. 
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First, open the Generic Palette window by pressing the [PALETTE] display button (either the on screen one or the
hard console display button) and move it to the second monitor.   This is the generic palette window.

Note:  If on a single monitor, it may be easier to use the second example of storing a color generic palette later in this 
section.

Mix one of the color mixing fixtures to a color to use.

Then type [RECORD] and press one of the open generic palette buttons. A properties window will appear.
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Assign a name, shortcut, the color of the button and assign attribute values for additional parameters. For example,
Gobo 1 Idx: 1 will go to Gobo 1, Zoom: 25 will zoom to 25 degrees, Focus: 50 will output at 50%.

20. Generic Palette Options

With the Generic Palette display open, any programmed Generic Palette can be modified by right clicking the mouse
pointer when it hovers over any Generic Palette.

Note:  If using a touchscreen, click and hold will achieve the same results.

Edit
Edit pulls up the Generic Palette creation and editing dialogue box and allow the user to edit the data that is stored in
the selected Generic Palette.

Just type in the data for any parameter to be added.

Clear
Will clear out and remove the Generic Palette data.
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Move
Allows moving a Generic Palette from one number to another.  Select "Move" from the list , the mouse pointer will
change to show a pointer with move page on it. Then click the desired destination.

21. Generic Palettes - Options

In the Generic Palettes window, there is an Options button in the top right corner. Open that to get the list of options...

Use 3D buttons – Default: On. 3D buttons have a shaded appearance and are generally sharper than the normal
buttons. Turn this feature off if experiencing slow response in painting the window. 

Set font size – Default: 8. Sets the size of the button legends. 

Set grid size – Default: 10x10. Controls the number of buttons appearing in each window. 

Create default show colors – Creates a set of palettes with some basic colors and also adds them to the “Show” tab
of the standard color picker. 

Create full color page - Creates a full page of color palettes that range the color spectrum.

Clear - removes all created generic palettes on the selected page.

Only show palettes containing selected fixtures - When off, the Palettes will now function as the new smarter
Virtual Palettes and apply data from “any” fixture that has this families’ data.  When on, these Palettes will only apply
data if it is stored for the fixture(s) selected. 
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22. Creating Generic Palettes Graphically

Color palettes are a very common use for Generic Palettes so let's talk about creating a color palette.

Select desired fixtures and change their color output. Cyan and Magenta are set to full to make a color (for this
example) called "Show Blue".

Create the Palette...

From the NEO screen, press the Record Palette button or, using Command Line, press and hold
[RECORD] and press [GENERIC PALETTE]. (By pressing and holding RECORD and then
pressing any item button, this will bring up the dialogue box to change settings. If the user knows
that the settings are correct and do not need adjustment, just go straight to Command Line by typing [RECORD]
[GENERIC PALETTE] (#) [ENTER].

This example stores "Show Blue".
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Once the color palette is stored, it can be applied to any color mixing fixture that is patched.

1. Select the fixtures. In this example: 51 thru 57.

2. Open the Palette window. 

3. Select the desired color palette.

This example applies "Show Blue". 

Notice that in the Fixture Grid, the user can see that both 31 thru 36 (the fixtures that were used to create the palette)
and 51 thru 57 (the fixtures used to apply the palette) are both in Show Blue. The ML Attribute window at the bottom
of the screen shows both attribute data (CMY values) and the Palette reference "Show Blue".

Palette references can be added to a cue at the time of recording or using the palette tab in the cue detail window. In
this tab is two panels separated by a movable splitter. In the left hand panel is a list of all the available palette
230 Software Configuration



NEO Lighting Control Console
references that can be added to the channels in this cue. The list is an alphabetical list of both channel groups and
generic palettes.

The panel on the right is similar to the overview and DMX tab. Each row is a fixture and each column an attribute.

To add a palette reference to an attribute select it from the panel on the left and while holding the mouse button down
drag and drop it onto the attribute.

Alternatively enter palettes by clicking in the required attribute field and start typing the name of the palette. As the
user begins to type a popup list of palettes will appear. Use the up and down arrow on the keyboard to select the
palette and press enter to assign it to the attribute.

Using the palette reference tab in the detail editor is a very slow way to add palette reference and is designed to be
used as an editing tool to make changes after the cue is created. The easiest way to work with palettes is to record
them from the channel display. 

23. Generic Palettes, Specific Palettes, and Virtual Palettes

One of the most powerful features in NEO is the use of palettes as building blocks for the show. These are useful not
only in on-the-fly control but also for building flexible cue lists. This section will cover both uses for palettes and
groups and explain how these are related.

Generic Palettes
The simplest way to explain Generic Palettes is they are referenced groups that can apply to any patched fixture as
long as the fixture has the capability. Using smart logic inside the software, a palette can be applied to any fixture

Assigned
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regardless of its capabilities. Obviously if a fixture does not have a specific attribute (zoom for example) then a zoom
palettes will not do anything with that fixture. 

The application of some palettes is not always obvious but this highlights the power of what can be done with them.
For example if a palette containing color information is applied to a CMY fixture then NEO will work out what levels
to set the CMY flags to reproduce this color. If the fixture only has a color wheel then NEO will find the color that is
the closest match to the color in the palette. If the fixture has no color attributes at all then it will calculate the grey
level of that color and apply this as a dimmer percentage.

The disadvantage of palettes is that they hold one set of values for any fixture they get applied to. This is useful for
color where NEO can work out how to apply the setting to the fixture but is not so useful for position where the same
pan & tilt angle will have a different position on stage for each fixture. A 20deg tilt on a fixture upstage is a different
position to 20deg tilt of a fixture down stage. To get around this we need a palette that is capable of holding different
information for each of the fixtures. This is often referred to as a specific palette because the values held by the
palette is specific to the fixture. NEO uses "Channel Groups" for specific palettes.

Palette System Reimagined
The Palette system has been overhauled and improved. In software 3.7 there are Specific Palettes that only store
specific fixture data. These are the Intensity, Position, Color, Beam and Edge Palettes. This data cannot be used in
fixtures where the data has not been stored. If there are two moving lights, and one of them has data in a position
palette, but the other fixture does not, then only the palette can only be used for the first fixture. In 3.7 there are also
Generic Palettes, where data in one fixture can be applied to any fixture. This is most useful for common data
elements like Color. In software 3.8, a new system of Virtual Palettes has been created. 

Virtual Palettes allow a palette to apply to any fixture regardless of whether it’s been record in the Palette or not. 

Specific Palettes now have the option of being Virtual Palettes. This allows them to function as Generic Palettes…but
smarter. Here is an example, if there are three types of color mixing fixtures, VL1100s, Selecon PL4s and a generic
RGBA fixture, mix a color in the VL1100, store it as Color Palette 1 and that will be able to be used in all 3 fixture
types by default. The VL1100s, CMY color mixing system will be converted and applied to RGB for the other 2 types
of fixtures. However since CMY is converted to RGB, that means the White channel on the PL4s is not calculated as
it doesn’t know what to do with that data so it is ignored. Select a PL4, apply the Color 1 palette, and add the white
value as needed. Update Color Palette 1 and now that PL4 “and all” PL4s will look to that color palette data first.
Now apply Color 1 to the RGBA fixtures. There is no data for these fixtures but it will look to the first fixture that has
color data and it will find the VL1100 as the lowest channel number. So it will convert CMY to RGB but has no
information to apply to the Amber so that color is ignored. Select the RGBA, add the amber value as needed. Update
Color Palette 1 and now that RGBA “and all” RGBA units will look to that fixtures color palette data first.  Now if
one particular RGBA fixture needs different values to output the correct value, then adjust appropriately and update.
Once data exists for a particular fixture, that data will be used first and take priority over data from another fixture of
the same type.

To summarize. When a fixture is told to apply a color palette, it looks for the data in the following order…

• Current selected fixture.

• From another fixture of the same fixture type.

• From the first channeled fixture that has data for this palette.

Additional Benefits
Virtual Palettes will apply color to the correct additional colors of White and Amber rather than just to RGB.

Virtual Palettes will apply color to color wheels if the destination fixture does not have a color mixing system.

When recording a cue, the NEO system will automatically convert Virtual Palette references to real Palettes.  So if a
Palette has information for one fixture and then it’s applied to other fixtures, the information is calculated using the
Virtual Palette system.  Once the cue or palette is recorded or updated, then the virtual data becomes actual data that
is stored in the item.

“Only Show Palettes Containing Selected Fixtures” (new image: "palette window options")
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This is the setting that determines if Palettes function as smarter Virtual Palettes (new) or as Specific Palettes
(legacy). It is turned on, by default, for Color Palettes but turned off by default for Position, Beam and Edge palettes.
For each Palette window, this feature is under the Options pulldown and called “Only show palettes containing
selected fixtures”.

When this option is turned on, only the palettes that have data recorded in them for the current channel selection will
be enabled and available to be pressed.

Groups
While Groups are typically used to select a collection of lights and apply a level, they are capable of holding any
combination of fixture information. This makes them perfect for use as a specific palette. By storing only the position
information into the group we have effetely created a specific palette for a position on stage (this is called a position
palette).

Because groups can store any combination of data we are not restricted to just one attribute. We can store color
information with our position if we wanted but this is generally not recommended because it limits flexibility when
we come to using it later. We may however want to store zoom information with the position so that we always have
the same size circle of light on stage regardless of the position.
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Before recording groups, open the Groups display, go to Options > Edit Palette Types.

Adjust the group type to store the data that the user wants that type to store.

For example, some programmers like groups to only store intensity info. In that case, just "unselect" or click on each
attribute family except for intensity. The green cells will identify what will be stored.

To get attribute specific just move down to the Attribute section and adjust there.
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When recording groups NEO provides options specifically designed for using it as a palettes.

If we are only using the group as a palette then we do not need to assign a submaster. We may however want to assign
a shortcut for quick access to call this up. 

The "Record Attributes" check boxes allows selection of a subset of attributes to include. All other attributes will be
set to "OFF" and will not be changed when the group is applied.

On the Fly Control (Busking a Show)
When using NEO in live control environment palettes become a key component of the show. Palettes can be used to
pull up looks on stage quickly as needed.

This is also useful when programming a cue list based show by making it quicker to setup scenes.

For the examples shown here we are going to work with color and positions but remember that any attribute can be
used.

Creating Position Palette
To create a position palette we need to record a channel group with each fixture pointing into the location we want.

With all of the fixtures selected click on the "Record Group" button. In the group name enter a description of the
position (e.g. Pos DSC or Position Down Stage Center). Set the submaster to 0 so that no submaster will be set for
this group. In the shortcut field enter 51 and select only "Position" in the "Record Attributes" options.
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Click "OK" to proceed with the record and a new channel group will be created recording only the position
information for the changed fixtures.

Note that as soon as the palette has been recorded, the Classic View will show the group name in the fixture box.
Also, the ML Attribute view shows both the degree values and the focus group name so that if we record a cue the
correct reference will be recorded.

Repeat the process for positions DC and CC so that 3 position palettes have been stored.

Open the Groups display to see the new groups labeled appropriately. Double click on the channel field of the first
group, the Channel Group Detail will open.

Notice that in the channel details for the newly created group that all of the attributes are set to "Off" except for the
pan & tilt and the Focus Time. If we do not want to include Focus Time into the position palette simply select all of
the values and press "O" (for off) and press the enter key. 

Using the Color Palettes
The quickest way to apply a color palette is to select the fixtures to change and then click on the "palette" button. A
menu will drop down with each of the colors listed. Select the color "Red" from the list and the color of the selected
fixtures will change to red. If the light does not have color mixing capabilities, it will find the closest match on any
available color wheel. The results will depend on the fixture and it's capabilities.
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We can also apply the color over time by simply entering the number of seconds before selecting the palette. On the
keyboard enter the number 5 and then select "Green" from the palette menu. Notice that rather than jumping to the
color green the fixtures will fade to green over 5 seconds.

Using the Position Palette
Groups (the position palettes that have just been recorded) can be applied the same way as the color palettes.
However because the channel group contains a specific list of channels we can apply it without selecting channels
first. To apply a position preset to all channels that were originally recorded simply select it from the drop down menu
"ar" in the channel display.

Alternatively if we want to apply the position preset to just a few of the fixtures then select the desired channels
before selecting the preset. For example, if i select 31 thru 33 and then pick CC from the Ch Groups drop down menu,
then these 3 fixtures will move to the CC position.

NEO NOTES & TIPS:  If using movement effects with a relative offset, position focus groups to move the effect 
around the stage. For example if the fixtures are performing a circle, create a position with the fixture on stage and a 
position with the fixtures pointing at the audience. Once the effect is running, move the effect between the stage and 
the audience by applying the position focus group.

Using Palettes from the Shortcut Window
Using the drop down menus in the channel display can be slow in a live show environment because it relies on
several mouse clicks and can be hard to hit with a touch screen.

An alternative way to access these palettes is to use the shortcut window or an external shortcut keyboard. To open
the shortcut window click on the "Shortcuts" button on the main NEO window.

In the above example, the shortcuts that we have created in the earlier examples can be seen. In the top right corner of
this window is a button that will toggle between the text "Normal" and "4-Up". The display shows the window in "4-
Up" mode. This mode segments the shortcuts into 4 groups with configurable labels. At the top there are different

Applying Position Palettes (CH Group)
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pages for each different fixture type. On each page, the shortcuts are broken up into 4 types. Colors, Gobos, Beam /
Edge and Positions. By default the color palettes automatically assign the appropriate background color to the button
representing the color that the palette will produce.

Pressing any of the shortcuts in this window will apply the palette associated with it without needing to open the drop
down menus in the channel display.

Using this window we can still enter timing information on the keyboard before pressing the shortcut. Pressing the
number 3 before pressing a color palette will apply that palette in 3 seconds.

By adding selection shortcuts to this window, the user can select some fixtures, set the color and set the position with
3 clicks of the mouse or presses on a touch screen.

Ranging Color
The ability has been added to range colors across multiple fixtures. For this to function, either the fixtures have to
have data stored in the color palettes or the gel manufacturer’s colors can be used.

The example below uses Rosco colors R68 and R312.

The command is [1] [THRU] [100] [@] [COLOR] [4.68] [THRU] [4.312] [ENTER]

Remember that the 4 major gel manufacturers are available in alphabetical order…

In addition to this, the ability exists to range twice to get a color to peak in the middle.

Gel 
Manufacturer 

Numerical 
Reference 

Apollo 1 

GAM 2 

Lee 3 

Rosco 4 
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The command is [1] [THRU] [100] [@] [COLOR] [4.68] [THRU] [4.312] [THRU] [4.68] [ENTER]

One of the powerful features of ranging color is that it applies to selected fixtures in the order in which they were
selected. 

The example below, the selection order was 1+3+5+7+9+11+13+15+17+19+2+4+6+8+10+12+14+16+18+20.

Cue List Based Shows
While using palettes and channel groups is not required for programming a show, creating a show with building
blocks makes it easier to make changes later. At the same time palettes and channel groups will also make
programming quicker because this will minimize the need to setup moving lights for each cue.

When recording a cue in NEO will the channel state and all attributes associated will be store so that it can be recalled
for playback. The values recoded are referred to as hard values because the value recorded directly represents the
output values.

For Example: Channel 1 = 50%

When palette recording is enabled NEO stores the reference to the palette rather than the actual value of the attribute.
This means that if a palette is changed any cues that reference that palette will automatically use the new value. The
cue does not actually hold the value of the attribute but obtains the value when the cue is run by looking up the
referenced palette.

For Example: Channel 1 = Intensity Palette = 50%

If "Intensity Palette" is changed to 60% then channel 1 will automatically reflect this change. 

A good example of where this is useful is with position presets. If a show is created and hard values are recorded with
every cue, then the show moves to a different venue we need to go back and revisit every cue and change the
positions of the lights. If the show is recorded with position presets then a change in venue only requires that we
update the position presets that are referenced by the cue list.
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Recording Palettes into Cues
NEO is able to automatically use the palettes created when a cue is recorded.

Before recording the cue apply the palettes to use. In some of the views (Verbose view, ML Attribute view) the name
of the Palette that is applied to the attribute(s) can be seen.

Record the cue as normal and enable the option "Include palettes".

After recording the cue open the cue list editor and double click on the channel field to access the "Cue List Details"
window. 

In the cue list detail window recorded palettes show up as red text. We can see that the "color 1" attribute and the "Pan
& Tilt" attribute are now referencing palettes. Some of the "P / T Speed" attributes are referencing palettes and some
have hard values of 0%.

Clicking on the DMX tab of this window will display the values that are referenced by this palette. Remember that
the value is not actually stored with the cue but rather referenced. If a change is made to the channel group "Pos DSC"
then all of the cues that use this channel group (as a palette) will automatically reference the changed value.

Manually Changing a Palette in a Cue
The channel detail window can also be used to manually change palette references. If in the example above we
wanted to remove the palette references for "P / T Speed" and change channel 3 and 4 to blue rather than magenta.

Include Palettes
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Do this by clicking on the "Palettes" tab of the channel detail window to view only palette information for this cue.

To remove a palette click on the cell and press the backspace key to clear out the entry. Once cleared press the enter
key and the cell will change to "Not set" indicating that no palette is referenced for this attribute any more.

To change a palette reference select the desired palette from the left hand panel and drag and drop it onto the cell to
replace.

Alternatively click in the field to change and simply type the name of the palette to reference. As the user types, a list
appears below the cell of all the palettes that match what has been typed so far. Use the up and down arrow to select
from the list and press enter to apply the selected palette. A palette can also be selected from the list using the mouse.

Edit multi palettes at the same time by highlighting multiple cells and typing the name of the palette to apply. As soon
as the palette is selected it will be saved to all of the selected cells.

Notice that when editing palettes in this window both palettes and channel groups are displayed as a merged list. Any
attribute in a cue can reference a channel group or a palette and so the two types are merged to make selection easier.

Updating a Cue with a Palette
When updating cues that contain palettes special care must be taken to ensure that the end result is what was intended.
If a attribute that is referencing a palette is changed, before the cue is updated, the options exists to either "Record
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Hard Values" (which will place raw data into the cue) or "Update Selected Palettes" (which will update the adjusted
data into the referenced palette and not into the cue itself).

If NEO detects that an attribute has changed that is referencing a palette a dialog will appear asking what should be
done with this change. The dialog above will list all of the palettes that are referenced and require updating. 

If the Palette does not want to be changed (or channel group) and simply record hard values into every cue press the
button labeled "Record hard values". The dialog will close and the cue will be update with all changed palette
references replaced with the actual values of the attribute.

Use the "Update selected palette" button to change the reference to the new value. Use the check boxes to update only
a subset of the palettes in the cue.

24. Patch

NEO provides up to 25,000 control (desk) channels that can be assigned any number of DMX dimmers or intelligent
fixtures. Up to 51,200 DMX outputs are supported by the software and can be patched into the control channels or
fixtures. By default the system will create 500 control channels however increase this number in the "System
Properties". Try and keep the number of channels as low as needed as the more channels the system creates the
slower the start-up and the more load there will be on the system.

NEO NOTES & TIPS:  System will require a restart when the channel number is changed.

To modify the patching of dimmers or intelligent fixtures to channels open the "Patch" window by clicking on the
"Patch" button on the command window or pressing F7 on the keyboard.

There are two different ways to Patch. 

• Command Line Patch which is more traditional for experienced operators.

• GUI Patching which is more aligned with LightFactory using a graphical solution.
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The "Dimmer Patch" window is broken into three sections.

Channel / Fixture View - On the left of the window, this allows the user to see all of the channels and how they are
currently patched.

DMX Output View - At the top right is the DMX output view, containing all of the available outputs.

Fixture List - At the bottom right is the fixture list, containing all the different fixtures that can be patched into
channels.

When NEO is started for the first time or when a new show is created, all channels will be patched 1 to 1 with the
available dimmers.

NEO NOTES & TIPS:  Page up and down the channel / fixture list with [PAGE] and [SHIFT] + [PAGE].

NEO NOTES & TIPS:  Open the Visible Columns pulldown to determine what columns of information are 
appropriate. Many of the secondary columns may be turned off.

Fixture
This first column is a numerical list of all system fixtures. The number of fixtures is set per console (not showfile) in
System Properties > System Input / Output. This is a non-editable column indicated by the darker background color.

Patch Address
This is the address for the fixture based on the fixture make / model. A standard dimmer will consume 1 DMX
address.  For an attributed fixture, this will indicate the starting address of that unit.

Fixture Make / Model
This is the type of fixture by manufacturer and model that is patched to the fixture number at the beginning of the
row. Many generic fixture types will not list a manufacturer as that is not known. The default make and model will be
"Standard Dimmer".

Fixture Spreadsheet

Command Line Patch Area Available Fixtures for GUI Patching

Commands and Pulldowns DMX Outputs
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Initiate a search function with this column per fixture much as can be done with the global Fixture Make / Model box
at the bottom. This will allow the user to search and apply a fixture make and model for each fixture.

P / T (Pan & Tilt) Adjust
These options give the ability to reverse the operation of the pan and tilt control of moving lights. If the user finds that
a moving light has been hung in reverse to the logical movement of the light then it can be corrected without having
to physically change the position of the light. Use the drop down combo to select the adjustment.

Flip Pan - The pan function of the fixture will be reversed

Flip Tilt - The tilt function of the fixture will be reversed

Flip Pan & Tilt - The pan & tilt function of the fixture will be reversed

Swap Pan & Tilt - The pan function will operate tilt and the tilt will operate pan.

When patching via Command Line, the P / T adjust can be accessed by pressing the "Position" key during patching.

Profile
Use the drop down combo box to select the default profile for the dimmer. See “Profile” on page 193 for more
information about this option.

Aux Dimmers
Some fixtures require a separate DMX channel for dimmer control. The VARI*LITE VL5 wash for example does not
have the dimmer included in the list of control channels. This is because the dimmer is a separate power feed to the
fixture. To aux dimmer can be used to set the channel number for this type of fixture.

Use this option when working with color scrollers where the dimmer is not located at a fixed distance from the
control channel.

Enter any list of dimmers required into this field.

Vis Patch
NEO supports having a separate patch for the visualizer output. If nothing is set in this field the software will default
to the same patch information shown in the "patch detail" column and the information will be displayed in a light gray
color.

To change the visualizer patching for any channel simply edit the data in the same way as the "patch detail" column. 

To return the visualizer patching to the default simply delete the contents of the field. As soon the user presses enter,
the default information will be displayed in a light gray color.

Position
Use the position field to describe where the fixture is located in the lighting rig. This field will be displayed in the
verbose view of the channel display.

NEO NOTES & TIPS:  Position info can be used in the Live screen as a Smart Group. For example, if populating 
Position info with 1LX, type (1LX) [ENTER] on the Command Line and it will select all labeled channels.

Unit #
The unit number can be a number that stays with the fixture. Use the unit number field to store any number that may
be useful to identify the fixture.

Purpose
The purpose field should describe what the fixture is being used for. For example - general wash, actor special etc.
This field will be displayed in the verbose view of the channel display.
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Color Description
The color description field can hold any text to describe the color filters that may have been added to the light. This
field will be displayed in the verbose view of the channel display.

NEO NOTES & TIPS:  Color Description info can be used in the Live screen as a Smart Group. For example, if the 
user populates Color Description info with Blue, type (Blue) [ENTER] on the Command Line and it will select all 
labeled channels.

Color
The color field is used for a real world representation of the color used in the fixture. This color will be shown in the
channel display for easy reference. To set the color type any known color description (e.g. Red, Yellow, L202, L194)
into this field. If the color description is not known then the color will be set to "None". Select the color from the
standard NEO color chooser by clicking on the button to the right of the field or by double clicking on the field.

NEO NOTES & TIPS:  Color info can be used in the Live screen as a Smart Group. For example, if the user 
populates Color info with L201, type (L201) [ENTER] on the Command Line and it will select all labeled channels.

Fixture Type
The fixture type field will automatically be populated by patching a fixture from the library. This can however be
changed at any time. The fixture type is used to determine the symbol used in the Magic Sheet view for the channel.

Power
The power field will automatically be populated by patching a fixture from the library. This field should show the
power consumption of the light. 

Weight
The weight field will automatically be populated by patching a fixture from the library. This field should show the
physical weight of the fixture.

Circuit Name, Circuit Number, and Dimmer Phase
Use these fields to record the power source to the fixture. This information may be needed later to debug power
problems.

Accessories
If the fixture has any added accessories added to it (top hat etc) the information can be recorded into this field. 

Generic Data 1, 2 and 3
Any other information to record with the fixture can be stored in any of the three generic fields. Information in these
fields will be displayed in the verbose view of the channel display.

VN Area, VN Rooms, VN Channels
When using NEO in concert with Vision.net, the Vision.net Area, Room and Channel assignment can be configured
directly into NEO. This allows for architectural system programming from a traditional theatrical console. 

For example, if channels 1 thru 6 are set to be VN Room 1, VN Channels 1 thru 6. If you have 3 and 4 at full but all
other channels are at 0, when you record a VN Preset, the data stored in the preset is 1, 2, 5 and 6 @ 0%; 3 and 4 at
50%.

If the VN Area info is left blank, it assumes to be set to VN Area 1.
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DMX Settings
The DMX settings column is a read only display of the dip switch settings for the patched
address. If the fixtures address is set by dip switched then this field can be used as a handy
reference. 

Command Buttons and Pulldowns

Options
Listed are the different options available to the user in patch.

The main issue to understand about patching in NEO is that the patch data is
not saved until you say Save Patch. This gives the user the flexibility to
make changes and restore the patch prior to committing to it for the
showfile.

Insert (Move All Fixtures Down a Channel)
Use the insert if you need to add a fixture to the patch and want to add it
between two other patched channels. The insert option will move all of the
patch information down one channel form the currently selected channel.

Reset Patch
Selecting "Reset patch" from the menu will return all of the channels back
to a 1:1 patch. Each channel will be patched to the corresponding dimmer
number.

To reset only a range of channels select the desired channels by clicking in
the left of the system channels grid to highlight the desired channels. Select
"Reset patch by range" to only reset the highlighted channels.

Clear Patch
Selecting "Clear patch" from the menu will remove all of the patch
information form the system. Each channel will no longer be patched to
dimmers.
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To clear only a range of channels select the desired channels by clicking in the left of the system channels grid to
highlight the desired channels. Select "Clear patch by range" to remove dimmers and patching details form the
channels.

Clear the patch by universe by selecting one of the sub menu items that will appear when clicking on "Clear patch by
universe"

Swap Universe

Use this option to move fixtures from one DMX universe to another.

Copy Selected Channels

This will copy any selected fixtures patch info to a different fixture.

Options allow for DMX Universe offset and DMX Output offset.

Edit Dimmer Profiles
Allows the ability to set a system profile to a dimmer rather than a channel / fixture.
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Just click on the appropriate dimmer and select the desired profile.

NEO NOTES & TIPS:  Select "Open Profile Editor" to customize or create a custom profile.

When assigned, both the Dimmer Profile window listing as well as the DMX Outputs table will identify the assigned
profile.

Removing a custom profile, just return the dimmer profile to the Linear profile as that is the normal default profile.

Auto Palettes
When an automated luminaire is patched that has DMX channels that has frames or slots (whether mechanical or
electronic) then NEO will trigger the ability to create Auto Palettes if the option below is turned on.

Create palettes automatically when patching fixtures. Allows palettes to be created automatically for color wheels,
color presets and gobo wheels. These palettes will be mapped to Shortcut pages. One page for each fixture type.

Remove automatically created palettes for the selected fixture. - on the selected fixture, will remove all palletized
shortcuts.

Create palettes for the selected fixture. - on the selected fixture, will create all available palettes. This is the same as
create auto palettes upon patching.

Export Patch to CSV
Use this option to create a csv file of the patch that can be imported into Excel or other application. This is also a good
way to get the correct fields to use for importing patch data.

Import Patch Data from CSV File
To import patching from a delimited file format (csv) select "Import Patch Data" from this menu. An "open file"
dialog will be displayed to select the file to import. Import patch will trigger the same auto-palette creation feature as
traditional patching.

The format for the imported data is channel, dimmer, fixture brand, fixture name. To supply a list of dimmers for a
channel enclose the list in quotation (") marks. If including an intelligent fixture in the patch information it is
recommended that the brand and fixture name be enclosed in quotation marks.

Import Patch from LIGHTWRIGHT®
Patch information can also be imported from a LIGHTWRIGHT® file. First export from LIGHTWRIGHT® as a
CSV file and keep all default column settings and assignments.

Note:  NEO needs the first record to be the export field labels. The first 3 are the important ones and they must be 1. 
Purpose. 2. Channel. 3. Dimmer in that order. If that is not there, then it will not be recognized as a legal file.

Print Patch
Select "Print Patch" to print all patched channels to a system printer. 
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Use the print preview and printer settings to adjust the look and layout of the patch information that will be sent to the
printer.

Print Patch
Creates a printable file of the showfile's patch data.

Release All Captured Dimmers
If a dimmer has been manually set to a value it is considered captured. This means that regardless of the desk channel
setting the output of that dimmer will remain at its captured value. Captured dimmers are identified by a red number
showing in the top right hand corner of the channel.

To release all channels back to regular control select this option from the menu. This can also be achieved by entering
"dim rel" in the command line interface.

Show Patched Addresses as Absolutes
By default, patched address will display as "Universe.Address". So the first address in the second universe will be
"2.1". If this option is checked, the address will show as the absolute DMX values of 513.

Release All Captured Dimmers
Will release all dimmer override levels from capturing dimmers. This is the same as the Command Line solution of
[DIMMER] [DIMMER].

Show Patched Addresses as Absolutes
By default all addresses will appear as #.# where the number on the left of the decimal point is the universe number
and the number on the right of the decimal point is the fixture's DMX address from 1 to 512.

Checking this feature will show all addresses in their Absolute DMX address so 2.1 will be shown as 513.

Replace Other Channels When Drag and Drop Patching
When using the GUI solution of drag and drop patching, the new channel will replace the old channel assignment
with this in the default position of on. If turned off, drag and drop patching shall add to the current assignment.

Patching Fixtures in Reverse Order
When doing range patching, will patch the list of items in reverse order rather than in numerical order.

Command Line always overwrites existing patch
Makes sure that when using the drag / drop method of patching, this will override and replace any existing fixture
assignment.

Automatically Look Up Text When Typing
When in a cell of the grid, start typing test it will try to auto complete based on what's already in the grid. Similar to
the way Excel does. 

First Dip Switch Value is 0
The last column in the grid shows the dip switch settings. Use this setting to change if the dip switches start at 0 or 1.

Show / Hide Search Bar
This will reveal or hide the patch search bar.

Reset Grid Layout to Default
This resets all column width settings to default.

Autosize Patch Address Column
Will automatically set the width of the patch address column to show all addressing that has been assigned to that
fixture.

Save Patch
A patch change is not automatically saved so changes can be made to the patch and reverted back should those
changes not be desired.
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Save Patch function saves the patch changes to the show file.

Save Patch and Close Window
Saves the patch changes and close the patch window taking the user back to the Live screen.

Revert to Last Saved Patch
Ignores the patch changes made since the last patch save.

Close Window without Saving
Ignores the patch changes made since the last patch save AND close the patch window taking you back to the Live
screen.

Standard Dimmer
By default the "Standard Dimmer" fixture is selected. Standard dimmers use only one dimmer to control the
luminaire.

To change the dimmer associated with a channel:

1) In the dimmer view, click on the desired dimmer number and hold the left mouse button down.

2) Drag the dimmer over the channel in the channel view area. When releaseing the mouse the channel will 
automatically be patched to the new value.

Multiple dimmers can be patched to a single channel by clicking in the "Detail" field and entering a list of channels
separated by a comma (,).

Command Line Patch
At the bottom of the Patch display, there are two entry boxes, the Make / Model box for the make and model of the
desired fixture and the Command Line box for entering the Command Line patch info, an Enter button and a
Channel/Dimmer switch.

The left box determines "what" gets patched. Standard Dimmer is the default for conventional dimmer patching. The
right box determines "where" the patching occurs for channels/fixtures and dimmers/outputs.

[SHIFT] + [DIMMER] will default the make/model back to the default of a dimmer.

Patch by Channel Number First
By default, the Patch is set to take a Command Line patch where the Channel number is first. So the sequence would
be "Channel Number @ Output Number Enter". This is the recommended way to patch.The Channel/Dimmer switch
determines the order of the info for Command Line patch. 

For example, to patch a standard dimmer of 12 to fixture 2, type [2] [@] [1] [2] [ENTER]. This will assign dimmer 12
to fixture 2.

Flip the Channel/Dimmer switch and type this output first. [1] [2] [@] [2] [ENTER].

Patching in reverse range order is also achievable. [6] [THRU] [10] [@] [10] [THRU] [6] [ENTER].

Patching by Dimmer Number First
Alternatively, patch using the dimmer number first, then move the switch to say "Dimmer" and now the Command
Line will need to be "Dimmer Number @ Channel Number Enter".

NEO NOTES & TIPS:  NEO allows the user to patch a dimmer to multiple channels. This can be useful with deck 
units that change from one scene/act to another yet the same dimmer still needs to be used. However, many users will 
patch a dimmer to multiple channels by mistake. The output display will identify any output that has been patched to 
multiple channels with a highlighted background. This is to alert the user to a double patched dimmer.
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Should the channel numbers for the double patched dimmer not be able to display completely, hovering the mouse
pointer over the double patched dimmer will reveal a text box that will identify the channel numbers.

Using Command Line patch, if the channel range goes beyond the 512 addresses of a single universe, the console will
patch as many fixtures as possible within the selected universe and then continue with address 1 of the next universe.

NEO NOTES & TIPS:  Multiple dimmers connected to a channel will output the same value dependent on the 
channel value and the channel profile curve. See “Profile” on page 193 for more information.

Viewable Channels Based On Patch
Only channels that have a dimmer assignment will be displayed in any of the Live channel displays. Should the user
want to view channels and program them but don't yet know the dimmer assignments, they can be patched to dimmer
"0". This will display in patch as "not patched". It will allow the channel to display in Live even though there is no
outputting dimmer assignment.

Intelligent Fixtures
Intelligent fixtures use more than one physical output to control various aspects or attributes of the luminaire. A
channel can only be patched to one intelligent fixture and can be identified by the name of the fixture in the detail
column of the channel view.

To patch an intelligent fixture to a fixture:

1) Select the desired luminaire from the tree view under the title "Available Fixtures".

Command Line Patch
At the bottom of the Patch display, there are two entry boxes an Enter button and a Channel/Dimmer switch.
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To patch an automated luminaire, start typing the fixture name in the left field. Once 3 digits are typed, the NEO
software will attempt to find it. VARI*LITE VL3000 is used as an example. From here, ARROW Up/Down or click
with the mouse pointer to select.

Once selected, type TAB to move the cursor to the right box. Now type in [CHANNEL LIST] [@] [Starting Address].

In this example, we will patch 10 - VL3000 Spots (Mode 1) starting at address 4.1. Type the absolute address number
here as well.

[ENTER] will complete the command. 

When Enter is pressed, a dialogue box will appear and ask if the NEO software should create AutoPalettes.

This will automatically create shortcuts for all color/gobo wheel items. Select Yes or No as you desire.

Once done, you can view the data in the DMX Output side of the Patch display.

Select the correct universe by it's tab at the top. In this case DMX 4. This shows all details (starting address, DMX
offset, patched channel number, attribute label and a band for the entire fixture.)

Offset Patching
Offset patching allows the user to skip a certain amount of DMX outputs when patching by using the "+" key twice in
the Command Line. [CHANNEL LIST] [@] [DMX OUTPUT] [+] [+] [OFFSET NUMBER] [ENTER]. When the
"+" key is pressed once, it allows multiple outputs to be patched. When the "+" key is pressed twice, the word
"OFFSET" appears on the Command Line to allow you to set the offset number.

In the previous example, we patched 10 VL3000s starting at 4.1. This just took the next available address for the
subsequent fixture. What if you wanted these units to be address to the next "10s" number. Since the VL3000 has 28
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addresses, the first one should be at 4.1, the second at 4.31, the third at 4.61 and so on. Using Offset Patching, you
patch them with the following syntax. [101] [THRU] [110] [@] [4.1] [+] [+] [30] [ENTER]. This will patch the first
unit at 4.1, the second at 4.1 + 30 which is 4.31 and so on until channel numbers run out. In this case, at 110.

Graphical Patch Option
Alternately, a GUI Patch option exists. Use the Available Fixture file structure (or the Find box) to identify the
existing fixture to be patched.

In the example below, I have typed "VL3000" into the Find box. Then clicked on the "+" in the file tree structure to
show the available modes. Select Mode 1.

Quantity
Set the Quantity of fixtures to be patched. This example only shows 1.

Patch with Click and Drag
Use the cursor and hover over the starting DMX address. Notice that the framework (background to DMX output
boxes) is in a medium blue. This identifies the number of DMX outputs required for the selected quantity of fixtures.
The example shows that I'm hovering over the starting address of 5.21. When the correct starting address has been
identified, just "click" and "drag" to the correct channel number.

Note:  All of the fixtures are grouped under the brand name and can be accessed by clicking on the small plus (+) to 
the left of the brand name. The brand will then be expanded showing all of the models available.

• Click on the fixture model to patch to see a picture of the light on the right.

• When the fixture is selected in the available fixtures list, it will assist with Command Line patch by populating this 
fixture in the Make/Model box.

• Move the mouse over the "Dimmers" section of the window, click the mouse on the dimmer where the fixture 
starts and, while holding the mouse button down, drag the dimmer over the channel to patch.

NEO NOTES & TIPS:  When intelligent fixtures are selected, the dimmers will be highlighted in a grey background 
to show the number of dimmers that the fixture uses.

The channel detail will now show the newly patched fixture followed by the "@" symbol and the start dimmer
number.
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Patch multiple intelligent fixtures at one time (consecutively) by changing the quantity (Qty) value at the top right of
the "Available Fixtures" section. If more than one fixture is patched then additional fixtures will occupy the channels
following the first one you drag the patch to.

Once an intelligent fixture has been patched, add more to the patch by holding down the shift key on the desired
fixture and pressing the down arrow.

Other Information
The channels grid on the left hand side of the window also allows more information about the patch to be stored.
Some of the fields directly influence the output of the channel while others are used for reference to help program the
show.

Multiple Intensity Fixtures
Many of today's current generation fixtures have multiple intensities. Fixtures that give multiple LED cells that can
be controlled individually. Most of these fixtures allow for different modes that include complete control of the entire
unit as one fixture or breaking each cell out to have individual control of every LED cell. LED wash fixtures like the
Showline Punchlite 220 gives either global control or the wash head can be controlled with 3 different RGBW
intensities. The outside ring of LEDs is separated into the left/right half while the inside ring is separate. The
Showline 640 strip has 12 pairs of RGBW LEDs and a setting called "Group". This determines the grouping of LEDs.
It can be set to 1, 2, 3, 4, 6 or 12. Grouping of 1 means that the entire fixture is controlled as one unit. Group 12 means
that each pair of RGBW LEDs can be controlled individually. While this means more resolution and greater control,
it takes up more DMX channels. For example, the SL Bar 640 in 16 bit mode and group 1 requires 16 DMX channels.
Group 12 requires 104 DMX channels. That's a big difference. Don't assume that more control/separation is always
better. If it's not needed, then it's likely best not to use it.

Master/Cell Fixture Patching
One way to deal with multiple intensity fixtures is to patch them as Master/Cell channels. The first channel patched is
the Master channel. This means that all parameters patched to the Master channel to the entire fixture. Typical master
parameters would be pan, tilt, zoom, strobe and so on. Then each cell gets a different channel individually. So if I'm
patching up the SL640 in group 12 then I would have 1 master channel and 12 cell channels. The SL Punchlite 220
would have 1 master channel and 3 cell channels. 

If in the fixture library for a given fixture, modes follow this format...

• PHILIPS SHOWLINE - SL BAR 640 (RGBW 16Bit Master)

• PHILIPS SHOWLINE - SL BAR 640 (RGBW 16Bit Cell)

...then these 2 fixture types would be used to patch one SL Bar 640. Set the type to the Master mode and patch this to
the first channel. Then change the fixture type to the Cell mode and patch the next range of channels (the quantity
being determined by the grouping number) starting with the next available DMX address. Remember, as far as the
fixture is concerned, this is one mode so the DMX string is consecutive. For example, on the SL 640, the first 8
addresses are master addresses (Intensity Hi, Intensity Low, Color Presets, Strobe, Duration, Intensity Timing, Color
Timing, Control), starting with address 9, it outputs Red Hi, Red Low, Green Hi, Green Low, Blue Hi, Blue Low,
White Hi, White Lo. This grouping repeats for the number of groups set on the menu of the fixture.

Sub-Fixtures

Sub-fixtures is a way to improve on the management of multiple intensity fixtures over the master/cell procedure.
Many LED strips allow for “Group” setting determining how many groups can be used to control all intensity
components. For example, the Philips Showline 640 strip has 12 pairs of LEDs. The Group setting on the fixture
allows for Group 1 – all cells, Group 2 – 6 cells per fixture, Group 3 – 4 cells per fixture, Group 4 – 3 cells per fixture,

Quantity Control for Intelligent Fixtures
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Group 6 – 2 cells per fixture or Group 12 – 1 cell per fixture. NEO’s fixture library has all of these grouping options
available as a patchable fixture. Once patched as a sub fixture the following basic functionality exists. 

For example, if patched as channel 101 in group 6 mode, channel 101 will be the master, while the cells will be
patched a sub channels 101.1 thru 101.6. 

• (Channel List) [FULL] will take the virtual master AND all cells to full. 

• (Channel List) [@] (Level) will take the virtual master to the level and all cells to full. 

• (Channel List) [.] [ENTER] will expand the sub-fixture to show all sub channels. Repeating the command will col-
lapse the channels from the Classic Grid. 

• (Channel) [.] (Cell) [ENTER] will select only the individual cell. For example, [101] [.] [1] [ENTER] will select 
only the first cell. 

• (Channel) [.] (Cell) [THRU] [.] (Cell) [ENTER] will select all cells. For example, [101] [.] [1] [THRU] [ENTER] 
will select all cells. 

• Whether NEO has selected multiple masters or multiple cells the following will apply. 

• Odd – [SELECT] (Tools & Macros) [1] {ODD} 

• Even - [SELECT] (Tools & Macros) [2] {EVEN} 

• Offset – [+] [+] {OFFSET} 

• Offset and Cluster – [+] [+] {OFFSET} (#) [+] [+] {CLUSTER} 

• Fan – [FAN] 

• FX Library FXs 

The master intensity on any sub fixture will now function like the master for all sub fixture components.

• If both master and cells are selected and a level is applied (and sub fixtures are not at a level) then the master is 
now set to the level specified and the sub fixtures set to full.

• (Channel List) [.] @ (Level) adds the ability to set the intensity for all sub fixture’s sub channels.

• Changed sub fixtures so that they are mastered by the master fixtures virtual intensity. If the fixture has a real mas-
ter intensity then this is ignored. 

• If a sub-fixture’s intensity is set and the master is currently 0 then the master intensity will now automatically be 
set to full.
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The example belows shows patching channels 101 and 102 as SL 640s in 6 Group mode.

Back in Live, here is how they look in the Classic View...

Type [101] [ENTER] and that will select the channel as normal. If the user types [101] [.] [ENTER], the parent
channel of 101 expands to display all of the daughter or point channels of 101.1 thru 101.6. Type [101] [.] [THRU]
[ENTER] and that will select all sub-fixtures as well as expand it in the Live/Blind display.

If a level or change color applies to 101 only, it will apply to the entire fixture.

However to change levels or colors on the individual cells, just type the sub-channels that you want to control. In this
example, 101.1+101.3+101.5 have been selected and had their colors changed. Also type [101.1] [+] [.3] [+] [.5] and
it will assume cells are being selected for 101.

Added special sub fixture intensity logic when setting the master intensity:

a. If the fixture has a master intensity and the sub fixture virtual intensity is 0 then set the sub fixture 
intensity to full (final output will be overridden by the master real intensity).

b. If the fixture does not have a master intensity and the sub fixture intensity is 0 then set the sub fixture 
intensity to the level specified.
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c. If (and only if) the master intensity is virtual and the sub fixture intensities are already at a level when set 
the sub fixture intensity to the proportional level.

With sub-fixtures patched and the parent channel selected, the Side Bar will display both a Master Control tab (for all
parameters that apply to the entire fixture and an All Sub Fixture Control that will give the ability to control all cell
colors.

Encoder paging has improved with sub-fixture control as well. If the user pages the encoder assignment page by
pressing the [COLOR] key, it will cycle through all pages for controlling color on each individual cell. Just look for
the identifiers of "RGB (#)". The # will indicate which cell/page is being controlled. Below the image shows that the
encoders are controlling the second cell.
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Any normal control, (intensity control, parameter control, Fan, FX Library, Groups, Subs) that you expect to work on
standard channels versions of that fixture will work on the sub-fixture version.

Sub-fixtures are now supported in the Matrix Editor, the Matrix Effect, the Cue List Detail Matrix view as well as the
Chase Effect Matrix Editor.

25. RDM

RDM is an extension to the DMX protocol that provides bi-directional communications with RDM compatible
devices and fixtures.

Clicking on the RDM button will bring up a separate window for RDM control.

NEO NOTES & TIPS:  Not all output devices support RDM functionality. The universe selection in the RDM 
window will only display hardware that supports RDM. If the device is not listed then RDM functionality cannot be 
used.

The RDM window can be used to find devices connected to the DMX network, change their label, set the start
address and personality. If the fixture supports identifying its attribute list NEO can also automatically build a fixture
and store it in the fixture library the first time it is patched.

To start the discovery process select the DMX universe form the menu in the in the top left corner and click on "Find
All". The discovery process may take some time to return and if possible NEO will notify of its progress. This is not
always possible and it may appear as though nothing it happening. When the discovery process has finished the "find
all" button will become active again. If devices are added to the system use the "Find additional" button to find only
those not already found.

Once the devices have been found they will be listed in the grid as shown. If not all of the information is correctly
found use the small button to the right of the "Number" to attempt a second retrieve.

Model - The model field is a read only field that will typically tell what the device is.

Device Label - The device label is a changeable field stored on the device. Use this to store user information on the
fixture itself. When the device is patched into NEO the label will automatically be placed into the first generic data
field.

Channel - When the devices are discovered NEO will work out what channel is currently assigned to the DMX start
address and display it in this field. If the channel number has an asterisk (*) attached to it then this indicates that the

RDM Control Window
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fixture definition does not match the model and footprint. This simply means that while the start address is patched
the fixture is not. 

Note:  Any changes made to the channel field will not apply until the "patch" button is pressed.

DMX Address - The DMX start address is the first DMX channel number that the fixture or device will use for
control. Changing this field will automatically update the device with the new value. If the value returns to the
previous setting then the message has not reported a successful change.

Note:  Changes to the DMX address field will automatically patch the fixture.

Footprint - The footprint is a read only field to indicate how many DMX channels the fixture uses for control.

Personality - Setting the personality will change how the fixture or device is controlled. Changing the personality by
selecting form the drop down list will automatically update the device/fixture. If the value returns to the previous
setting then the message has not reported a successful change. Changing the personality may change the footprint of
the fixture.

Identify - Use the identify button to find the fixture or device. This function is used for the user to physically identify
the device. The device/fixture shall physically identify itself using a visible or audible action. For example, strobing a
light or outputting fog. Click on this button will put the device/fixture into identify mode and change the label top
"Identify Off". Clicking again will turn off the identify mode.

Clear channel assignment - Click on this button to clear all of the channel numbers currently assigned to the
devices. No changes will be made to the actual patch at this point. All of the devices/fixtures will show "not patched".

Clear DMX address - Click on this button to clear all of the DMX addresses shown. This will not change the
assigned DMX start address on the device/fixture. Use this option when to automatically patch all of the fixtures
found using the instructions below.

Automatic Patching
The NEO RDM window provides a quick and easy way to patch all of the RDM devices that have been found. Before
starting this process click on the "clear channel assignment" and the "clear DMX addresses" button.

Next use the identify button to find the first fixture to be patched. Once the first fixture has been found, click on the
"Patch" button. The selected fixture will be patched to the first channel and the first DMX address.

If the fixture (referenced by the Manufacturer and Model information) if not found the NEO fixture database then the
software will interrogate the fixture using RDM and build a suitable fixture profile. The amount of detail contained in
the new fixture profile will depend on the RDM commands supported by the device/fixture.

To patch the rest of the devices/fixtures use the identify button to find the next fixture and click "Patch" to patch it
into NEO. The software will automatically assign the next channel and the correct DMX start address to fit the
fixture.

Edit Menu
The edit menu provides access to the following windows:

Edit Fixture Library
The fixture library is the list of all available fixtures that can be patched in the
software. Each fixture has an associated definition file that contains information
about how the NEO can manipulate the features of the light.
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The fixture editor is a separate program provided with NEO. Use the graphical interface to add, remove or modify
fixtures.

See the "NEO Fixture Editor Manual" for a detailed description of how to work with this application. This is
available at www.strandlighting.com.

Edit Profiles
The channel profile is a way to adjust the relationship between channel value and the final output of the dimmers. The
default relationship is called linear (1:1) meaning that if the channel is set to 0 then the output is 0, if the channel is set
to 50 then the output is 50 and if the channel is set to 255 then the output is also 255.

Changing the profile allows correction for older lamps or make special channels for fixtures that do not have full
dimmer functions. (e.g. A smoke machine)

Profiles are also used in the "Profile Effect" as the path that the effect will apply to an attribute. See “Profile Effect
Options” on page 270 The same editing window is used for both the channel profile and the profile effect.

To selection a profile for a channel simply use the drop down list in the channels grid. The list that appears will show
a small image of the profile and its name.
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To adjust a profile or to make a new one choose "Edit Profiles" from the drop down menu attached to the "Edit"
button. Access the profile editor from the main command window from the "Extras" menu.

On the left side of the window is the list of profiles in the system. Profiles are not stored with the show information
and will remain in the system until deleted using the profile editor.

When the software is first installed a number of default profiles will be created. The default profiles cannot be edited
and are identified by the small padlock that is sown in the bottom right corner of the window. To edit a default profile
first make a copy of it using the button provided.

To create a new profile click on the "Create New Profile" button under the list of available profiles. A dialog will
appear asking for the name of the new profile. Enter a short description of the profile to create and click on the "OK"
button. The new profile will default to the "Linear" path.

To make a change to this click anywhere on the grid and a small red dot will appear. The path will now smoothly go
through the point just created. Move this point by clicking and holding the mouse button down to drag the point
around the window. Repeat this process to create more points.

By default the system will draw a tight path between every point created. Use the Elasticity spin edit to adjust the
obtuseness of the curve. Setting the elasticity to 1 will draw straight lines between each point without a curved fit.

Profile Editor, Damped Profile Selected

Profile Editor, Custom Profile
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Edit Matrices
Before creating matrix or LED effects, define how the fixtures and lights are laid out in the real world. The "Edit
Matrices" window provides a simple interface to provide a rough layout of the fixtures.

Access this window from the "Extras" menu on the NEO Command Line interface window.

A lighting matrix is a simple two dimensional grid where each cell can be assigned a channel or fixture from the
system. On the left of the window is a list of available matrices that have been created previously. To edit any matrix,
click on the name and the right hand grid will change to show the definition.

To create a new matrix definition click on the "Add Matrix" button in the bottom left corner of the window. A dialog
prompts the user to enter a name for the new matrix. Click on the "OK" button and the new definition will appear in
the list on the left hand side of the window.

To delete a matrix click on the "Remove Matrix" button in the bottom left corner of the window. A dialog asks for
confirmation. Click on the "OK" button to delete it from the system.

The size of the matrix can be changed at any time by setting the columns and rows spin edit boxes along the bottom
of the window.

By default a matrix will be empty with no fixtures assigned. In order to output a matrix effect to fixtures you must
identify where the fixtures are in the grid. To do this click on the desired cell and a fixture number will appear. The
"Next Fixture" edit at the bottom of the window will automatically increment so that the next fixture can be assigned.

At any time you can change the "Next Fixture" number to any desired system channel.

By clicking in the grid (holding the mouse button down) and dragging the mouse over several cells to assign a
number of fixtures at the same time. Each cell will be assigned a unique fixture and the "Next Fixture" value will be
incremented.

Assigning an Image
Use the Load & Clear options to assign a picture of the matrix for future reference. The image assigned to the matrix
is displayed behind the matrix editor and can be used to align the position of fixtures in a real environment.

Edit Matrix Window
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Click on the "Load" button to open an image dialog. Select any image that represents the matrix of fixtures and click
"Open" to complete the operation. The image should appear in the window just above the load and clear buttons.

Click on the "Clear" button to remove the image from the system.

In the "Auto Patch" menu is an option labeled "Match rows and columns to the image size". This will automatically
set a 1:1 relationship between the pixels in the image and the matrix itself. This option should not be used on images
bigger than 500 pixels wide and high.

If the predominant color of the image makes the text unreadable in the matrix view tick the "use white text" option
below the Load and Clear buttons.

Auto Patch
The auto patch menu makes it easy to setup simple matrix situations such as filling the entire matrix or creating bars
and checker patterns. 

This menu also provides an option the Clear Patch to remove all channel assignments from the matrix.

Use the Number Vertically check box to have increasing numbers vertically rather than horizontally when
automatically assigning channels.

MUTE Output
The mute button will temporarily STOP all DMX output from NEO at a hardware level. To use another DMX
controller temporarily, mute NEO so that the output streams do not fight for control. 

This button will toggle the MUTE state so clicking again will un-mute the system. When the system is muted the
button is display in red.

A warning appears at the bottom right of the screen when the output is muted. Output muting can be turned on or off
in Patch. When the output is muted the physical DMX ports on the console will stop sending data (no RS485 signal).
For Ethernet output from the desk the mute function will only stop DMX packets being sent on the Ethernet. This
does not guarantee that node will not continue to output the last received state.

Visible Columns
Click on the Visible Columns menu to pop up a list of columns displays in the left panel of the window. From this list,
turn on and off any of the columns so that only necessary fields are visible.

This menu will persist until you click anywhere outside of the menu. This is to help make the selection process
quicker when you want to turn on and off multiple columns.

Note:  When in Basic Mode, some of the columns will be turned off by default. 

26. Cue Playbacks

The cue playbacks are designed to execute multiple cue lists from one place. Each
playback is a repeat of functions seen in the cue list editor window. (See “Cue List
Display / Editor” on page 179 for more information).

Open the "Cue Playbacks" window by clicking on the button at the bottom of the
Command Line interface or by pressing F8 on the keyboard.

When selecting a playback, the side bar automatically switches to the Current Playback tab.
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With the NEO Cue Playback window as with many areas of the software, color tells the story. Cyan indicates a Cue
List Playback, Magenta indicates an FX Playback and Yellow is the color of the selected cue list playback.

NEO provides the ability to assign cue lists to a virtually unlimited number of playbacks. Use the system properties
settings to define how many playbacks will appear on each page. Use the page control at the bottom left corner of the
window to move between pages.

To use a cue playback, assign a "Cue List" by pressing the appropriate Cue List's 'Select" button. Once it is assigned,
pressing the "Select" button again sets the selected cue list on the Side Bar Cue List so it is clear which cue list is
being manipulated. Once the cue playback is assigned, press [SHIFT] + [SELECT] on the appropriate cue list to
reassign a different cue list as needed.

The Page Up/Down buttons will page the virtual Cue Playbacks up and down. (To page the hardware Playbacks, use
the Playback Page setting on the bottom right hand of the Live screen).

Execute Cue Lists Exclusively
Will force all force all other running cue lists to terminate.

Disable Reset
Will disable the Reset button within the Cue Playback window.

Console View 
When checked, will display the NEO Cue Playback window that matches the hardware. When unchecked, restores to
the legacy display format that gives more on screen options.
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Add a playback to the system by pressing the "Add" button at the bottom of the page. The new playback will be
placed at the end of the list. To remove the last playback click on the "Remove" button provided. A confirmation
dialog will asks to confirm removal of the playback.

Click on the button on the left of the playback to assign a cue list and starting cue. The following dialog will appear
listing the available cues and cue lists in the system.

Expand the cue list that by clicking on the small plus next to its name and then select the starting cue (Normally Cue
0). Click on "Select" to use this as in the cue playback or click "Cancel" to return without making any changes.

To clear out the cue playback and disable the controls use the "Clear" button.

The description field can be used to enter a meaningful name to the cue playback for future reference. Use the other
fields to set shortcuts and submasters to the playback.

After selecting a valid cue list and starting cue number, the playback controls will become active. Use them to run the
show.

To move a playback to a different location right click anywhere on the playback and select "Move" from the resulting
menu. The mouse cursor will change to a small hand indicating for the user to click on the playback to move it to.

Assign the cue list and starting
cue number using this button.

Show Runner Number

Cue List Group

Current Cue
Cue Progress

Playback Controls

Cue Playback, Cue Selection
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27. FX or Effects Playbacks

"Effect Playbacks" provide a quick and easy way to access effects in an ad-hoc manner.
Once the effects have been created (See "Effects Editor" to learn how), they can be used
either within cue lists or manually from effects runners.

Open the "Effects Playback" window by clicking on the "Fx Playbacks" button at the
bottom of the Command Line interface or pressing the F9 key on the keyboard.

This window will remain empty until the user begins adding playbacks by clicking on the "Add Playback" button.
Playbacks can be removed by clicking on the small X in the top right of the frame.

At any time re-order the effects playbacks by right-clicking to bring up the move menu. Click on the "Move Up",
"Move Down" or "Move To" to rearrange the effect runner appearance order. "Copy color to other playbacks" will
match the color appearance from one playback to the others. 

Options
The "Options" button at the bottom of this window can be used to change the size of the playbacks or toggle the edit
mode sate. When the edit mode is turned off, delete a playback or change its settings. This switch is designed to avoid
accidentally changing the configuration during a show. 

Effects Playbacks

Effects Playbacks Move Options
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Effects Playback Sizes
The "Options" menu allows the user to set three different sizes for the playbacks.

Setting up a New Effect Playback
Left click inside the playback to bring up the "Effect Playback Properties" window.

The description field can be used to easily identify the playback and will appear along the top of the control. By
default, this will be set to the same as the effect name but can be changed as desired.

Effect Playbacks - Compact Mode

Effect Playbacks - Normal Mode

Effect Playbacks - Large Mode

Effect Playback Properties Windows
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To set the effect to the playback, select the desired effect from the drop down list and the effect playback will become
active.

Depending on the type of effect selected, different options will become visible.

Click on the "Edit Effect" button to open the effects editor and automatically show the effect assigned to this
playback.

Exclusive Group
When a playback is created it is automatically placed into the "Independent" group (exclusive group 0). Effects
contained in the independent group will run independently and can all be run at the same time. Setting an effect into
an exclusive group other than 0 will make it exclusive. Only one effects contained in an exclusive group (group other
than 0) can be active at any time. If another effect is started in an exclusive group while another is already running
then the existing effect will stop and the new one starts.

Timeline Effects Options

Submaster - Assigning a submaster to the playback will override the dimmer of the fixtures contained in the effect.
As the effect runs the position of the submaster will determine output of the fixtures.

Playback - Assigning a playback will disable the submaster edit box as only one can be assigned to the playback.
Assigning a playback does more than just utilize the fader on the wing. The play, back and pause buttons can also be
used to run the effect.

Start/Stop Shortcut - Set a shortcut number to assign to the playback controls for this playback. Pressing the shortcut
will start the effect running. Pressing the shortcut while the effect is running will pause the effect and pressing it twice
within 2 seconds will rewind the effect to the start.

Override Effect Length - Set this field to change the length that the effect will run for. If this value is set to 0, the
default length (Set during creation of the effect) will be used. If the effect length is overridden then all of the segments
in the effect will be rescaled to this new length.

Loop Continuously - Check this option to make the effect loop back to the start when it finishes. If this option is not
checked then it will stop as soon as the effect ends.
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Chase Options

Submaster - Assigning a submaster to the playback will override the dimmer of the fixtures contained in the effect.
As the effect runs the position of the submaster will determine output of the fixtures. A submaster assigned to a chase
will also cause the effect to automatically start when the value is above 0 and pause with it returns to 0.

Playback - Assigning a playback will disable the submaster edit as only one can be assigned to the playback at a
time. Assigning a playback does more than just utilize the fader on the wing. The play, back and pause buttons can
also be used to run the effect.

Step Shortcut - Set a shortcut number to use to step the chase. Pressing the assigned shortcut will cause the chase to
transition from the current step to the next.

Fade Time Submaster - To manually adjust the fade time or transition time as the chase is running, assign a
submaster that will control this. As each step executes the fade time will be dependent on the position of the
submaster. The maximum fade time that can be set by the submaster is 10min.

Step Time Submaster - To manually adjust the step time (time between automatic executions of steps) as the chase is
running, assign a submaster that will control this. As each step executes the time before the next step executes will be
determined by the position of the submaster. The maximum step time that can be set by the submaster is 10min.

Chase Direction - Use this drop down option to specify how chase will run. 

• Forward - The chase will run from the first step to the last. If the chase is set to loop the chase will return to the 
first step after the last step.

• Backward - The chase will run from the last step to the first step. If the chase is set to loop the chase will return to 
the last step after reaching the first step.

• Bounce - The chase will run from the first step to the last step and then back to the first step. If the chase is setup to 
loop then this will operation will repeat.

• Random - Every step in the chase will execute in a random order.

Step Time - To specify a step time other than the default defined in when the chase was created enter a value into this
field. Setting the step time to zero (0) will cause the default step time to be used.

Click on the buttons to the right of the "Step Time" field to set the chase to be triggered by either the audio or tap
tempo features.

Fade Time - To specify a fade time other than the default defined in when the chase was created enter a value into
this field. Setting the fade time to zero (0) will cause the default fade time to be used.
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Profile Effect Options

Submaster - Assigning a submaster to the playback will override the dimmer of the fixtures contained in the effect.
As the effect runs the position of the submaster will determine output of the fixtures.

Playback - Assigning a playback will disable the submaster edit as only one can be assigned to the FX playback at a
time. Assigning a playback does more than just utilize the fader on the wing. It also allows the play, back and pause
buttons to run the effect.

Start/Stop Shortcut - Set a shortcut number to assign to the playback controls for this playback. Pressing the shortcut
will start the effect running. Pressing the shortcut while the effect is running will pause the effect and pressing it twice
within 2 seconds will rewind the effect to the start.

Override Effect Length - Set this field to change the length that the effect will run for. If this value is set to 0, the
default length (Set during creation of the effect) will be used. 

Loop Continuously - Check this option to make the effect loop back to the start when it finishes. If this option is not
checked then it will stop as soon as the effect ends.

Scale Submaster - Assign a submaster to this field to manually adjust the scale parameter of the effect while it is
running. This can provide a dynamic way to vary the effect.

Offset Submaster - Assign a submaster to this field to manually adjust the offset parameter of the effect.

Stagger Direction - Use this drop down option to specify how stagger will operate on the list of fixtures. 

• Forward - The stagger will be spread across the fixtures starting at the first fixture.

• Backward - This is the opposite of the forward stagger as the fixtures will be staggered from the last one through 
to the first.

• Bounce - Each time the effect runs the direction of the stagger will alternate between forward and backward 
behavior.

• Random - The fixtures in the effect will have a random order and the stagger applied over the new order.
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Matrix Effect Options

Submaster - Assigning a submaster to the playback will override the intensity the all of the fixtures contained in the
matrix. 

Playback - Assigning a playback will disable the submaster edit as only one can be assigned to the FX playback at a
time. Assigning a playback does more than just utilize the intensity control of the fixtures in the matrix but also
allows the play, back and pause buttons to run the effect.

Start/Stop Shortcut - Set a shortcut number to assign to the playback controls for this playback. Pressing the shortcut
will start the effect running. Pressing the shortcut while the effect is running will pause the effect and pressing it twice
within 2 seconds will rewind the effect to the start.

Override Effect Length - Set this field to change the length that the effect will run for. If this value is set to 0, the
default length (Set during creation of the effect) will be used. 

Loop Continuously - Check this option to make the effect loop back to the start when it finishes. If this option is not
checked then it will stop as soon as the effect ends.

Step to points only - Set this option to jump between points rather than tracking a smooth path. When the effect is
started the length of the effect will be broken up into the number of control points. As the effect runs it will jump from
point to point at equal time intervals.

Stop at each point - Set this option to run the effect more like a chase where each point becomes a step. The effect
will play normally however when each point is reached the effect will pause and wait for a play command.

Media Effect Options

Submaster - Assigning a submaster to the playback will override the volume of audio and the brightness of video
during playback of the effect.

Playback - Assigning a playback will disable the submaster edit as only one can be assigned to the FX playback at a
time. Assigning a playback will control the running the media file plus provide submaster functionally via the slider
below the playback controls.
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Start/Stop Shortcut - Set a shortcut number to assign to the playback controls for this playback. Pressing the shortcut
will start the effect running. Pressing the shortcut while the effect is running will pause the effect and pressing it twice
within 2 seconds will rewind the effect to the start.

Loop Continuously - Check this option to make the effect loop back to the start when it finishes. If this option is not
checked then it will stop as soon as the effect ends.

Playback Controls
Along the bottom of the effect playback frame are the three playback controls and a progress time indicator.

Play
Use the play control to start the effect running. As soon as the effect starts the play control will be
highlighted in green and the time progress will beginning counting. In the case of simple chases the play
control is also used to step through the chase.

Pause
Pausing an effect will stop its execution immediately but keep the position pointer at the current location.
If the effect starts again, the effect will continue from this location.

At the bottom of the page is a button to pause all active effects. Pressing this is the equivalent of clicking
on the pause button of all running effects.

Rewind
Pressing the rewind button will stop the effect running and reset its position back to the start. If the effect
is started again, it will start from the beginning.

At the bottom of the page is a button to reset all active effects. Pressing this is the equivalent of clicking
on the reset button of all running effects.

28. Macro Editor

The macro editor is an enhancement to the Command Line interface and allows the user
to create a list of commands that are executed in one operation.

NEO NOTES & TIPS:  This is particularly useful if you have a sequence of 
commands that you use frequently. Creating a macro enables you to activate the 
sequence in one operation rather than entering each command manually.

Use the macro editor to create new macros or to edit existing ones. 
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Open the "Macro Editor" by clicking on the button at the bottom of the Command Line interface or by pressing F10
on the keyboard.

Figure 13:  Macro Editor Screen

NEO NOTES & TIPS:  Create any number of macros, limited only by system resources.

To create a macro:

1) Click the "Add" button at the bottom left of the window.

2) The add macro dialog box will appear. Enter a meaningful name and click "OK" to create the macro. To 
assign a shortcut to the macro do so in the same dialog.

3) Type the commands for the macro into the window at the right-hand side of the macro editor. This can be 
done from either the external keyboard or from the NEO console's faceplate.

4) The "Run" button can be used to execute the macro (or a shortcut if one is assigned). As the macro executes, 
each line will appear in the Command Line interface window.

Deleting a macro can be achieved by clicking on the appropriate row and clicking the "Delete" button. A
confirmation dialog prompts the user to confirm the deletion before the macro is removed.

To edit the macro name and/or shortcut double click on the row in the macro list. The same dialog as was used to add
a macro will be displayed.

Additional Commands
Macros consist of the same commands that are available in the command window. In addition to these commands,
enter comments and an execution delay (sleep).
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C++ Style Comments 
To add a line of text that will not be executed, place two back slashes (//) before the text. As the system executes each
line, it will ignore lines that begin with these symbols.

Inject
The Inject command forces a command to appear on the Command Line. By default many commands may not
actually appear on the Command Line for user interaction. Added simplified way to add an ENTER to the INJECT
command. A $ or {enter} can now be used instead of %13

Sleep
The sleep command will cause the software to pause before continuing to execute commands after this line. In the
above example (Figure 13 on page 273), the control channel is set to DMX 230 and then set back to 0 after a short
delay of 3.5 seconds. Enter the time of the delay in brackets after the commands. 

Loop & End Loop
Loop a series of commands using the "Loop" and "End Loop" keywords.

Loop {number of times} - This command will mark the beginning of the loop and also define how many times NEO
will perform the loop block.

Loop End - This command will mark the end of the loop. All the command between these two commands will
execute however many times was specified in the "Loop" command.

Branch
The "Branch" command can be used to create conditional jumps in the macro. If the condition is true the macro will
jump to a predefined label.

Branch {condition} {Label}

Labels are any text that starts with the hash (#) character.

Cue
"CUE" can be added to the Command Line or Macro to affect change or trigger cues. Below are some examples that
can be typed in from the external keyboard and thus placed in a Macro.

Cue "Cue List Name" GO

Cue Playback# {Cue #} GO

CUE PLAYBACK{number} {cue list name} will allow the user to assign a cue list to a specified playback.

Smoke
"Smoke" can be added to the Command Line or Macros in the event that a smoke machine or hazer has an attribute
labeled "Smoke" and a direct DMX value is required. Ex: (Channel List) [SMOKE] [@] [50] [ENTER]

branch channel(3) > 30 label1
3@10
end
#label1
3@50.
The above macro will set channel 3 to 50% if its current value is 
greater than 30 otherwise it will be set to 10%

branch my_variabe <= 5 label1
Jump to label1 if the system variable is less than or equal to 5.

branch playback(0) > 10.5 label1
Jump to label1 is the current active cue in playback 0 is greater then 
10.5
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Restart
"Restart" can be added to the Command Line or Macros in order to automatically restart the console.

Exit
"Exit" can be added to the Command Line or Macros in order to automatically exit the NEO software.

User
This is a startup parameters to auto login a user. Parameters are -USER {username} -PASS {password}. The
password parameter is optional.

Direct Serial Port Commands
Allows the ability to communicate to a serial port directly. This will assume communication with the primary serial
port unless otherwise instructed.

• SERIALOPEN {port} {optional parameters} - Open a com port.

• Parameters - Baud (9600), Data bits(8), Parity(none), Stop bits(1), Flow(none)

• Parameters - Add "IGNORE" to the parameter list to not pass incoming serial data to the command line processor

• SERIALWRITE - {port} {Text} - Write the text data to the com port. Add \r to send a return. If the port has not 
been opened then this command will open it with the default parameters and ignore incoming commands.

• SERIALCLOSE - {port} - Close the associated com port.

• SILENT - when this is added to a macro the system will suppress commands being shown on the main command 
line. This will improve performance for high speed macro execution.

• MACRO STOP {number/name} stops macro.

Real time conditional events available to the macro system.

• {F##} option to the INJECT command to trigger a function key. e.g. {F10}

• {^F##} option to the INJECT command to trigger a shifted function key. e.g. {^F10}

• {CLEAR} option to the INJECT command to clear the contents of the command line.

• Right click sorts macros by their ID rather than the name.

• "Lock" option in the macro editor prevents accidental changes to macros.

• INJECT command can be substituted with the > character.

29. Macros - Variables

Variables can be defined and used in macros. Once defined, the value of a variable may be set or altered as part of the
macro or via the command line. Variable names should not conflict with the normal command words used by NEO.
See Reserved Words for exclusions for variables.
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Creating / Editing Variables
To create new variables or edit existing ones, click on the “Variables” tab. To create a new variable, click on the “Add
Variable” button. A new line with the name “New Variable” will be added to the bottom of the list. Click or double-
click on each field to alter the value.  In addition to the name, the following can be set:

Value – Enter the value for a fixed variable or the initial value for an incremental variable.

Min & Max Values – Defines the range of an incremental variable.

Increment – Defines the value that will be added to or subtracted from the variable when it is referenced.  A positive
increment will add to the value and a negative increment will subtract from the value.

Using Variables
Once a variable has been defined, it can be referenced and manipulated within a macro.  The value of a variable may
be set or altered as follows:

{variable name} = {value} – Set the variable to an absolute value

{variable name} =+ {increment] – Add the increment value to the current value

{variable name} =- {decrement} – Subtract the decrement value from the current value.

The following is a list of variables that was created for use in a Channel Check macro.
276 Software Configuration



NEO Lighting Control Console
The macro “Channel Check” illustrates some uses for variables. The first line initializes the variable “Next” to the
value set in “Startchan”. Line 3 is a channel command where the value in “Next” is the channel number and the value
in “Level” is used to set the channel level.

If a variable has an increment value set, each time the variable is referenced it will be added to or subtracted from by
the value.  For example, if “Next” is equal to 1 when Line 3 is executed, it will be incremented by 1 after so if it is
referenced again, it will have the value of 2, etc. This is useful when used inside a loop (see below) to step
incrementally through a set of values, such as channel number in this example.

To stop the macro from running type [MACRO] (#) "STOP". This would be a useful macro to work with the Channel
Check Macro.

30. Macros - Conditional Events

Allows the programming of an event based upon certain conditions. These conditions can apply to different types of
items. After the type has been assigned (like a channel), then the type's number is selected (like channel 1). Then the
condition under which the event is triggered is assigned (like a greater than value). Then the specific value to the
condition is determined. Finally the action that is triggered is selected.

The columns of information to enter are...

Name - user given name to the event.

Type - the item that will be listed to for the triggering of the event. The options are...

Channel - This is a NEO Control Channel.
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DMX Output - This is the output number or the dimmer number.

Submaster - This is the NEO Submaster number.

VN Mode - This is the Vision.net Mode letter.

VN State - This is the Vision.net State letter.

Note:  Vision.net is Philips Strand Lighting's architectural program and can connect with NEO for a powerful 
combination of features that link an architectural lighting programing with a theatrical control console. Go to 
www.strandlighting.com to learn more about Vision.net.

List - a alphanumerical value based upon the type selected. (If the type is set to Channel, then the List is the
Channel(s) used. If the type is set to VN Mode, then the list is the VN Mode letter(s) used.

Condition - the rule that determines what triggers the event. The options are...

All Equals - all in the listed type have a level that is equal to the value set.

Any Equals - any in the listed type have a level that is equal to the value set.

All Less Than - all in the listed type have a level less than the value set.

Any Less Than - any in the listed type have a level less than the value set.

All Greater Than - all in the listed type have a level greater than the value set.

Any Greater Than - all in the listed type have a level greater than the value set.

Value - the level at which the condition applies.

Macro# - the even that is triggered when all conditions are met.
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31. DMX View

The DMX display is provided as a means to debug the system output by showing the final output values being sent to
the DMX hardware.

To open the " DMX View" window click on the DMX View button or select from the MORE pulldown. Each of the
DMX dimmers is represented as a cell in the above grid. The DMX value is displayed to the right of the dimmer
number. Whenever a DMX dimmer has a value greater than 0, it will be highlighted in grey.

The first tab in the window will always display the DMX in state for use in debugging submasters. Click on the
"DMX In" tab to see what is being received by the DMX in hardware.

32. System Properties

Basic Mode vs Advanced Mode
There is a systemic switch at the bottom of the System Properties page, that switches the software between Basic and
Advanced mode. With Basic Mode, the NEO software is configured to work in a typical theatrical environment and
the majority of the options are hidden. A "basic" user working in a performance based environment will operate best
in Basic Mode. New users should start with the Basic Mode.

DMX Output Display Window
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Basic Mode
Basic Mode gives the user only the basic options to configure. Advanced features are listed under the Advanced
Mode section. 

When the system boots the first time, the user has the option of selecting Basic or Advanced mode as well as
watching an introductory video.

In basic mode, the following features are available.

DMX Output Options
The system will report the number of authorized universes on the NEO.
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Philips Advantage DMX will be turned on.  

- Output device/protocol - set the DMX device or protocol to use when outputting over a network or a plug in DMX
device.

Console Ports 1 thru 4 can be configured to the choice of universes. 

System Settings
On Level - the level the "On" key applies.

Up/Down Level - the level the "Up" or "Down" keys will apply.

GM1/2 Buttons - select the desired option for those buttons from the pulldown menu.

A/B Fader Mode - select the desired option for the A/B Faders on the Master Playback from the pulldown menu.

Preset Fader Mode - allows the console to function as a Preset style console. See "Preset Fader Mode" in this
manual for instructions.

Checkbox to show command line syntax help. This is defaulted on.

Automatic show file backup service
This determines the frequency and locations where backups are stored.

• Backup location 1 is the Neo's hard drive in the backup folder.

• Backup location 2 can be set to the users preference. Philips recommends a USB key.

• Number of automatic backups: Determines the number of backups the console will make and keep.

• Backup Interval (Minutes): This is the frequency that backups are created.

Note:  Backups are only created if there is changed data in the showfile.

Show Defaults
Cue List Defaults

• Cue Time: This is the time for the transition of the cue to complete.

• Down Time: This is the time for all intensities that are going down or out in a cue.

• Default tracking record mode: Determine the mode of tracking set to record in.

• Set auto mark: Determines if the attributed fixtures will prepare themselves before they are needed when running 
cues.

• Check box for Mark in cue time. This determines if the mark feature occurs in the cue time or in a straight default 
time.

Check box for the following...

• Include running effects when recording cues. If on, running effects will be recorded into cues. When off, effects 
will remain running independently.

• Include submasters when recording cues. If on, all levels from subs (yellow) will be recorded into the cue. If off, 
levels from subs will be ignored by the record command.

• Include palettes when recording cues. If on, when palettes are used, the reference to the palette will be stored in the 
cue. If off, the reference will be ignored and the raw data will be stored in the cue.

Play Introduction Video
Plays a NEO Introduction Video to help get the user started.

Note:  Speakers/headphones should be plugged in prior to playing the video.
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Note:  When switching from Advanced to Basic Mode, some settings will reset to the basic mode settings when 
applied.

Advanced Mode
The "system properties" window can be accessed by selecting the "Options" drop down menu or by pressing the
System Properties display button at the bottom of the main window or by Shift + F6.

There are nine tabs of settings that to configure in this window:

System Input/Output (DMX) - provides access to settings affecting the flow of DMX data and system channels.
This is primarily related to external DMX hardware installed with the software

System Settings - provides settings that effect the operation of the software. This tab also provides access to the
tracking backup options.

Show Defaults - setting in this tab provide default options for cue lists, channel groups and recording. 

Appearance - the appearance tab allows changing the colors and fonts used throughout the software.

Registration - Options for registering the NEO software. Without a valid registration, NEO will not produce any
DMX output.

Visualizer - Configures integration with WYSIWYG, Capture, or Light Converse visualization tool.

Media - Setting that control the global output of media playback

Special Shortcuts - Setup special shortcuts to control miscellaneous functions.
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System Input/Output (DMX)
The system input/output tab provides access to settings affecting overall operation of the software. This is primarily
related to external DMX hardware installed with the software. Also found in this tab is setting to enable the telnet and
UDP interface.

Figure 14:  System Properties, System I/O Tab

Number of Desk Channel
NEO can support over 25,000 desk channels (also referred to as system channels). Each desk channel can control
multiple DMX channels either by patching several DMX channels to a desk channel or by patching an intelligent
fixture that requires multiple DMX channels for operation.

The more desk channels configured, more CPU resources will be required. By default the software configures 500
desk channels as this will run without issue on the minimum specification for the software. Any PC purchased in the
last couple of years will easily run a lot more than 500 channels.

This number will also define the number of cells in the channel display window. Some may find it easier to view this
window will only the number of channels they need for a show. 

Enter the number of channels for the software to use and restart NEO for the change to take effect.

Max DMX Universes
By default the software will be setup for 10 DMX universes. A DMX universe is a block of 512 DMX channels.
Think of a DMX universe as a physical cable running out from the system.

Although any number of Universes can be configured output will always be restricted to the limit of the registration.
Configure as many universes as desired but only the universes registered will be active. This allows the user to
program any sized show desired without the registration being required until output is needed.

As the user changes the "Max DMX Universe" spin edit notice the number of rows in the grid below will also change.
Each row defines the output for a DMX universe.
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Merge DMX input with output

The most common use for DMX input is the ability to add external physical submasters to the software. In some cases
however it may be desirable to simply merge the input with one of NEO's outputs. The output of the merged DMX
channels will be defined by the behavior set by this combo box.

The merge options are "Highest takes precedence (HTP)", "Lowest takes precedence (LTP)", "Build", "Input takes
precedence" and "Desk Channel Merging".

Merge with Universe
Use this spin edit option to set what NEO universe the software will merge input with. Merging will only occur on the
universe if the "Merge DMX input with output" combo box is set to something other than "None".

Restart DMX System
This button allows restarting of the DMX card and network system. This is to be used when a change is made to the
DMX system's configuration instead of being forced to restart the software or NEO console.

Configuring DMX Universes
The grid in this tab of the system properties defines what physical hardware the software will use to send DMX data
on a universe.

The first column of information cannot be edited and identifies the universe by a number. The first row is different
from all of the rest as it defines the input configuration for the software.

Device
Use the drop down box's provided in the device column to configure the input or output protocol used by the software
to communicate with the DMX system.

• Supported protocols used to input/output DMX data:

• Philips Strand Lighting ShowNet

• Artistic License ArtNet

• Color Kinetics KiNet

• Pathway Pathport

• Streaming ACN (E1.31)

In addition, many external hardware devices are available for configuration. These are primarily available for NEO
PC.

NEO NOTES & TIPS:  After changing either of the hardware selection, restart NEO for the changes to take effect.

Port
Some device options have several output ports available. Each port is a separate DMX universe. In the case of USB
hardware this will refer to a physical plug on the device. For Ethernet hardware the number of ports can be as many as
the protocol supports. 

The drop down box in the port column will only list the available ports for the selected device. For USB hardware
device must be connected for the port to be selected.

When selecting the device the next available port number will be automatically chosen and populated into the port
field.

Network Interface
When using any of the Ethernet based protocols  may need to configure the network interface that the software will
use to communicate with the DMX system.
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By default the system will be set to output to all available network interfaces however to restrict the output to a
specific device use the Network Interface drop down provided. The network interfaces are identified by the IP
address that it is bound to.

DMX Frame Rate
Some of the USB hardware also provides the ability to set the DMX frame rate. Use this control to define the frame
rate you want to use. You should not change this from the default (40) fps unless requested to by our support staff.
Changing this frame rate may stop your DMX output from working correctly.

Information
The "information" column of the grid will display any additional data that could be obtained about the port. For USB
devices this will often show the firmware version and device serial number. For Ethernet options this will usually
show the official name used to identify the port on the network.

ArtNet and sACN Unicast options
The ArtNet and sACN DMX over Ethernet protocols also support a unicast option. By default these protocols
broadcast the data onto the network meaning that all devices on the network receive all data. For large installations
this can mean that all devices are receiving and handling a lot of data.

Unicast transmission of the DMX data means that the data packets are sent only to the devices that need it. The data
packets for universe 1 for example will only be sent to the devices that need universe 1. This mode also helps with
network management as many Ethernet switches can struggle with continuous broadcast data.

In order to use Unicast transmission NEO needs to know what devices are outputting each DMX universe. The
ArtNet protocol has a discovery process that can configure this automatically (assuming the device supports the
ArtPoll message). For sACN the Unicast routing must be configured manually by editing a file.

To turn on Unicast communications double click on any line of the device settings page that is set to ArtNet or sACN
to open the advanced protocol options. If using both protocols they must be configured separately.

Tick the check box labeled "use unicast communications" to enable this system. Below this check box any devices
found or configured will be shown.

To manually configure Unicast routing create a CSV file in the NEO install directory called "unicast_list.csv". Each
line has 3 fields - IP Address, DMX Universe, Description.

For example: 10.27.34.73,1,"Desc 1"
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System Input/Output - Advanced

The Advanced tab is used to onfigure advanced and complex DMX routes that do not necessarily conform to the
standard DMX universe length.

NEO NOTES & TIPS:  Not all protocols allow for sending a partial DMX universe string. Philips ShowNet does 
which gives the system the ability to output to discreet DMX routes over Ethernet. 

Route - is the ordered number of the DMX route itself. This is just a numerical listing and has no bearing on output or
priority.

Start - is the starting DMX address of the DMX route.

End - is the finishing DMX address of the DMX route.

Protocol - is the Ethernet protocol over which this advanced routing is allowed to be configured.

NetSlot - is the starting location of the route on the Ethernet string.

For example, a route that starts at DMX 1 and ends at DMX 100 but is placed on the Ethernet at the Net Slot of
10,001. This is often used with multiple control signals going to the same range of DMX address thus allowing two
points of control onto the same DMX device.

Notes - allows for a simple short note on the route.

Delete - allows for the removal of the selected route.

Add - allows for the addition of another route.

Advanced Routing Network Adapter - allows the user to determine the proper network interface card for the
routing of the network signal.

Telnet and Remote Device Access
Telnet Command Line Interface
To access the Command Line interface remotely from any computer on the network enable the telnet interface. Once
checked, connect to NEO through port number 3100. This includes access by iOS and Android devices.

If the characters are not visible when typing in the telnet client, enable the "Echo Telnet characters" option. Use the
"Telnet Port" edit box to set the IP port number that the software will bind to. 
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The "Enable discovery by remote systems" will cause NEO to broadcast a message onto the network at regular
intervals so that the system can be discovered automatically without needing to know the IP address.

NEO can also receive commands via a direct UDP message. Unlike the Telnet interface the UDP system is
connectionless and no acknowledgment of the message is sent back to the sender. Turn on "Enable receiving UDP
based commands" to allow NEO to listen for commands via UDP messages.

NEO NOTES & TIPS:  The Telnet interface must be enabled to use any of the remote (e.g. LFRemote for iPad) 
applications with NEO.

The "Enable TCP bulk transfer" starts an internal server for transferring bulk data like the show file. The "TCP
Transfer port" allows the user to set the port number for this feature.

Telnet & UDP Port Number can be changed in the box. The default is 3100.

There is a checkbox to Enable SNMP event messages and a box to identify the SNMP Host.

There is a checkbox to Enable remote viewing (RDP) and the ability to identify the Shared Monitor. If set to 0, that
will share all monitors.

Remote Commands are a Separate User
Any commands coming from a NEO Remote will be a separate user. This allows the NEO console operator to
program without interruption. There is a setting to turn this off (System Properties > System Input/Output > Telnet &
Remote Device Access: Remote command are separate user. This is on by default.

Remote App Now Available
The NEO Remote app is now available both for iOS and Android. 

It is available for iOS from the App Store. 

https://itunes.apple.com/us/app/philips-lighting-neoremote/id1178883700?ls=1&mt=8

It is available for Android from Google Play.

https://play.google.com/store/apps/details?id=com.philips.li.NEORemote&hl=en

Remote Connection from iOS/Android App
The NEORemote app now operates as a separate user. All channels that the remote selects will appear in a green
selection box rather than red. This allows the NEO console user to be editing in any screen and it will be separate
from the NEO Remote user.

• [SHIFT] + [SELECT] will pull values from the Remote back to the Main console. This allows the NEO Console 
user to take control of the channels that the NEO Remote user first selected. So all green selected channels will 
become change to red when this occurs.

• [SELECT ACTIVE] [SELECT ACTIVE] will select active fixtures including those active via remote.

• [SHIFT] + [RELEASE] will release all channels from both the NEO Console user and the Remote user.

• [SELECT] + [UP] will select all channels going up (blue levels) in the current cue.

• [SELECT] + [DOWN] will select all channels going down (green levels) in the current cue.

• Added option to the ON drop down to "Pull remote user data to live". This can also be done on the console by 
pressing the ENTER key (blank command line) after double tapping the SELECT ACTIVE button.

• Added option to the RELEASE drop down menu to "Release all remote control".

• Added the commands to the system: TELNET ON, TELNET OFF - these will enable and disable the telnet con-
trol.

The telnet controls the ability for the remotes to communicate. This means that a Shortcut could be added to Cue 1
that disables the remotes during any performance. A Startup Shortcut (System Properties > Show Defaults: Run
Shortcut on Startup) that could turn remote communication back on for the start of the day and focusing or system
checkout.
System Properties 287

https://itunes.apple.com/us/app/philips-lighting-neoremote/id1178883700?ls=1&mt=8
https://play.google.com/store/apps/details?id=com.philips.li.NEORemote&hl=en


User’s Manual
Enable HTTP (Web) Server
Enables NEO to host and support a web server. This allows remote access over the Internet to a custom webpage
created for playback access to the NEO lighting control console. The default HTTP Port will be the port used for
traffic to the NEO.

A basic web page and supporting files will be in C:\Users\neo\My Documents\HTTP Home. Any customizable
webpage files will need to be placed in this directly. Note: This directory does not exist if the web server is not active.

Once the feature is turned on and files are in the HTTP Home directory, open the Web Browser (More > Control
Panel > Applications > Web Browser and type "localhost" into the web address. This will populate the internal web
server on the web browser.

Note:  The default port for some software programs is to use Port 80. It is recommended that only one software 
program use port 80. If this is on NEO or the NEO Playback Controller there should be no conflict. If this is running 
on a laptop, other programs could provide a conflict. Skype could be one of those programs.

CAUTION:  Placing NEO on the Internet to provide remote access should be setup by an IT professional in order to 
provide proper access and security from unwanted access.

Console
There are two desk lights and NEO gives individual control for each light.

The Backlight Level control the key backlighting levels.

Fan speed controls the pan mounted fan speed. 

Note:  The user cannot control the motherboard's fan speed.
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33. System Settings

The system settings page provides settings that effect the operation of the software. This tab also provides access to
the tracking backup options and sets the current location for sunrise and sunset calculations.

Basic Settings
These are the settings most likely used during traditional programming on the NEO console. System Settings stay
with the console and are not saved with the showfile.

On Level
Use this to specify the value fixtures will be set to when clicking on the "ON" or "SOLO" buttons in the channel
window. This also applies to the ON command in the command window.

Up / Down Level
Pressing the [UP] [DOWN] keys level change.

GM (Grand Master) Buttons
Disabled - feature is turned off. Button will not function.

DBO Momentary - will blackout all fixtures configured for this GM button as long
as the button is depressed.

DBO Latch - will blackout all fixtures configured for this GM button as a toggle.
Pressing again shall release.

Stop Attributes - will pause all attribute movement for all fixtures configured for this
GM button.
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Full Momentary - will take all fixtures configured for this GM button to full as long as the button is depressed.

Full Latch - will take all fixtures configured for this GM button to full as a toggle. Pressing again shall release.

Preset Fader Mode
The NEO Control System has a Preset Fader Mode for those that are most comfortable with a Preset Desk style of
operation. Preset Fader Mode can be turned on in System Properties > System Settings for Advanced Users and under
System Properties for Basic Users. 

There is an indicator in the sidebar for Preset Fader Mode.

When on, the NEOs 10 single button faders, normally submasters, are now Preset Faders. Each fader has a 1 to 1
relationship with patched channels. The first page (page 0) will be channels 1 thru 10 (this is identified in the bottom
right hand corner of the Live screen. (Preset Page #). Preset paging can be adjusted there or by using the [PAGE UP]
/ [PAGE DOWN] buttons to the right of the faders. Page 1 will control channels 11 thru 20, Page 2 for channels 21
thru 30 and so on.

To operate in Preset Fader Mode, just move faders 1 thru 10 to the desired levels (levels will appear in red boxes),
paging as needed to access all necessary channels. Once set, press the [PARK] key. This will hold the output of the
preset faders. Once held, the levels will go white from red and the A/B faders will fly to 0 and are now the masters for
the preset scenes.

The Side Bar will identify that levels are held by flashing “Preset Fader Mode (HOLD)”. The A/B faders are now
configured so that the A fader (left fader) is the master for 2nd scene. While the B fader (right fader) is the master for
the 1st scene. The faders are now free to be set for the next scene so change fader levels as desired once the A fader is
moved to full. When the fader levels are changed, the parked levels will appear bracketed in a small font to the right
of the current level.

When in Preset Fader Mode, the Multi-Function Faders (3 button playback faders) convert automatically to
Submasters so any Submasters that are stored will be activated by those faders.
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Show Command Syntax Help
Default On - This option will toggle the balloon popup that provides context sensitive help about the commands
being entered. As the commands are entered, the popup dialog will show which commands are valid in the context of
what has been typed so far.

Command Line Single Digit Entry
Default on - In most cases when entering commands the channel values are in multiples of 10 (e.g. 10%, 20%, 50%
etc.). To save the typing of an extra digit this mode allows the user to enter just the first number and the additional 0
will be added automatically. 

With this mode values below 10 can still be entered by putting a 0 in front of the number (e.g., 03%, 05%, 08%).

Two-Digit Entry
Default Off - with this setting off the Enter key will complete all Command Line level change entries. With this on
two digit level will auto complete. Ex: [1] [@] [50] will set 1 to 50%.

A/B Fader Mode
Disabled
If this option is chosen, the sliders will do nothing. If doing a "GO SHOW", this is the safest mode of operation as
inadvertent moves on these faders will have no effect. 

PB (Playback) Master + Disabled
In this mode, the left hand fader is the overall intensity master of the cue list assigned to this playback and the right
hand fader is disabled. Use this mode if there is not need to manually execute fades and to avoid inadvertently starting
a transition by touching a fader. 

PB (Playback) Master + Crossfader
In this mode, the left hand fader is the overall intensity master of the cue list assigned to this playback and the right
hand fader is, at will, a manual cross fader. The [GO] and [HALT/BACK] buttons function as normal, but at any time
grab the fade and manually complete it using this handle. To [HALT] the cue, either press [GO] to complete it, or use
the handle to manually complete the transition to the next cue. If sitting in a cue, moving the handle will initiate the
transition to the next cue.

All levels going up and down will be affected. All times will be re-scaled to the distance the handle has to travel, with
the greatest time in the cue being measured using that distance and all others scaled to that. Wait times will be scaled
too. 

At any point before reaching the end of travel, move the handle backward to reverse the transition. Once reaching the
end of travel, the next cue in the cue list will be pending. Do not physically reload a cue or move the fader back to its
starting position. The next cue transition will begin by moving the fade off the end of travel reached or by simply
pressing [GO].

If [SHIFT] is held down while manually moving a Crossfader, it is possible to move backwards through a cue list.
(i.e., the cue that has just been completed will be the pending cue, rather than the next cue in the cue list). In this case,
the pending cue is Cue 1 - the cue just before Cue 2.

Cue List Split Crossfader
The Split Crossfader mode sets up the left-hand fader to, at will, manually control the levels moving up in the next
cue while the right-hand fader manually controls the levels going down in the next cue. Moving these faders in
tandem executes a standard crossfade. Both handles need to reach their end-travel destination before the cue
completes. Once the cue completes, the pending cue changes and the handles are ready to execute the next manual
fade. There is no need to exercise the full travel of the handles to re-load the next cue.

NEO NOTES & TIPS:  Regardless of configuration of the playback faders, the [SELECT], [HALT/BACK] and 
[GO] buttons will function as normal on the appropriate cue list.
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Automatic Show File Backup Service

Determines backup file settings.

Backup Location
By default NEO will store the backups in a sub folder of the "NEO Shows" directory. Use this field to change this
location. This can be useful for automatically storing the backup on a remote system.

The second location provides an additional backup location for backup redundancy.

Number of automatic backups - Determines the quantity of backups kept in the configured folder.

Backup Interval (Minutes) - Determines the frequency at which the backups are triggered.

When NEO is shut down the software will automatically create a backup of the current show file. Each backup file
created will have the date and time encoded into the name of the file. Use this option to determine how many of these
backups should be kept before automatically deleting the oldest one. 

Intermediate Options
These are options that are needed when more than basic programming is required.
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Wheel Sensitivity
The level wheel sensitivity allows the user to alter the percentage increment that will apply for each segment rotation.
By default, rotating the level wheel by one increment will change the fixtures or groups by 1%.

Fine Movement Sensitivity
The fine movement sensitivity determines the resolution moved when the fixture control is set to fine mode.

Number of Submaster Pages
This setting will allow the user to configure the maximum page number for the onscreen submasters, external
submasters connected via MIDI, DMX or the Playback wing.

Number of Submasters Per Page 
The software will allow up to 100 submasters per page. Use this option to configure the submasters per page count to
match the number of physical handles on the device being used.

For example with an external 24 channel DMX lighting board connected to DMX input then it is recommended to set
number of submasters per page to 24. This means that when the second page is changed in NEO channel 1 on the
physical lighting desk will correspond to submaster 25.

Submaster Debounce Level
The submaster sensitivity option will determine how much the DMX value of an external or hardware submaster
must change before it is registered by the system. In most cases this option should be left at 1 as we want the software
to register a change every time the submaster moves. 

In some cases the external submaster can be set just between 2 values and the output may jump between these values
continuously (This is known as bouncing). To get around this problem we can set the submaster debounce to 2 and
the system will not update the submaster unless the value moves by 2 or more.

Submaster Group ID Record Offset
By default, if a Submaster is recorded [RECORD] [SUB] (#) [ENTER], it records the Group number 1000 higher
than the submaster number to eliminate any overlap between Group numbers and Submaster numbers. Adjust this
offset as required.

Number of Cue List Playbacks Per Page
There are virtually unlimited cue list playbacks that can be setup in NEO. To manage the display of the playbacks set
the number to appear on each page with this setting. 

NEO NOTES & TIPS:  It is recommended that this is set to the maximum number that is visible without the need 
for the scroll bar.

Select Fixtures After Assigning Level
Default off - When using the command line to set channel values this option allows the user to perform a selection at
the same time. The channels set will automatically become selected after applying the value.

Immediately Select After Pressing @
When on, and typing in a fixture number, the moment the @ is pressed, the fixture is selected. This is to help the
designer find the fixture on the grid.

Disable Double Click Function
Default off - Double clicking on a channel or fixture will toggle it between the on value and off. Use this option to
disable this function to prevent accidentally performing this operation.

Submasters Must Return to the Current Position After a Page Change
Motorized faders make this option redundant (as with the on-screen faders). This option is only useful where using a
non-motorized external fader board. In the event of using a non-motorized external fader board, use this option to
avoid unexpected jumps in-stage output after changing the submaster page. Normally if a submaster is moved after a
page change the output will take effect immediately. With this option on the effect of the submaster will not be
applied until the physical slider is returned to the current value of the submaster.
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Start New Show with Nothing Patched
When creating a new blank show NEO will patch all of the available desk channels 1:1 with the dimmer (DMX)
channels. Tick this option stop this happening and start all new shows with no channels patched.

Wheel Changes Ignore Master Fade Time
When using the level wheel to control the dimmer intensity of a channel the master fade time will not be used if this
option is turned on.

Use Attribute Default Values When Nothing is in Control
If all control of a fixture is released and no instruction is currently active the DMX output will default to a zero (0)
value. Turning this option on will result in the default output value set for the attribute being used instead. The most
common use of this is the pan and tilt setting that would typically have their mid points set as the defaults. 

Don't Show Palette Options When Recording a Cue
Simplifies programming by limiting recording options. This keeps it to raw data.

Group updates record dimmer proportional to group level
When updating a group, the intensity level will be stored proportional to the level in the group.

Use Advanced Color Heuristics
Default Off - NEO has a unique feature that allows the software to calculate color matching for fixture that have
more than the 3 primary colors (RGB, CMY or HSI).

For example if a fixture has red, green, blue, amber, and white LEDs (RGBAW) traditional color matching is only
able to apply the first 3. This is because in a perfect system all colors can be achieved by the combination of red,
green and blue. Because LEDs are not perfect some manufacturers add additional colors to the fixture to expand the
available colors that can be produced. The software however can traditionally only work in a perfect color space
when converting from a selected color to the elements of that color.

The advanced color heuristics system of NEO attempts to overcome this problem by applying an advanced algorithm
to calculate how much of other colors should be applied.

It should be noted that this algorithm is not perfect and is an approximation of the maximum output for a selected
color. 

Because this option may be used frequently, the same check box can be found in the attribute color picker. Change
this setting in either location.

Virtual Dimmer to Inhibit Colors
When a fixture does not have a dimmer (RGB LED fixture for example) NEO will create a virtual dimmer to make
working with that fixture easier. The way the virtual dimmer operates can be changed between a inhibit function and
a build operation. 

With this option turned off the virtual dimmer will add to each of the color values eventually making it white (all
colors at full). Each of the colors will be adjusted proportionally to maintain the color hue until one of the colors
reaches 100%. Continuing to increase the virtual dimmer will result in the color moving towards white.

With the virtual dimmer in inhibit mode the fixture will not output any color without the dimmer on. Each of the
colors in the fixture will be scaled by the value of virtual dimmer such that when the dimmer is at full the set colors
will be fully realized. 

Apply Color Selection to All Color Mixers
If the fixture used has more than 1 color mixer then selecting a color using a color picker will be applied to all of the
color mixers in the light. If this option is off then the selected color will only apply to the first mixer in the fixture.

This option can also be changed in the generic color picker that is shown with color mixing fixtures.

Multiple Shortcut and Submaster Windows.
Default Off - With this option off only one shortcut and one submaster window can be opened at any time. Clicking
on the button once opened will cause the window to be brought to the foreground and given the current focus.
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When this option is turned off click on the buttons will cause another copy of the window to appear. This can be
convenient for running the submasters or shortcuts on multiple pages.

If this option is turned on the save and restore options will only work on the first window opened.

Disable Fader Move with Bump Buttons
Disallows motorized fader movement when bump buttons are used to minimize distractions and improve response
time.

GM (Grand Master) Affects Record
When on and the GM inhibiting values by not being at full, the record function will record the actual values. When
off, the record function shall ignore any affect the GM has on output and record as if the GM is not in use.

Invert Flick Gestures
Should the ability to use the touchscreen to "flick" a floating window from one monitor to another work backwards
from what is expected (left to right or right to left), this feature will invert the flick gesture from right to left or left to
right.

Flick Gestures Available...

Left - sends a floating window to the monitor on the left.

Right - sends a floating window to the monitor on the right.

Up - maximizes a floating window.

Down - returns a maximized window to a floating window.

Blind Follows Live
When on and the Blind view is selected, the console will show the Live cue in Blind. When off, selecting Blind will
return to the last cue that was viewed in Blind. Should there be no previous cue viewed in Blind, it will show the
current cue.

Tracking Backup Options
A tracking backup is a second console mirroring the main console. This backup console mimics the master system so
that in the event of something going wrong with the master the backup can take over.

The tracking backup options should only be turned on for the secondary system. The only option needed on the
master system is the Telnet interface must be turned on.

“Disable output until failure is detected” is on by default. 

Check the option "Run as a tracking backup" to identify the system as the backup.

Set the Master IP address to identify the master system. The IP address of the master can be found on the command
window when the software starts.

It is also recommended that to disable the output until a failure is detected. This option will temporarily stop DMX
output until the operator tells the software start outputting DMX or the auto failure detection is activated.
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Restart the software and to see a dialog identifying that the system is running as a backup.

In the event of a failure by the master system click on one of the two large buttons "Start DMX output", "Start DMX
output and run the next cue", or "Synchronize Show File". Warning as this will overwrite the current showfile.

Below these buttons are options to automatically poll the remote system. Set how often the poll message should be
sent using the spin edit directly below the buttons and set the number of failures that should be detected before taking
over.

Sunrise/Sunset
When using the built in scheduling feature of NEO, create schedule items that will operate on sunrise and/or sunset.
The software will automatically calculate the time of the day for these events based on location.

In order for this feature to work set the latitude and longitude information. To make this easier select the closest city
from the drop down combo provided and latitude and longitude information will be populated automatically. 

These numbers can still be adjusted the user’s global position is known. A GPS may be used to set these numbers.

Tracking Backup Window
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34. Advanced System Settings

Click on the advanced options button to open an additional screen of system settings.

Primary Database Server
The primary database is where the show is stored between saves. Any changes made to the show are always
immediately saved to this database allowing the system to always recover from a restart without the loss of data. This
file is a firebird database file and there for must be located on a local hard disk. 

To store this data on a server or remote firebird system enter the IP address of the firebird server in the “Primary
Database Server” field. 

Primary Database File
The primary database file must be the path to the file on the remote system. Do NOT use a network path location (e.g.
\\server\files\show.fdb).

External Joystick Sensitivity
Controls the sensitivity to an external joystick.

External Joystick Threshold
Controls the range of the dead zone before the joystick responds to movement.

Special Fixture Control Wait Time
This determines how long the Lamp On/Off/Reset Macros will wait before returning the Control parameter back to
Idle.

Advanced System Settings
Advanced System Settings 297



User’s Manual
Lamp On Fixture Interval
This determines the time that the system will delay each Lamp On value for the selected range of fixtures. This can be
needed for a large system of 208V arc sourced automated luminaires to reduces the in current load on lamp up.

Cue Playback Rate Override Limit
Advanced options available to set the cue playback rate override submaster maximum multiple (X time). If a fader is
set to be a “Length Sub”, (as set in the Cue List FX from the Cue List display), this system option sets a limit for the
number of times the cue list can increase it’s speed.

FX Length Override Lower Limit
Advanced options available to set the lower limit of the length override submaster for FX playbacks. If a fader is set
to be an “Override Length”, (as set in the Cue List FX from the Cue List display), this system option sets an lower
limit to the rate at which this effect can be adjusted.

FX Length Override Upper Limit
Advanced options available to set the upper limit of the length override submaster for FX playbacks. If a fader is set
to be an “Override Length”, (as set in the Cue List FX from the Cue List display), this system option sets an upper
limit to the rate at which this effect can be adjusted.

Log Incoming Telnet Data
This is a debug feature and should only be used if Philips Entertainment Lighting Tech Support requires it during a
tech support session.

All incoming commands via the Telnet server are written to a file called "TelnetLog.txt" in the standard log file
folder. To get to the folder go to More > Control Panel > Maintenance > Open Log File Folder.

Show "first time software is run" Dialog

When on, the following screen appears to help the user chose which mode to use - Basic or Advanced.

Check for Software Updates
Default on - With this option on NEO will attempt to connect online and check if a new version is available. When a
new version is released a popup notifies the user soon after startup.

Don't Prompt to Close the Software
If using the NEO console in an automated shutdown environment, turn this option on to prevent the software from
prompting the user to confirm closing.
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Don't Show Startup Failure Warning
If NEO does not start correctly, it will ask if the user wants to open a default show the next time the program is
started. To disable this prompt, turn this option on.

Don't Apply Submasters for Merged Channels
By default DMX input will always be routed to the submaster system. Use this option to disable DMX input going to
submasters when using the DMX merge feature.

Remember Cue Update History
The cue update history is a powerful system to enable the user to retrieve a cue state from any previous record
operation. At any time revert to a previous cue state. To do this the software will store the cue state into an update
history table. This feature can cause the show file to grow in size much faster than normal. If the user does not want
to keep this historical information (to save space) turn this option off.

Disable Undo in the Cue List Window
If using a very high channel count then the undo system can result in sluggish performance. If modifying a cue is
taking a long time then disable the undo using this option.

Reset Chase When Submaster Reaches Zero
By default a chase will be paused when an assigned submaster reaches zero (0). Turn this option on to perform a
Reset rather than a pause.

Shutdown System on Exit
Default on for consoles, it is recommended to turn this off for laptop or PC use.

Use Legacy Cue Command to Run a Cue
If the option is set, this command will cause the specified cue to be executed; (LightFactory mode) otherwise,
channels in the specified cue will be selected. (NEO mode).

Restore Running Playbacks on Startup
If playbacks were running upon shutdown, they will be restored on startup.

Show Patching to Multiple Channels Dialogue
This is a dialogue box that appears if/when an attempt is made to patch an output to multiple channels.

Auto Revision Saved Show Files
Under the updated file save system, NEO will automatically save the previously saved version of the showfile called
"SHOWFILE NAME_REV#.NEO. This will store the last 10 revisions. This feature is turned on by default and if
unchecked, will no longer create revision files. Turning this off removes one level of redundancy for the security of
the showfiles and is recommended to be left on (checked).

Make Database File Smaller
This option will perform a database pack on the show file. Packing the database removes dead space from deleted
allocations and makes the allocations for tables, blobs and indexes contiguous in the database. So it compacts and
defragments within the database file. The result of this operation is often a significantly smaller file.

When clicking on this option a new window appear s(external to NEO) that will perform this operation. The show file
being worked on will be close while the database pack is running.

This option can also be used if you suspect that the show file has become corrupted. 

This operation will export all of the data in the show file and re-import it into a new clean file.
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Purge Cue Update History
NEO saves every version of every cue since the showfile was first created. Over time, that can create a lot of data.
Even if cue lists are deleted, the update information remains. This features allows the removal of that historical data.
This will reduce the size of the file accordingly.

35. Show Defaults

Use the show defaults settings to provide default options for cue lists, channel groups and recording. The settings on
this page are stored with the show file and can change when loading a show or create a new show. 

To make the current setting the default for future shows click on the "Set as default settings" button at the bottom of
this tab. Any new show created will have these settings automatically.

Basic Options - Cue List Defaults

The cue list defaults will apply every time a new cue is created (By default, these settings are all set to zero seconds).
Set a cue default by either typing the desired time or using up and down arrow controls to the right of the edit box.
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Delay - default delay or wait time when a cue is recorded.

Cue Time - default cue time used when a cue is recorded.

Delay Down - default delay for the cue's down time when a cue is recorded.

Down Time - default cue down time used when a cue is recorded.

FX Delay Time - default delay time used when a cue triggers an effect.

Mark Time - default Mark time set for a cue that is recorded.

Mark Delay - default delay time when used for the default Mark time.

Mark in Cue Time - defaults that the marking time will happen in the cue time.

Full Tracking Mode/Hybrid Tracking Mode Switch (Important)
This is a systemic switch that determines how the NEO console records cues. 

NEO NOTES & TIPS:  This is an important option, please read below prior to selecting.

Hybrid Mode - In hybrid mode all active channels are recorded into the cue. An active channel is any channel
currently "on". If a channel was on in a previous cue and not recorded into the next cue it will be turned off when the
cue runs. All other attributes (pan, tilt, color etc) will not change until a new cue instructs them to change. 

When running cues, NEO will only apply changes to the cue state. If an attribute does not change between cues then
the value will not be applied even if the output value has been changed by another control element in the software
(group, effect etc.).

Full Tracking Mode - In full tracking mode only changes are recorded into each cue however any channel that is
currently on will stay at that level. When a cue is recorded or updated NEO will work out what has changed and
record only that information. If a channel is not in a cue then it will maintain any state it was set to by a previous cue.
To turn a light off in a cue the channel will be added with its value at zero. 

When the cue is played back only the changes specified in the cue will be applied. If playing back a cue out of order
NEO will track back through the cue list and calculate the correct lighting state at that point based on the previous
cues.

Tracking is a playback function in NEO but there are some important recording options that will assist the user to
program the show. Tracking behavior will be applied regardless of the cues being run sequentially or out of order. 

The tracking mode is set per show in NEO and can be changed at any time in the system properties. The tracking
switch will be stored with the show to avoid the chance of a hybrid show running on a tracking setup or the other way
around.

NEO NOTES & TIPS:  It is recommended to set tracking mode prior to programming and not change to or from 
Hybrid Tracking/Full Tracking once you have started or after the show has been programmed.
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Cue Default Record Mode
When a cue is recorded, what channels/fixtures does it take into account? 

The options are…

Live - this stores everything the desk is outputting with the exception of
running effect and submasters (depending on how the "Include Submasters"
option is set). This is the NEO default option as its most common in a theatrical
environment.

Selected - this stored only channels that are currently selected (in the red box). 

Active - this stores only channels that have an intensity above zero.

Changed Only - this stores only changed values (shown in red).

Smart Block - will block intensities only for all channels in the current cue list.

Block - this will force an instruction for every channel/attribute in the system.

Default Tracking Record Mode
Determines what data gets recorded and tracked. 

The options are…

Cue Only - will store the information normally (instruction or tracked value) in
this "cue only". Information will not track beyond the current cue.

Cue Only (Int)/Track (Atts) - will store the intensity information in the current
cue and not track beyond the current cue as well as allow attributes to track down
the cue list until each fixture's attribute hits another instruction. This is a blending of the two worlds of cue only and
tracking.

Tracking - will store the information normally (instruction or tracked value) in this cue and all changed values will
continue down the cue list until each fixture's attribute hits another instruction. This means that the light will stay
where it is until it gets an instruction to do something else. This occurs per attribute.

Trackback - will store the information normally (instruction or tracked value) and will go back up the cue list, in
reverse order until each values gets another instruction. This is tracking back up the cue list.

Block - will store the information as a hard value on every channel and parameter. This stops any tracking from
continuing into or through this cue.

Smart Block - This only blocks channels that have an instruction in the cue.

Set Auto Mark
Auto Mark will prepare the moving lights for their next use before they are needed. This happens automatically and is
calculated by the NEO console. 

The options are…

None - meaning that the NEO console will not auto mark when running cues.

Mark as early as possible - will mark for the next use as soon as the lights go to 0 intensity.

Mark as late as possible - will mark for the next use in the cue previous to the next use.

Default Release Time - default time used with the Release command.

GOTO Time - default time used with the GOTO command. Checkbox for "Use cue timing for goto". Allows the goto
function to use cue timing.

Include Running Effects
If an effect is running while a cue is being recorded, this feature will determine if the running effect is stored to be
triggered by the cue. This feature is turned on by default.
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Include Submasters
If any channels/fixtures are being controlled by a submaster (levels in yellow), this feature will determine if the action
of Recording will include those levels when stored. This feature is turned off by default.

Default Attribute Family Timing
This allows the user to set a default time and delay to each attribute family. If the user changes the default time/delay
for color, when color movement is recorded into cues, this timing will be used to override the default cue time.

Just click on the appropriate cell and edit.

Include Palettes and Presets
If any channels/fixtures are being controlled by palettes or focus groups, this feature will determine if the action of
recording will include those palette or focus group references. If not, then the cue will hold raw data. This feature is
on by default.

Intermediate Options
These are show defaults that may need to be adjusted for more than basic operation. However, most of them are likely
set and forget.

Make cue active after record live - When this option is selected the cue that was just recorded or updated will
automatically become the active cue. Note: This only works when using the Record Live setting.

Release channels after Record/Update - when this option is on and a cue is recorded or updated, the channels/
fixtures will be released to the cue.

Release set channels on cue go - When pressing "cue go" the system will release all channels not being controlled by
cues before running the next cue.

Force Fixture Block - when this option is on and attribute information is stored in a Cue/Group/FX, any attribute that
is changed will force the entire fixture to be recorded. 

Auto create playback with a new cue list - When a new cue list is created a cue list playback will automatically be
created and assigned to the new cue list.
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Use fade mode up/down (off - in/out) - This option allows you to work the way you are familiar with on other
consoles. By default NEO fades cues with incoming channels and outgoing channels. Up/Down fade mode means
that the channel or attributes increasing in value will fade in the "Up" time and channels or attributes decreasing in
value will fade in the "Down" time.

NEO NOTES & TIPS:  With Fade mode in Up/Down (not In/Out) the next option is as the option does not apply.

NEO NOTES & TIPS:  Cue List time options change when this is turned off.

Cue "Fade Out" applies to outgoing cue - Some lighting systems apply the fade out of a cue differently to NEO.
With this mode turned on the fade out of a cue applies to the cue executed before this one.

Follow to run next cue - with this option on, Follow works in a traditional theatrical console style where the follow
time goes on the cue that is "triggering" the follow and not the cue that is "triggered". If this is off, then it works in the
traditional LightFactory mode where the follow time goes on the cue that is "triggered".

Don't record parked channels - By default parked channels are recorded into cues. If you do not want parked
channels recorded (e.g. house lights) enable this option.

Last cue links to cue 0 - with this option on, at he last cue of the show, press GO to go back and start the cue list
again at cue 0. With this option off, it will function as a traditional theatrical console.

Looping cue lists to apply state - with this option on, looping cue list will output no differently than if they were
non-looping. The entire state of each cue shall output. 

Auto set out/down - with this option on and a cue time is changed, it will apply equally to the in/up as to the out/
down.

Set shortcut mode per page - The shortcut mode refers to the 4up mode or the standard mode. By default this is a
global setting for all shortcut pages. By turning this option on the mode can be set for each page. Include running
effects when recording submasters - will include running effects when recording into Groups or Subs.

Include running effects when recording submasters - with this option on, any running effects will be stored to be
triggered in the just recorded group/submaster. With this option off, the effect will continue to run independently.

Default filter library - choose the gel manufacturer for Command Line entry of gel colors. If this is Lee, then select
the channels and use [@] (gel number) [ENTER] to select. Ex: [1] [@] [COLOR] [201] [ENTER] to select L201.

Channel Group Defaults
The channel group defaults will apply every time a new channel group is created. Set the default fade time and
behavior using the controls provided.

Fade Time - default fade time set for future recorded groups.

Group Behavior
A channel group can behave in one of many ways when setting the actual output values. To change the behavior of a
group to be recorded in the future, select the desired option from the drop down menu accessed by clicking on the
small arrow to the right of the field.

Override (LTP) - Also known as "Latest Takes Precedence". This is the default behavior of channel groups. This
behavior will apply the channel levels set in the group to output channels and take over control of that channel. As
soon as something else sets the channel value the group value will get overridden. Likewise as soon as the group
value changes it will override the existing values set in the channel.

Build - The values set in the channel group will be added to the current output value of the channels.

Exclusive - The Exclusive behavior type has changed in software version 3.3. An exclusive sub's contents cannot be
controlled by other items. However it no longer has the "Solo" component that is does in version 3.2 and prior
versions. Note: An exclusive sub is outside of being affected by the Grand Masters.
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Highest Takes Precedence (HTP) - When a group value is set with HTP behavior the output on the channel is
determined by what has a higher value. If the value set in the group is higher than the value in the channel then the
group will control the channel. If the value in the channel is higher than the group value it will remain unchanged.

Independent - Channels in an "Independent" group will override all other requests to modify the channel value. As
soon as the group level is above 0, channels within this group will be controlled by the group values. 

Inhibit - With an inhibit group the value masters all channels that are in the group. The output value of the channel
will be scaled by the value of the inhibit group it belongs to. 

Subtract - Similar to the "Build" behavior this option will subtract the value set by the group from the output value of
the channel and attributes.

Intensity HTP/Attributes LTP - this combines the world of HTP for Intensities and LTP for Attributes.

Submaster Behavior
The submaster can behave in one of many ways when setting the actual output values. To change the behavior of a
future recorded submasters, select the desired option from the drop down menu accessed by clicking on the small
arrow to the right of the field.

The options are the same as the Group Behavior listed in  "Group Behavior" on page 304.

Group Default Record Mode
Determines "what" is recorded when recording a group/palette. The options are...

Selected - will record only fixture's parameters that are selected AND changed. 

Changed Only - will record only fixture's parameters that have been changed.

Live - will record all fixture's parameters.

NEO NOTES & TIPS:  When recording palettes, check the "Edit Palette Types" in the Groups display, Options 
pulldown to understand how the group/palette filtering is set for recording. For example, if Position is set to include 
Edge parameters, then it could store Zoom, Focus, Edge or other parameters. If Position is set to include ONLY 
Position parameters, then Zoom, Focus, Edge or other parameters will be ignored.

Auto assign next available submaster - When checked (default) the submaster field will automatically be populated
with the next free submaster when recording a new channel group.

Auto assign next available shortcut - When checked (default) the apply shortcut field will automatically be
populated with the next free shortcut when recording a new channel group.

Advanced Level Programming Options

Advanced options are likely only needed for advanced level programming.

Send cue execution messages to telnet clients - With this option checked (default) connected telnet clients will
receive a message each time a cue is executed.

Allow shared submasters - By default a submaster can only control a single element within the software. If the user
tries to assign a submaster to more than one control element an error will be reported. Turning this option on will
allow the submaster to control multiple elements. 

Override takes precedence over HTP - Override will not apply to HTP channels if the override value is less that the
set HTP value. Turning this on will allow the LTP value to take priority over the HTP value.
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Apply channel group shortcuts to selection only - When checked channel groups will only apply to the channels
currently selected. This option is also available in the "Channel Groups" menu in the channel display.

Run shortcut on startup - allows the ability to run any shortcut number when the NEO console starts up.

Run shortcut on shutdown - allows the ability to run a shortcut number when the NEO console shuts down.

Lock Code - set the code here to add additional security to the console lock functionality. [SHIFT] + [HELP] shall
lock the console. Without a password, the same command shall unlock it. With the lock code set, [SHIFT] + [HELP]
will allow the user to input the code to unlock.

Console Shortcut Page - sets the Shortcut page used for the 10 Shortcut buttons that are on the console. They are
listed as Shortcuts 1 - 10.

Set as default settings - The options in the "Show Defaults" tab are stored with the show. Click this button to make
the current settings the default for all future shows.

Restore Factory Defaults - will restore all Show Defaults back to factory defaults.

36. Appearance

Use the options in the appearance tab to define how the software looks on screen. This provides the ability to set up
the software to the user’s own personal look and feel. If running NEO on a slow computer system, the user may also
want to turn off some of the graphical options in the channel window.

Show pan and tilt position within fixture image - By default NEO will draw a small x inside the image at the top of
the channel cell to represent the position of the pan and tilt values. Turn this option off to disable this feature. Note:
Applies to Expanded, Compact and Fader views only.

Show graphic bar representation of dimmers - The "fade bar" is a blue (default) bar that displays the current
channel level and appears just under the text. Toggle this option to determine if the software displays this bar. Note:
Applies to Expanded, Compact and Fader views only.

System Properties, Appearance Tab
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Show picture of intelligent fixtures - If there is a patched an intelligent fixture you can display a picture in each cell
of the channel view. Toggle this option to turn this on or off. Note: Applies to Expanded, Compact and Fader views
only.

Show picture of basic fixtures - A basic fixture is a fixture with only a single dimmer attribute. Use this option to
toggle if the software will display a picture in each cell of the channel view. 

Note:  Applies to Expanded, Compact and Fader views only.

Skip over unpatched channels - With this option on the software will not draw a cell for every channel unless it is
patched. Unpatched channels will be ignored. When turned off the unpatched channels will appear as a gray cell in
the channel display.

Return focus to channel grid when opening fixture control - When an intelligent fixture is selected the fixture
control window will automatically appear. This option determines if the focus is retained in the channel display or
moved to the new fixture control window.

Show color block for RGB fixtures - By default a color only fixture will not display an image of the fixture like
other intelligent fixtures but rather a block representing the color set. Turn this option off to show the image instead of
the color. The color will still be shown but in a small bar below the image.

Show help balloon for keyboard shortcuts - In the channel display a help balloon will appear in the top right hand
corner as soon as the control key is pressed to show all of the keyboard shortcuts that can be accessed. Use this option
to turn off the display of these messages.

Make active color proportional to dimmer level - Use this option to make the active channel colors intensity
proportional to the current output level. When the channel is at full the background will be the defined active channel
color. At 50% the background will be a half shade of the defined color.

Intelligent (ML) view grouped by fixture type - with this on, all MLs will be grouped together by type. With this
off, MLs will appear in numerical fixture patch order.

Intelligent (ML) view will show simple color fixtures - with this on, simple color mixing fixtures will appear in the
ML view.

Auto switch the sidebar when selecting fixtures - When turned on and fixtures are selected, the side bar will
automatically switch to show fixture control. When turned off, the side bar will stay on Master Playback.

Channel Display - Channel Select Color - Defines the background color of selected channels. Click on the colored
box to select a different color.

Channel Display - Channel Active Color - Defines the background color of active channels. Click on the colored
box to select a different color.

Channel Display - Grid Background Color - Defines the background color of the entire channel grid. Click on the
colored box to select a different color.

Channel Display - Channel Intensity Bar Color - Defines the color of bar representing the dimmer output value.
Click on the colored box to select a different color.

Channel Display - Magic Sheet background color - Defines the background color of Magic Sheet view. Click on
the colored box to select a different color.

Channel Display, Font - Click on the font button to set the text style used in the channel display. A sample of the
font will be displayed just below this button.

Fixed column count - If this value is set to zero then the channel view will adjust the number of columns depending
on the width of the window. Setting a fixed column count will automatically adjust the width of each of the cells but
maintain the same number of columns per row.

General Grid Settings - background color - Defines the background color of all grids other than the channel
display. Click on the colored box to select a different color.

General Grid Settings - Selected row background color - Defines the background color of all selected rows in
grids other than the channel display. Click on the colored box to select a different color.
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General Grid Settings - Font - Click on the font button to set the text style used in all grids other than the channel
display. A sample of the font will be displayed just below this button.

Cue List Editor - Scene breaks background color - Defines the background color of all scene break rows in the cue
list editor. Click on the colored box to select a different color.

Use Dark Styling - Turning this option on (requires a restart) put LightFactory in a dark mode. All of the windows
and controls will adopt a color scheme that is dark (black, dark grey etc).

Enable Advanced Docking System - see Advanced Docking System.

Use Metro Style Scroll bars - 

Always dock the patch window to the main display - Setting on by default always docks the patch window to the
main screen.

Reopen windows on startup and loading settings - When saving setting and closing down the software the position
of all windows will be saved. With this option turned on the windows will return to the position they were when the
software starts up or the setting are restored.

Advanced Docking System
Turns on the ability to dock NEO floating windows on a second monitor.

Note:  Once changed, the system must be restarted for the advanced docking system to take effect. 

Once turned on, open a floating window (Cues Lists, Groups, FX List and others) and drag the floating window onto
the second monitor. The following docking system will appear...

Drag the floating window onto the second monitor and "lock" the window into the docking system by hovering over
the one of the individual tabs.
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Once a floating window isdocked into either the top, bottom, left or right, open and dock other windows. Once this
docking system is filled, then drag existing NEO windows within each 1/4 section and break it down further. Just use
the 4 up tab to arrange them to the preferences.

When the layout is setup as needed, use the Window Layout Manager to save these combinations as a show defined
layout.

Keep command window on top of all other windows - By default whatever window is active will draw itself on top
of all other windows including the Command Line interface. Turn this option on to make sure that the command
window is always drawn on top of all other windows regardless of its focus status. (Note, this option is not available
on the console. It is only available on a specific PC install version.)

Use metro style scroll bars - with this option on, the scroll bars will be a sleeker version. With this off, the scroll bars
are bigger.

Reset to default colors - will restore colors to factory defaults.

Show AB faders in the submaster window - with this feature turned on, a virtual version of the AB faders will
appear on the virtual Submaster display.

With this optioned turned off (default) the submaster display only shows submasters.

37. Software Registration

NEO uses a software license to ensure that the product has been legally purchased. Without a valid registration code,
the software will still operate normally and no functionality will be restricted, however the software will not produce
any DMX output.
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To enable the DMX hardware interface, a valid registration must be entered - whether at time of install, or through the
"Registration" tab in this window.

Contact the local Philips Entertainment dealer or Philips Entertainment Technical Support for more information. 

Note:  NEO PC has some additional functionality regarding registration. Refer to  "NEO PC" on page 27 for more 
information.

38. Upgrade this NEO system

Enter the registration details and click on the "Upgrade this NEO system" to confirm that the details entered are
correct. A dialog informs the user if incorrect details have been entered.

System Properties, Registration Tab
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39. Visualization

NEO supports integration with the popular WYSIWYG (Cast Group. http://www.cast-soft.com), Capture (http://
www.capturesweden.com), LumiDMX and Light Converse (discontinued support in the latest version of Light
Converse) visualization software.

• To use this feature select the desired visualizer by clicking on the appropriate button.

• To temporarily disable the output uncheck the "Output live data to visualizer"

Accept incoming patch information - Use this option to enable or disable receiving patch information if the
visualizer supports sending it.

Send Fixture Selection Information - With this option turned on NEO will send messages to the visualizer to
indicate if a fixture is selected or not.

Receive Fixture Selection Information - With this option turned on NEO will select and de-select fixtures in the
channel display when they are selected or de-selected in the visualizer.

Enable Auto Focus Exchange - Auto focus is the term used for transfer of fixture state between the visualizer and
NEO. If enabled changes made to the fixture in the visualizer will be transferred back to NEO. For example setting
the position of the fixture in the 3D environment can be automatically translated into pan and tilt information in NEO.

Add snapshot of live view to cue notes when recording - with a camera installed, will allow recording of cues to
create a visualizer snapshot and store that in the cue notes.
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40. Media

The settings in the media tab are used to globally control the output of media playback when using the media effect.

Video Output Monitor - Use this option to define what display on the computer all video content go to. With only 1
monitor or to select the primary monitor then the video will play in a sizeable window. If using a secondary display
the video output will automatically be played in full screen.

Video Capture Device - The video capture is used to map live video into a matrix effect and can also be used to
capture an image when recording cues. This setting determines the device that will be used.

Video Scaling - NEO supports a number of advanced scaling routines to improve the output quality when the video
size does not match the output size. These options can require a lot of CPU to work at full frame rate so it is always
recommended that the video be pre rendered to the size needed.

Width & Height - Used to set the output size that the video will be scaled to when using the advanced scaling
routines.

Audio (video) output device - Used to set the audio device that all video sound will be sent to.

Use media codec for internal timecode clock - uses the codec that is appropriate for each media that is played when
using the internal timecode clock.

Connect audio output to media used in matrix effects - By default a matrix effect does out output any audio from
the playing media. Turn this option on to connect the audio channels when the effect is played.

Brightness - The Brightness property defines the luminance intensity.

Contrast - The Contrast property defines the relative difference between higher and lower luminance values.

Hue - The Hue property defines the phase relationship, in degrees, of the chrominance components. 

Saturation - The Saturation property defines the color intensity, in IRE units.

Lightness - 

Volume - The volume property defines the default audio level of the playback.

Reset to Default - pressing this will reset all settings back to default.

System Properties, Media Settings
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41. Special Shortcuts

Special system shortcuts are miscellaneous functions in the software that the user may want to put onto a shortcut.
Most of these functions are related to the channel view such as the options in the right click menu and at the bottom of
the window.

The special shortcuts also allow the user to set shortcuts to open various windows.

The attribute shortcuts also serve a dual purpose depending on the window that currently has focus. If in the channel
display and have an intelligent fixture selected then the attribute shortcuts will shift focus to the control appropriate
for the attribute. Pressing the shortcut while in the Command Line interface will bring up the appropriate word to use
in the command line.
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42. More

This gives access to advanced displays and advanced features like the timecode monitor, power monitor, fixture
library editor, matrix editor and more.

Live Video Preview
Allows the user to view the live video output of a connected video camera.

Note:  Video camera by others.

Touchscreen Keyboard
Opens up a touchscreen keyboard.
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Timecode Monitor
Opens up the timecode monitor or clock.

Power Monitor
The power monitor will display the calculated amps based upon the data entered into the Power and Dimmer Phase
columns in Patch.

Remote Connection Options
When using NEO as a remote console, the remote connection options allow the user to determine the level of control
that NEO Remote has to the main console.

Remote ID – allows setting up multiple remotes with different IDs so different interfaces that will or will not overlap
with other remote users.
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Network Adapter – allows setting the specific network adapter to be used. This is useful if one NIC set to the
lighting network and the other NIC set to gain network access.  In this situation, it is recommended to set the Network
Adapter to the lighting network only.

Receive Channel Updates - allows NEO Remote to receive channel/fixture level info from the main console.

Send Channel Updates - allows NEO Remote to send channel/fixture level info to the main console.

First Channel - starting communication channel/fixture range.

Last Channel - ending communication channel/fixture range.

Track Master Cue List - synchronize the primary cue list.

Send Shortcuts - transmit Shortcut commands to the main console.

Send Submasters - transmit Submaster changes to the main console.

Track Effects - transmit FX commands to the main console.

Allow show file changes from remotes - allows the NEO Remote to trigger the ability to load show files. This is
necessary if the NEO Remote is needed to changes show files from a NEO family console that is locked away or
otherwise inconvenient to access.

The text box will provide useful connection information to help troubleshoot any multiple console connection issues.

Console Debug Window
This is a great troubleshooting tool to help identify communication to the hardware.

The top portion identifies the NEO console tiles that it is communicating with. It identifies the Board Type, ID,
Firmware Version, Message Count and Status.

If troubleshooting a problem, please contact Philips Entertainment Technical Support for help.

Buttons at the bottom give options to help troubleshoot any issues. Should only be necessary if instructed by Philips
Entertainment Technical Support.

Firmware Update - allows updating of firmware. 

Display ROM Data - will display console debug messages. 
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Restart Hardware Interface - will restart the hardware interface between the PC and the console hardware
components.

Copy debug info to clipboard - will copy all text from the console debug messages to the Windows clipboard to
allow for saving and sending to tech support.

Show Internal Flags - will display internal flags for messages.

Wing Screens - will display NEO wing screens.

Capsense - will turn off capacitive sense on motorized faders. Requires a password and should only be accomplished
with the recommendation of tech support.

Wings - If wings are plugged in, ability to go into the Console Debug Window and change the wing's device ID.

Desk Light Control
Desk Light controls are here as well.

43. Control Panel

This opens the NEO Control Panel. See “Control Panel” on page 328 for more information.
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Reports

Channel/Fixture Report
The Report section allows the user to pull up a report on several different areas of the contents of the showfile.

Here is the report interface.

Print - allows the printing of the document assuming a printer has been configured.

Open - allows the opening of a Prepared Report (*.fp3) file.

Save - allows the saving of a Prepared Report (*.fp3) file.

Find - allows the finding of text.

Zoom In/Zoom Pulldown/Zoom Out - allows zooming of document.

Borderless View - allows viewing without options and border. Double click to restore.

Contents View - not associated with the viewing type.

Page View - shows thumbnails of all pages.

Page Settings - allows configuration of page settings.

Edit Page - not associated with the viewing type.

Beginning of File - goes to the beginning of the file.

Page Down - moves one page down.

Page Number - choose by page number.

Page Up - moves one page up.

End of File - goes to the end of the file.

Print

Open

Save

Find

Zoom In/Zoom Pulldown/Zoom Out

Contents View

Borderless View Page View

Page Settings

Edit

Beginning of File

Page

Page Number

Page

Down

Page

Up

End of File

Close File
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Close - will close the file.

Fixture Report

This shows all patched fixtures in the showfile.

Macro Report

This shows all macros and their content in the showfile.

Sample Fixture Report

Sample Macro Report
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Profile Report

This shows all profiles in the showfile.

Sample Profile Report
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Channels/Fixtures In Use Report

This shows a list of all channels/fixtures that are programmed in the showfile. This includes cues, submasters and
effects.

Sample Channels/Fixtures In Use Report
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Channels/Fixtures Not In Use Report

This shows a list of all channels/fixtures that are not used in the showfile. This looks at cues, submasters and effects.

Sample Channels/Fixtures Not In Use Report
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Group Report

This shows a list of all groups and the group's settings.

View Director Stack (Selected Fixtures)

This is a selected fixture report that displays the selected fixtures and their current data.

Sample Group/Group’s Settings Report
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Edit Fixture Library

This opens the NEO Fixture Library Editor. There is a separate manual for the Fixture Library Editor. Please go to
www.strandlighting.com or www.neocontrol.net to download.

Edit Matrices
Opens the Matrix Editor. See “Edit Matrices” on page 262 for more information.
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Edit Profiles
Opens the Profile Editor. See “Edit Profiles” on page 260 for more information.

Edit Color Filters
Opens the Edit Filters dialogue box.

Allows the user to add/edit filters in the color filter library.
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ADD

Allows the user to add a filter by Brand, Name, Number, Description and allows the user to pick the color. (click the
white box).

EDIT
This allows the user to edit an existing color filter in the library much like ADD works.

REMOVE
This allows the user to remove a color from the library.

44. Window Layout Manager

The window layout manager allows the user to save floating window configurations to the second monitor as part of
the showfile. All layouts can be triggered by a Shortcut allowing the user to switch between custom layouts quickly
and efficiently.

First, turn on the Advanced Docking System. See "Make Database File Smaller" on page 299 for more information.
This turns on the ability to dock NEO floating windows on a second monitor.

Once turned on, open a floating window (Cues Lists, Groups, FX List and others) and drag the floating window onto
the second monitor. The following docking system will appear...
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Drag the floating window onto the second monitor and "lock" the window into the docking system by hovering over
the one of the individual tabs.

Once a floating window is docked into either the top, bottom, left or right, open and dock other windows. Once this
docking system is filled, then drag existing NEO windows within each 1/4 section and break it down further. Just use
the 4 up tab to arrange them to the user preferences.

When the layout is setup as needed, use the Window Layout Manager to save these combinations as a show defined
layout.

• The list on the left will list all created layouts.

• The Layout Name box will allow the naming of a layout.

• The Apply Shortcut box will assign a Shortcut to the layout for quick access.

• The Default Layout toggle will allow any single layout to be identified as the default layout.

Store New Layout - will store a new layout to the showfile.

Update Selected Layout - will update any selected layout.

Apply Selected Layout - will apply the selected layout to the additional monitor.

Delete Layout - will delete the selected layout.

Close - will close the Window Layout Manager dialogue box.
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Update & Close - will update the latest changes and close the Window Layout Manager dialogue box.

Right click on the show's layout list, and the options appear to "Export a layout to a file" and "Import a layout to a
file".

45. Control Panel

The NEO OS software runs on a PC processor under a Windows® operating system (OS). An OS system means that
only the software necessary to run the console is installed and no unauthorized software can be installed by the user.
There are no user-configurable applications that are included in the OS. This protects the system and the operating
software parameters, assuring that system integrity is never compromised.

Since the Windows OS is used, other features are available, such as a web browser, file manager and more. The Light
Palette console can also be connected to a network to take advantage of services like DHCP networking, mapped
network drives, Internet connectivity, and more.

Note:  There are keyboard shortcuts to navigate the Control Panel in the event that a mouse or touchscreen is not 
available.

• Ctrl + Tab will go between the environments on the left hand side. (Start Up, Applications, System and Mainte-
nance).

• Once the correct environment has been selected, the Arrow keys will navigate to the correct item (Up, Down, Left, 
and Right) and ENTER will select and open the desired item.

The Control Panel appears when called up through the MORE display.

The Control Panel provides management of the console, lighting system configuration and data.

It is divided into four categories:

• Start Up

• Applications

• System

• Maintenance

Click a category to view its control icons.
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Start Up
The NEO Control Panel: Start Up gives access to basic start up icons.

NEO - launches the NEO operating software. This is the console software itself.

NEO Remote - launches the NEO Remote Console software. The Remote Console allows a second faceplate (NEO
or PC) to connect as a second programming surface. Just launch NEO Remote and populate the Server pulldown with
the Main consoles IP address. That will identify the show name that is open on the Main console.  Preferred interfaces
should be set to the network interface card's IP address that is being used to connect to the Main console.  My IP
Address should be the address of the Remote system.

NEO Backup - launches the NEO software to connect as a tracking backup. The Backup Console allows a second
faceplate (NEO or PC) to connect as a redundant backup.  Just launch NEO Backup and populate the Server pulldown
with the Main consoles IP address.  That will identify the show name that is open on the Main console.  Preferred
interfaces should be set to the network interface card's IP address that is being used to connect to the Main console.
My IP Address should be the address of the Backup system.
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NEO Remote Viewer - launches the NEO software to connect as a remote viewer. This allows a PC to function as a
remote video system.  Populate the Server pulldown with the IP address of the Main console.

If needed, go into System Properties > System Input/Output and check "Enable Remote Viewing (RDP) and  set the
Shared Monitor settings as desired. 0 for All, 1 for Monitor 1, 2 for Monitor 2 and so on.

Fixture Library Editor - launches the NEO Fixture Library Editor.

Mobile Interface Builder - launches the NEO Remote Interface Builder from More > Control Panel > Startup:
Mobile Interface Builder. This allows the user to build an interface for a third party device that is Android or iOS
based. 

• Adjust the layout for tablet or phone, portrait or landscape.

• Create the layout with Buttons (triggering Shortcuts) and Sliders (mimicking Submasters). 

• Then save the Layout.

• The PIN number is there to add security for each layout file. Users will be prompted for a PIN number for access-
ing the interface.
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Edit Static IP List. The NEO Mobile Interface Builder system will
display files from all consoles on the network. It may become desirable
to limit the displayed NEOs that the MIB can connect to. This list
limits NEO consoles that it can connect to. Just “Add” the static IP of
the desired console and provide a name. 

Mobile interface builder app matches IP address when loading a new
layout to ensure that if multiple systems are being used that the correct
interface is selected.

Mobile interface builder app added labels {IP}, {NAME}, {PORT} to
display layout information on the interface.

Mobile interfaces are no longer broadcast if the system is running as a
tracking backup. If the backup takes over the interfaces will begin
broadcasting again.

Quick Start Guide - launches the Quick Start Guide document.

Manual - launches the manual document.

Fixture Editor Manual - launches the fixture editor manual.

Live Support - launches live support from Philips Strand Lighting technical support to allow the console to connect
to a Philips Strand Lighting technical support member for troubleshooting purposes. (Requires an internet connection
at the console.)

Virtual Console

A virtual console interface has been added to NEO. With the virtual console, PC users can see the console layout and
select keys as if sitting at the console itself.
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Applications
The NEO Control Panel: Applications gives access to basic auxiliary applications.

File Manager - launches the Windows file manager.

Web Browser - launches the default web browser (NEO Console version only).

Notepad - launches the Windows Notepad.

PDF Viewer - launches the Adobe PDF viewer (NEO Console version only).

Calculator - launches the Windows calculator.

Paint - launches the Windows Paint program.

Pegasus software application. (Control Panel > Applications)

Philips StrandNet application. (Control Panel > Applications)
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System
The NEO Control Panel: System gives access to Windows PC system configuration items to help configure the NEO
to the system.

Configure Network - launches the Windows Network Connections application. Here is where NEO's network can be
configured for the lighting network. Remember that NEO has two isolated network ports so ensure that correct one is
being configured.

Select the correct Local Area Connection. Right click and select Properties.
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Select Internet Protocol Version 4 (TCP/IPv4) then press the Properties button.

A typical setup will require NEO to have a static IP address. Select Use the following IP address: and assign
according to the needs of the network. The image below shows a standard static IP for a Strand network installation.

NEO NOTES & TIPS:  Network configurations can vary greatly. If the user system has been commissioned by a 
certified technician, then it is recommended to leave the commissioned settings intact. Be aware that changing the 
network configuration can cause the NEO console to become unable to communicate with networked devices such as 
dimmer racks and nodes. Please consult your network administration prior to changing network settings. 
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Change Console Name - allows the ability to change the computer name and domain.

NEO NOTES & TIPS:  Consult your network administrator prior to changing this setting.

Set System Time - allows the ability to change the computer's date and time setting.
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Set Screen Resolution - allows the ability to change the appearance of the displays.

Screen Saver Preferences - allows the ability to change NEO's screen saver setting. This is off by default and it is
recommended to keep that setting.
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Mouse Options - allows the ability to change the pointer device options and settings.

Touchscreen Calibration - allows the ability to configure and calibrate touchscreens.

• If touchscreen(s) are not functioning correctly, go to the Touchscreen Calibration option. 

• Click on Setup and follow the on screen instructions to "Touch this screen to identify it as a touchscreen." 

NEO NOTES & TIPS:  The user may need to touch the screen multiple times. It will change screens when it has 
enough data.

If touchscreen is not calibrated correctly, press the Calibrate button and follow the onscreen instructions to calibrate
the touchscreen(s).
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On Screen Keyboard - allows the ability to have an onscreen keyboard that will mimic the hardware keyboard.

Note:  On screen keyboard will only operate with a touchscreen (sold separately).

Regional Settings - allows the ability to change the Region and Language settings.

Volume Control - allows the ability to change the volume control.
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Sound Properties - Opens Windows Sound Properties dialogue box for audio configuration.  This is most likely used
when configuring the audio output for media effects or training videos.  The Playback Devices listed will depend on
the audio devices plugged into the NEO console.  This could include but not be limited to speakers, headphones and
monitors that have built in speakers.

Task Manager - this accesses Windows Task Manager and is password protected.

Windows Task Manager is a advanced level utility that helps with discovering, diagnosing and troubleshooting
Windows and Windows program issues.

Note:  Consult with Philips Entertainment Technical Support when troubleshooting any console related issue.
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Printer Setup - allows the ability to setup a printer for the NEO console.

Firewall Settings - allows access to the Windows Firewall Settings.

Note:  Consult Philips Entertainment Tech Support before changing any Firewall Settings.

Command Prompt - this opens a Windows Command Prompt as is password protected.
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A Command Prompt gives DOS level access to the NEO Windows PC.

Note:  Consult with Philips Entertainment Technical Support before using the Command Prompt.

Disk Cleanup - this opens Windows Disk Cleanup utility.

Note:  Consult with Philips Entertainment Tech Support before using the Disk Cleanup utility.

Windows Access Point Configure - allows access to the Windows Access Point Configure utility.
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Note:  Consult with Philips Entertainment Tech Support before using the Windows Access Point Configure utility.

Sound Properties. (Control Panel > System)

46. Maintenance

The NEO Control Panel: Maintenance gives access to higher level functionality for commissioning, troubleshooting,
and other system level functions.

Update NEO Software - the first step to updating the NEO console is to copy the software file to the C: drive. Then
Force NEO Shutdown. Once done, press the Update NEO Software button and follow the prompts to update the
console's software.

Update NEO Fixture Library - will update the consoles fixture library.

Hardware Test *- will run a hardware test that is independent of the NEO console software. Allows the ability to
check button functionality, the LED backlight and sliders.

Note:  * The NEO console software must not be running in order for the Hardware Test to function. Use Force NEO 
Shutdown prior to running the Hardware Test.

Open Fixture Folder - this will use File Manager to open the folder where NEO's fixture library is stored.

Open Log File Folder - will open the folder where the log file exists. In this folder, a log file exists and is being
maintained by the NEO software. A new file will be created every month, for March 2015, the file will be
NEO_Log_2015_March.txt. In this file will be a log of all command made during programming. This is for tech
support purposes and is not necessary to access during normal operation.
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Open HTTP Server Folder - when using NEO to host a web server (System Properties>System I/O) all web server
files will be stored here.

Note:  When updating software, if a version of the file name is found to exist, it will NOT be updated. Should the user 
wish those to be replaced, just delete all older files prior to updating.

Language Manager - will open the Language Manager software.

Restore Factory Settings - will restore the NEO console to factory defaults. Note: This is available on the NEO
console only. If running NEO PC, this will be removed. Just use Windows File Explorer if running on a PC.

Restore Fixture Library - restores the NEO's fixture library back to factory default. A great feature for rental house
consoles.

Force Software Only Shutdown - will force the NEO software to shutdown. This is required prior to updating
NEO's software.

Shutdown Firebird Server - the underlying engine for NEO is a Firebird database server. This feature will force the
shutdown of that server. Only use when recommended by tech support.

Registry Editor - this accesses the Windows Registry Editor and is password protected. 

Note:  This should only be accessed by authorization of Philips Entertainment Technical Support. 

Device Manager - this accesses the Windows Device Manager and is password protected.

Note:  This should only be accessed by authorization of Philips Entertainment Technical Support. 

Force System Restart - will restart the NEO console.

Force System Shutdown - will shut down the NEO software and Windows software. DMX will be held until the
power supply’s rocker switch is turned off.

option to shut down the Firebird server so that remote clients cannot connect. (Control Panel > Maintenance)

Language manager. (Control Panel > Maintenance)

- Added control panel item to reset the fixture library to the installed default. (Control Panel > Maintenance)
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GENERAL CONCEPTS

This section covers some lighting basics as well as introducing the user to NEO's main concepts and computer
terminology required to use the software.

1. Lighting Concepts

DMX System
DMX 512 is an EIA-485 based communications protocol and is the standard protocol by which lighting control desks
communicate with lighting equipment.

The DMX 512 protocol is a stream of data that is sent via a cable system connected between the console (NEO) and a
data receiver, which could be anything ranging from a basic light to intelligent lights, smoke machines, etc.

NEO uses the standard DMX512 protocol to communicate with the equipment it controls. DMX is connected to the
NEO software via either a USB-DMX512 connection or Ethernet to DMX converters.

Developed by the Engineering Commission of USITT, the standard started in 1986, with subsequent revisions in
1990 leading to USITT DMX512/1990. In 1998 ESTA began a revision process to develop the standard as an ANSI
standard, including a Public Review process. The revised standard, known officially as "Entertainment Technology -
USITT DMX512-A - Asynchronous Serial Digital Data Transmission Standard for Controlling Lighting Equipment

NEO Console

Dimming Racks

DMX512 Network

LED/Conventional/Automated Luminaires

DMX512 Network

DMX512 Network

System Concept
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and Accessories", was approved by ANSI in November 2004. This current standard is also known as "E1.11, USITT
DMX512-A", or just "DMX512-A", and is maintained by ESTA.

DMX512 is unidirectional and does not include automatic error checking and correction, so it is not safe to use for
applications involving life safety, such as controlling pyrotechnics or laser lighting display where audience or
performer safety is involved. 

RDM
Remote Device Management or RDM is a protocol enhancement to USITT DMX512 that allows bi-directional
communication between a lighting controller and attached RDM compliant devices over a standard DMX line. This
protocol will allow configuration, status monitoring, and management of these devices in such a way that does not
disturb the normal operation of standard DMX devices that do not recognize the RDM protocol. 

The standard was developed by the ESTA Technical Standards and is officially known as "ANSI/ESTA E1.20,
Entertainment Technology - Remote Device Management over USITT DMX512"

Dimmers
In the simplest terms, a dimmer is a physical apparatus used for controlling the intensity of a conventional light.

A dimmer can be fully on, fully off, or somewhere in-between. The setting of a dimmer is referred to as the DMX
value. DMX values range from zero to 255. A value of DMX 0 means the light is off, and DMX 255 means the light
is fully on. By adjusting the DMX value up and down, the intensity of the light increases and decreases. By default
the NEO console will control this via percentage values. So 0% will be off and 100% will be fully on.

Basic dimmers are in different formats. A permanent installation may have a full rack of 96 dimmers. This is known
as a Dimmer Rack. They have 48 dimmer modules with 2 dimmers per module. A standard dimmer module will have
a 2400w capacity. This is known as a 2.4k dimmer module. 

There are also smaller collections of dimmer units known as Dimmer Packs, usually made up of 4 to 24 dimmers per
pack.

Strand Lighting C21 Dimming Rack
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For example, a 12-pack consists of 12 dimmers. Each dimmer is a physical plug on that 12-pack, each of which
operates independently of the other 11.

DMX Value
The setting of a dimmer is referred to as the DMX value. DMX values range from zero to 255. A value of zero means
the light is off, and 255 means the light is fully on. By adjusting the DMX value up and down, the intensity of the
light increases and decreases.

DMX Universe
A DMX universe consists of 512 DMX dimmers. In the case of the NEO system, the console was purchased with a
set number of universes. This can be from 1 to 100 universes. Should the NEO console need more universes after the
initial purchase, more DMX universes can be authorized at any time. Contact local Philips Entertainment Dealer for
details.

Channels (Logical/desk channels or Fixtures)
A channel is a controller on a lighting console that is used for controlling dimmers or attributed luminaires. This is
often called a Fixture.

In the case of a simple light with one dimmer, a single channel would control one dimmer. More sophisticated
lighting fixtures, which utilize multiple dimmers to control various properties or attributes of the fixture (such as
intensity, position, color, etc), are controlled by a single channel or fixture.

The “IF” Command
The IF command will allow conditional changes based upon the state of the channels. The following examples will
demonstrate the types of changes the IF command will allow. The IF command works globally on all channels or on
selected channels. The examples below will work to query all channels or on just selected channels. The ability to
bump palettes has been added when using the IF command so look to bump a legal palette instead of typing
[POSITION/COLOR/BEAM/EDGE] (#) as any some of the examples below.

IF can work on channels 3 different ways.

• IF can work on selected channels. Meaning that if channels are selected, the IF statement will only look through 
the selected channels to apply the entered IF logic.

• IF can work on all channels. Meaning that if nothing is selected, the IF statement will look through all live chan-
nels and apply the entered IF logic.

• IF can work on a leading channel list. Meaning that if a list of channels is provided prior to entering IF, then the IF 
statement will search and apply to only the list of channels.

IF can access Palettes in three different ways.

• Palettes can be accessed using Command Line. This works by pressing the Position, Color, Beam and/or Edge 
keys.

• Palettes can be accessed by pressing a Palette from any Palette windows. For example, a Position palette can be 
accessed by pressing a stored Position in the Position palette window.

• Palettes can be accessed from the “Ch Groups” display button on the top of the main display. This will open the Ch 
Groups display where there are tabs for all palette pages.

Strand Lighting A21 Dimming Panel
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The below IF statement examples work on either the entire system or on selected channels.

• If channels are at 40%, change them to 50%.

• [IF] [40] [@] {THEN} [50] [ENTER] or

• [IF] [4] [@] {THEN} [5] [ENTER]

• If channels are in the “DC” position palette, change their color to “L201”.

• [IF] (Bump the DC Position Palette) [@] {THEN} [COLOR] [3.201] [ENTER]

• If channels are in Position 2, change them to Position 3.

• [IF] (Ch Groups) (Select Position Tab) (Position 2) (Position 3)

• If channels are in Position 1, change them to 80%.

• [IF] [POSITON] [1] [@] {THEN} [80] [ENTER]

• If channels are in Positions 1 or Position 3, make them Color 2.

• [IF] [POSTION] [1] [IF] [IF] {|} [POSITION] [3] [@] {THEN} [COLOR] [2] [ENTER]

Note:  The “|” symbol represents “or” in the English language.

• If channels are in Position 2, make then Edge 2.

• [IF] [POSITION] [2] [@] {THEN} [EDGE] [2] [ENTER]

• If channels are below 50%, then make them Color 3.

• [IF] [-] {<}50 [@] {THEN} [COLOR] [3] [ENTER]

• If channels are in R80, put them in Position 4.

• [IF] R80 [@] {THEN} [POSITION] [4]All of the above IF statements can be applied to a leading channel 
list. Meaning that the IF statement can be applied to a portion of the lighting system identified by a list of channels 
before the IF command is added. Taking the first example from above and adding a leading channel list to show the 
addition.

• If any channels are at 40%, change them to 50% but only do this for channels 1 thru 30.

• [1] [THRU] [30] [IF] [40] [@] {THEN} [50] [ENTER]

If pressing the IF key after selecting a palette (or any condition) you will get the & character (logical and), pressing
again will give the | character (logical or). Pressing another palette without an & or | will automatically do a THEN
{palette} Pressing the @ key on a command starting with IF will populate the line with THEN examples... IF Position
1 | Position 3 THEN 40 - this would set channels in either of those positions to 40% (the @ key isn’t needed) IF
Position 1 | Position 3 THEN Color 2 IF Position 1 & Color 3 THEN Edge 2 IF >50 THEN Color 2 IF R80 THEN
Position 4

A summary of accessing the IF command from the console... [IF]

When no "IF" is on the command line pressing this key will add it. 

[IF] - When "IF" already exists on the command line pressing this key will add the & (and) character. 

[IF] - When "IF" already exists on the command line and the last character is & then it will swap this character or the
| (or) character. 

[+] - If the last thing on the command line is IF, & or | then pressing this key will add a > (greater than) character. 

- If the last token on the command line is IF, & or | then pressing this key will add a < (less than) character. 

[@] - When "IF" exists in the command chain and the last token is not IF, & or | then the keyword THEN is added to
the command chain. 

Palette windows - When "IF" exists in the command chain then pressing a palette button will add that palette to the
command (e.g. COLOR 3). If the last token is not IF, & or | then the system will automatically add "THEN
{PALETTE}" to the command chain.
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As part of the IF logic, the IF key can be used to access the Position, Purpose and Color info from the Patch display.

• Ch Groups pull down can now be used as a bump option for the IF command.

Dimmer Patching
Dimmer patching is the patching of dimmers into channels. This allows a single channel to control any number of
dimmers.

In NEO, this is achieved via the "Dimmer Patching" window. See “Standard Dimmer” on page 250 to learn how to
use this feature.

Patching is also done to define which channel/fixture controls an intelligent fixture, i.e., a fixture that utilizes multiple
outputs for its various features. When patching an intelligent fixture, all the outputs for that fixture are automatically
patched into that channel/fixture.

When a user attempts to patch the same dimmer to more than one channel, the following Dimmer Conflict dialogue
box will appear. (This can be turned off by checking the “Don’t show this question again” box or by going into
System Properties > System Settings > Advanced System Settings and checking or unchecking “Show Patching to
Multiple Channels Dialogue”.

See “Intelligent Fixtures” on page 251 for further information about intelligent fixtures.

Channel Profile
Typically, a channel:dimmer level ratio is 1:1. That is, when the channel is at a certain value, the dimmers in that
channel are also at that value.

On occasion, it may be necessary to configure a channel to output levels other than 1:1. The actual level sent to the
dimmer can be scaled up or down, or configured into a non-linear relationship. For example, a lamp may not perform
well below a certain level. The Channel Profile curve can configure the channel to prevent the dimmer from ever
reaching such levels. The Channel Profile can be used for configuring individual channels or for multiple channels at
once.

Conventional Fixtures
Conventional fixtures are those that have only one property that can be controlled from the lighting desk, hence
requiring a single output to control it.

Channel Profiles
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Examples of conventional fixtures are:

• Standard luminaires - profiles, fresnels, etc

• Effects Equipment - smoke/fog machines, bubble machines, mirror balls, etc.

Intelligent Fixtures
Intelligent fixtures, in contrast to conventional fixtures, have multiple attributes that can be controlled from the
lighting desk. Examples are LEDs, automated luminaires, effects equipment and more.

Fixture Attributes
Fixture attributes can be 8-bit or 16-bit. This essentially determines how finely a property can be controlled. A 16-bit
attribute uses 2 DMX outputs to control the value to be set. Instead of 256 value levels the attribute can have 256 x
256 values or 65,536 different values.

A 16-bit property can be more finely controlled than an 8-bit property. For example, 16-bit pan and tilt enables the
fixture to be moved much more precisely than 8-bit pan and tilt.

• 8-bit - has 256 steps, 0 to 255 for the value.

• 16-bit - has 65535 (256 x 256) settings, 0 to 65535 for the value.

NEO's Fixture Library stores attribute information about the fixtures. The library is divided into fixture brands. This
helps to organize the wide range of fixtures that are available into manageable groups. 

Table 1 on page 350 shows a list of common attributes that a fixture may have.
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Table 1: Common Attributes

Attribute Description

Color wheel (color changer, color 
scroller)

A wheel-shaped device containing circles of colored media (gels) that attaches to a luminaire in order 
to create a colored beam of light.

Can be manually controlled or motorized and controlled via a dimmer.

Gobo A thin plate with a design cut out of it that can be placed in the path of the light beam, causing a 
pattern to be projected.

Pan Horizontal movement of an automated lighting fixture

Tilt Vertical movement of an automated fixture

Zoom Zoom is a way of controlling the size of the light beam. It is achieved by moving the lens back and 
forward inside the fixture.

Control Advanced fixture properties, such as turning the lamp on and off or controlling cooling fan speed.

Color Mixing Color mixing comprises multiple colors that can be combined together in varying proportions to 
achieve a desired color of light. The most common mixing system is subtractive CMY (cyan, 
magenta, yellow) and RGB (red, green blue).

Framing shutters Achieved via a set of shutters, this enables the shape of the light beam to be altered. The shutters 
can be moved towards/away from the edge of the beam, as well as angled to create non-
perpendicular corners.

Iris Iris is a set of shutters used for controlling the size of the light beam.

Opening and closing the shutters allows more or less light through the iris. The light intensity is 
decreased, due to less light being allowed to pass through.

Edge Controls the hardness or softness of the beam edge.

Focus Adjusts the beam so that the light is concentrated on the focal point.

Diffusion Created using a filter, diffusion is the scattering of light.

Strobe Flashing light, of which the speed can be configured via the control channel. 
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NEO CONCEPTS AND TERMINOLOGY

1. Channel Groups

Channel groups enable the user to collect channels at a level that can be recalled at a later time.

In NEO channel groups serve several functions:

1) Channel groups allow the simultaneous control of multiple channels at once. These can function as 
collections or channels only or collections of channels that output a particular level.

2) A channel group can also be assigned to a submaster to provide a single handle for controlling the level of 
the group.

3) A channel group can be applied in a single press of a Shortcut. This means that the levels set in the channel 
group will be set in the fade time supplied with the group.

4) By setting a selection shortcut use a single button press to select the channels in the group.

5) Channel groups can be put into a cues so there is no need to repeat the look when building cue lists.

6) Channel groups can be referenced as advanced palettes in individual attributes of cues.

A channel group can be configured to have one of five types of behavior. This behavior defines what happens to the
current channel settings when the group is being controlled. 

NEO NOTES & TIPS:  The behavior is not used when the channel group in included inside a cue.

Override (LTP) - Also known as "Latest Takes Precedence". This behavior will apply the channel levels set in the
group to output channels and take over control of that channel. As soon as something else sets the channel value the
group value will get overridden. Likewise as soon as the group value changes it will override the existing values set in
the channel. Override will not apply to HTP channels if the override value is less that the set HTP value. Turn this
behavior off by setting the "Override takes precedence over HTP" option in the system properties, show defaults tab.

Build - The values set in the group will be added to the current output value of the channels.

Exclusive - All other channels will be set to zero and only the channels in this group will be applied.

Highest Takes Precedence (HTP) - When a group value is set with HTP behavior the output on the channel is
determined by the item that has a higher value. If the value set in the group is higher than the value in the cue (or other
item) then the group will control the channel. If the value in the cue (or other item) is higher than the group value, it
will remain unchanged.

Independent - Channels in an "Independent" group will override all other requests to modify the channel value. As
soon as the group level is above 0, channels within this group will be controlled by the group values. 

Inhibit - With an inhibit group the value masters all channels that are in the group. The output value of the channel
will be scaled by the value of the inhibit group to which it belongs. 

Hue LTP - The Hue LTP behavior is a special type designed to be used with color mixing fixtures. As the value of the
group changes from 0 to 100% the output of the group will be the saturated hue value between 0 and 360 degrees. In
real terms this translates to a full color spectrum that can be accessed from the group.

Subtract - Similar to the build option, the subtraction behavior will subtract the value set from the current output
value.

Intensity HTP/Attributes LTP - combines the two worlds allowing intensities to function HTP and attributes to
function LTP.

2. Submasters and Shortcuts

Submasters and shortcuts are both ways of accessing the various functions of the channel groups.

A submaster is generally a slider on a lighting console desk that can be assigned to a group. The submaster can then
control the output value of the group.
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There are 3 different shortcut functions available with channel groups:

Selection Shortcut - Setting a selection shortcut allows the user to select the channels in the group with a single
button press.

Toggle Shortcut - A toggle shortcut can be used to temporarily turn the channel group on and off. Pressing it once
will set the channel group to full and once in that state pressing a second time till set the group to 0.

Apply Shortcut - Pressing the button assigned to an apply shortcut will set all of the channels to the state recorded
into the group without changing the group value. The level will be "Applied".

Submasters and shortcuts are both accessible via controls at the top of the Command Line interface.

3. Cues

A cue is an event in a production that is the signal for a specific action. The response may include any lighting change
that is required. Cues define how the lighting is set during the various parts of a performance. Using the NEO
console, cues can run automatically or be user-controlled.

A cue can contain a number of channels, and defines all their states for a particular part of a performance. One or
more effects can be included, as well as defining the fade times, dwell, and effect delays.

Cue can also trigger executing system shortcuts such as macro's and palettes.

Cues can be sub-grouped into "Cue Lists", enabling them to be easily identified and managed. 

Cue Number
Each cue within a cue list has a unique number, known as a cue number. When a cue is created, it is automatically
assigned a number. NEO supports up to 7 whole number and 3 decimal places with each cue numbering allowing for
cues to be inserted in between other cues. When a cue is added to the end of the cue list it will always be given a
whole cue number. If a cue is inserted between two other cues then the new cue number will be half way between the
cues.

Blocking
Blocking is an override of the tracking behavior for a cue or a channel. A channel that is "Blocked" will always apply
the values set regardless of the previous cue state. Blocking is most commonly applied to an entire cue to create a

Shortcuts

Submasters
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known or fixed lighting state in the show. The first cue should always be blocked and in NEO this will be done
automatically as a Smart Block. 

Added new logic when recording cue so that if a channel has never been used in the cue list and has been added since
the block was put in, then the software will look forward for any block cues and automatically add the channel @0 to
the block.

Fixture Block
In addition to blocking a cue, choose to "Force Fixture Block". This will block all parameters of a fixture should any
parameter change in the edited cue. This is available either as a default state (System Properties>Show Defaults) or
from the Record Cue or Update Cue dialogue box.

1) Force Fixture Block is designed to be a higher priority block at the fixture level. It's intent is to stop all 
parameter tracking for all parameters of a fixture regardless of whether the cue is blocked or unblocked.

2) This would be assigned on a per fixture basis using command line to engage and disengage.

3) Fixture Block is not affected by Cue Block. The user can Block and Unblock the cue without changing the 
status of any fixture block.

Smart Block
This only blocks channels that have an instruction in the cue. This is a cue-level block that applies a block flag to all
intensities of currently active fixtures.

Cue List
A Cue List is a collection of Cues. Cues are lighting states that playback in numerical order using stored time
information. These are sometimes called a "cue stack" or "cue sheet". On some systems that only allow a single cue
list this may be simply called the "Show".

Example: A band is performing a song in a concert. Rather than having simple lighting that does not change for the
duration of the song, cues can be set up to change the lighting as the song progresses. As each "cue" in the song is
reached, the lighting can be easily set for that part of the song by activating the relevant cue.

Cues are set up and managed via the "Cue List Editor". See "Cue List Editor" for more information.

Cue Lists
To easily manage and organize of a large number of cues for a production, NEO enables cues to be grouped into "Cue
Lists".

Example: A concert contains 10 songs, all of which have different lighting. By creating a "Cue List" for each song,
the cues for each song can be easily identified and kept separate. The benefit of having multiple cue lists is that it's
easier to playback the songs in any order.

Part Cues
Cues can be broken up into Parts. A Part cue is a portion of a cue that has the ability to run in a different time.

The only reason to breakup a cue into different parts is if the need exists for a channel or collection of channels is
required to change in a different time.

Assigning a channel to a different part is simple. Just type (Channel List) [PART] (#) [ENTER]. Example: If I want
channel 1 to be in part 1, type [1] [PART] [1] [ENTER]. Upon completion, a part ID will appear in the upper right
hand corner of the Classic View's Channel Block.

Now the cue needs to be recorded or updated. When you do that, there will be a line in the cue list for each part.
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Note:  The part cue number designator will display in red when assigned, however once stored, the color will change 
to light grey.

The base part of the cue is part 0 so the user can return a parted channel back to the base cue by typing (Channel List)
[PART] [0] [ENTER] or [PART] [0] [ENTER] will apply to selected channels.

Changing Time on a Part Cue
To change time on a part cue, simply type [CUE] (#) [PART] (#) [TIME] (#) [ENTER]

Changing Delay on a Part Cue
To change time on a part cue, simply type [CUE] (#) [PART] (#) [DELAY] (#) [ENTER]

The example images show how a cue with parts displays on both the Side Bar and the formal Cue List.

Changing Text on a Part Cue
Edit the Description cell in the formal Cue List for the appropriate cue and part.

For the current cue, type [CUE] [PART] (#) [EDIT] {TEXT} (Name) [ENTER].

For a non-current cue, type [CUE] (#) [PART] (#) [EDIT] {TEXT} (Name) [ENTER].

Cue Playbacks
The Cue List Editor is used for setting up and managing cue lists and cues. When it comes to running a show, the
"Cue Playbacks" window can be used. The Cue Playback window is a simple screen that enables cue lists to be set up
in the desired order, defining the starting cue for each.

As the show progresses, the lighting programmer simply presses the "Go" button for each cue list to activate each
cue. The display shows the current cue and the next cue so that the operator can see progress during the show.

Cue Trigger
A cue's trigger defines the circumstances that cause a cue to become active. There are four types of trigger:

Manual - The user must physically press a "Go" button either on NEO or on the Cue List screen.

Auto Follow - Cues set with the auto follow trigger will execute the follow command. Once this AF countdown is
complete, the following cue will execute.

MIDI - The cue will be triggered by an external midi event occurring.

Line In - The cue will be triggered by the line-in audio source. 

Timecode - The cue will trigger when the specified timecode is reached. If the timecode has already passed when this
cue is reached, the software will trigger the cue immediately. Enter the timecode value into the field provided.
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Cue Channels
The channels that are used or recorded into a particular cue. A cue can contain any number of channels, limited only
by the system resources of the NEO.

Cue Effects
Effects can be triggered by a cue so that they will run when the cue is run and stop when the cue finishes.

Cue Shortcuts
When a cue runs the user can optionally fire any number of shortcuts. This is designed to extend the capabilities of
the cue by allowing any function that can be assigned to shortcut to be run in the cue.

Cue Channel Groups
To make programming cues easier add into the cue any pre-built channel group. The channel groups become a
building block for the cue and allow the user to change a single channel group and have the effect automatically
applied to all cues that contain the group.

4. Tracking (Intelligent Cue Execution)

NEO supports two different modes of cue playback. If not sure or are new to stage lighting we recommend using
"hybrid" mode.

Hybrid Mode
In hybrid mode all active channels are recorded into the cue. An active channel is any channel currently "on". If a
channel was on in a previous cue and not recorded into the next cue it will be turned off when the cue runs. All other
attributes (pan, tilt, color etc) will not change until a new cue instructs them to change. 

When running cues, NEO will only apply changes to the cue state. If an attribute does not change between cues then
the value will not be applied even if the output value has been changed by another control element in the software
(group, effect etc.).

Full Tracking Mode
In full tracking mode only changes are recorded into each cue however any channel that is currently on will stay at
that level. When a cue is recorded or updated NEO will work out what has changed and record only that information.
If a channel is not in a cue then it will maintain any state it was set to by a previous cue. To turn a light off in a cue the
channel will be added with its value at zero. 

When the cue is played back only the changes specified in the cue will be applied. If a cue play back is out of order
NEO will track back through the cue list and calculate the correct lighting state at that point based on the previous
cues.

Tracking is a playback function in NEO but there are some important recording options that will assist the user to
program the show. Tracking behavior will be applied regardless of if the cues are run sequentially or out of order. 

The tracking mode is set per show in NEO and can be changed at any time in the system properties. The tracking
switch will be stored with the show to avoid the chance of a hybrid show running on a tracking setup or the other way
around.

Tracking Options
Track - If Track (or Track Forward) is selected when recording a cue then the software will look at each cue after the
cue being recorded and apply the same channel settings until the channel state changes from its original value.

Cue Only - Only the cue being recorded or updated will be affected by the changes made. All of the cues after and
before the cue will remain unchanged.

Trackback - If Trackback is selected when recording or updating a cue then the software will look at each cue prior
to the cue being recorded and apply the same channel settings until the channel state changes from its original value.

Cue Only (Ints)/Track (Atts) - the option of Cue Only applies to intensities and the option of tracking applies to
attributes. It's a combination of Cue Only and Tracking. The benefit is if the user is traditionally a cue only
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programmer and are now working with LEDs or Moving Lights, the user may want the fixtures attributes to track
while dealing with the intensities cue only.

5. Recording Modes

This define what channel/fixture selection is used to store data.

Live (Full Tracking Only) - simply put, this records the state of the lighting system. If it's "on", then it's stored. The
only exception to this is whether levels from submasters are included and whether running effects are included.
(These exceptions defaults can be set in System Properties > Show Defaults.) 

Selected (Both Modes) - this mode records only the channels/fixtures that are currently selected (with the red box
around them). 

Active (Hybrid Tracking Only) - this mode records only "active" channels. Those are channels that have an
intensity level above 0. All other channels/fixtures are ignored. This means that any attributed fixture with changed
values will only be stored if it has an intensity above 0.

Changed Only (Full Tracking Only) - only changed values will be stored. This is primarily useful for a multiple cue
list full tracking environment.

Block (Full Tracking Only) - will place a hard value on all channels/fixtures and attributes for that cue. This is
useful when using Full Tracking in Tracking Mode for the cue that ends a scene, act or production number. This will
stop all values from tracking into this cue.

Smart Block (Hybrid Tracking Only) - this will force an instruction for every channel that has a level. The NEO
software evaluates the cue and for every channel/fixture that has a level above 0, it will block those channels.

6. Effects

Effects are time-based programs of lighting changes, such as chase sequences, simple loops, color changes, etc.

The NEO Effects Editor allows effects to be easily created, tested, and adjusted using the intuitive graphical interface.
Effects can be run from inside shows via cues or by using Effect Playbacks.

To facilitate the management of large numbers of effects, effects can be given simple labels that describe what the
effect does. Whenever the user needs to find or select an effect within NEO use the filters to narrow down the list.

Effect Types
NEO has 6 different effects types that can be created. Each effect type is designed to be the most efficient way of
programming the effect you want.

Simple Chase - A chase is very similar to a cue list in that each step of the chase contains a static lighting state. As
the chase progresses through each step the lighting state changes. Unlike a cue list the timing is made simpler and
only a single fade time can be applied between steps.

Timeline - With a timeline effect you can design what happens in a graphical format of fixture vs. time. Each
segment in the timeline defines a lighting state and how it will change.

Profile - The profile effect (sometimes called the Profile/Attribute effect) will apply a profile curve to a specific
attribute over time.

Paint Box - this applies a color effect across a large quantity of LED fixtures, in a Matrix, utilizing an unlimited color
path. 

Matrix - The matrix effect is designed to make working with large arrays of lights, such as multi-color LEDs, easy
and efficient. The Matrix effect allows you to map an image or video file to a channel array while at the same time
apply a moving box over the resulting image.

Media - NEO provides the ability to playback audio and video files directly from the software. This can be used to do
sound effects in a show or play a video presentation for a corporate event.

DMX Recording - The DMX recorder can be used to record and playback a DMX512 stream. 
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Effect Playbacks
The Effect Playbacks are simple controls for running effects ad-hoc. The NEO Effects Playback screen allows the
lighting programmer to see at-a-glance all the effects of interest and conveniently run them at the click of a button.

Exclusive Groups
To ensure that only one effect operates within a specified group, exclusive groups can be created. We may have a
number of effects for the same group of lights where it makes no sense to run any more than one effect at a time. If we
did, the effects would conflict and cause undesirable results.

By placing an effect into an exclusive group, it will stop all other grouped effects when attempting to start it.

7. Command Line Interface

NEO comes equipped with a Command Line interface. This is similar to traditional theatrical lighting consoles and
allows the programmer to type commands directly to the system bypassing the graphical interface.

It can be advantageous to do this if a quick change is required and the programmer is familiar with the required
commands. The Command Line interface can be accessed via the primary monitor's window.

Command History
The command history allows the viewing of past commands made via the Command Line interface. This can be
handy when something unexpected has happened and the programmer needs to check exactly what commands were
sent to the dimmers.

8. Telnet Interface

Telnet allows a programmer to connect to NEO remotely using a hand-held device or similar. Commands can be sent
from the remote device using the command language used by the Command Line interface.

The freedom of remote access to the NEO software means that the programmer/operator can be almost anywhere
while setting up the lighting fixtures and make changes without needing to reside at the NEO itself.

9. Palettes

Palettes are a way to configure a particular look that the user may want to recall quickly and without executing
several commands to the system. A palette may put a fixture into a specific position or setup a number of fixtures into
a specific color.

NEO allows palettes to be assigned to a specific list of fixtures or operate on currently selected fixtures. 

10. Macros

Macros are simple programs made up of a sequence of commands. If a particular sequence of commands is used
frequently, it makes sense to create a macro for them. This means that rather than re-typing the commands every time,
the macro can be run instead, automatically executing the commands.

This saves time as well as reducing the chance of errors being made.

11. Modes

Active selection mode - Turn on the active selection option for channels/fixtures and they will automatically go to
the ON level whenever selected. The fixtures will also turn OFF if the fixture is unselected. When active selection
mode is enabled the on screen "Select Active" button will highlight in red as a warning and the Active Select Mode
button will be backlit in red. This is a great tool for a channel check. Turn Active Select Mode on, select channel 1,
then Next/Last to move up and down the channel list.

Inclusive Mode - If the "inclusive selection" option is active then each selection made will be added to the previous
selection. All channels currently selected will remain selected unless they are in the new selection area. Any selection
will toggle the selection state of a channel. When Inclusive Mode is enabled, the on screen "
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Highlight selection mode - This is toggle option that will have a small check mark next to it when turned on. Turn on
the highlight selection option for channels and fixtures to automatically go to the highlight state whenever selected.

When on, the "Select Active" on screen button will be in red.

12. Shortcuts

A shortcut is a quick route to a particular setting or feature that is used frequently. There are many places that
shortcuts can be assigned within NEO. A shortcut may select some fixtures, run a cue, start an effect, apply a setting,
or just about any operation.   
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COMPUTER CONCEPTS

In order to use the NEO console or the Hyperion software on a PC, it is necessary to understand a few basic computer
concepts.

1. Trackball

A trackball is available for mouse-like pointer movement from the NEO console. The buttons labeled "Left" and
"Right" will function as the left mouse button and the right mouse button on a mouse. The "center" button will lock
the mouse point to the selected fixture's pan and tilt parameters. The Center button is locked when the backlighting is
red. When the backlighting is white, it will function normally as the mouse pointer.

2. Mouse Scroll Wheel

A mouse is a small device that connects to a computer. It is used for navigating around computer software, by means
of a pointer. Many types of mice have what is known as a scroll wheel. This is a wheel set into the top of the mouse,
usually located between the left and right buttons.

On NEO or using the Hyperion software, the scroll wheel is used for increasing/decreasing dimmer values in a
similar way to the sliders on a lighting console desk

3. Drag-and-Drop

Drag-and-drop is a commonly used method of moving one or more items from one location to another using the
mouse. Typically, it is done by left clicking on the item you wish to move, then, while still holding down the mouse
button, moving the mouse to the required destination. Release the mouse button when the mouse pointer is over the
destination.

In NEO or Hyperion, drag-and-drop is used to assign fixtures into channels, dimmer patching, etc…

4. Right-click Pop-up Menus

Right-click menus are hidden menus, accessible by right-clicking the mouse button. If there is a right-click menu
available for a feature, it will appear. Once available, you can click on the desired menu item.

If you right-click and a menu appears that you do not want to use, simply press the escape key on your keyboard (or
click elsewhere on the screen) and the menu will disappear.

5. Screen Real Estate

As the name suggests, screen real estate refers to the screen area you have available on your monitor for viewing
information.

There is a primary window available for single monitor systems. Once you get beyond that, there are individual
features of NEO are in their own separate windows and can be arranged/resized on the computer screen according to
an individual programmer's preference. NEO will remember the screen layout for next time.

It is also possible to expand to 3 monitors, thus expanding the available screen real estate.

6. Window Docking

Some windows in NEO can be "docked" onto other windows. This means that the two windows are attached to one-
another, which is useful if you want to have two related windows remain next to each other at all times.

7. MIDI

Musical Instrument Digital Interface, an industry-standard interface used on electronic musical keyboards and PCs
for computer control of musical instruments and devices.

8. SMPTE

Society of Motion Picture and Television Engineers. SMPTE allows for timecode triggering of cues.
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9. Timecode

A feature within media that identifies individual frames to define how frames are counted throughout a project. It is
similar to the page numbers of a book: if the pages of the book are out of sequence or have gaps, then things get
confusing. Similarly, if a video tape does not have a timecode, then finding a particular clip on tape would be time-
consuming and confusing.

10. SQL Server

Structured Query Language server. A computer that provides client computers with highly efficient access to
database files.

Firebird SQL Server is a type of database. A database is an electronic way of storing information on your computer.
When you use NEO, your entire lighting configuration is stored in a SQL Server database. This means that you can
switch off your computer, even unplug everything, and NEO will still remember your set-up.

NEO's SQL Server database has built-in backup and restore features to safeguard you against data loss. Your
individual backup settings adjusted in System Properties.

11. USB

Universal Serial Bus. USB is a standard port that enables you to connect external devices (such as digital cameras,
scanners, and mice) to Windows and Macintosh computers.

The USB standard supports data transfer rates of 12Mbps (million bits per second), a vast improvement over the
serial port standard it has replaced. Aside from speed advantages, USB devices can be connected or disconnected
without the need to restart the computer. Many USB devices can work on either a Windows PC or a Mac, provided
the device manufacturer offers connectivity software for both computer systems. Many of the latest digital cameras
offer USB as well as serial connections.

NEO makes use of USB devices to transmit and receive data.

12. Ethernet

A very common method of networking computers in a LAN using copper cabling. Ethernet will handle about
10,000,000 bits-per-second and can be used with almost any kind of computer.

NEO can communicate with DMX systems using standard DMX over Ethernet protocols. 2 Ethernet jacks are
available on every NEO console.

13. Hardware Interfaces

CueServer
CueServer is a lighting control solution for of stand-alone architectural and show control. NEO is now able to directly
integrate with these products by exporting a cue list directly to the device. The CueServer tab will allow you to select
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the cue list you want to upload and the actions you want for each of the buttons. NEO will then take care of creating
the necessary resources containing your show data and upload it in one operation.

When this window is opened NEO will automatically search for CueServers connected on the network. You can
select the CueServer you want to send a show file to by selecting it from the drop down combo box at the top of this
window. Detailed information about the selected CueServer will be shown on the right including its version number,
model and serial number.

Use the "Cue List Name" selection to set the cue list you want to load onto the device.

The CueServer has 8 buttons on the front of the device that can be set to either advance the cue list or load to a
specific cue. Use the selection box to set the action you want for each of the buttons. If the "Load Cue" option is
selected a second drop down box will be shown for you to select the cue you want.

Click on the "Save" button to upload the cue list you have selected into the CueServer. If your show file contains a lot
of effects then this may take a while as each effect is rendered.

Hardware Submasters
NEO provides the ability to add physical hardware to the system by using any standard DMX lighting desk, MIDI
Control desk or Playback wing. By connecting the DMX-IN hardware, you can connect your existing lighting desk to
the software.

NEO will only use the first 100 channels of the lighting desk as submasters, but these 100 channels can be paged to
provide up to 100,000 submasters.

See “Hardware Setup” on page 26 for more information about connecting the playback wing to your system.

External Hardware Wings - CueServer
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NEO can also read fader levels from a standard MIDI controller using the "Control Change" messages. If the MIDI
device supports motorized faders then NEO will also send MIDI messages when changing page or setting the on-
screen submasters. This will allow the physical submaster to reflect the current value.

14. Hardware Shortcuts

Programmable keyboards can be connected to the NEO system to provide physical shortcut buttons. Programmable
keyboards are most commonly used in point-of-sale environments but are perfect for this application. Each key can
be assigned a sequence of characters to send to the computer and are generally designed for heavy continuous use.

NEO has a built-in command sequence that will trigger shortcuts from programmable keyboards. Each shortcut can
be triggered by the key sequence control-Q {digit 1} {digit 2}. For example to trigger shortcut 21 from an external
keyboard you would need to program the key sequence control-Q 21.

If you are using the Enttec shortcut wing no programming is required as the system will immediately associate the
keys with the shortcuts in the system.

For more information on shortcut hardware, please visit our web site. www.strandlighting.com.

15. Stats

This command will generate a listing of system processing times. This is of main use if you are experiencing timing
problems with the software and have contacted technical support. A typical listing is shown below:

• System Stats

• Average fps: 50

• Missed frames: 23 (0.0%)

• Avg pool time: 0ms

• Avg pool 2 time: 0ms

• longest pool time: 26ms

• longest pool 2 time: 5ms

• Current pool Size: 700

• Avg dmx processing time: 0.71ms

• Avg cue list processing time: <0.1 ms

• Avg cue execute time: ~

• Avg Fx processing time: <0.1 ms

• Avg Fx playback processing time: <0.1 ms

• Avg channel view processing time: <0.1 ms

• Avg ext triggers processing time: <0.1 ms

• Longest processing time: 79ms

• Longest dmx process time: 79ms
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• Longest fx process time: 51ms

• Longest cue execute time: 0ms

• Main processing thread is running
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